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Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger.

DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

CAUTION
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.
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used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified 
personnel are those who, based on their training and experience, are capable of identifying risks and avoiding 
potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

WARNING
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
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Welcome to COMOS 1
Overview

With COMOS, Siemens is the only supplier in the world to provide the process industry with a 
software solution for holistic management of a plant project – from
planning, operation and upgrading to decommissioning. COMOS ensures that all involved 
parties can access all project-relevant data at any time
across all company levels and during all project phases.

Contents of this manual
This manual is designed for users who create and edit engineering objects and documents in 
COMOS.

The following functions are not included in this manual: 

● Functions with write access to base objects, report templates, and other base data 

● Functions with write access to the base project or system project 

● Functions which require expertise in writing VB scripts

● Configuration of project properties

See the "Administration" manual for more.

Database
The database is at the heart of COMOS. The database contains the predefined objects and 
components. 

All information is stored and managed in the object-oriented database throughout the entire 
lifecycle of the plant. 

Operation
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COMOS product areas
COMOS consists of the following product areas:

● COMOS Platform
With COMOS Platform we provide you with the basis for efficient data management. The 
data of all the applications and areas are stored centrally and object-oriented in the COMOS 
database and are therefore always consistent. 
Changes that are carried out in one application are therefore available immediately in all 
the other applications. No interfaces are required within COMOS. Automated interfaces are 
available for interfacing with external systems.

● COMOS Process 
COMOS Process provides you with applications for creating process data – as well as 
everything you need for process engineering in the product area. 
It enables you to use design data even in early plant engineering phases for the creation 
of process flow diagrams and then to refine the data in the piping and instrumentation flow 
diagram. COMOS Process makes quality-assured pipe planning and pipe spec generation 
on the basis of international industry standard. The implementation of the process data on 
the geometric level in the form of isometrics and 3D images can be derived simply from the 
given data.

● COMOS Automation 
COMOS Automation is used for electrical engineering of plants up to their full automation: 
Solutions developed specifically to this purpose cover all relevant electrotechnical, 
measurement, open-loop and closed-loop control processes. 
To this purpose logical links between the objects as well as automated processes are 
represented graphically in the form of diagrams - and hydraulic as well as pneumatic flow 
charts are created based on previous data. The integration of COMOS and the SIMATIC 
PCS 7 process control system allows the combination of data from parallel work processes 
and workflows. With just the press of a button, the complete plant structure from the 
engineering data in the process control system. On the basis of these data virtual 
commissioning can furthermore be carried out through the seamless interfacing of SIMIT. 
Consistent engineering throughout the entire life cycle brings the worlds of plant planning 
and operation closer. Decision processes are simplified and costs for the plant management 
optimized.

Welcome to COMOS
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● COMOS Operations 
COMOS Operations is the first choice for implementing an efficient strategy for plant 
support. 
All data from the engineering phase can be used in the operational phase. Solutions are 
available for the planning, execution and analysis of maintenance measures during 
operation. The management of shutdowns or inspections as well as the interfacing of 
portable terminal devices are supported efficiently. Performed measures can be reported 
directly from the field or from the workshop using special interfaces. The integration of 
COMOS and SIMATIC PCS 7 furthermore allows the intelligent utilization of the operating 
data and based on this the implementation of status-based maintenance strategies. A 
further lever for increasing the plant availability is the mutual utilization of COMOS and XHQ 
Operations Intelligence.

● COMOS Lifecycle 
COMOS Lifecycle provides comprehensive information management over all lifecycle 
phases of a plant, regardless of the functional assignment, on the basis of COMOS platform 
or via web-based solutions.
This allows you to profit from maximum decision-making reliability and from global access 
to data and documents, for example, via mobile terminal devices and the integration of 
sharepoints. The high-performance 3D Virtual Reality visualization with COMOS 
Walkinside allows the utilization of the data generated in engineering for implementing a 
"digital twin" of the plant. This can be used as a common portal for all the project participants 
in the plant data in order to gain a common understanding via its status. This allows training 
courses, for example of maintenance teams, to be carried out effectively.

COMOS Enterprise Server
This allows global application networking through its service-oriented architecture (SOA) and 
ensures the central availability of all required data in the plant management and the automated 
transfer of data between COMOS and other software systems. Moving resource-intensive 
tasks to the COMOS Enterprise Server increases the performance on the client. You can find 
additional information on this topic in the "Enterprise Server" manual.

Welcome to COMOS
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Using the COMOS help 2
2.1 Help on COMOS

Help has been converted to HTML5 with version 10.2.  

Software requirements
To display help as of COMOS 10.2, you will need an HTML5-capable browser.

The following browsers have been tested and approved:

● Windows 7 with Internet Explorer 10

● Windows 7 with Internet Explorer 11

● Windows 10 with Edge
MS Edge is entered as the standard app at Windows 10.

● Windows Mobile with IE 11

● Windows 7 with Chrome 46

● Windows 7 with Firefox 38

● Apple with Safari (iPad, iPhone)

Overview of the COMOS help 
You can open the COMOS help as follows:

● COMOS help system:

– From COMOS

– Online

– From the file system

● Individual help files:

– From COMOS

– From the file system

Opening the help from COMOS
1. Start COMOS.

2. To open the COMOS help system, select the menu command "Help > Start".

3. To open an individual help file, select the command "Help > <File name>" in the menu.

To read the help in a different language, switch the language of the COMOS user interface 
and call up the help system again.
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Opening the help online
See also chapter Displaying the COMOS help system online (Page 23).

Opening the help through the file system
1. Open the directory in which the help files are located in the file explorer.

For example: <COMOS installation directory>/Help/<Language folder>.

2. To start the COMOS help system, double-click on the file "start.htm". 
The help system opens.

3. To open a PDF document, double-click the document.

2.2 Copying documentation to the help folder

Requirement
COMOS is installed.

Permissible data types: .doc / .docx / .txt / .pdf

Procedure
1. Open the directory in which the help files are located in the file explorer.

For example: <COMOS installation directory>/Help/<Language folder>.

2. Save your documentation in the <Language folder>.

Note
"Help" directory

Documents that are located directly in the "Help" directory are not displayed.

Result
The files are displayed in COMOS with the "Help" button.

Using the COMOS help
2.2 Copying documentation to the help folder
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2.3 Displaying the COMOS help system online
The COMOS help system is available free of charge and in multiple languages on the Internet:

● Open the following Internet page: COMOS documentation (http://www.siemens.de/comos-
dokumentation/)

● In the "Overview", you will find the various product areas of COMOS product family.

● In the "Topics" column, you will find the COMOS Manual Collection or individual help files. 
The lines contain links to the My Documentation Manager and the SIEMENS Industry 
Online Support Portal:

Clicking on the icon opens the document in My Documentation Manager 
(MDM). The range of functions in MDM depends on whether you are logged 
in:
● Without registration/login: View documents
● With registration and login: Configure, compile documents, notification 

function, etc.
See chapter Using the COMOS help system in My Documentation Manag‐
er (Page 25).

DE, EN, ZH Link to the document in the available languages in the SIEMENS Industry 
Online Support Portal:
● DE=German
● EN=English
● ZH=Chinese simplified

COMOS help files in the SIEMENS Industry Online Support Portal
The COMOS help files are also available as PDF files in the Siemens Industry Online Support 
Portal. In addition, you can display the documents with the My Documentation Manager.

Using the COMOS help
2.3 Displaying the COMOS help system online
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To find COMOS help files, proceed as follows:

1. Open the Web page of the Siemens Industry Online Support portal: SIOS (http://
support.automation.siemens.com/)

① "Product Support" in the navigation bar
② "Index (A-Z)" tab
③ "Navigation" tab

2. Click on "Product Support" in the navigation bar.

3. You have three ways to find COMOS help:

– Open the "Navigation" tab and look for COMOS in the product tree. You can find COMOS 
help under: "Automation technology > Automation systems > Automation software > 
Plant Engineering Software COMOS"

– Open the "Index A-Z" tab. If you click on "C", you will see the COMOS help files in the 
list.

– Enter the term "COMOS" in the search box at the top right and click "Search". You can 
narrow search results by clicking on "Manuals" below "Search area" in the hit list.

4. Select a COMOS help file from the list and click the title.

5. When the selected COMOS help is displayed, you can choose from the following:

– "Displaying and configuring": Opens the document in My Documentation Manager.

– "Download": As PDF file

Using the COMOS help
2.3 Displaying the COMOS help system online
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2.4 Using the COMOS help system in My Documentation Manager
My Documentation Manager is a central online database for SIMATIC and COMOS customer 
documentation. My Documentation Manager  allows you to edit the entire customer 
documentation, reorganize it and export it into a variety of formats if needed. You can assemble 
documentation corresponding exactly to your system or configuration from the documents that 
are available. The notification feature informs you by e-mail when a document in your collection 
has changed.

Range of functions in My Documentation Manager
The range of functions depends on whether or not you are logged in:

● Functions without login:

– View customer documentation

– Open help for My Documentation Manager

● Additional functions with login:

– Configuration: Assembly of individual documents in a collection

– Delete, add, move, copy any document in a collection

– Send collection to an e-mail address as a link

– Search and assemble documents in one language and then export them to one of the 
available languages

– Notification feature is available on all levels: Single page, chapter, manual, collection, 
etc.

– Export documents, folders and collections as a PDF, XML, or RTF file

Working with My Documentation Manager 
● The following section describes how to open the My Documentation Manager : Displaying 

the COMOS help system online (Page 23).

● A comprehensive description of working in My Documentation Manager is available in the 
help: AUTOHOTSPOT.

Using the COMOS help
2.4 Using the COMOS help system in My Documentation Manager
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Registration and login to My Documentation Manager
1. Click "Full scope of functions after login/registration".

The login form for My Documentation Manager  opens.

2. Click "Yes, I would like to register now" and fill out the fields in the following windows.

Using the COMOS help
2.4 Using the COMOS help system in My Documentation Manager

Operation
26 Operating Manual, 03/2017 V10.2.1, A5E37082875-AB



3. Click the Next button, until your login information is completed.

4. You have now successfully registered and can use all the functions of My Documentation 
Manager .

Using the COMOS help
2.4 Using the COMOS help system in My Documentation Manager
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Fundamentals of data structures 3
3.1 Basic knowledge on projects

3.1.1 Definition of the term "project"

Definition: COMOS projects 
A COMOS project contains all of the data you need to engineer a task that you have been set. 
You always access the data via the project. In other words, you must open the project before 
you can view and edit its data. 

A database can include one or more projects. Only one project is ever opened at a time. Which 
projects you see depends on your user rights.

There are different project types. The most important for you are the engineering project and 
base project types.

See also
Basic knowledge on the project types (Page 29)

Using projects (Page 185)

3.1.2 Basic knowledge on the project types

Overview 
COMOS supports the following project types:

● Engineering projects

● Base projects

● Template projects

● System projects

Engineering projects
● An engineering project contains all of the data that you need to complete an actual 

engineering task (for engineering, servicing, or decommissioning a plant, for example).

● To work in an engineering project, users require read rights and write rights for the project.

● A database can contain many engineering projects.
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● Engineering projects are exclusive. Their data is not visible or available in any other project.

● The engineering project can have any objective. 

– One engineering project can map exactly one working project. This is a frequently used 
procedure when engineering a plant construction with COMOS.

– An engineering project can include several working projects. This is a frequently used 
procedure when operating a plant with COMOS.

Base projects 
● The base project contains a library of objects and templates which you reuse in engineering 

projects, adapting them to meet the actual requirements of your project.

● Users who are responsible for base project administration need at least administrator and 
base data rights in addition to read rights and write rights. Other users usually only have 
read rights.

● As a rule there is only one base project per database.

● Base projects are not exclusive. Their data is visible and available in the linked engineering 
projects.

Template projects
Template projects are complete COMOS projects which are used as reference projects. 
Usually these are completed jobs or training examples. 

System project
As a rule, there is only one system project. The system project is used to control COMOS. This 
project is only relevant for system administrators. 

See also
Basic knowledge on project links (Page 30)

Using projects (Page 185)

3.1.3 Basic knowledge on project links

Principle
Project links control which objects and templates are available to you in the engineering project. 
Types of project links:

Fundamentals of data structures
3.1 Basic knowledge on projects
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To a base project
The base objects and templates which are located in the released area of the linked base 
project are available.

To a base working layer
This link restricts the link to the base project: Only the base objects and templates from the 
corresponding base project working layer are available. 

To the project structures
The project structures control the structure of the project and thus which entries are available 
in the "New" context menu. 

The structures defined by the project structures can be set up so that they correspond to a 
labeling system. See also chapters Structure engineering using project structures and labeling 
systems (Page 46) and Creating objects from a project structure (Page 233).

You can find additional information on this topic in the "Administration" manual, keyword 
"Administration of the labeling system and ALIAS".

Link to a template project
If an engineering project is linked to a template project, you can copy its contents to the 
engineering project. There is no connection between the copied data and the originals in the 
template project.

If you only want to use part of the template project, use cross-project copying.

See also
Using projects (Page 185)

3.1.4 Basic knowledge on projects with shared access

Controlled access and data consistency
Several users can work in the same project at the same time. Data consistency is guaranteed 
as follows:

● Object operations are coordinated through a cache. 
You can find additional information on this topic in the "Installation" manual, keyword 
"Overview of the cache technologies".

● Joint working on attributes is coordinated. See chapter Attributes for joint access 
(Page 72).

● Interactive reports can only be opened with write access by one user.
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There are also control tools which help to prevent one user from overwriting the work of another 
user:

● Rights management

● Use of views and working areas
See chapter Fundamentals of views and working areas (Page 50).

● Use of working layers
See chapter Basic knowledge on working layers (Page 32).

See also
Using projects (Page 185)

3.2 Basic knowledge on working layers

3.2.1 Purpose of working layers

Requirement
● The user has a basic understanding of projects.

See chapter Basic knowledge on projects (Page 29).

Definition
Working layers are overlapping views of a project on which users work at the same time. When 
working in working layers, the shared, tested portion of the database (the released area) does 
not change. The released area is technically a working layer, but one with special significance. 
The released area is also called a Customer Release Area (CRA).

Purpose of working layers 
● They make distributed working in projects easier.

● They allow you to outsource project states and parts of projects to partners.

● They protect the tested data stock against unintentional or erroneous changes.

● They support seamless project histories.

See also
Interaction between released area and working layers (Page 33)
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3.2.2 Interaction between released area and working layers
The diagram below illustrates how working layers work. The diagrams are described in the 
sections that follow. 

The released area and its working layers
In its basic state, a project consists of the released area. Any number of levels with working 
layers can be created under the released area. One or a number of working layers can be 
created for each level. Each working layer has any number of subordinate working layers but 
only one superordinate working layer. In the working layer display mode, the released area 
can be edited in many functions like in the working layers.

Objects that shine through
When you create working layers of the first level, you initially see all the objects from the 
released area. When you create working layers of the second and third levels etc., you 
immediately see all objects that are visible from the superordinate working layers (in other 
words, the objects shine through). 

An object shines through from a layer until it is edited in the layer and thus checked in. As long 
as the object shines through, you will automatically see all changes made to it from the 
superordinate layers. 

Check in objects (edit or delete)
When you edit or delete an object that is shining through in a working layer, you check it in to 
the layer. When an object is checked in, a new object is created and superimposed onto the 
object from the superordinate layer (in working layers from the first level, it is superimposed 
onto the object from the released area). The change or the information that the object has 
been deleted is written to the new object. The object from the superordinate working layer is 
no longer visible. It does not change. See also chapter Deletion in working layers and in the 
released area (Page 38).

When the checked-in object is edited again from the superordinate layer, a collision occurs. 
See also chapter Collisions (Page 36).
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Adding objects
Objects created in the working layers initially have no effect on the released area. The released 
area only changes when you release the objects to it. See also chapter Release of working 
layers (Page 41).

When you create an object in a working layer, it shines through on all subordinate working 
layers. 

Merging data 
Finally, the project data distributed to the various working layers is merged again in the released 
area via a controlled release process. See also chapter Release of working layers (Page 41). 

See also
Using working layers (Page 193)

3.2.3 Working layer display mode

Principle
● The working layer display mode is a control tool: When the working layer display mode is 

activated, a color code indicates the status of an object compared with the superordinate 
level. The color code also indicates if there are status changes in the substructure of a 
subtree. History display and working layer display use the same color code. See also 
chapter Status in the working layer display mode and history display (Page 37).

● In the working layer display mode, the released area can be edited in many functions like 
in the working layers.

● A background color can also be assigned to the working layer levels and the released area 
in the Navigator, allowing you to see immediately which level you are working from.

User interfaces
The working layer display mode is available in the following user interfaces:

● Navigator

● Queries

● Interactive reports

The working layer display mode covers objects of all system types that are displayed in these 
user interfaces.
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Working layer display for standard tables
If you have read rights in the base project, a "Standard tables" node is displayed on the "Base 
objects" tab. The "Standard tables" node is not marked in color when the working layer display 
mode is activated. The local standard tables of the project and those inherited from the base 
project and system project are located under it. The standard tables below it are marked in 
color.

See also
Purpose of working layers (Page 32)

Enabling and disabling the working layer display mode (Page 196)

Displaying legend of color settings (Page 197)

Configuring the working layer display mode and the history display (Page 198)

Using working layers (Page 193)

3.2.4 Scope of working layers

Engineering objects
With the following exceptions, all engineering objects are covered by working layers:

● Nodes that are labeled manually as not release-relevant

● Special objects that are relevant for system functions
Example:
Object with name "@Project" and the class "Document group" and all the objects below it. 
These engineering objects only exist if you work with project revisions.

Properties of documents
If the properties of the document object are changed, the document is checked in to the working 
layer when it is saved.

Content of interactive reports
Interactive reports support working layers as follows:

● The report is checked in to the working layer when it is opened.

● When a report is opened, all changes from the superordinate working layers are applied.

● When a working layer is released, all changes in the working layer are transferred into the 
superordinate working layer.

● The working layer display mode is visible in the working area.
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Contents of external documents
● Properties of document with "normal" option: The document is checked in when it is opened.

Exception: In the case of Microsoft Office documents, COMOS checks whether the 
document has changed in comparison to the version in the superordinate working layer 
when a document is closed. If it has, the document is checked in to the working layer.

● Properties of document with "Reference", "File link", or "HTTP" options: These documents 
are always independent of working layers.

Report templates
Report templates can be customized for each working layer. You can find additional information 
on this topic in the "Administration" manual, keyword "Creating a template file depending on 
working layer in COMOS" and keyword "Overview of the administration of working layers".

Functions that are independent of working layers
There are functions that are completely independent of working layers. Changes to these areas 
take effect at once in all working layers. For example: 

● Project properties

● Customer-specific attributes in the project properties

● User management

● Case variants

● Languages

● Timestamp

● Standard tables

Revisions
* revisions do not have an effect on the subsequent working layers.

See also chapter Unit revisions and project revisions (Page 110).

See also
Purpose of working layers (Page 32)

3.2.5 Collisions

Principle
A collision occurs when an object checked in to a working layer is edited again or deleted in 
the superordinate working layer. The object checked into the working layer is no longer based 
on the most up-to-date information from the superordinate working layer.
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COMOS detects collisions automatically. 

The collision occurs in the working layer to which the object was checked in the first time.

You have the option of displaying collisions:

● In the Release manager
See also chapter Performing release check by means of Release manager (Page 218).

● Via the working layer display mode
See also chapter Enabling and disabling the working layer display mode (Page 196).

If collisions are not resolved, data may be inadvertently lost or corrupted during release.

Resolving collisions
To resolve collisions, select one of the following options:

● Retain the information from the subordinate layer.

● Restore the information from the superordinate layer.

See also chapter Identifying and resolving collisions (Page 223).

Special case
Due to the hierarchical structure of working layers, you can edit an object that has been 
checked in to a superordinate working layer, and thereby check it in again. In that case, the 
collision is only displayed for the first object that had been checked in. 

See also
Interaction between released area and working layers (Page 33)

3.2.6 Status in the working layer display mode and history display

Status values of the working layer display mode and history display
The status values are as follows:

● "Not changed"

● "Changes in subobjects"

● "Changed"

● "New"

● "Deleted"

● "Collision"

● "Collision in subobjects"

● "Deleted in one of previous layers"
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Note
"Deleted" / "Deleted in one of previous layers"

In the software, there is a differentiation between hard deleted and soft deleted. If an object 
has the status "Deleted" in the working layer display mode or history display, it is always soft 
deleted. 

See also chapter Deletion in working layers and in the released area (Page 38).

Detailed status information
The "Object status (Working layers/History)" window displays more detailed information about 
the object status than the working layer display mode and the history display. 

Example of detailed status information 
In a working layer, you create an engineering object under which elements are automatically 
created. The status of the object in the working layer display mode is "New". 

You delete one of the elements. The status of the engineering object in the working layer 
display mode remains set to "New". You can only see that you have deleted one of the elements 
in the "Object status (Working layers/History)" window.

See also chapter Displaying the working layer status and history status of an object 
(Page 201). 

See also
Working layer display mode (Page 34)

Enabling and disabling the working layer display mode (Page 196)

Purpose of working layers (Page 32)

3.2.7 Deletion in working layers and in the released area

Principle
When working with working layers there are two types of deletion:

● Hard delete: Physical deletion

● Soft delete: Logical deletion

According to the working layer principle, the information that an object has been deleted is 
passed on to the subordinate layers. 
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Hard delete
For objects with the status "Hard delete":

● They are not visible in the COMOS user interface whether working layer display mode is 
activated or deactivated.

● Administrators can restore them within a certain time frame. You can find additional 
information on this topic in the "Administration" manual, keywords "Notes on objects marked 
"Hard delete"" and "Using the "Restore COMOS objects" query" and in the "Class 
Documentation COMOS_dll" manual, keyword "UndoDelete".
The objects are removed from the database once this time frame has expired.

Soft delete
For objects with the status "Soft delete":

● They are not removed from the database.

● If the working layer display mode and history display are deactivated, they are hidden in 
the Navigator, in the report and in all other user interfaces.

● If the working layer display mode or history display is activated, they are displayed in red, 
but remain visible in all user interfaces and in the reports.

● This also applies to hierarchically structured working layers.

Note
Compatibility problems with working layer display mode in the report
● Behavior for versions older than COMOS 10.2:

– Report: Objects are marked as 'Soft deleted' on the report when the working layer 
in which the object was deleted is active. In the subordinate working layers, the object 
appears in the report with the status "Unchanged" (black).

– Navigator: Objects are marked as 'Soft deleted' in the Navigator when the working 
layer in which the object was deleted is active. The object is invisible in the 
subordinate working layers.

● Behavior as of and including COMOS 10.2:
Report behaves like Navigator: Objects are marked as 'Soft deleted' when the working 
layer in which the object was deleted is active. The object is invisible in the subordinate 
working layers.

● You can undo the soft delete and restore the objects. See also chapter Undoing the deletion 
of objects with the "soft delete" marker (Page 226).

See also chapters Working layer display mode (Page 34) and Fundamentals of history 
display (Page 44).

Deletion in the released area
In databases of the type "cDB", the released area is the first working layer. If you delete objects 
in the released area, the following applies:

● History management deactivated: The objects are hard deleted.

● History management activated: The objects are soft deleted.
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See also chapter Fundamentals of project history and object history (Page 42).

In databases of the type "iDB", the working layer model includes two superordinate layers for 
the released area: the MRA and the CRA. The following therefore applies to the iDB: a hard 
delete is possible for each object in the layer in which the object was originally created.

Deletion in working layers
● If you delete objects that are checked-in or shine through, they are soft deleted.

● If you delete objects in the working layer in which they were created, the following applies:

– History monitoring deactivated: The objects are hard deleted. 

Note
No collisions on subordinate layers

If the objects have been checked into a subordinate working layer or are subject to 
history monitoring, they are also hard deleted there. No collisions occur.

– History monitoring activated: The objects are soft deleted. 

See also chapter Fundamentals of project history and object history (Page 42) and chapter 
Collisions (Page 36).

Releasing deleted objects
● cDB

– Release to the released area
Objects from the source working layer with the status "Soft delete" are assigned the 
status "Hard delete" in the target working layer.
Exception for release to the released area: If the object already has the status "Soft 
delete" in the target working layer, the status does not change. 

– Release to a working layer that is not the released area
Objects from the source working layer with the status "Hard delete" are not released.
The object in the target working layer is assigned the status "Soft delete" if either the 
source object or the target object has the status "Soft delete".

● iDB

– Objects that are hard deleted are not applied to the superordinate layer (target working 
layer).

– The "Soft delete/Hard delete" status is always transferred from the object in the source 
working layer to the object in the target working layer.
In practice, these rules only apply to objects with the status "Soft delete", because 
objects with the status "Hard delete" are not released.

See also
Interaction between released area and working layers (Page 33)

Deleting (Page 180)
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3.2.8 Release of working layers

Requirement
● You are familiar with the purpose of working layers.

See section Purpose of working layers (Page 32).

Release workflow
Once work in a working layer is complete and has been checked, the working layer is released. 
When a working layer is released, its data is transferred as follows:

Action in the subordinate layer 
prior to release

Result in the superordinate layer 
after release

See also chapter ...

An object shining through from 
the superordinate layer is deleted.

The object is also deleted. Deletion in working layers and 
in the released area (Page 38) 

An object shining through from 
the superordinate layer is 
checked in and changed.

The changes are applied. Interaction between released 
area and working layers 
(Page 33) 

A new object is created. A new object is created.

At the end of the release process, the data is released in the released area.

As of COMOS 10.2.1, a new release technology is used with MS SQL. This also has an effect 
on the object history. 

Note
Server-based releases can lock the COMOS access

The release of a larger working layer until completion of the release locks the write access of 
COMOS clients. See chapter New release technology for MS SQL servers (Page 227).

Release checks
During the release, COMOS automatically checks the consistency of the released data. 

The following criteria will prevent a release:

● Open revisions
See also chapter Unit revisions and project revisions (Page 110).

● Objects with duplicated names or labels
Duplicated names or labels of attributes and connectors are also taken into consideration.

Note
Checking a working layer in the Release manager

You can check working layers in the Release manager before releasing them. See also chapter 
Performing release check by means of Release manager (Page 218).
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Working with working layers following release
The administrator controls what happens to the working layer following release:

● The working layer and its objects are deleted.
In this case, only working layers without subordinate layers can be released.

● The objects in the working layer are deleted but the working layer is not.

● The working layer is set to read-only.

You can find additional information on this topic in the "Administration" manual, keyword "Using 
the base object to control rights".

See also
Releasing a working layer (Page 228)

Using working layers (Page 193)

3.2.9 Fundamentals of project history and object history

Project history (history management in the project)
The project history logs the changes of the released area when a working layer is released to 
the released area. A release of a working layer in a working layer has no effect. 

For each change generated by the release, a new history entry is created with the following 
information:

● The period during which the data stock of an object was valid

● Who edited the data

● What data was edited

If you need history entries for changes within the released area, you also need to activate the 
object history for the objects in the released area.

Using project history (history management in the project)
The project history uses two tools:

● The history display
See chapter Setting the comparison time for the history display (Page 203) and chapter 
Activating and deactivating the history display (Page 205).

● The "Object history" window
An entry is created in the "Object history" window for each changed object in the history. 
Objects without history monitoring at the object are also given a history entry.
See chapter Open the "Object history" window (Page 206) and chapter Checking the object 
history (Page 208).

Activating project history (history management in the project)
● You need to activate the "History management" option in the project properties.
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You can find additional information on this topic in the "Administration" manual, keyword 
"Administering history management (project history)".

Object history (history monitoring at the object)
The object history logs changes to objects and their child objects in a working layer. 

For each saved change, a new history entry is created with the following information:

● The period during which the data stock of an object was valid

● Who edited the data

● What data was edited

Using object history (history monitoring at the object)
The history entries are associated with the working layer. To check the history entries, you 
have to open the working layer in which the history entries were generated. The released area 
is also considered a working layer. 

The object history uses two tools:

● The history display
See chapter Setting the comparison time for the history display (Page 203) and chapter 
Activating and deactivating the history display (Page 205).

● The "Object history" window
In the history, an entry is generated in the "Object history" window only for objects with the 
"History monitoring at the object" property.
See chapter Open the "Object history" window (Page 206) and chapter Checking the object 
history (Page 208).

Activating object history (history monitoring at the object)
● You need to activate the "History management" option in the project properties.

● You must activate history monitoring at the object individually for each working layer and 
each node.

You can find additional information on this topic in the "Administration" manual, keyword 
"Administering history monitoring (object history)".

Delete 
If history management and history monitoring are activated, this influences the deleting of 
objects. See also chapter Deletion in working layers and in the released area (Page 38).

See also
Fundamentals of history display (Page 44)
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3.2.10 Fundamentals of history display

Requirements
● You are familiar with the fundamentals of history management.

See chapter Fundamentals of project history and object history (Page 42).

Principle
The history display is a control tool. See chapter Check by means of working layer display 
mode and history display (Page 196). You have the following options:

● It uses a color code to indicate the status of the objects in relation to a comparison time 
defined by you. 

– If you do not set a comparison time, the history display indicates whether the nodes 
have history entries or not. 

– In setting a comparison time you are restricting how far back in time the last change 
logged in the object history may be located if it is to appear in the history display. There 
are the following comparison times:

– Time of release into the released area

– Time any object was created 
See chapters Setting the comparison time for the history display (Page 203) and 
"Working layer/History management" tab (Page 212).

● The color code also indicates if there are status changes in the substructure of a subtree. 
History display and working layer display use the same color code. 
See chapters Status in the working layer display mode and history display (Page 37) and 
Configuring the working layer display mode and the history display (Page 198). 

● The history display is available in the "Object history" window and in the same user 
interfaces as the working layer display mode.
See chapter Working layer display mode (Page 34).

3.3 Basic knowledge on planning the project structure

3.3.1 Project structure fundamentals

Principle
Project data is structured in object trees on the tabs of the Navigator. See also chapter Structure 
of the Navigator (Page 157). 

The tab you work in depends on the respective COMOS product.  Unit engineering is done on 
the "Units" tab; location engineering is done on the "Locations" tab. In special cases, units and 
locations can be mixed. See also chapter Mixing units and locations (Page 48). The objects 
on the "Units" and "Locations" tabs are also referred to as engineering data.

Fundamentals of data structures
3.3 Basic knowledge on planning the project structure

Operation
44 Operating Manual, 03/2017 V10.2.1, A5E37082875-AB



The hierarchical tree structure shows you how your unit or location is structured at a glance. 
The object structure and device labeling depend on the project structure with which the objects 
were created or whether they were created freely.

Structure engineering using project structures and labeling systems
See also chapter Structure engineering using project structures and labeling systems 
(Page 46).

Free structure engineering
See also chapter Free structure engineering (Page 47).

Assignment between units and locations
You can assign locations and units to one another via references. See also chapter Setting 
general references (Page 257).

Example: There are three units in a "factory" building. The "factory" object is located on the 
"Locations" tab; the objects for the units are located on the "Units" tab. The units have 
references to the "factory" building and vice versa.

Owners and children
In most cases, an object is the owner of the objects which are located underneath it. The 
objects underneath it are referred to as children. If the owner is an engineering object, the 
subordinate objects are also referred to as engineering data elements.

However, it is the COMOS object model, rather than the position in the Navigator, which is the 
deciding factor for the owner/child relationship. For more information on this topic, see the 
manual "Class Documentation COMOS_dll".

Examples of cases in which the owner and the object under which the object is located in the 
Navigator are not identical:

● Links

● Objects under search objects and index objects

See also
Fundamentals of creating objects (Page 54)
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3.3.2 Structure engineering using project structures and labeling systems

Principle
Projects are based on project structures. Project structures fulfill the following purpose:

● They control which objects can be created in the engineering data and under which owners 
they can be created.

● Accessed via the context menu, they enable you to create a correct project structure in next 
to no time.

● Indirect: They define the device label.
The position of an object in the object tree determines:

– How many labeling components it has

– The content of the labeling components

– Prefix and delimiter between the labeling components

Note
Generating the label

You can find additional information on this topic in the "Administration" manual, keyword 
"Administering the behavior of engineering objects".

If you are using project structures to engineer the structure of your project, you can only create 
objects freely at the points defined by the project structures. 

Implementing standards and labeling systems
The project structures can be configured so that they conform to standards or labeling systems.

Management and provision of project structures
Administrators prepare the project structures and make them available in the project.

See also
Creating objects from a project structure (Page 233)

Project structure fundamentals (Page 44)

Free structure engineering (Page 47)
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3.3.3 Free structure engineering

Principle
Free structure engineering supplements work with project structures. This allows you to create 
objects which may not be created at another position in the project structure. You usually only 
create single objects or nodes freely. 

Free structure engineering can occur in the following scenarios:

● If you are working with general engineering objects.
See also chapters General engineering objects (Page 80), Free creation of objects directly 
under the project root (Page 238), and Creating general engineering objects (Page 238).

Note
Permissible subobjects

There are no restrictions on which objects can be created under a general object.

● If you may create any number of additional engineering objects under the engineering 
objects.
See also chapter Free creation of objects (Page 234).

Most project structures support free structure engineering in a number of predefined places. 
In addition, you can create general engineering objects directly under the project root.

Application example
Initial situation: You are working with the "Factory/building/production EN standard" project 
structure. You have configured a query which finds all armatures of a subunit with a specific 
design temperature. You want to save the query in the engineering data. 

Problem: The project structure does not allow you to save the query in the subunit or under 
the folder in which the armatures are located.

Solution 1: You can create a general unit directly under the project root. Save the query under 
this object.

Solution 2: The project structure allows you to create a general object under the "Factory/plant/
production EN standard" object. Save the query under this object.

See also
Project structure fundamentals (Page 44)

Structure engineering using project structures and labeling systems (Page 46)

3.3.4 Mixing units and locations

Background
The device labeling must be unique. 
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However, there are various definitions as to exactly when a device tag is regarded as unique. 
One definition is that the device label must be unique throughout the entire character string of 
the unit, location, and device. According to this definition, the following example device labels 
are unique and, therefore, permissible: 

● "=A1+O1-B1"

● "=A2+O1-B1"

The device labels correspond to the following object structure: 

This object structure is rejected by COMOS as incorrect and corrected. Only one device "B1" 
is permitted under object "O1". 

Mixed structures
So that labels of this type can be permitted nevertheless, you can mix units and locations on 
one tab. On the first level in the Navigator, only objects with the "Unit" class may be created 
on the "Units" tab and only objects with the "Location" class may be created on the "Locations" 
tab. However, on the second and all subsequent levels, you can mix units and locations. 

The mixed structure for the example above looks like this: 

When creating a mixed structure, you have the same creation methods available as when you 
create the locations and units separately. The usual method is to use the context menu or 
drag&drop from the "Base objects" tab.
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Requirement for mixing units and locations
● The project structure supports mixing units and locations.

● The base data has been configured so that mixed structures are output correctly on reports.

See also
Project structure fundamentals (Page 44)

Creating engineering objects using drag&drop with a base object (Page 239)

Creating engineering objects via the context menu (Page 235)

3.3.5 Alternative labeling system

Principle
Projects which have been engineered using a specific labeling system can be mapped onto a 
different labeling system. That way for example, you can map a labeling system in a foreign 
language.

You can find additional information on this topic in the "Administration" manual, keyword 
"Administration of the ALIAS identification system".

See also
Setting general references (Page 257)

3.4 Fundamentals of views and working areas
Views and working areas filter the contents of the Navigator.

Views
Views are objects which lie in a subnode of the object tree and filter the contents of this node.

There are two types of views:

● Search objects: Underneath the search object, you can see all objects which are located 
under the same owner as the search object and which have been detected by an associated 
views query.

● Index objects: You can see all objects which refer to the index object.

Administrators prepare views. As a rule, you create them using the "New" context menu.
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Working areas
Working areas structure the engineering data according to technical aspects, for example, into 
one area for process engineering, one for electrical engineering, etc. You can only see the 
data of the working areas which your administrator has assigned to you in your user profile. 

You can find additional information on this topic in the "Administration" manual, keyword 
"Administration of working areas".

3.5 Fundamentals of templates and usages

Principle
If a group of logically or physically related objects can be reused, this group can be made 
available as a template (also known as an assembly). 

You can derive any number of uses (assemblies) from templates in an engineering object. 
When you insert a template, all objects belonging to it are created and configured automatically 
as defined in the template. 

Examples for templates:

● Pump station

● Control loop for a valve

● Path macros for generating a circuit diagram

Global and local templates
There are two groups of templates:

● Global templates are located in the template branch of the base project. Global templates 
can be used in all engineering projects that are linked to the base project.

● Local templates are located in the template branch of an engineering project. They are only 
available in this engineering project. 

You usually work with global templates.

Template object
A template object is a container under which all objects that are part of the template are located.

Template objects perform two tasks:

● They structure the template branch.

● They permit access to templates. 

When selecting a template, you select the template object and not its individual components. 
When inserting a template to the engineering data, the template object is usually not created. 
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Inserting templates
You usually insert a template via the shortcut menu. In addition, you can use drag&drop to 
insert templates into a base object that has a reference to the template object.

Templates for inserting objects on interactive reports
There are templates that can be used to insert objects into interactive reports. The following 
requirements apply:

● An interactive report belongs to the template. 

● The objects that are part of the template are placed on this report and connected.

When you insert the template into an interactive report, the following happens:

● With the exception of the report, the objects belonging to the template are created in the 
Navigator.

● The objects are placed on the interactive report and are connected as defined in the 
template.

See also chapter Placing objects by inserting a template (Page 384). 

Creating templates
Administrators usually prepare the templates in the base project. You can find additional 
information on this topic in the "Administration" manual, keyword "Administration of templates".

In an engineering project, you can also create engineering objects in an interactive report, 
connect them and then create a template for other interactive reports from these objects. 
Depending upon your write rights, you can create the template as a global template or a local 
template.

See also chapter Creating templates from placed objects (Page 441).
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Fundamentals of objects and documents 4
4.1 Fundamentals about the term "object"

Principle
In COMOS, data is encapsulated in objects. You implement your project by:

● Creating objects

● Establishing relationships between objects (by connecting them or setting references, for 
example)

● Editing object properties

If you move, copy, or edit an object in some other way, its data always remains intact and 
consistent.

Visible and invisible objects
In COMOS, there are visible and invisible COMOS objects:

● Visible COMOS objects:
These objects have a configurable user interface. They are relevant for you as a user. The 
"Operation" manual only deals with visible COMOS objects.

● Invisible objects:
These objects are only addressed via script. They are relevant for administrators. You can 
find additional information on this topic in the "Administration" and "Class Documentation 
COMOS_dll" manuals.

4.2 Access to objects

Principle
Which objects you can see and edit depends on the following factors:

● Your read rights and write rights 

● If the objects are assigned to working areas: The working areas must be assigned to your 
user profile.

● In the Navigator, the visibility of objects is also determined by the Navigator settings 
(filtering, sorting).
See chapter Setting up the Navigator (Page 157).

You can find additional information on this topic in the "Administration" manual, keyword 
"Administration of users and rights" and ""Object locking" and "System object" state".
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4.3 Fundamentals of creating objects

Methods for creating objects
For an overview of the creation methods, see section Creating engineering objects 
(Page 233) and section Creating Documents (Page 307).

The method you choose depends on the following factors:

● Are you using a project structure or are you engineering freely?
See also chapters Creating objects from a project structure (Page 233) and Free creation 
of objects (Page 234).

● What are the specific basic conditions of your project and what is the resulting workflow?

● Would you like to create one instance or several instances of an object?

Sequence for creating objects and documents
The sequence in which engineering objects and documents are created is determined by the 
specific basic conditions of your project and the resulting workflow. 

Engineering objects and documents are often created in the following order:

1. The engineering objects that structure the project (units, subunits, and folders, for example).
Objects and documents to assist you with project engineering and documentation are 
usually created automatically under these objects. 
Examples:

– Evaluating reports (material lists, for example)

– Queries, bulk processing

2. Interactive reports, in which you engineer a unit in the form of drawings

3. The physical and logical engineering objects you use to create the unit (devices, cables, 
and pipes, for example). These objects are often generated upstream in the work you do 
in the interactive reports.
Evaluating reports documenting the object are usually created automatically under these 
objects.
Example: Data sheets

Creation of elements
If virtual elements have been prepared at the base object of an engineering object, you can 
choose between the following options when creating these elements:

● You create an instance of the element under the engineering object.
See also chapter Creating objects from a project structure (Page 233).

● You create any number of instances under the engineering object.
See also chapter Creating multiple objects via the static new menu (Page 241).

See also chapter Elements (Page 75).
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Automatic creation of multiple objects 
Base objects can be configured so that multiple objects are created automatically when an 
engineering object is derived. This is the case in the following scenarios:

● The base object has a reference to a template object. 
The template is inserted. Its objects are usually already linked via their connectors. See 
also chapter Fundamentals of templates and usages (Page 50).

● The base object is a block.
The objects belonging to the block are created. Their connectors are not linked.

● The base object defines elements which are created automatically with the engineering 
object. See also chapter Elements (Page 75).
The connectors of the elements are not connected.

Automatic opening of properties
If your Navigator settings have been configured accordingly, the properties of new objects 
open automatically.

See also chapter Activating "Directly edit new objects" (Page 162).

See also
Basic knowledge on planning the project structure (Page 44)

4.4 Fundamentals for identifying objects

4.4.1 Overview of the identification of objects

Alternative definitions for uniqueness of an object
Objects must be uniquely identifiable. How you uniquely identify objects depends on the 
context. 

See chapter Alternative definitions for uniqueness of an object (Page 56).

The definition used for uniqueness of an object determines the tool with which the objects are 
searched for and identified.

Tools for identifying objects
Database-independent description of the identification:

● Name, label, description
See chapter Identification via name, label, description (Page 59).

● Classification
See chapter Identification by classification (Page 59).
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● Object system type
See chapter Identification via object system type (Page 60).

● Object icon
See chapter Identification via object icon (Page 61).

The search and identification can be improved in the iDB when you are familiar with the rules 
of the iDB. The iDB rules include name masks, specifications during structuring of the objects 
and specifications for the object properties.

● Using the database of the type "iDB" efficiently
See chapter Using the database of the type "iDB" efficiently (Page 525), especially chapter 
Overview: Search techniques for the iDB (Page 525).

4.4.2 Alternative definitions for uniqueness of an object

Requirements
● You are familiar with the overview of the identification of objects.

See chapter Overview of the identification of objects (Page 55).

Uniqueness when using device labels
Device labels are an important method for uniquely identifying engineering objects. See also 
chapter Structure engineering using project structures and labeling systems (Page 46).

Uniqueness in the database
Via the SystemUID

In a database, no two objects have the same SystemUID. 

The SystemUID is usually only relevant for administrators and internal software procedures. 
You can find additional information on this topic in the "Administration" and "Class 
Documentation COMOS_dll" manuals, keyword "SystemUID".
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Uniqueness in the project
If the project option "Unique name across folders" is activated:

● Via the FullName: 
The FullName provides the complete path to an object. It has the following components:

– Name of the object 

– Name of the owners, except for parent folders

– Delimiters for objects defined in the project properties

If the database is configured in such a way that the labels are unique, you can also specify 
the path via FullLabel. You can find additional information on this topic in the 
"Administration" manual, keyword "Unique label".

● Via the SystemFullName: 
As with FullName, but including all folders

Fundamentals of objects and documents
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Uniqueness on one hierarchy level of the object tree
● Identity via the name

What counts as the same hierarchy level depends on the configuration of the "Unique name 
across folders" project option: 

– Deactivated: Two objects with the same direct owner and the same system type may 
not have identical names. 
Exception: Two engineering objects with different classes may have the same name.

– Activated: 
As above. In addition, the following applies to engineering objects and documents: If 
they are located in folders, they are on the hierarchy level of their folder. Therefore, two 
engineering objects or documents which are located in parent folder, subfolders, or 
parallel folders may not have identical names. The search for folders is always recursive. 
It discontinues for a node if an object is found that does not have the "Folder" property.

Exception: Objects in the "Element" class are not checked across folders.
Example: 

1 "Unique name across folders" option activated: Identical name forbidden
Option deactivated: Identical name allowed

2 Identical name always forbidden due to same system type and same class
3 Identical name always allowed due to different class
4 Identical name always allowed due to different system type

● Identity via label
If the database is configured in such a way that the labels are unique, objects can also be 
identified uniquely by their label. You can find additional information on this topic in the 
"Administration" manual, keyword ""System" tab".

Uniqueness of an attribute
Attributes are uniquely identified using their NestedName based on their base object, 
engineering object, or document. 

Notation: <tab name>.<attribute name>
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Example: SYS.SYS001

4.4.3 Identification via name, label, description

Requirements
● You are familiar with the overview of the identification of objects.

See chapter Overview of the identification of objects (Page 55).

Principle
● In COMOS, all objects have a name. They can also have a description. Engineering objects 

can also have a label. 

● These texts are often used to display objects in user interfaces, e.g. in the Navigator or in 
a query. Other texts may also be displayed depending on the respective user interface and 
the database configuration. 
See also chapters Navigator text (Page 163) and Symbols and symbol components 
(Page 93).

● Name and label are used for unique identification of objects and for device labeling. See 
also chapter Alternative definitions for uniqueness of an object (Page 56).
If objects can no longer be uniquely identified due to changes to the names or labels, 
COMOS adjusts the values so that they are unique again. 

● If the label is empty, the name is used wherever the label is required.

● Name, label, and description of the engineering object are initially applied from the base 
object. 
Users can edit these properties. See chapter Editing general data (Page 253).
Administrators can configure engineering objects in such a way that users cannot change 
this data. 

4.4.4 Identification by classification

Requirements
● You are familiar with the overview of the identification of objects.

See chapter Overview of the identification of objects (Page 55).

Purpose
Classifications are the replacement technology for the "Classes/Subclasses" functionality. See 
also chapter Classes and subclasses (Page 66).
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Classifications offer the following advantages:

● Assigning similar behavior
Objects with the same classification label have the same behavior or are treated in the 
same way by the software.

● Standardization of the database
You can identify, compare, replace, or collect objects across databases and companies 
using classifications.

● Search for specific or similar objects

Classifications are available for:

● Engineering objects

● Documents

Types of classification
Types of classification:

● Classification

– Hierarchical classification
Is structured in accordance with the base data structure of a COMOS product.

– Functional classification
Is structured in accordance with non project specific functions of an object.

● User classification
Available to you as the user. The functional classification technique is used in the 
background.

– Hierarchical user classification

– Functional user classification

Application
See chapter Classifications in the iDB (Page 557).

4.4.5 Identification via object system type

Requirements
● You are familiar with the overview of the identification of objects.

See chapter Overview of the identification of objects (Page 55).

"System type" mandatory property
All objects in COMOS are divided into system types. The system type of an object determines 
its properties and behavior. 
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Important system types
The following system types are important when you are working in engineering projects: 

Objects System type assigned in soft‐
ware

See also chapter ...

Engineering ob‐
jects

Device Basic knowledge on engineering objects 
(Page 63) 

Base objects CDevice Fundamentals of base objects (Page 62) 
Connectors Connector Connectors (Page 73) 
Attributes, tabs Specification Attributes (Page 68) 
Documents Document Fundamentals of documents and reports 

(Page 81) 

There are more system types. You can find more information on this topic in the "Class 
Documentation COMOS_dll" manual, keyword "System type".

In the default setting, the system type also determines the icons. See chapter Identification via 
object icon (Page 61).

4.4.6 Identification via object icon

Requirements
● You are familiar with the overview of the identification of objects.

See chapter Overview of the identification of objects (Page 55).

"Icon" mandatory property
Every object has an icon. It is used to display the object in the Navigator, in queries, or in other 
user interfaces. See also chapter Object icons reference (Page 578).

Objects with identical features have the same icon. Administrators specify which icon the 
objects have. You cannot change the icon of an object in the engineering data.

Dependent upon how an object is used, additional icons can be added. See also chapter 
Context-dependent additional icons (Page 588).

Display on interactive reports
In the working area of interactive reports, the symbols of the engineering objects are displayed. 
See also chapter Symbols and symbol components (Page 93).
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4.5 Fundamentals of base objects

Purpose
Base objects are templates for engineering objects and documents. A base object specifies 
the properties of the engineering objects and documents derived from it. See also chapters 
Relationship between base and engineering objects (Page 63) and Documents and base 
objects (Page 81).

Base objects are located on the "Base objects" tab in the Navigator. In the default setting, you 
can derive any number of engineering objects or documents from a base object. See also 
chapter Fundamentals of creating objects (Page 54). 

Base objects have different colors depending on the function:

● Normal base objects have red icons

● Base objects that are an element of another base object have green and turquoise icons.

● Base objects that are only used for sorting have pink icons. You cannot derive engineering 
objects from them.

See also chapter Icon coloring (Page 586).

Global and local base objects
Base objects are created and configured in the base project. Engineering projects that are 
linked to the base project have read access to these base objects. In the engineering projects, 
engineering objects are derived from the base objects. 

Administrators can also create local base objects in engineering projects. They are only 
available in the engineering project in which they were created.

Configuration
Administrators create and configure the base objects. Normal users usually come into contact 
with base objects when they create engineering objects or documents.

You can find additional information on this topic in the "Administration" manual, keyword 
"Preparing the base data: Basic techniques for base objects and documents" and "Preparing 
the base data: Customizing Guide iDB" and "Preparing the base data: Editing properties".

See also
Basic knowledge on project links (Page 30)
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4.6 Basic knowledge on engineering objects

4.6.1 Engineering object fundamentals

Definition
Engineering objects are objects that you create on the "Units" or "Locations" tab in the 
Navigator during the course of completing your engineering task. You can differentiate the 
following groups of engineering objects, based on their function: 

Group Examples
Objects which structure the project ● Units and subunits

● Locations
● Folders

Managing or supporting objects ● Queries
● Workflows
● Objects for additional symbols on interactive 

reports, e.g. graphical symbols such as 
revision clouds in P&ID

Physical objects necessary for engineering and 
operation

● Pipes
● Valves
● Cables
● Signals

Logical objects necessary for engineering and op‐
eration

● Case variants
● Functions
● Software objects
● Cost objects

See also
General engineering objects (Page 80)

4.6.2 Relationship between base and engineering objects
See also chapter Fundamentals of the properties of engineering objects (Page 64).

Base objects as templates for engineering objects
Each engineering object is based on exactly one base object. In other words: It is derived from 
the base object. 
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The base object determines:

● The properties of the engineering objects derived from it

● The values of these properties when engineering objects are created

During your work, you change the properties of engineering objects and in so doing adapt 
them to actual engineering requirements. 

Dynamic connection
The connection between base and engineering object is retained following creation of the 
engineering object. Changes to a base object affect the derived engineering objects.

Inheritance
In COMOS, the fact that base objects are templates for engineering objects and the connection 
between base and engineering objects is dynamic is referred to as inheritance. 

There is also inheritance between base objects. You can find additional information on this 
topic in the "Administration" manual, keyword "Inheritance and forwarding of objects and 
information".

Interrupting inheritance
Inheritance between base object and derived engineering objects can be interrupted:

● By switching the base object
The engineering object then inherits the properties of the newly assigned base object. See 
also chapter Switching the base object (Page 258).

● By checking in inherited properties at the engineering object
If these properties are changed at the base object, these changes no longer affect the 
engineering object. See also chapter Fundamentals of the properties of engineering 
objects (Page 64).

See also
Fundamentals of base objects (Page 62)

4.6.3 Fundamentals of the properties of engineering objects

Preliminary knowledge
See chapter Relationship between base and engineering objects (Page 63).
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Groups of properties
Engineering objects have the following groups of properties:

● Inherited properties

● Checked-in properties

● Properties that can only exist at the engineering object

● Optional: Extended properties

Whether a property is inherited or checked in is significant in the following scenarios:

● If you are copying engineering objects.

● If base objects from which engineering objects have been derived are changed.

● If the base object of an engineering object is switched.

● If you are searching for objects.

Inherited properties
Inherited properties are properties that belong to the base object and to which the engineering 
object has read access. If these properties are changed at the base object, the change is 
visible at the engineering object.

There are two groups of inherited properties:

● Properties that are always read out from the base object and are also saved at the base 
object in the database
Although these properties affect work with engineering objects, they can only be edited at 
the base objects. You can find additional information on this topic in the "Administration" 
manual, keyword ""System" tab" and ""System settings" tab". 
Examples: 

– "Class" and "Subclass" properties

– Base object script blocks

– Object icon

– Classifications

● Properties that are read out from the base object until the default setting for the engineering 
object is overwritten (in other words, the property is checked in)
This minimizes processor utilization and memory space requirements. 
As long as the following properties are inherited, they are displayed in italics:

– Description

– Folder

– Attributes
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Checked-in properties
Checked-in properties (synonyms: Own properties and Own collections) are properties which 
are inherited from the base object and then overwritten at the engineering object. They are 
saved in the database at the engineering object. If these properties are changed at the base 
object, the change is not visible at the engineering object.

Examples:

● Description, folder
See also chapter General properties of engineering objects (Page 67).

● Attributes
See also chapter Attributes (Page 68).

● Connectors
See also chapter Connectors (Page 73).

Properties that can only exist at the engineering object
Some properties of the engineering object are neither inherited nor checked in. There are two 
groups:

● Properties for which the base object is irrelevant; for example, layer relevance

● Properties for which the base object defines what value the properties have when the 
engineering object is created. Changes to the base object do not affect the properties, even 
if their values have not been changed since creation.
Examples:

– Object-based status

– Name and label

Extended properties
Projects can work with extended properties. You can find additional information on this topic 
in the "Administration" manual, keyword "Configuring extended properties (free attributes)".

See also
Using engineering objects (Page 251)

4.6.4 Classes and subclasses

Purpose of classes and subclasses
Engineering objects are divided into groups based on the class and subclass of their base 
object. Objects with the same class and subclass fulfill the same task and have similar 
properties. They behave in the same way; for example, when they are copied.
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Classes and subclasses allow you to search for and recognize objects more easily:

● In queries, you can specifically search for objects of a certain class. You can find additional 
information on this topic in the "Administration" manual, keyword "Setting general inputs 
for queries". 

● You can filter the Navigator by classes and subclasses. See also chapter Filtering object 
trees in the Navigator (Page 160).

● Class and subclass determine which object icon an engineering object has. See also 
chapter Icons for base and engineering objects (Page 579).

Class and subclass for documents
Documents always have the "Document" class. There are no subclasses. The object icon is 
determined by the document type. See also chapter Icons of the document types (Page 587).

Classifications
Classifications are a more flexible and powerful tool for categorizing objects than classes and 
subclasses. Searching via classification key is also faster. See also chapter Identification by 
classification (Page 59).

4.6.5 General properties of engineering objects
The following table provides you with an overview of important general properties of 
engineering objects:

Property See also chapter ...
Name Identification via name, label, description 

(Page 59) 
Changing name, label, and description (Page 254)

Label
Description
Folder Declaring objects as folders (Page 255) 
General references, e.g.:
● Base object reference
● Unit reference
● Location reference
● Implementation reference

Setting general references (Page 257) 
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4.6.6 Relationships between engineering objects

Principle
Engineering objects are related to other objects in many and varied ways:

● Via references:

– References in the general properties of the engineering object, e.g. location reference, 
implementation reference

– Reference attributes on the attribute tabs of properties

● Via connectors
See also chapter Connectors (Page 73). 

● Via linked attributes
See also chapter Linked attributes (Page 71).

● Via their position within the hierarchical object structure of the Navigator

Hierarchical object structure in the Navigator
Some functions and script commands evaluate the object structure. Their result can vary 
depending on where the object is located in the Navigator.

Example: Attributes linked by owner

Visibility of general references in the Navigator
If engineering objects are connected via general references, this information is displayed in 
the Navigator. See also chapter Navigator text (Page 163).

Navigation 
You can navigate to the objects to which the object has a reference. See also chapter 
Navigating (Page 170).

4.6.7 Attributes

4.6.7.1 Attribute fundamentals

Purpose of attributes
Attributes describe engineering objects and documents in more detail in the context of 
engineering. Examples: 

● Attributes for the technical data and manufacturer data of engineering objects

● Attributes that save data that is displayed in the drawing header of a report
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Some attributes are evaluated by the software. You use them to control engineering objects 
and documents. Examples:

● Attributes for configuring the equipment bar and substance stream bar in process flow charts

● For pumps, the "Pipe cut mode" attribute controls whether the pump cuts a pipe into pipes, 
pipe sections, or segments.

There are also attributes which are only relevant for base objects:

● Attributes which are not inherited by the derived objects
You can find additional information on this topic in the "Administration" manual, keyword 
"Editing inheritance mode". 

● Attributes of base objects from which no objects are derived; for example, the base objects 
of the "@99 System settings" branch.
These attributes control the behavior of the COMOS functions and tools.
You can find additional information on this topic in the "Administration" manual.

General information about attributes
● Attributes are objects.

● In the Navigator, attributes are located underneath the base object, engineering object, or 
document on what are known as attribute tabs (for short: tabs):

① Engineering object
② Tab
③ Attributes

Whether or not you see the attributes in the Navigator depends on your Navigator settings. 
See also chapter Filtering object trees in the Navigator (Page 160).

● In the properties, attributes are located on subtabs of the "Attributes" tab or on top-level 
tabs.

● Attributes belong inextricably to their engineering object, document, or base object.
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● Attributes are automatically created with their engineering object or document. 

● Base objects take on the attributes of their owner or the base object to which they have a 
base object reference. You can find additional information on this topic in the 
"Administration" manual, keyword "Inheritance and forwarding of objects and information".

4.6.7.2 Editing attributes

Principle
The base object defines the attributes of its derived engineering objects or documents and the 
values with which they are initialized.

During the engineering, you adapt the values inherited from the base object to the actual 
engineering requirements. The attribute values are checked in by overwriting the values 
inherited from the base object.

See also chapter Fundamentals of the properties of engineering objects (Page 64).

There are numerous tools available for editing. See also chapter Overview of editing 
engineering objects (Page 251). 

You have the following options when editing:

● Set the attributes of an object
See also chapter Editing attributes (Page 260).

● Set the attributes of several similar objects at the same time
See also chapters Editing object properties in the properties tree (Page 279), Editing object 
data via bulk processing (Page 490), and Editing editable data (Page 448).

● Copy attributes: You can copy single attribute values or all values from a tab

● Attributes can be linked. See also chapter Linked attributes (Page 71). 

Read-only mode
If attributes have been locked in the base data or their object is locked, you can only read their 
data and not change it. You can find additional information on this topic in the "Administration" 
manual, keyword ""Lock object" function right".

Mandatory attributes with redlining
Administrators can define mandatory attributes. You can only save an engineering object with 
mandatory attributes if all mandatory attributes have been filled out.

You can find additional information on this topic in the "Administration" manual, keyword 
"Administration of mandatory attributes and red coloring".

Automatic unit conversion
The following applies for attributes with a unit: When the unit is changed, the attribute value is 
converted.
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Display of attributes
● The values of inherited attributes are shown in italics.

● The background of an attribute can be marked in color for the following reasons:

– The attribute is linked. Its source attribute has a different value.1

– For attributes with a value range: The value does not conform to the value range.1

– The attribute is instantiating.1

– The attribute has a high editing priority.1

– Gray marking: The attribute has been locked for editing in the base data. 

● If the attribute value is marked in color, the color indicates when and by whom it was 
changed.1

1: The colors are freely selectable. See also chapter Defining the background color and text 
color of attribute values (Page 267).

See also
Attributes for joint access (Page 72)

4.6.7.3 Linked attributes

Principle
If an attribute (source attribute) is linked to another attribute (target attribute), the value of the 
source attribute is applied to the target attribute. The way in which the attributes are linked 
determine whether the value is applied automatically and whether the link is bidirectional. The 
following links modes are available

● "Static"

– The user decides if and when the target attribute adopts the value of the source attribute.
See also chapters Entering values for linked attributes (Page 262), Refreshing static 
links (Page 264), and Accepting differences between static links (Page 264).

– If the values differ, the background of the target attribute is marked orange.

● "Dynamic"
The source attribute is applied automatically to the value of the target attribute.

● "Full dynamic"
Data flows in both directions. If you edit one of the two attributes, the value is applied 
automatically to the other one. 

Setting up links
You can find additional information on this topic in the "Administration" manual, keyword ""Link" 
tab".

Fundamentals of objects and documents
4.6 Basic knowledge on engineering objects

Operation
Operating Manual, 03/2017 V10.2.1, A5E37082875-AB 71



See also
Editing attributes (Page 260)

4.6.7.4 Attributes for joint access

Coordination via message boxes
If several users are working on the attributes of an object simultaneously, the software 
automatically coordinates the work. If users change the same attribute, they are informed of 
this via a message window.

A message window is also used if a user saves an object whose attributes are also being 
edited by other users. 

See also
Editing attributes (Page 70)

4.6.7.5 Status-related attributes

Principle
Administrators can mark attributes as status-related when using object-based status 
management. These attributes are automatically evaluated when the status is checked and 
set. If one of the attributes is inconsistent, the object status must not be higher than the status 
value defined by the attribute.

Causes of inconsistencies:

● A product data-related attribute infringes the template in the manufacturer device. You can 
find additional information on this topic in the "EI&C Operation" manual, keyword "Entering 
product data".

● A range attribute violates the range testing. See also chapter Entering attribute values 
(Page 260).

● A statically linked attribute differs from the linked value. See also chapter Entering attribute 
values (Page 260).

Status value when there is an inconsistency
COMOS checks what status value is determined by the "Engineering object status" attribute 
property. If the engineering object implements the "CheckStatus" script block of the 
corresponding status type, the script block is also executed. It provides a status value. The 
lower status value is used.

You can find additional information on this topic in the "Administration" manual, keyword 
"Attribute: "Engineering object status" and "Engineering object status value" and CheckStatus" 
fields.
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See also
Object-based status management (Page 78)

4.6.8 Connectors

Principle
Connectors are objects that physically link engineering objects. See also chapter 
Connections (Page 74). Every connector is inextricably linked to its engineering object. In the 
Navigator, it is located under the engineering object. Whether or not you see the connectors 
in the Navigator depends on your Navigator settings. See also chapter Filtering object trees 
in the Navigator (Page 160).

When engineering objects are linked via connectors, data can be passed via their connectors. 

Connector direction and type
Connectors have a connector direction: 

● Input

● Output

● Neutral

The COMOS products have different connector types and subtypes. You can find more 
information on this topic in the COMOS product manuals.

Static and dynamic connectors
Static connectors (synonyms: fixed connectors, prepared connectors) are created with their 
engineering object, regardless of whether or not the engineering object is connected. The 
connectors are visible on the interactive report in the symbol of the engineering object. They 
are used for components for which it is clear how many connectors they have and where they 
are located in the symbol. Example: 2-way valve

Dynamic connectors are only created and integrated into the symbol on interactive reports 
when the engineering object is connected. They are used for components for which it is not 
yet clear how many connectors they have and where they are located in the symbol. Example: 
Containers 

Deleting connectors
Static connectors cannot be deleted, only their connection. Dynamic connectors and auxiliary 
connectors can be deleted. See also chapter Disconnecting connectors (Page 288).

See also
Managing connectors (Page 276)
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4.6.9 Connections

Principle
Engineering objects are connected by connectors. See also chapter Connectors (Page 73).

There are two types of connection:

● Connections without objects

● Object-based connections
The product determines which object the connection represents. In functions diagrams, for 
example, connections represent logical connections, in pipe schedules they represent 
pipes with a flow direction.

Connection without objects
Connections without objects are used when the connectors of the connected objects can save 
all information available for the connection. 

Examples of connections without objects:

● Electrical connections

● Electrical signal connections

● Logical connections on function diagrams

● Pneumatic connections

● Action lines

Connections without objects can be displayed as graphic information on interactive reports. 

Object-based connections
Object-based connections are used when the connectors cannot save all information available 
for the connection. An object is created for the connection and this object saves the necessary 
information. 

This connection type is used if, for example, substances are being transported via the 
connection. The connection object then saves information about the flow direction, the flow 
speed, or the temperature, for example.

Examples of object-based connections:

● Pipes

● Process streams

● Connections on installation diagrams

Connections in the Navigator and on interactive reports
Usually, you connect engineering objects in interactive reports. See also chapter Connection 
options for connectors (Page 284).
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If two objects are connected in an interactive report, they are automatically connected in the 
Navigator as well. If they are connected in the Navigator, however, they are not necessarily 
connected in the interactive report.

If objects are connected, this is visible in the Navigator: The path to the counterpart connector 
is shown after the connector, including prefix and delimiter.

More information
See also chapters Fundamentals of connections on interactive reports (Page 90) and 
Connecting objects (Page 392).

You can find more information on this topic in the COMOS product manuals. 

4.6.10 Elements

Definition and purpose
Elements are saved in the "Elements" collection on the engineering object.

In the broader sense, all engineering objects which are located directly underneath an 
engineering object in the Navigator are elements (engineering data elements). The 
engineering object must be the owner of the elements. In the narrower sense, elements are 
subobjects with an inextricable relationship to their owner. Example: The motor of a pump

The elements of a base object also control which objects are available to the derived 
engineering objects. There is a difference between virtual elements and automatically created 
elements. See below. You can differentiate between these elements based on the icon color. 
See also chapter Icon coloring (Page 586).

You can see which elements the engineering object has in the engineering object properties 
on the "Elements" tab.

Documents and links do not belong to the elements. Documents can be configured in the base 
data in such a way that they are also automatically created with their owner engineering object. 
See also chapter "General" tab for documents (Page 358).

Example:
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Virtual elements 
If a base object has virtual elements, you can create these elements under the derived 
engineering objects. The elements are offered for creation in the following interfaces:

● In the "New" context menu

● In the static New menu 

● In the properties of an engineering object on the "Elements" tab

As soon as an instance is derived from a virtual element, it belongs to the engineering data 
elements.

The configuration of the base object will determine whether:

● You can derive one, any number, or a specified number of instances from a virtual element.

● You can create any engineering objects or just instances of the virtual elements under the 
engineering object.

Automatically created elements
A base object can have elements that were created automatically under the engineering 
objects when the engineering objects were derived.

Whether or not these elements can be deleted from the engineering data depends on the 
configuration. If they have been deleted, you can recreate them:

● Via the "New" context menu 

● In the static New menu 

● In the properties of an engineering object on the "Elements" tab 

The "Element" class
Objects can have the class "Element". Objects with the "Element" class are not automatically 
elements and vice versa.
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More information
You can find additional information on this topic in the "Administration" manual, keyword 
""System" tab" and ""Elements" tab".

See also
Creating engineering objects via the context menu (Page 235)

Deriving new elements from virtual elements (Page 274)

Creating multiple objects via the static new menu (Page 241)

Managing elements (Page 271)

4.6.11 Status management

4.6.11.1 Fundamentals of status management

Status types
Engineering objects have an object status. There are up to thirteen status types available in 
COMOS. The status types allow monitoring sequences to be delineated in terms of content. 
They can be freely delineated; e.g. based on functions or personnel requirements. The status 
levels display the progress of the data monitoring operation within a status type. An engineering 
object has a separate status value for each status type. 

Engineering objects also have a working layer/history status. This is managed within the 
system. See also chapters Working layer display mode (Page 34) and Fundamentals of history 
display (Page 44). 

Status display
When the status display is activated, the objects are marked in color according to their status. 
You can change the color settings. See also chapter Using the status display (Page 299).

Status management options
There are two options for status management:

● Query-based status management
See also chapter Query-based status management (Page 78).

● Object-based status management
See also chapter Object-based status management (Page 78).

For each status type, you use either the query-based or object-based status management.
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Example
Examples of object-based status types and status levels from the database:

Status value Color legend Status type "1 PE" Status type "11 Date violation"
0 Gray "Not processed" "OK / done"
1 Red "Presetting Changed" "Date overdue"
2 Blue "Processing" "No date"
3 Green "Finished" "In tolerance range"
-1 / / "Inactive / not calculated"

See also
Checking the object-based status (Page 296)

4.6.11.2 Query-based status management

Principle
In query-based status management, you call the status calculation for an object. A status query 
prepared by the administrator calculates the status values of the object and its subobjects 
recursively. The status display shows the result of the calculation. When you open the status 
query, you are also given detailed information about the object status. See also chapter 
Displaying status information in the status query (Page 293).

The status values are stored in an XML file in the document directory. Changes to the object 
status do not change the engineering object. It is not checked in to the working layer.

If the query supports hierarchical query-based status management, owners automatically take 
the lowest status value that one of their children has. You can find additional information on 
this topic in the "Administration" manual, keyword "Purpose of query-based status 
management".

See also
Fundamentals of status management (Page 77)

4.6.11.3 Object-based status management

Principle
In object-based status management, you set the status value manually. See also chapter 
Setting the object-based status (Page 295). It is saved to the engineering object. You can also 
check whether the current status value is valid. See also chapter Checking the object-based 
status (Page 296). These actions check in the objects to the working layers.

You usually set the status in the higher levels of the structure tree; for example, on the subunits 
rather than the devices. If you set a status value, COMOS checks recursively whether there 
are status-related attributes which are inconsistent and corrects the status if necessary.
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Recursive status changes
Changes to the status value of an engineering object influence the status of other engineering 
objects. It is a requirement that the objects are in an owner-child relationship according to the 
COMOS object model. 

The following objects are, therefore, not taken into consideration when COMOS checks or sets 
the status of engineering objects:

● Links

● Objects under search objects and index objects

Checking and setting status values
When you set the status of an engineering object, COMOS checks recursively whether the 
object and its subobjects have inconsistent status-related attributes:

Inconsistent sta‐
tus-related attrib‐
utes 

Result

No ● A new status of the object is created.
● A new status of its subobjects is created.

Recursive process
● COMOS checks the nodes parallel to the object. If they have the new status 

or higher and the owner has a lower status, the owner receives the new status 
too.
Recursive process

Yes The value defined by the status-related attribute is set: 
● At the object which has an inconsistent status-related attribute
● At its owners, provided that their status value is higher than the status defined 

by the status-related attribute
Recursive process

When you check the status of an engineering object, COMOS also checks whether the object 
and its subobjects have inconsistent status-related attributes and what the correct status 
values are. You can see the result of the check in the status calculation protocol.

Status calculation protocol
If you set an invalid status value or check the status values and the check finds invalid values, 
the status calculation protocol opens. It contains the following information:

● Which objects have invalid status values? 

● Why are the values invalid?

● What are the correct status values?

You can apply the correct status values or correct the causes of the invalid status values. See 
also chapter Correcting invalid status values (Page 297).
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See also
Status-related attributes (Page 72)

Fundamentals of status management (Page 77)

4.6.12 General engineering objects

Definition
In projects that work with a project structure, general objects function as collection nodes:

● For testing and approval

● As collection nodes for objects that you are not permitted to create elsewhere in the project 
structure.

The following general engineering objects exist:

● General units

● General positions

● General locations

● General objects
General objects are the only engineering objects that do not have a base object reference 
when they are created. You can assign a base object to a general object at a later point. 
This turns the general object into a normal engineering object.

See also
Engineering object fundamentals (Page 63)

Free structure engineering (Page 47)

Free creation of objects directly under the project root (Page 238)

Creating general engineering objects (Page 238)

4.6.13 Requests and implementations

Introduction
The engineering objects used in basic engineering define general requirements relating to the 
devices. During engineering, the requirements become more specific. At the end of the detail 
engineering phase, the manufacturer devices to be ordered are selected.
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Examples: 

● On a P&ID, one pipe connects two apparatuses. In the isometry report, several pipes, parts, 
and bows are required to engineer the exact pipe run.

● A terminal is placed on a terminal diagram. In the course of the order preparation, a 
manufacturer device from a manufacturer catalog is assigned to it.

The COMOS technique of requirement and implementation connects the general devices with 
the more specific ones. It ensures a consistent data flow and integrated data management.

Definition of requirement and manufacturer device

Requirement
Engineering objects which define general requirements have the "Requirement" property. They 
are referred to as requirements. Their object icon has the following additional icon:

When an engineering object which substantiates the requirement is created, the more concrete 
object is referred to as the implementation. The requirement gains an implementation 
reference to the more concrete object, while the implementation gains a requirement reference 
to the implementation. If the implementation itself has the "Requirement" property, it can also 
gain an implementation reference to an even more specific object, and so on.

Engineering objects without the "Requirement" property cannot be implemented further.

Manufacturer device
Manufacturer devices never have the "Requirement" property. They must have an article 
number or order number.

See also chapter Setting general references (Page 257).

You can find more information in the COMOS product manuals.

4.7 Fundamentals of documents and reports

4.7.1 Documents and base objects

Principle
Like engineering objects, documents are also based on base objects. Each document is based 
on exactly one base object. The base object must have the "Document" class. When 
documents are created, they are all initialized with the properties specified by their base object. 
You can adapt the properties to the prevailing engineering requirements.

See also chapters Relationship between base and engineering objects (Page 63) and Attribute 
fundamentals (Page 68).
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4.7.2 Document types
The document type determines which icon a document has. See also chapter Icons of the 
document types (Page 587).

Overview
Every document has a document type. Depending on which file formats the document types 
are based on, you can differentiate between the following document types:

● COMOS-specific document types

● Document types for external documents

● "Unknown document" document type
A placeholder document which is created when a document with an unknown file type is 
imported into COMOS.

The following document type groups are assigned to the document types in the database:

● COMOS

● Office

● Conval

● Other

COMOS-specific document types
The COMOS-specific document types apply to original COMOS formats which cannot be 
opened and edited in any other application. 

The most important document types for working in engineering projects are: 

Document type Description
Interactive report See also chapter Basic knowledge on interactive reports (Page 86).
Evaluating report See also chapter Overview of evaluating reports (Page 95).
XML connector Converts COMOS data to XML and vice versa.

For data exchange, particularly with other software applications
Document package For shared revisioning of documents
Reference document A link to a document
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Document types for external documents
Document types for external documents are divided into the following groups:

Group Examples
Document types for external documents whose ap‐
plications can be started from COMOS

● Excel files, Word files, and PowerPoint files 
from Microsoft Office

● PDF files from Adobe
Document types for external documents whose con‐
tents you can import into COMOS and access with‐
out starting the corresponding application

● Conval documents
● AutoCad
● PROII

Document types for external documents which are 
not linked to a specific application

● *.txt files
● *.igr files
● *.xml files

More information 
You can find additional information on document types and document type groups in the 
"Administration" manual, keyword "Administration of documents".

4.7.3 Properties and content of documents

Properties
Documents take on the general properties and attributes from their base object. You can adjust 
them. 

The properties of the "General" tab and the change tab are specified on creation. The name 
and content of the change tab depend on the document type. You usually only edit these tabs 
when creating a document freely. See also chapter Editing document properties (Page 355).

Content
The document contents are stored in a file. Depending on where the file is located, the 
documents are either managed externally or in COMOS. See also chapter Storage of 
document files (Page 85).

See also
Opening properties (Page 171)

Opening documents (Page 173)
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4.7.4 Automatic referencing of documents

Advantage of automatic referencing
The documents from the "Units" and "Locations" tabs are automatically referenced on the 
"Documents" tab if the database is configured accordingly.

Advantage:

● The original documents are located at the devices or in the unit, subunit, or the location to 
which they belong. 

● The "Documents" tab gives you clear access to all engineering documents. Documents of 
the same type are located in the same document group. You can process them together, 
e.g. printing, revisioning, or exporting.

Example: The data sheets for the devices are located on the "Units" tab underneath their 
device. All data sheets are collected into one document group on the "Documents" tab.

Technical details
● References to the original documents are located on the "Documents" tab. They are of the 

"Reference document" document type. They are sorted into the document groups based 
on the names of the original documents and document groups. 

● If there is only one document group located on the first level of the "Document group" tab 
under the project root, the references are always sorted into this document group. If there 
are several document groups on the first level, one document group must have the name 
"@NameSystem". The references are then sorted into the document groups under the 
"@NameSystem" document group. The automatic reference settings only function when a 
suitable document group already exists. 

● If you are working with project revisions, a document group on the first level must have the 
name "@Project". If no suitable document group exists, it is automatically created when 
the reference is created.

● You can create missing references manually. See also chapter Referencing documents in 
document groups (Page 340). 

Relationship between original documents and reference documents
● When you open a reference, you automatically see the contents of the original document.

● With the default database setting, deleting an original document also deletes its reference 
document. Automatic deletion can be stopped. You can find additional information on this 
topic in the "Administration" manual, keyword "Reference documents and document 
groups".

● When you delete a reference document, only the reference is deleted.

Administration
You can find additional information on this topic in the "Administration" manual, keyword 
"Configuring automatic references in document groups".

Fundamentals of objects and documents
4.7 Fundamentals of documents and reports

Operation
84 Operating Manual, 03/2017 V10.2.1, A5E37082875-AB



4.7.5 Document groups

Purpose of document groups
● Document groups organize documents by aspects of content or form. 

● They make projects clearer.

● You can process the documents in a document group together, e.g. printing, revisioning, 
or exporting.

Document groups can contain additional document groups. Many functions of the document 
management are recursive. This means that the function does not only cover a specific 
document group, but also all document groups that are created directly underneath it.

Document groups on the "Documents" tab 
Document groups can be located on all levels of the object tree on the "Documents" tab. The 
document groups collect references to the original documents from the engineering data. See 
also chapter Automatic referencing of documents (Page 84).

The document group structure is usually already created when you start working in the 
engineering project.

Document groups on the "Units" and "Locations" tabs
Document groups are also possible on the "Units" and "Locations" tabs. In these cases, they 
can only appear as of the second level of the object tree.

4.7.6 Storage of document files

Principle
For external documents, the physical document files are located in the file system. The 
COMOS document has a link to the file. For documents managed in COMOS, they are located 
in the COMOS document directory.

The settings on the change tab of the document determine which type of document it is. See 
also chapter Change tab (Page 360).

See also
Creating documents freely via the context menu (Page 309)

Creating external documents from a File Explorer using drag&drop (Page 310)
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4.7.7 Basic knowledge on interactive reports

4.7.7.1 Fundamentals of interactive reports

Purpose
Interactive reports are electronic drawings which you use to engineer and document your unit. 
When you place and connect objects in the working area of an interactive report, the 
corresponding engineering objects are created in the Navigator and linked via their connectors. 

Examples of interactive reports:

● Flow diagrams

● Isometry reports

● Circuit diagrams

General information
● Interactive reports are COMOS-specific documents. They have the following object icon:

● Interactive reports offer numerous functions to support you in your work. There are functions 
that are common to all interactive reports and product-specific functions. 

Note
Coupling to specialized modules

To work in an interactive report, you need COMOS Platform plus a specialized module. 
The functions which are the same for all modules are described in this manual using the 
example of the P&ID module.

It describes the functions and properties which apply to all or most of the modules. Individual 
drawing types may deviate from these descriptions. Example: Operating the connector tool 
on isometry reports

You can find more information on this topic in the COMOS product manuals.

● Interactive reports have a report template. It specifies the layout, contents, and functionality 
of the reports. 

● Reports are derived from a base object. The base object can also influence the layout, 
contents, and functionality through its attributes. 
Example: The database is configured in such a way that you control whether a PFD has a 
substance stream bar and which streams it displays via the attributes of the PFD.
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Contents
Interactive reports have the following contents:

● Contents created by your work in the report:

– The symbols of the engineering objects placed and connected on the working area

– Graphical elements

● Contents from the report template
See also chapter Report template (Page 87).

See also
Fundamentals of placing on interactive reports (Page 88)

4.7.7.2 Report template
Every interactive report has a report template. Administrators maintain the report template in 
the base data. You can find additional information on this topic in the "Administration" manual, 
keyword "Administration of report templates".

Meaning of the report template
The report template determines:

● Size and alignment of the report

● The drawing type
According to standard table "Y10 > M00 > A10 > Y10M00N00001 Drawing type", for 
example, "PFD", "P&ID (ISO 10628)" or "EE circuit diagram".
The drawing type controls the following:

– Which objects are offered in the symbol bar

– Which symbol the placed objects have

– Which tools are provided on the report-specific toolbar

– Whether the report has layers, and which layers it has

● Whether the derived reports contain lists and subreports
The report template defines the layout of the lists and subreports and the rules for computing 
their contents. The actual content is calculated dynamically when the interactive report is 
opened. The same contents are possible as in evaluating reports. See also chapter 
Overview of evaluating reports (Page 95).
Examples:

– Drawing header

– Bill of materials on an isometry report

● Via the options script: The behavior of the report and its tools
Examples:

– Are diagonal connections allowed?

– How are connections that cross one another displayed?
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See also
Working with interactive reports (Page 368)

4.7.7.3 Fundamentals of placing on interactive reports

Placeable elements
The following elements can be placed on interactive reports:

● Engineering objects

● Attributes of the placed engineering objects
See also Placing or deleting attributes (Page 386).

● Graphical elements
There are no objects behind graphical elements, just texts, lines, circles, and rectangles. 
See also chapter Fundamentals of graphical elements (Page 92) and chapter Working with 
graphical elements (Page 406).

● Other interactive reports
See also Placing a report on a report (Page 387).

Principle of placing engineering objects 
Engineering objects can only be placed on a report if their base objects have a symbol for the 
drawing type of the report. 

When an engineering object has been placed in the working area, you see the symbol defined 
at the object for the drawing type of the report. See also chapter Symbols and symbol 
components (Page 93). A DocObj object is created below the object. See also chapter DocObj 
objects (Page 95).

An object can be placed on several reports.

Methods of placing engineering objects
Various options are available for placing engineering objects. The following table provides an 
overview of all the options and describes whether a new engineering object is created through 
placing:

Method New object is created See also chapter ...
Via the symbol bar
Recommended method

✓ Placing objects via the symbol bar 
(Page 381)

Using drag&drop with a base object 
from the Navigator

✓ Placing base objects from the Navi‐
gator (Page 382) 

Using drag&drop with an engineering 
object from the Navigator

- Placing engineering objects from the 
Navigator (Page 383)

Via the context menu of a symbol Case by case Placing objects via the context menu 
of a symbol (Page 383) 
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Method New object is created See also chapter ...
By inserting a template ✓ Placing objects by inserting a tem‐

plate (Page 384)
By placing another interactive report - Placing a report on a report 

(Page 387)

Some COMOS products work with interactive reports where objects are automatically placed 
when the report is opened. Example: Position diagrams in EI&C

Insertion location of symbols 
When you place an object in the working area of the report, the point of origin of the symbol 
is inserted at the X/Y coordinate determined by the mouse pointer. See also chapter Symbols 
and symbol components (Page 93).

Insertion location of new engineering objects in the Navigator
If engineering objects are created on placement, they are inserted into the Navigator 
automatically. Where they are inserted is determined by the COMOS product and the database 
configuration. You can find more information on this topic in the COMOS product manuals.

The table below provides an overview of where the objects can be pasted and what special 
conditions apply:

Insertion location Symbol color Comment
Under the report Blue You later move the objects to the unit 

structure or location structure. See 
also chapter Changing owners 
(Page 402).

Parallel with report Black

The objects are sorted into the unit 
structure or location structure.

Black Nothing needs to be moved.

The symbol colors can be defined by the COMOS products.

Multiple placement
If their base objects are configured accordingly, objects can be placed on several reports. You 
can find more information on this topic in the COMOS product manuals, keyword "Multiple 
placement".
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4.7.7.4 Fundamentals of connections on interactive reports

Direct and indirect connections
When you connect engineering objects on interactive reports, you connect their symbols. You 
have the following options:

● Place the connector of one of the symbols on the connector of the other symbol. See also 
chapter Connecting objects directly (Page 398).
The objects are directly connected via their connectors on the report and in the Navigator.

● Draw a connecting line between the symbols using the "Connection" tool. See also chapter 
Drawing the start point and end point of the connection (Page 392). 
The following applies:

– If the tool creates an object-based connection, the objects are indirectly connected on 
the report and in the Navigator - via the object created with the "Connection" tool. 

– If the tool creates a connection without an object, the objects are connected indirectly 
on the report and directly in the Navigator via their connectors.

● Place an object on a connecting line which has already been drawn. See also chapter 
Inserting objects on a connection (Page 396). 

General information about the "Connection" tool
● When you touch a free connector of a symbol with the "Connection" tool in the report, the 

symbol turns yellow and the connector is highlighted. Example:

● In most interactive reports, the "Connection" tool generates object-based connections. The 
moment you set the end point of the connecting line, the connection object is created in 
the Navigator; for example, a pipe in P&ID. Some drawing types also work with connecting 
lines without objects. See also chapter Connections (Page 74).

Connection run
The following applies when drawing a connection:

● The connection run consists of straight lines. 

● By default, the connecting lines are right-angled. Some drawing types allow diagonal lines.
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● Every connection has a start point and an end point. Intermediate points are optional. They 
mark the changed alignment in the coordinate system. If a connection has intermediate 
points, the connection consists of several connected lines which are treated as one line 
(polyline).
Example:

See also chapter Drawing the start point and end point of the connection (Page 392) and 
chapter Drawing intermediate points on the connection (Page 394).

● You can change the connection run later using the grab points of the connection. You have 
the following options:

– Extend or shorten the lines

– Add or remove intermediate points

See also chapter Changing a connection run (Page 398). 

● The connecting lines align themselves with the grid. See also chapter Grid (Page 92).
You can switch off the grid. See also chapter Switching off the grid (Page 380). 

● A connection without an end point is displayed differently to a line with an end point: 
Example:

Without end point With end point

See also
Connecting several objects with one line (Page 395)

Connectors (Page 73)

Connecting objects (Page 392)
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4.7.7.5 Fundamentals of graphical elements

Usage
You use graphical elements in engineering projects to add drawings or notes to interactive 
reports. Administrators use graphical elements to add graphical features to symbols and report 
templates. 

Principle
Graphical elements include lines, circles/arcs, rectangles, or texts that are not based on base 
objects. They are saved as graphical information in interactive reports. You can edit graphical 
elements subsequently, e.g. change line type and line width, move elements or assign a layer 
to them in the report. 

See also chapter Working with graphical elements (Page 406) and chapter Assigning layers 
(Page 404).

4.7.7.6 Grid

Principle
Administrators usually configure the report template so that the interactive reports work with 
a grid. 

When you place, draw or move objects and graphical elements on the report, the mouse pointer 
snaps to the grid points. The following points are, therefore, always located on a grid point:

● Points of origin

● Connectors of objects 

● Start points and end points of connections or lines 

If the report has a grid, you have the following options:

● Change grid size via the report toolbar
See also chapter Toolbar in interactive reports (Page 369).

● Switch off grid
See also chapter Switching off the grid (Page 380).

See also
Symbols and symbol components (Page 93)

Fundamentals of objects and documents
4.7 Fundamentals of documents and reports

Operation
92 Operating Manual, 03/2017 V10.2.1, A5E37082875-AB



4.7.7.7 Layers in interactive reports

Principle
The objects and graphical elements of a report are assigned to layers. You can use the "Layers" 
tool to show, hide, and lock for editing objects and graphical elements that are located on a 
layer. See also chapter Showing/hiding or freezing the content of a layer (Page 377).

Which layer the symbol of an engineering object is located on is defined by its base object. 
You can overwrite the setting locally at the engineering object. Objects to which a layer has 
not been explicitly assigned start on layer 0. Graphical elements always start on layer 0. You 
can assign a layer to these objects or elements at any time subsequently. See also chapter 
Assigning layers (Page 404).

A default layer can be assigned to texts and graphical elements in report templates. You can 
find additional information on this topic in the "Administration" manual, keyword "Setting up 
layers for reports".

4.7.7.8 Symbols and symbol components

Definition of symbol
A symbol is the graphical representation of an object placed on an interactive report. Which 
symbol you see on the report depends on the drawing type of the report. If an object does not 
have a symbol for a particular drawing type, you cannot place it on a report of this drawing 
type.

Difference between the terms object and symbol
The term 'object' is often used as a synonym for the term 'symbol'. Sometimes, however, it is 
important to differentiate between objects and symbols; for example, when deleting from 
interactive reports. See also chapter Deleting in interactive reports (Page 436).

Symbol components
Every symbol consists of a basic symbol. It can also have subsymbols and texts.

Example: A 3-way valve with a motor on a P&ID
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① Basic symbol (valve)
② Connector
③ Subsymbol (motor)
④ Texts

Basic symbol (1)
A basic symbol consists of the following components:

● A point of origin
Symbols are inserted at the point of origin at coordinates determined by the user (device 
placement). The point of origin is not visible on the working area. 
The point of origin only rarely happens to be in the upper left corner. It is created in such a 
way that the connectors are located on the grid.

● Graphical elements such as lines, circles, and similar
The actual symbol

● Connectors (2)

The actual symbol and the connectors have graphical properties. Administrators can prevent 
users from redefining them locally.

Subsymbols (3) 
If an engineering object has elements, your administrator can embed the element symbols in 
the basic symbol of the engineering object. As soon as you create the element, the symbol for 
the element is added to the symbol of the engineering object on the working area.

Depending on how your administrator has embedded the subsymbols, you can either only 
select and edit the subsymbols along with the engineering object symbol, or select and edit 
them individually. 
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Texts (4)
The texts output the properties of the engineering object itself or of other engineering objects 
which are related to the engineering object. Administrators insert them to the symbol using 
text functions. 

Examples: Device labels, references to counterpart connectors, output of an attribute value

Administration
You can find additional information on this topic in the "Administration" manual, keyword 
"Preparing symbols".

See also
Fundamentals of placing on interactive reports (Page 88)

Connectors (Page 73)

Grid (Page 92)

4.7.7.9 DocObj objects

Principle
DocObj objects are located underneath engineering objects which have been placed on an 
interactive report. They have the following object icon:

The DocObj objects store placing information. If an engineering object is placed on several 
reports, it has several DocObj objects. 

You can navigate to the report the engineering object is placed on via the context menu of the 
DocObj object.

See also
Basic knowledge on copying documents and reports (Page 122)

Fundamentals of placing on interactive reports (Page 88)

4.7.8 Overview of evaluating reports

Purpose
Evaluating reports are used for plant documentation, order preparation, and for corresponding 
configuration of data processing.

Typical evaluating reports are data sheets, terminal diagrams or bills of materials.
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Application example
You have planned the coolant supply system for a factory in an interactive report. The 
interactive report contains storage tanks, valves, and pipes, for example. The evaluating report 
generates a bill of materials for you from the engineering data available. You order the required 
materials based on the bill of materials.

General information
Evaluating reports are COMOS-specific documents. You can recognize them in object trees 
by this icon:

They evaluate the existing data and present the result dynamically in the form of lists, text 
fields, options, and charts. If the database changes, the content of the report also changes. 
Elements that cannot change (graphics, pictures or static text, for example) can be part of an 
evaluating report, too.

Evaluating reports can be configured so that you can edit the data displayed. Changes are 
written to the corresponding object once the report has been saved. Data inconsistencies 
between linked attributes are also displayed in the editable fields. See also chapter Editing 
editable data (Page 448).

Every evaluating report is based on a report template. The report template determines the 
following properties of an evaluating report:

● Size and alignment of the report

● What data is evaluated and displayed

● How the data is displayed

● If and how data can be edited

● Whether and, if so, which unchangeable elements belong to the report

See also
Structure of evaluating reports (Page 447)

Overview of the sketch reports (Page 97)

Working with evaluating reports (Page 447)

Printing reports (Page 451)

Updating reports (Page 450)

Exporting and importing reports (Page 452)
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4.7.9 Overview of the sketch reports

Purpose
A sketch report is a combination of an interactive and an evaluating report. It provides a means 
of combining technical data such as lists or subreports with a sketch created by the user on a 
single sheet. 
The sketch report supports limited drawing functions but otherwise behaves like an evaluating 
report.

Editing options
You have the following options when working in sketch reports:

● Inserting drawings
The following graphical tools are available:

– Line

– Circle

– Text

– Dimension

– Hatching

● Inserting notes

● If the report is configured accordingly, you can edit the contents of the evaluating report. 

See also
Overview of evaluating reports (Page 95)

Inserting drawings (Page 450)

Inserting notes (Page 449)

4.7.10 Overview of the CDI documents

Purpose
Data sheets, bills of materials, and similar can be produced using CDI documents. They 
perform a similar function to evaluating reports.

CDI documents are COMOS documents of the "Excel" and "Word" document types which have 
been configured by administrators in the "COMOS Document Interface" (CDI) plugin. Which 
objects and object data a CDI document evaluates and displays depends on the configuration. 
You can find additional information on this topic in the "Basic interfaces" manual, keyword 
"COMOS document interface".
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Advantages of CDI documents
● The layout is easy to insert into the corporate design of a company.

● You have more formatting options than in evaluating reports.

● You work with Microsoft Office applications and only need basic knowledge of COMOS to 
edit the COMOS data.

● It is easier to edit COMOS data externally because the documents can also be opened 
outside of COMOS. 

● You can archive the documents outside of COMOS.

See also
Using CDI documents (Page 354)

4.7.11 Overview of the document search

Search options
Select one of the following tools to search for and in documents:

● Navigator search
See also chapter Using Navigator search (Page 519).

● Queries for documents
See also chapter Using queries and bulk processing (Page 455).

● "Full-text search" plugin
See also chapter Fundamentals of full-text search for documents (Page 99).

4.7.12 Overview of the PDF document view

Purpose
With the "Multiple document preview" plugin, you can view one or more external PDF 
documents on the working area of the report. You can change and print the placed PDF 
document in the view, but not edit it.

Alternatively, administrators can open the working area of the report and place predefined PDF 
documents by means of a script block. You can find additional information on this topic in the 
"Administration" manual, keyword "Comparing PDF revisions".

Editing options
The selection of commands is limited in the toolbar, in the standard toobar and in the context 
menu.
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The following editing options are available:

● Print

● Zoom

● Move sheet

● Complete view

● Bird view

● Change the picture box parameters

● Delete individual or several PDF documents

See also
Menu "Extra > ..." (Page 573)

PDF document view with "Multiple document preview" (Page 355)

4.7.13 Fundamentals of full-text search for documents

4.7.13.1 Aim of the full-text search

Purpose
You can search the contents and metadata of the following documents using the "Full-text 
search" plugin:

● External documents and their revisions 

● PQM documents and their revisions

● Metadata of reports and the contents and metadata of their revisions

Search examples
● Search for all revisions of a specified revision step

● Search for all revisions that you have checked 

● Search for documents and PDF revisions which contain the same string

Alternative tools
If you are primarily searching for the metadata of documents or document properties, specially 
configured queries or the Navigator search might be faster than the full-text search. See also 
chapters Using Navigator search (Page 519) and Using queries and bulk processing 
(Page 455).
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See also
Basic principle of the full-text search (Page 100)

Search modes for the full-text search (Page 101)

Using the full-text search (Page 341)

4.7.13.2 Basic principle of the full-text search

Principle
The full-text search offers the following search modes:

● Content-based search

● Attributed search, e.g. revision search

See also chapter Search modes for the full-text search (Page 101).

The following applies for both search modes:

● The search always takes place in the current project. 

● You can search with placeholders, operators, and regular expressions.
See also chapter Operators, placeholders, and regular expressions in the full-text search 
(Page 348).

● You can set the following search options:

– Search scope
Search only documents, only revisions, or documents and revisions

– Search precision

– Search logic
Search for at least one of or all of the strings entered or select Boolean search

– Exclude or include files, file formats, and file paths in the search

● The search is carried out on the basis of a full-text index. It is generated by the administrator 
and then updated automatically. You can find additional information on this topic in the 
"Administration" manual, keyword "Preparing a full-text search for document contents".

● The full-text search is not a Navigator search and does not find COMOS properties.

Behavior of the full-text search in working layers
The full-text search works across working layers. It searches all documents and revisions which 
are visible in the layer in which you are searching. It searches the content or metadata which 
is visible in the layer in which you are searching.

The following details apply:

● The current layer, all superordinate layers, and the released area are searched.

● The search also finds documents which are not checked into the current layer.
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● If a document is checked into several layers, the hits will only show the document which 
corresponds to the status of the current layer or the next superordinate layer the document 
is checked into.

Example Result
The document is not dis‐
played as a
hit because it has been 
deleted in the current
layer.

Only the document from 
the current
layer is displayed as a hit.

● It is not necessary that all layers between the current layer and the released area have an 
index. If indices are missing, the search result no longer corresponds to the documents 
visible in the Navigator. Documents with contents or metadata visible in the current layer 
can be missing. If a document does not exist from the point of view of the current layer, it 
is generally not shown - even if the index of the layer in which the document was originally 
deleted is missing.

See also
Aim of the full-text search (Page 99)

Using the full-text search (Page 341)

4.7.13.3 Search modes for the full-text search
The full-text search offers the following search modes:

● Content-based search

● Attributed search, e.g. revision search
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Content-based search
You use the content-based search to search the content of documents and revisions for a 
string. See also chapter Using a content-based search (Page 344).

Attributed search
An attributed search searches the metadata of documents and revisions. The metadata which 
is available for searching depends on the database and can be adapted to customer-specific 
requirements. 

You usually use an attributed search in the context of project quality management (PQM) to 
search for DVM documents. This is where you can search for the metadata you entered when 
checking the documents in. You can find additional information on this topic in the "Project 
Quality Management" manual, keyword "Attributed search".

The revision search is included in the scope of delivery for the database. The revision search 
is an example of a preconfigured special form of the attributed search.

Revision search
The revision search is a special form of the attributed search. You can search for revisions 
under a unit or a location using the revision search.

You can choose between the following search criteria:

● Executed revision steps

● User responsible 

● Name, label, and index of the revision

You can also search the content of PDF revisions.

See also chapter Using revision search (Page 345).

See also
Aim of the full-text search (Page 99)

Creating document metadata outside COMOS (Page 352)

4.7.14 Print jobs

Principle
● Print jobs accelerate printing, reduce the amount of resources needed, and simplify 

administration. 

● A large number of documents are often printed at once. COMOS aims to combine single 
printing tasks for reports into print jobs where possible. It is possible to print reports with 
different formats such as A4, A3, landscape, portrait, etc. within one and the same print job.
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● External documents are each handled in a separate print job.

● Revision printers work without print jobs.

Naming
Print jobs have a name. The following applies to naming:

● If a single COMOS document is printed, the print job gets the "FullLabel" of the selected 
document as a name.

● If several documents are printed, the job gets the name "Comos prn_<consecutive 
number>".
Multiple subsequent reports are combined into one print job.

● When you print an external COMOS document, such as a Word document, the print job 
gets the name set by the respective application. Example: In Word and Excel it is the file 
name of the respective document.

Example 1: Printing four reports
If printing to a paper printer, you will see one printing task in the print queue. If printing in a 
file, one file is created which contains all four reports.
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Example 2: Printing eight reports and three Office documents
Print order:

● COMOS sorting:
For the following COMOS sorting, the following print jobs are created:

COMOS sorting Print jobs
Report 1
Report 2
Report 3
Office document 1
Report 4
Report 5
Office document 2
Office document 3
Report 6
Report 7
Report 8

1 print job for reports 1 to 3
1 print job for Office document 1
1 print job for reports 4 to 5
1 print job each for Office documents 2 to 3
1 print job for reports 6 to 8

Six files are created when printing to file.

● Selection by user:
If you select the reports to print first, followed by the Office documents, the following print 
jobs are created:

Order of documents as determined by selection Print jobs
Report 1 to 8
Office document 1 to 3

1 print job for reports 1 to 8
1 print job each for Office documents 1 to 3

If printing in a file, four files are created.

See also
Printing documents (Page 312)

Printing reports (Page 451)

4.8 Fundamentals of document revisions

4.8.1 General information about revisioning

Aim of revisioning
You can use revisions to check and save the editing statuses of documents. The result is a 
revision file which permanently documents the working state of a document. You can print it 
out, archive it, and compare it to other revision statuses.
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Documents which can be revisioned
If the database is configured accordingly, you can revision all printable documents. Documents 
which have a link to a file in the file system are an exception to this.

Only make revisions of imported PDF files if they were not created with the Microsoft Office 
PDF converter.

Functional scope
Revisioning offers the following possibilities:

● Revisioning of single documents (single revision) or document groups (group revision)
See also chapter Single revisions and group revisions (Page 109).

● Bulk revisioning of single documents
See also chapter Single revisions and group revisions (Page 109).

● Verification of revision files with a security certificate to protect against subsequent 
manipulations (eSign)
See also chapter Security certificate (eSign) (Page 113).

● Visualization of the revision information in the revision file 
See also chapter Visualization of the revision information in the revision file (Page 115) 

● Search for revision information in queries and the full-text search
See also chapter Search modes for the full-text search (Page 101).

● Redlining functionality in PDF revision files 
See also chapter Redlining (Page 112).

● Automatic monitoring of the revision statuses and the working states of the documents 
See also chapter Revision monitoring (Page 114).

● Cross-working layer and working layer-specific revisioning
See also chapter Unit revisions and project revisions (Page 110).

● Visualization of differences between the working state of a report and its last two revisions 
in the opened report
See also chapter Change display for revised reports (Page 116).

● Printing and exporting revision files and redlining files
See also chapter Overview of printing and exporting revision files (Page 337).

File type of the revision files
Possible file types: 

● PDF 

● TIFF

Data synchronization between user interfaces
COMOS usually synchronizes the data in the visible user interfaces automatically. If you 
change and save an object description in a query, for example, this change is visible 
immediately in the open properties of the object. 
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For technical reasons, this data synchronization only functions partially when working with 
revision information. To ensure that you are seeing the up-to-date content, close and then 
reopen the properties of the documents and document groups.

Administration of revisions
You can find additional information on this topic in the "Administration" manual, keyword 
"Configuring revisions".

See also
Definition: Completed, open, and * revisions (Page 108)

Technical information about the revision process (Page 106)

Revision process (Page 320)

Revising and signing (Page 320)

4.8.2 Technical information about the revision process
See also chapter Definition: Completed, open, and * revisions (Page 108).

General rules
● Revisions are created either by users or automatically through revision monitoring.

● When a revision is created, a * revision is created.

● How many and what revision steps belong to the revision process depends on the database 
and can be adapted to customer-specific requirements. The following revision steps are 
prepared in the database:

– "Created by"

– "Inspected by"

– "Released by"

● The revision step stores information regarding which user carried out the step and when. 

● A revision file is created during the revision process. 
The revision file stores the revision status in an unchangeable data format. This archives 
the revision status so that it can be accessed for subsequent inspections.
Information about the revision steps is visualized in the revision file. See also chapter 
Visualization of the revision information in the revision file (Page 115).

● Because the revision is carried out on the basis of the revision file, you can continue to 
work in the document as soon as a revision file has been created.
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Creating the revision file 
● As long as there is no revision file, the revision is a * revision.

● The revision printer specifies at what point the revision file is created:

Revision printer Time
TIFF After the release
PDF Depending on the project configuration, the fol‐

lowing options exist:
● After the first revision step

(Normal case)
● After the release

The revision printer is defined in the project properties.

Revision index
● When the revision file is created, an index is created for the  revision.

● Revisions which belong to the same group revision have the same index.

● Separate pools of numbers are used for the unit revisions and project revisions of a 
document. See also chapter Unit revisions and project revisions (Page 110).

Deleting revisions
● Revisions are not generally deleted; instead, new ones are created. 

● If a document is changed while revision monitoring is switched on, a new * revision is 
created automatically. For * revisions with steps, the steps are reset.

● Completed revisions cannot be deleted. 

● Open revisions with a revision file: Only the last opened revision can be deleted. 

● * revisions can be deleted.

● When you delete an open group revision, you decide whether the open revisions of the 
documents are also deleted.

See also
Security certificate (eSign) (Page 113)

General information about revisioning (Page 104)

Revision process (Page 320)
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4.8.3 Definition: Completed, open, and * revisions

Completed revisions
● A completed revision is a revision which has passed through all revision steps. 

● It has a revision file and a revision index.

Open revision
● An open revision has not yet passed through all revision steps. 

● Whether or not it has a revision file and a revision index depends on the revision settings 
of the project: "Create PDF file at first step" option

Activated Deactivated
Index and revision file are available. Index and revision file are not available. 

The open revision is a * revision.

● A document can have several open revisions with an index and a revision file at the same 
time.

* revision
● A * revision is the pre-stage of a revision. It has no revision file and no index. 

● When a new revision is created, a * revision is created.

● Whether * revisions have revision steps and how long * revisions exist depends on the 
revision settings of the project: 

"Create PDF file at first step" 
option

Revision steps Life span of the * revision

Activated - Between creation of the revi‐
sion and execution of the first 
revision step

Deactivated ✓ Between creation of the revi‐
sion and the execution of the 
last revision step

● A document cannot have multiple * revisions at the same time.

● Automatically created * revisions indicate that there is a difference between the current 
state of the document and the state for which the most recently completed or open revision 
applies.

See also
General information about revisioning (Page 104)

Technical information about the revision process (Page 106)
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4.8.4 Single revisions and group revisions

Group revisions
In a group revision, you make revisions to the documents in a document group together. 

Group revisions are only possible on the "Documents" tab for document groups from the 
"@NameSystem" or "@Project" branches. These branches contain reference documents 
which refer to documents in the unit view and location view.

The following applies for group revisions:

● Which documents are part of the group revision depends on the document group settings: 
Document group property > "System data" tab > "Revision" control group > "Revision all 
documents" option:

Option acti‐
vated

Documents without * revision Documents with * revision

Yes The documents are part of the group re‐
vision. 

The documents are part of the group re‐
vision. 

No The documents are not part of the group 
revision.

● When you start a group revision, a group revision is created at the document group. 
A separate revision is created simultaneously for each document which is part of the group 
revision. These revisions are visible on the "Revision" tab of the documents but can only 
be controlled via the document group.
If a document already has a * revision, this is used. 

● All revisions which belong to the group revision have the same index. The index is selected 
in such a way that it is unique across all documents of the document group. 

● As long as the group revision is a * revision, you cannot start any new single revisions on 
participants in the group revision. You can continue single revisions that are already open.

● When you delete an open group revision, you decide whether the open revisions of the 
documents are also deleted.

See also chapter Performing group revisions (Page 325).

Single revisions
● In a single revision, you make revisions to a document independent of other documents. 

● You make revisions via the properties of the original document. 

● The index of a single revision is selected in such a way that it is unique within the document. 

See also chapter Carrying out single revisions (Page 322).

Bulk revisions
You can carry out single revisions in bulk with the "Revision" document tool. See also chapter 
Carrying out single revisions in bulk (Page 324).
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See also
General information about revisioning (Page 104)

4.8.5 Unit revisions and project revisions

Basic principle
There are two types of revision:

Type of revision Mode of operation Purpose
Unit revision Across working layers ● Without project revisions:

For documenting all the intermediate states that a document has in a 
working layer.
All intermediate states are available in the subordinate layers and, after the 
working layer release, in the superordinate layers.

● Combined with project revisions:
For documenting the most up-to-date intermediate state that a document 
has in a working layer  
Only the most up-to-date intermediate state is available in the subordinate 
layers and, after the working layer release, in the superordinate layers.

Project revision Working layer-specific For documenting all the intermediate processing states that a document has in 
a working layer The intermediate states are only available in the layer in ques‐
tion.

By default, projects in the database only have unit revisions. If projects are configured in such 
a way that they use project revisions, they always have unit revisions as well. These unit 
revisions function differently to the unit revisions in projects without project revisions.

In both cases, the basic rules described in section Technical information about the revision 
process (Page 106) apply for unit revisions and project revisions. In addition, the specific rules 
described below apply.

Project revisions
● Project revisions are layer-specific. They are only available in the working layer in which 

they were created. They are not released to the superordinate layer when the working layer 
release takes place.

● They document the intermediate processing statuses of the document in the working layer.

● Index:

– Their pool of index numbers functions separately from that of the unit revision. 

– Each document uses a separate pool of numbers per working layer for its project 
revisions. The newest revision has the highest index number. 

● When you finish a project revision, COMOS automatically creates a unit revision from the 
most recent project revision. See below.

Fundamentals of objects and documents
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Unit revisions 
The following applies to all unit revisions:

● They are available in the working layer in which they were created, and shine through in 
the subordinate layers.

● They are released to the superordinate layer when the working layer release takes place. 

● A document uses the same pool of numbers for its unit revisions across all working layers. 
The newest revision has the highest index number. 

● If revisions are made to a document in several layers, inconsistencies can occur due to the 
working layer release. Therefore, COMOS prevents you from creating new unit revisions 
or creating a revision file for existing * revisions in the following cases:

Initial situation Consequence Canceling the revision lock
A document has been revi‐
sioned in a subordinate layer.

You cannot revision the docu‐
ment in the superordinate layer.

Release the subordinate layer.

Working layer "A" has parallel 
working layers. A document 
has been revisioned in working 
layer "A".

You cannot revision the docu‐
ment in the parallel layers.

Release layer "A" to the super‐
ordinate layer.

See also chapter Revision process (Page 320) 

● At the end of the release process, the unit revision released to the released area represents 
the actual state of the unit.

Fundamentals of objects and documents
4.8 Fundamentals of document revisions

Operation
Operating Manual, 03/2017 V10.2.1, A5E37082875-AB 111



In addition, the following applies to unit revisions from projects which work with both unit 
revisions and project revisions:

● There is only one unit revision for each working layer. 

● They are not created manually. When a project revision is released, a completed unit 
revision is created automatically. It represents the same state as the project revision. 
The following applies: 

– As long as no project revision has yet been completed in the working layer, the unit 
revision shines through from the superordinate layer.

– As soon as a project revision is completed, the unit revision stops shining through from 
the superordinate layer. You can now only see the unit revision created by the project 
revision.

– If another project revision is completed, the previous one is replaced with the new unit 
revision.

– If the document has already been revisioned in a parallel or superordinate layer, the unit 
revision is created as a * revision. It is locked.

Note
Forcing revision

Depending on the project configuration, an open unit revision can prevent the release 
of a working layer.

You can search for open revisions in the release manager and force their release. See 
also chapter Performing release check by means of Release manager (Page 218). The 
unit revision with the same index number from the other layer is deleted.

● When a working layer is released, the unit revision is released to the superordinate layer. 

Specialty * revision
* revisions do not have an effect on the subsequent working layers.

See also
General information about revisioning (Page 104)

4.8.6 Redlining

Aim
The Redlining function supports you when inspecting, marking and editing documents during 
the revision process. Redlining is also described as evaluating and commenting. 

Availability
Redlining is only available for PDF revision files. 

Fundamentals of objects and documents
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Principle
If you display the PDF revision files with Redlining, you can insert markings and comments. 
They are stored in a separate Redlining file. The revision file is not changed. The markings 
and comments are shown in the working area of the open report. See also chapter Change 
display for revised reports (Page 116).

See also
General information about revisioning (Page 104)

Working in Redlining files (Page 335)

Viewing revision files and Redlining files (Page 333)

4.8.7 Security certificate (eSign)

Availability
eSign is only available for PDF revision files which were created in the first revision step.

Principle
If the project works with eSign, the execution of the revision steps is linked to a security 
certificate.

Consequence:

● Only users with a valid PFX security certificate can execute a revision step. The signature 
is protected by a personal password.

● The file hash of the revision file is monitored. This allows you to determine whether the 
revision file has been manipulated subsequently. 

Visualization of the signature
See also chapter Visualization of the revision information in the revision file (Page 115).

Administration of eSign
You can find additional information on this topic in the "Administration" manual, keyword 
"Managing eSign" and "Managing eStamp".

See also
General information about revisioning (Page 104)

Signing revisions electronically (Page 330)

Checking the signature (Page 332)
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4.8.8 Revision monitoring

Availability
Revision monitoring is only available for reports.

Principle
Revision monitoring identifies differences between the working state of a report and the state 
of its current revision. The following alternatives are available:

● If the report has a revision with a revision file, the revision monitoring creates a * revision.

● If the report has a * revision, the revision steps are reset.

● If the revision file is created in the first step, the revision monitoring compares the current 
data stock with the revision status at the first step. 

● If the revision file is created in the last step and the project properties are configured 
accordingly, the revision monitoring ensures that the data stock has not changed between 
the first and last steps. 

COMOS uses one of the following comparison methods:

Comparison methods Description
Timestamp-based Changes to the following timestamps are monitored:

● Timestamp of the document to be revisioned
● Timestamp of the objects evaluated by or placed on the 

document
● Timestamp of the first revision step or the last revision step 
Graphical elements are not monitored. 

Content-based Changes to the texts which were defined by the report template 
are monitored.
The timestamp-based method applies to the rest of the contents. 

Administrators configure revision monitoring in the project properties. You can find additional 
information on this topic in the "Administration" manual, keyword "Revision options: Editing 
the options for the revision archive".
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Examples
The following are typical user actions that effect revision monitoring:

Action Content-based method Timestamp-based method
You change an object evaluated by a 
report or placed on it.
The report is then evaluated; for exam‐
ple, because you open it or print it. 

✓ ✓

You open a report and place a new sym‐
bol or move a placed symbol.

✓ ✓

You open a report, change nothing, and 
save it.

- ✓

The above-mentioned actions have the following effect:

● Activated revision monitoring and "PDF in first step": Creating a * revision.

● Revision file in the last step: Reset of the current * revision (discarding all previously 
conducted revision steps).

Opening evaluating reports for the first time 
When you open evaluating reports for the first time, they automatically get a * revision if revision 
monitoring is switched on, even if the report is empty. 

See also
General information about revisioning (Page 104)

4.8.9 Visualization of the revision information in the revision file

Without eSign
In projects which work without eSign, the revision information is only visualized in the document 
if the following conditions are fulfilled:

● The revision file is only created on release. 

● The document is configured accordingly.
Example: The report template specifies that the report header contains revision information.

With eSign
In projects which work with eSign, the revision information is always visualized in the revision 
file.

When the revision file is displayed and printed, COMOS automatically creates and opens a 
temporary copy of the revision file. The revision information is stamped into this copy (eStamp). 
The revision file is not changed. 

Fundamentals of objects and documents
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Where and in what form the revision information is displayed depends on whether the 
administrator has prepared eSign placeholders in the document:

eSign placeholder Result
Yes The information is stamped where the administrator has inserted the place‐

holders.
The information that is stamped depends on which placeholders the admin‐
istrator has inserted.

No The signatures are placed on the first page of the document one below the 
other:
● Left margin
● Rotated 30°
● Font Bookman Oldstyle 
● 8 Pt
● Italic
● Right-aligned
● 3-line in the form:

Reason, name, place, and date

You can find additional information on this topic in the "Administration" manual, keyword 
"Managing eSign" and "Managing eStamp".

See also
Security certificate (eSign) (Page 113)

4.8.10 Change display for revised reports

Requirements
● A report with at least one revision is open.

See also chapter General information about revisioning (Page 104).

"Display of textual changes" option
● "Display in italics"

Note that inherited texts are also displayed in italics. 

● "Enclose with revision frame"
See the section "Revision rectangles" below.

You can find additional information on this topic in the "Administration" manual, keyword 
"Reference of the "Revision options" category".
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Revision rectangles
With appropriate administration, changes since the last revision status are highlighted in the 
report using a revision rectangle.

Note

Changes to graphical elements are not shown. 

Color code of the revision rectangles:

● Gray: Changed since the last revision with a revision file
Only displayed when there is no * revision.
Whether the revision rectangles are printed in the revision file when the new revision file is 
created depends on the report configuration.

● Green: Changed since * revision
When the revision file of the * revision is created, these revision rectangles do not appear 
in the revision file.
Example:

Example: When a change in the report (for example, the placement of a device) generates a 
new * revision, the change is marked with a green revision rectangle. At this point in time, the 
report contains gray and green revision rectangles, depending on the situation. If the report is 
saved, there is a * revision. The next time you open the report, only the green revision 
rectangles are visible.

Note
Printing revision rectangles

If the report is configured accordingly, the revision rectangles are also printed out on paper. If 
you are printing with a TIFF printer, they are always printed in black and white.

You can find additional information on this topic in the "Administration" manual, keyword 
"AutoMarkAsChanged" and "PrintRevisionRectangles".

Redlining markings
When you open a report which has completed revisions with redlining files, you see the 
markings of the last completed revision in the working area. 

See also chapter Redlining (Page 112).
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Limits of the automatic change display
In very rare cases, the automatic change display does not detect a change. Example:

● A component is placed in a revised report. With a closed report, there is a full run-through 
of the revision and the placed component is renamed.

● If the report is then opened, the changes for this component are shown in the report but 
the change display does not immediately appear.

If it is important that a report actually records all changes in the change display, click 
"Reevaluate document".
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Copy fundamentals 5
5.1 Overview of the copy methods

You can copy either texts or objects.

Copying texts
See chapter Copying, cutting, and pasting texts (Page 178).

Copying objects
You can choose between the following copy methods:

1. Create a copy from the properties of an engineering object
See also chapter Creating a copy of an engineering object from the properties (Page 246).

2. In interactive reports
See also chapter Copying/pasting and cutting in interactive reports (Page 433).

3. Simple copying
You usually use simple copying in the Navigator. However, it is also available in other user 
interfaces in which the objects have the "Copy" and "Paste" context menu commands (in 
other object trees or queries, for example).
See also chapters Simple copying in the Navigator without switching projects (Page 247) 
and Simple copying in the Navigator and switching projects (Page 248).

4. Using the "Copy structure" tool
See also chapter Basic knowledge on the "Copy structure" function (Page 123).

5. Using the "Cross-class copy" plugin
See also chapter Basic knowledge on the "Cross-class copy" function (Page 124).

6. Using the "Cross-project copy" tool
See also chapter Basic knowledge on the "Cross-project copy" function (Page 124).

7. Using the "Object matcher" tool
See also chapter Basic knowledge on copying with the object matcher (Page 125).

Note
Differences between copy methods

With copy methods 1 to 3, you cannot control the copy process. With copy methods 4 to 7, 
you can control the copy process. 

The copy methods also differ in the way that they deal with references to other objects during 
copy processes. See also chapter Basic knowledge on copying objects (Page 120).
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5.2 Basic knowledge on copying objects
This chapter provides an overview of the fundamentals of copying engineering objects:

● Amount to be copied

● Handling references

● Projection

You can find information about copying base data in the "Administration" manual, keyword 
"Copying objects".

Amount to be copied 
The amount to be copied is generated as follows:

● From all objects that were selected in a user interface when the "Copy" command was called

● Recursive: From all subordinate objects

The copy method determines which object data is included in the amount to be copied. The 
following data is always included in the amount to be copied:

● The object itself

● The checked-in properties of the engineering object or document
See also chapter Fundamentals of the properties of engineering objects (Page 64).

Note
Handling inherited properties

When you copy an engineering object, the inherited properties are not copied. The copy 
reads the data from the base object.

If you are working with local base objects, or the projects use different base projects and 
you copy across projects, there is a possibility that in the target project the base object does 
not exist, or there is one with the same name but different content. If this happens, data 
may be lost or altered when copied. 

The copy method determines whether references to other objects are copied or whether the 
referenced object is copied as well. 

Handling references
If an object has a reference to an object that is included in the amount to be copied, the 
reference points to the copy once the copy process is complete.

If the referenced object is not included in the amount to be copied, the following scenarios are 
possible:

● The reference is not copied. The corresponding field is empty after the copy process is 
complete.

● The copy process is aborted.

Copy fundamentals
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● The referenced object is also copied (i.e. traced). The reference points to this copy.

Note
Incomplete copy

To prevent the amount to be copied from getting too big, traced objects are not usually 
copied in full.

● The reference is replaced by projection, i.e. it is transferred at the insert location to another 
object. This is often the case for cross-project copying.

Alias references are not copied. See also chapter Setting general references (Page 257).

In the following copy methods, no objects are traced or references projected:

● Simple copying

● Copying in interactive reports

● Copying via the properties 

Projection
In the case of projection, the reference to an object is replaced by a reference to another 
comparable object.

An object can be projected if it has the same SystemFullName and the same system type as 
the object referenced originally. In the case of engineering objects, the "Class" property must 
also be identical. 

Example: 

More information
You can find additional information on this topic, particularly on handling base objects when 
copying, in the "Administration" manual, keyword "Copying objects".
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See also
Overview of the copy methods (Page 119)

5.3 Basic knowledge on copying documents and reports

Copying revisions
Revisions are not copied.

Cross-project copying of documents that evaluate objects
Following copying, the content of documents is calculated based on the new object structure. 
In other words, the content of the copied document might not be the same as that of the original.

Examples of such documents: 

● Evaluating reports

● Excel lists and Word files that evaluate objects

Copying interactive reports
The copy mode of the original DocObj objects determines whether the same engineering 
objects are placed on the copy of the interactive report as were placed on the original.

Note
Technical background

In the Navigator, the DocObj objects of the engineering objects placed on the interactive report 
are located under the engineering objects but belong to the report. 

See also chapter DocObj objects (Page 95).

Copy modes of DocObj objects
The following copy modes are available for DocObj objects: 

● Mode 1: DocObj objects are not copied. The first time the copied report is opened, the 
"Define paste mode for COMOS objects" window opens. In this window, you decide whether 
the engineering objects placed on the original report are used or if copies are created and, 
if so, where they are created.
See also chapter "Define insert mode for objects" window (Page 594).
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● Mode 2: DocObj objects are copied. Which engineering object the DocObj object points to 
depends on whether the engineering object placed on the original report was included in 
the amount to be copied.

– Yes: The DocObj points to the copy of the engineering object. Where the copies are 
pasted depends on the drawing type.

– No: The DocObj points to the same engineering object as in the original report. The 
engineering object is then placed twice.

● Mode 3: The DocObj objects and the engineering objects placed in the original report are 
copied. The copies of the engineering objects are created in parallel with their originals. 
The DocObj objects point to the copies.

● Mode 4: If the referenced object is not included in the amount to be copied, the DocObj 
object remains empty. The object referenced originally is not placed. Its symbol is marked 
as inconsistent on the report.

See also
Overview of the copy methods (Page 119)

Basic knowledge on copying objects (Page 120)

5.4 Basic knowledge on the "Copy structure" function

Usage
The "Copy structure" tool is used to copy objects including all references and substructures 
within a database. You can also make copies within a project and across projects. Compared 
to other copy methods, you have the maximum possible control over the copy process. 

Principle
● You can decide whether the object is traced or projected on an object-by-object basis. If 

you decide to project the object during cross-project copying, but projection is not possible 
in the target project, the reference is lost.

● You can exclude individual objects from the amount to be copied.

● Objects and documents located in different tabs in the Navigator can also be copied by 
tracing objects.

Differentiation from the "Cross-project copy" tool
● "Copy structure" gives you more control.

● "Cross-project copy" is more powerful.

● Unlike the "Copy structure" tool, the "Cross-project copy" tool enables you to copy objects 
that are located on different tabs in the Navigator and which are not traced objects.
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More information
You can find additional information on the topic of copying structures in the "Administration" 
manual, keyword "Copying a structure".

5.5 Basic knowledge on the "Cross-project copy" function

Usage
You can use the "Cross-project copy" tool to copy objects including all references and 
substructures within a database from one project to another. This allows you transfer complex 
object structures. 

Administrators also have the option of copying base objects, standard tables, and unit systems. 

Principle
● You can copy objects and documents that are located on different tabs in the Navigator.

● References between objects that are located on different tabs in the Navigator are lost. 
This also applies if both objects are included in the amount to be copied.

● When you select the corresponding setting, the cross-project copy process traces objects 
and projects references. 
Either the entire amount to be copied is projected, or none of it.

● External files must also be copied manually.

● Reports are not evaluated before the copy process.

More information
You can find additional information on the topic of cross-project copying in the "Administration" 
manual, keyword "Cross-project copy".

5.6 Basic knowledge on the "Cross-class copy" function

Usage
You can use the "Cross-class copy" plugin to copy objects which are located on different tabs 
in the Navigator and paste the copies under the same owner. The relationships that exist 
between the objects from the various tabs within the amount to be copied are retained. 

You can find additional information on this topic in the "Administration" manual, keyword 
"Cross-class copy".
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5.7 Basic knowledge on copying with the object matcher

Usage
In the object matcher, you compare a source node of the object tree to a target node. The 
nodes can be located in the same project or in different ones. Differences between the nodes 
are resolved in favor of the target node. This allows objects to be copied. 

The comparison of two objects requires comprehensive knowledge. You can find additional 
information on this topic in the "Administration" manual, keyword "Comparing and matching 
objects" and especially keyword "Principle of object matching".

See also
Overview of the copy methods (Page 119)
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Starting COMOS 6
6.1 Requirements for COMOS operation

Software
● COMOS is installed.

● The necessary COMOS product licenses are available.

Database
● You have access to the database supplied with the software or an in-house customer 

database containing the necessary projects, objects, and structures.

● You are entered as a user.

● An engineering project or a working layer has been created. See also chapter Creating 
working layers (Page 215).

● An engineering project or a working layer has been opened. See also chapters Opening a 
project or the released area of a project (Page 185) and Opening the working layers of a 
project (Page 193).

● There are engineering objects and documents located in the project or the working layer. 
See also chapters Creating engineering objects (Page 233) and Creating Documents 
(Page 307).

● The objects you are working with are not locked. See also chapter Locking engineering 
objects (Page 256).

● You have the necessary rights in COMOS user management and in the project or nodes 
in which you are working.
See also chapter Displaying user rights in a project (Page 190).
If you have any questions, contact your administrator.

● If you are working with working areas: The objects you are working with belong to a working 
area that is assigned to you in user management.
If you have any questions, contact your administrator.

Rights
The projects, menus, objects, tools, and functions you are able to access are determined by 
your user rights.

You can find additional information on this topic in the "Administration" manual, keyword 
"Administration of users and rights".
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6.2 Overview of startup options

Comos.exe startup options
COMOS offers the following startup options:

● File browser: "<Installation drive>\Comos\<COMOS version directory>\BIN\Comos.exe"

● Link to the Comos.exe file; for example, on the desktop

● Windows Start menu > Programs

● Call the  Comos.exe file from the command line

COMOS with 4GB support
COMOS uses 4GB of RAM.

Result 
● COMOS start without quick launch or start parameters

A COMOS instance will be started. You then open the database.

● COMOS start with quick launch
A COMOS instance will be started. The most recently closed database and project are 
opened. If necessary, change the database and project. 

● COMOS start with start parameters
A COMOS instance will be started. COMOS will be opened as specified by the start 
parameters. See also chapter Setting up a COMOS start with user-specific settings 
(Page 130). If necessary, change the database and project. 

See also the following chapters:

● Opening or switching between databases (Page 129)

● Opening a project or the released area of a project (Page 185)

● Switching between open projects (Page 188)

● Enabling and disabling quick launch (Page 130)

Startup via Comos.xif.exe
If there is no COMOS instance open, it is possible to start COMOS via a link to Comos.xif.exe. 

Links to Comos.xif.exe provide fast access to an object or document, regardless of whether 
or not COMOS is already open. When you double-click on the link, the corresponding project 
is opened, the object or document is selected in the Navigator, and its properties are opened. 
In the case of documents, the content is opened.

See also chapter Setting up a COMOS start with a link to an object (Page 132).

See also
Requirements for COMOS operation (Page 127)
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6.3 Opening or switching between databases

Requirements
You have started COMOS. See also chapter Overview of startup options (Page 128).

Procedure
1. Select the "File > Open database..." command in the menu bar.

2. In the "Open database" window, select a database type in the first line:

– "Microsoft Jet" for Access databases

– "Oracle"

– "SQL"

3. Select the database:

– If you select "Microsoft Jet", click on the "..." button next to the "Database" field. Select 
the required database in the "Open COMOS database" window.
Alternative: Enter a path manually.

– If you select "Oracle" or "SQL", select an instance in the "Database" list.

4. Log in with your user name.
Your user name will be applied in the "User name" field; it is the same name you used to 
log in to the company network when starting up the PC. 

Note
Changing the user

You can log in as a different user. You can find additional information on this topic in the 
"Administration" manual, keywords "Login in Access with the "Setup" user" and "Login with 
alternative access".

5. Click "Open".

Result
● You will be logged in to the database. The database is opened.

● When the database is opened, COMOS checks the versions of COMOS and the database. 
If the versions differ, a corresponding message window appears. Confirm the message. 
You can find additional information on this topic in the "Administration" manual, keyword 
"Login check: Database scheme and database indices" and "Login check: Database 
version and document version." If you have any questions, contact your administrator.

● For a database change with an open project: 
You get information about the currently edited but still unsaved objects of the previously 
opened project. You can choose to save or discard the information.
Finally, all other unsaved information still in the background is saved.

Starting COMOS
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See also
Requirements for COMOS operation (Page 127)

6.4 Enabling and disabling quick launch

Aim of quick launch
Restoring your most recent work environment: 

● Most recently closed database

● Project

● Working layer

● Tab visible in the Navigator

● Node displayed in the Navigator

Requirements
● See also chapter Requirements for COMOS operation (Page 127).

● You have started COMOS. See also chapter Overview of startup options (Page 128).

● Quick launch only functions if the following conditions are fulfilled:

– You have logged in to the database with your default access data or the alternative 
access data of a user

– No other setting has priority.
Example: You are not using start parameters

Procedure
Select "View > Quick launch" from the menu.

Disabling quick launch
Select "View > Quick launch" from the menu again.

6.5 Setting up a COMOS start with user-specific settings

Aim
You can also start COMOS with user-specific settings. Specify these settings via the start 
parameters.

Starting COMOS
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Differences from quick launch
When you use start parameters, COMOS will always start as defined in the start parameters. 
With quick launch, COMOS will always start with the settings in place at the end of the last 
COMOS session.

Principles of start parameters
In general:

● The start parameters are optional.

● You can assign any number of start parameters, but each start parameter only once.

● Delimiters between start parameters: Space

● Use the following notation for each start parameter:
/<Start parameter name>:<parameter value>

● When start parameters are assigned, they overwrite the quick launch settings.

Procedure
1. Open the Comos.exe properties or a link to Comos.exe.

You will find the path to Comos.exe in the "Target" field.

2. Insert a space after the path.

3. Enter the start parameters. Use the notation described above.
See also chapter Reference for start parameters (Page 133).

Note
Specifying an Access database

If the database path or the name of an Access database contains spaces, put the path and 
name parameters in quotation marks.

4. Confirm your entries.

Result
When you double-click on the link, COMOS will start as specified by the start parameters.

Note
Start parameters with command line call

It is also possible to assign start parameters by calling COMOS via the command line. The 
notation is identical.

See also
Requirements for COMOS operation (Page 127)
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6.6 Setting up a COMOS start with a link to an object

Principle
Links to Comos.xif.exe provide fast access to an object or document, regardless of whether 
or not COMOS is already open. When you double-click on the link, the corresponding project 
is opened, the object or document is selected in the Navigator, and its properties are opened. 
In the case of documents, the content is opened.

Starting COMOS via Comos.exe with the corresponding start parameters has the same result. 
In the case of Comos.exe, you have to enter the start parameters manually. When you create 
links to Comos.xif.exe, the start parameters are generated automatically and saved in the 
properties of the link.

Differences from starting with Comos.exe and start parameters 
If a COMOS instance was already open when starting via Comos.xif.exe, the work environment 
defined by Comos.xif.exe is loaded into the COMOS instance which is already open. If there 
was no COMOS instance open, COMOS will be started and the work environment defined by 
Comos.xif.exe will be loaded.

When starting with Comos.exe, a new COMOS instance is always opened. 

Differences from working with favorites
For favorites to work, COMOS must already be open. They only provide access to objects in 
the same database.

Requirements
See also chapter Requirements for COMOS operation (Page 127).

Procedure
1. Start COMOS. See also chapter Overview of startup options (Page 128).

2. Open a database and a project. See also chapters Opening or switching between 
databases (Page 129), Opening a project or the released area of a project (Page 185), and 
Opening the working layers of a project (Page 193).

3. Select the desired engineering object, base object or document in the Navigator.

4. Drag&drop it to your desktop.

Result
A link to Comos.xif.exe is created. The link automatically contains the start parameters 
necessary to restore the current work environment.

When you double-click the link, COMOS will start with this work environment. The properties 
of the object selected or the content of the selected document will also be opened. If COMOS 
was already open, the work environment will be loaded into the open COMOS instance.

Starting COMOS
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6.7 Starting plugins

Procedure
Select the "Plugins > Basic" command in the menu bar and the desired plugin.

You can only start each plugin once.

See also
"Plugins > Basic" menu (Page 574)

6.8 Reference for start parameters

List of start parameters

Parame‐
ters

Name Description

/? Help Do not use in combination with other start parameters. When CO‐
MOS starts up, a help window containing information about the 
start parameters is opened.

/AT: Application type
(AS: Assistant Mode)

Compact display of the COMOS interface. When the mouse is not 
on the application, the interface is represented by icons that are 
fixed in the foreground. This facilitates simultaneous work with oth‐
er applications.
Example: /AT:AS

/DG: Debug Debug mode
Example: /DG:D
You can find additional information on this topic in the "Administra‐
tion" manual, keyword "COMOS log files and debug mode".

/DT: Data type Data type of the database. You obtain this data type from 
Workset.Init(...), for example. 
Example:
/DT: [SQL -SERVER]PT_SQL_SERVER_1

/ID: Identify Internal unique identifier of an object: COMOS-Object.SystemUID
Example: /ID: A17XK7X4K0

Starting COMOS
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Parame‐
ters

Name Description

/MD: Module ● V: View mode
● E or ET: Electrical Engineering
● PID: Piping&Instrumentation Design
● FEED: Front-End-Engineering&Design
● CA: Construction Assistant
● PA: The COMOS products belonging to the package are 

started.
You can find additional information on this topic in the 
"Administration" manual, keyword "Packages".

If you assign a COMOS product as the start parameter, the menu 
file of the same name is loaded during startup. You can load a 
different menu file via the /MN: start parameter.
No longer supported: "/MD:AD", "/MD:AdvES"

/MDP: Multiple document pre‐
view

Configuration file
Example: /MDP:<Pfadangabe zur Konfigurationsdatei>
\ConfigurationFile.txt
You can find additional information on this topic in the "Administra‐
tion" manual, keyword "Comparing PDF documents".

/MN: Menu Name of the menu file. The menu file must be located in the folder 
of the respective COMOS version in the following subfolder: "Cur‐
rent\config\menu".

/PR: Project Project name
Example: /PR:"H001"

/ST: System type The system type
You can find additional information on this topic in the "Class Doc‐
umentation COMOS_dll" manual, keyword "SystemType".
Object example: /ST: 8
Base object example: /ST: 13

/US: User Possible values:
● User name (login) from Workset.CurrentUser.Name

Example: /US: Frank
● 1: Setup user
● 2: Second account

/WO: Working overlay ID Pass the ID of the working layer.
Procedure for determining the ID:
1. Open project
2. Open the working layer properties

"Extra > Working layers/history > Management" menu, 
"Working layers" tab

3. Apply the value from the "ID" field

See also
Setting up a COMOS start with user-specific settings (Page 130)
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Basic operation of the user interface 7
7.1 Overview of the COMOS interface

Overview
The graphic below illustrates the structure of the COMOS user interface:

① Menu bar
② Toolbar
③ Area of the Navigator for switching between projects and working layers
④ Structure area of the Navigator
⑤ Detail area of the Navigator
⑥ Working area
⑦ Status bar

Operation
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Menu bar and toolbar
The contents of the menu bar and the toolbar depend on the product involved. They can be 
customized to specific requirements. You can find additional information on this topic in the 
"Administration" manual, keyword "Administration of the appearance of the COMOS menu 
(main.xml)".

The toolbar allows you fast access to selected commands of the menu bar.

See also chapters Reference of the COMOS menu bar (Page 567) and Reference of the 
COMOS toolbar (Page 577).

Navigator
The Navigator provides you with access to the objects and documents in the project. It is always 
visible.

The Navigator comprises the following areas:

● Area for changing between recently opened projects and working layers
See also chapters Switching between open projects (Page 188) and Switching between 
open working layers (Page 194).

● Structure area containing several tabs with object trees

● Detail area

See also chapter Structure of the Navigator (Page 157).

Working area
This is where the tabs with the main tools are opened; for example, object properties, 
interactive and evaluating reports or queries. The tabs are arranged side by side.

If no tool is open, you see the "COMOS" tab.

Status bar
The status bar provides information relating to COMOS in general, for example, the number 
of unsaved objects. 

Many tools in COMOS have their own status bar. The status bar also provides context 
dependent access to some important management tools. See also chapters Saving objects 
that have not been saved (Page 180) and Checking objects (Page 179).

7.2 Language management fundamentals

Multilingual capability
The COMOS language concept enables multinational participants to work together on joint 
projects in their respective languages. 

Basic operation of the user interface
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COMOS is supplied in the following languages:

● German

● English (US)

● Chinese (Simplified)

User interface language and project language
In COMOS, the user interface language and the project language are managed and set 
separately. The user interface language and project language can be combined at will. 

The selected language settings are saved for each workstation.

User interface language
The user interface language controls the language in which the user interfaces generated by 
the software are displayed, e.g.:

● Menu bar

● Status bar

● Tabs

● Windows

● Notes or warnings

● Tooltips

● Help that is called up via the "Help" menu

The user interface is only available in the languages supplied with COMOS. The available 
entries cannot be changed.

See also chapter Switching the user interface language (Page 138).

Project language
The project language controls the language in which the translatable content saved in the 
database for a project is displayed. 

Translatable content:

● Description texts of objects

● "Text" type attribute values (Value, XValue)

● List fields and memo fields

● Help texts and tooltip texts of attributes

● Fixed texts in reports

● Column headers for queries

● Standard tables: The "Description" field in the "Properties" of the standard tables

Basic operation of the user interface
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Content which cannot be translated:

● Alphanumeric texts

● Names and labels
Alias labeling systems can be used to cover labels in foreign languages. See also chapter 
Alternative labeling system (Page 49).

● Description of revisions and revision steps
The description is written to the primary language and displayed in the same way for all 
languages.

When you change the project language, the translatable content changes in the Navigator and 
in all user interfaces in which it is displayed. See also chapter Switching the project language 
(Page 139).

All objects supplied with the database are translated prior to delivery. Objects you create can 
also be translated if you require. Various translation tools and workflows are available to you 
for this purpose. Translation tasks can be assigned to external service providers via the 
COMOS translation database, for example.

Administrators can create other project languages in addition to those delivered with COMOS.

7.3 Switching the user interface language

Requirements
● You have started COMOS. See also chapter Overview of startup options (Page 128).

● A database is open. See also chapter Opening or switching between databases 
(Page 129).

Procedure
1. In the menu bar, select "File> Languages".

The "Languages" window opens.

2. Select the language you want.

3. Click the "OK" button.

Result
● The user interface language is changed.

● All open tabs are closed.

● The object tree in the Navigator is reduced. You only see the nodes directly under the 
project root.

● The project language switches to the one set as the user default language or the project 
default language.

Basic operation of the user interface
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See also
Switching the project language (Page 139)

Language management fundamentals (Page 136)

Requirements for COMOS operation (Page 127)

7.4 Switching the project language

Requirements
A database is open. See also chapter Opening or switching between databases (Page 129).

Procedure
1. Select a project in the Navigator or on the "Open project" tab.

2. Select the "Properties" command from the context menu of the project.
The project properties are displayed.

3. Click on the category "General settings > Languages".

4. You have the following options:

– Switch language for the current session: Enable the option for the desired language in 
the "Current" column.

– Switch language permanently: Enable the option for the desired language in the "User 
default" column.

5. Click the "OK" button.

Note
Restriction

Switching the language does not affect objects from other projects.

Examples of such objects: Favorites from another project, base objects from the base 
project

Result
The database language is changed.

See also
Requirements for COMOS operation (Page 127)

Switching the user interface language (Page 138)

Language management fundamentals (Page 136)

Options when working with projects (Page 185)
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7.5 Changing user settings

User interface

Procedure
1. In the menu bar, select "File > User settings".

2. Select an entry in the "User" option.
Rights are not checked in the "User settings" window. When you change the settings of a 
user in this window, it means that the user also has all rights for the corresponding functions 
in a subsequent work step.

3. Select a tab and edit the settings.

4. Confirm your entries.

Storage location for ini files
The "User settings" user interface makes machine-specific settings available. If COMOS is 
installed locally, the user settings are stored as follows:
C:\Users\<User>\AppData\Roaming\Comos_Industry_Solutions\<User>.ini
The ini file is unencrypted. It is permissible to save a .ini file under another user name and 
store the corresponding user in the above path.

If Citrix is used, the ini file is stored in accordance with the Citrix rules. A local COMOS 
installation and a Citrix installation of COMOS use different ini files and consequently different 
user settings. There is no automatic synchronization. From the COMOS point of view there is 
no objection towards introducing a company-specific solution for synchronizing the local ini 
files and the Citrix-specific ini files in the context of customizing.

Basic operation of the user interface
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Restoring the default settings
● Delete the ini file to return to the internal defaults.

● Alternatively: Setting default settings in the "User settings" user interface

– Go to the manual chapter with the content description of the tabs (for example in the 
following paragraph to the ""Report" tab"). 

– The default settings are listed there.

– Open the "User settings" user interface and set the settings to the specified default 
settings.

– Confirm your entries.

"Report" tab
See chapter Reference of the "Report" user settings (Page 372).

7.6 Displaying a preview of symbols and working areas

Requirements
See also chapter Requirements for COMOS operation (Page 127).

Procedure
1. Select the "View > Symbol and document preview" command in the menu bar.

The "Symbol and document preview" tab opens in the detail area of the Navigator.

2. To preview the symbols of engineering objects, select a drawing type from the list of drawing 
types.

3. Optional: To see the symbol texts of the symbols too, activate the "Show texts" option.

4. Optional: For performance reasons, the administrator can deactivate the document preview 
so that only the symbol preview is active.
You can find additional information on this topic in the "Administration" manual, keyword 
"Controlling the "Symbol and document preview" in Workset.globals".

Result
● When you select an engineering object in the Navigator, you see the symbol which was 

defined at its base object for this drawing type.

● When you select an interactive report, you see a preview of the working area of the report 
on the tab. It does not matter which drawing type was previously selected in the list. 

● For performance reasons, the symbol and document preview is only updated when the tab 
is visible in the foreground.

Basic operation of the user interface
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7.7 Working with favorites

7.7.1 Basic information about favorites

Definition
Favorites are bookmarks which navigate to objects chosen by you. They are displayed in the 
detail area of the Navigator on the "Favorites" tab.

Favorites provide you with fast access to objects. When you select a favorite, the object tree 
is automatically expanded in the Navigator and the corresponding object is selected.

Working with favorites across projects: When you set an object from project A as a favorite 
and switch to project B, you will still have access to the favorite from project A via the favorites. 

Scope of actions in the "Favorites" tab
The following actions are available in the "Favorites" tab:

● Creating favorites (Page 144)

● Filtering favorites (Page 144)

● Navigating to favorites (Page 145)

● Deleting favorites (Page 145)

7.7.2 Opening the "Favorites" tab

Requirements
See also chapter Requirements for COMOS operation (Page 127).

Procedure
In the menu bar, select "View> Favorites".

Result
● The "Favorites" tab opens in the detail area of the Navigator. See also chapter "Favorites" 

tab (Page 143).

● If you have already created favorites in the current project, they are listed in this tab. 
You can filter the favorites in order to see favorites from all projects. See also chapter 
Filtering favorites (Page 144).
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See also
Basic information about favorites (Page 142)

7.7.3 "Favorites" tab

Call
"View > Favorites" menu

Structure

① Toolbar
② List of Favorites

Toolbar 
The toolbar has the following options:

Option Description
"Current" Only displays the favorites of the currently open project.
"All" Displays the favorites of all projects.

The toolbar has the following buttons:

Icon Description
Deletes the selected Favorites.

Updates the list with the Favorites

See also
Working with favorites (Page 142)
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7.7.4 Creating favorites

Requirements
● See also chapter Requirements for COMOS operation (Page 127).

● The "Favorites" tab is open. See also chapter Opening the "Favorites" tab (Page 142).

● You have experience of working with the user interface. See also chapter "Favorites" tab 
(Page 143).

Procedure
Drag&drop the desired object from the structure area of the Navigator to the "Favorites" tab.

Result
● The object is added to the favorites list.

● The same commands and, therefore, the same actions are available in the favorites context 
menu as in the structure area. Examples: "New", "Properties"

● You can navigate to the relevant object in the structure area. See also chapter Navigating 
to favorites (Page 145).

See also
Basic information about favorites (Page 142)

7.7.5 Filtering favorites

Requirements
● See also chapter Requirements for COMOS operation (Page 127).

● The "Favorites" tab is open. See also chapter Opening the "Favorites" tab (Page 142).

● You have experience of working with the user interface. See also chapter "Favorites" tab 
(Page 143).

● You have already created favorites. See also chapter Creating favorites (Page 144).

Procedure
Activate one of the following options in the "Favorites" control group:

● Display favorites from the current project: 
"Current" option

● Display favorites from all projects in the open database: 
"All" option

Basic operation of the user interface
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See also
Basic information about favorites (Page 142)

7.7.6 Navigating to favorites

Requirements
● See also chapter Requirements for COMOS operation (Page 127).

● The "Favorites" tab is open. See also chapter Opening the "Favorites" tab (Page 142).

● You have experience of working with the user interface. See also chapter "Favorites" tab 
(Page 143).

● You have already created favorites. See also chapter Creating favorites (Page 144).

Procedure
Double-click on a favorite.

Result
In the working area, open the properties of the selected object. If the favorite comes from 
another project, the project will be switched.

See also
Basic information about favorites (Page 142)

Filtering favorites (Page 144)

7.7.7 Deleting favorites

Requirements
● See also chapter Requirements for COMOS operation (Page 127).

● The "Favorites" tab is open. See also chapter Opening the "Favorites" tab (Page 142).

● You have experience of working with the user interface. See also chapter "Favorites" tab 
(Page 143).

● You have already created favorites. See also chapter Creating favorites (Page 144).
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Procedure
1. Select the desired favorite(s).

2. Click the "Remove selected favorite(s)" button:

Result
The favorites are deleted. The objects in the structure area are retained.

See also
Basic information about favorites (Page 142)

Filtering favorites (Page 144)

7.8 Customizing the arrangement of frames and tabs

7.8.1 COMOS user interface frames

Principle
The COMOS user interface is divided into sections around which there are frames:

● The working area in which you can see the tabs for the main tools

● The Navigator area in which you can see the tabs with the object trees

● The detail area of the Navigator

Frame size
You can change the frame size of the areas See also chapter Changing the frame size 
(Page 147).

Number of frames and display
You can edit the number and arrangement of the frames using a move cursor: 

Basic operation of the user interface
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You can:

● Change the sequence of the tabs inside a frame
See also chapter Changing the tab order (Page 147).

● Open new frames
See also chapter Opening new frames (Page 148).

● Move tabs to other frames
See also chapter Moving tabs to other frames (Page 150).

7.8.2 Changing the frame size

Requirements
See also chapter Requirements for COMOS operation (Page 127).

Procedure
1. Move the mouse pointer to the area between two frames.

The mouse pointer will change to a double arrow: 

2. Press and hold down the left mouse button.

3. Move the arrow down, up, right, or left.

Result
The size of the frame and the frames adjacent to it change accordingly.

See also
COMOS user interface frames (Page 146)

7.8.3 Changing the tab order

Requirements
● See also chapter Requirements for COMOS operation (Page 127).

● An area containing multiple tabs is visible. Example: Multiple reports are open in the working 
area.

Basic operation of the user interface
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Changing the sequence of the tabs inside a frame
1. Drag&drop the header of a tab to the center of its own frame and press and hold down the 

left mouse button. The move cursor appears.

2. Drag the header to the center of the move cursor. 
The entire frame is highlighted: 

3. Release the mouse button.

Result
The tab is positioned on the right-hand side.

See also
COMOS user interface frames (Page 146)

7.8.4 Opening new frames

Requirements
See also chapter Requirements for COMOS operation (Page 127).
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Procedure
1. Using drag&drop, drag a tab header into the center of the frame in which you want to open 

a new frame, and hold down the left mouse button. The move cursor appears.

2. Drag the header to one of the arrows on the move cursor. The area of the frame in which 
the new subframe will be inserted is highlighted.
Example: 

3. Release the mouse button.

Result
● A new frame opens. 

● The tab is moved to the new frame. 

● The frames are arranged as defined by the arrow keys. 

● If the original frame only consisted of the tab that has now been moved, the frame will be 
closed.

Example:

Basic operation of the user interface
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See also
COMOS user interface frames (Page 146)

7.8.5 Moving tabs to other frames

Requirements
See also chapter Requirements for COMOS operation (Page 127).

Procedure
1. Using drag&drop, drag a tab header into the center of the frame to which you want to move 

the tab, and hold down the left mouse button. 
The move cursor appears.

2. Drag the header to the center of the move cursor. The entire frame is highlighted.

3. Release the mouse button.

Note

You cannot move the Navigator tabs into the frame of the working area. You cannot move the 
working area tabs into the structure tree.
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Result
The tab moves to the frame and is positioned on the right-hand side.

See also
COMOS user interface frames (Page 146)

7.9 Pinning or reusing user interfaces

Principle
Many user interfaces are configured so that, by default, you cannot open multiple user 
interfaces of the same type in parallel. 

Example: The properties of an engineering object are open. You open the properties of a 
second engineering object. The properties of the second object are loaded into the tab of the 
first object.

You can often pin the user interfaces so that they cannot be reused.

Requirements
See also chapter Requirements for COMOS operation (Page 127).

Pinning user interfaces
A user interface is open. It is reusable.

Click the "Reuse tab/window" button on the top right-hand edge of the user interface.

Note

In the case of tabs you will only see the button when the mouse pointer hovers over the header.

Note

The button serves for informational purposes on some interfaces.

The button turns yellow. No more instances are loaded in the user interface.

Canceling pinning 
A user interface is open. It has been pinned.

Click the "Leave tab/window open" button at the top right of the user interface:
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The button turns green. New instances can be loaded in the user interface.

7.10 Displaying nodes from the structure area of the Navigator in the detail 
area

Aim
You can display nodes or individual objects from the structure tree of the Navigator in the detail 
area of the Navigator on a separate tab. This provides a convenient way of creating engineering 
objects by using drag&drop with a base object, for example. See also chapter Creating 
engineering objects using drag&drop with a base object (Page 239).

Requirements
See also chapter Requirements for COMOS operation (Page 127).
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Procedure
1. In the Navigator, select a structure area tab.

2. Select a node on the tab.

3. If the detail area of the Navigator is not yet visible, drag&drop the node next to the tab 
headers in the structure area: 

If the detail area is already open, drag&drop the node next to the headers in the detail area: 

Basic operation of the user interface
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Result
● If the detail area was not open already, it opens. It contains a tab displaying the node and 

all objects subordinate to it.
If the detail area was open already, the tab is inserted on the right.

● The node continues to be displayed in the structure area of the Navigator. You have not 
moved the node; you have simply created an additional means of accessing it.

● If you switch projects, the tab remains open. You can obtain read access to the node via 
the tab.

See also
Closing tabs from the detail area of the Navigator (Page 155)

7.11 Opening tools of the detail area

Requirements
See also chapter Requirements for COMOS operation (Page 127).

Procedure
1. Open the "View" menu.

2. Select one of the following menu commands:

Command See also chapter ...
"Properties tree" Editing object properties in the properties tree 

(Page 279) 
"Status window" You can find more information on this topic in the 

"P&ID Operation" manual, keyword "Status win‐
dow display".

"Symbol and document preview" Displaying a preview of symbols and working 
areas (Page 141) 

"Window list" Closing tabs or switching between tabs using the 
window list (Page 156) 

"Favorites" Working with favorites (Page 142) 
"Static new menu" Creating multiple objects via the static new 

menu (Page 241) 

Result
The tool opens in the detail area of the Navigator.
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See also
Closing tabs from the detail area of the Navigator (Page 155)

Structure of the Navigator (Page 157)

7.12 Closing tabs from the detail area of the Navigator

Requirements
● See also chapter Requirements for COMOS operation (Page 127).

● A tab is open in the detail area of the Navigator.

Procedure
Select "Close tab" from the tab header context menu.

See also
Closing tabs in the working area (Page 155)

Opening tools of the detail area (Page 154)

Showing and hiding structure area tabs and the "Details" tab (Page 161)

Closing tabs or switching between tabs using the window list (Page 156)

7.13 Closing tabs in the working area

Requirements
● See also chapter Requirements for COMOS operation (Page 127).

● Multiple tabs are open in the working area.

Procedure
1. Open the context menu of a tab header.

2. Select one of the following commands:

– "Close tab"
Keyboard command: <Ctrl><F4>

– "Close other tabs"

– "Close all except the pinned tab"

– "Close all tabs"

Basic operation of the user interface
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See also
Closing tabs from the detail area of the Navigator (Page 155)

Closing tabs or switching between tabs using the window list (Page 156)

7.14 Closing tabs or switching between tabs using the window list

Requirements
● There are tabs open in the working area or the detail area.

● See also chapter Requirements for COMOS operation (Page 127).

Procedure
1. In the menu bar, select "View > Window list".

The Window list tab opens in the detail area. It contains a list of the tabs open in the working 
area and in the detail area of the Navigator. Not contained in the list:

– The "Details" tab

– Nodes from the structure area of the Navigator which are shown in the detail area

● To close tabs, select them in the window list. Select "Close" from the context menu.

● To change the visible tab, double-click on a tab in the window list. 
The following keyboard command applies to the active COMOS area: <Ctrl><Tab>

● To sort the entries in the tab, click on the desired column header.
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7.15 Setting up the Navigator

7.15.1 Structure of the Navigator

Overview

① Area for switching between projects and working layers
② Structure area
③ Detail area

Area for switching between projects and working layers
In the lists, you can see all the projects and working layers that are open in the current session.

See also chapter Switching between open projects (Page 188) and chapter Switching between 
open working layers (Page 194).

Basic operation of the user interface
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Structure area
In the structure area, you can see several tabs. Here, you can manage the project data in 
object trees:

Icon Tab Description

 

"Units" For unit engineering

"Locations" For location engineering

"Documents" Alternative means of access to the documents on the "Units" and 
"Locations" tabs

"Base objects" Access to the following objects:
● Read:

– The base objects of the base project
– The templates of the base project from the "Units" and 

"Locations" tabs
– For administrators: Standard tables for the base project and 

system project
● Write:

– Local base objects
– For administrators: Local standard tables

Which objects you see in the object tree depends on the following factors: See also chapter 
Access to objects (Page 53).

If you reduce the size of the Navigator horizontally, the captions of the tabs are automatically 
hidden: 

If you hover the mouse pointer over the header, the hidden text is displayed as a tooltip: 

Basic operation of the user interface
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Detail area 
The detail area can display the following tabs:

● A series of tools to support your work in the Navigator or in the working area, e.g. the 
"Favorites" and "Status window" tabs.
See also chapter Opening tools of the detail area (Page 154).

● Tabs which show nodes from the structure area of the Navigator in the detail area. See 
also chapter Displaying nodes from the structure area of the Navigator in the detail area 
(Page 152).

● The "Details" tab, which shows the substructure of the object currently selected in the 
structure area.

See also
Overview of the COMOS interface (Page 135)

Showing and hiding structure area tabs and the "Details" tab (Page 161)

Context menu in the Navigator (Page 165)

7.15.2 Sorting object trees in the Navigator

Default
By default, the object trees in the structure area and on the "Details" tab are arranged according 
to internal COMOS sorting: The object trees are sorted by object name. The names are sorted 
according to ASCII.

You can modify the sort.

Requirements
See also chapter Requirements for COMOS operation (Page 127).
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Procedure
1. Select the "Navigator settings" command in the context menu of the Navigator.

The "Navigator settings" window opens.

2. Activate one of the following options in the "General" control group:

Option Description
"Sort alphabetically" Activated: Lexical sorting on the basis of the character strings 

visible in the Navigator
The character strings are sorted in descending order as follows:
● Special characters
● Numbers, which are sorted in ascending order according to 

the first digit
Example: 0, 1, 10, 2, 21, 3

● Letters
Uppercase letters first, then lowercase letters, then multiple 
instances of a letter

The "Sort 'Folder' objects bottom up" option is deactivated auto‐
matically.

"Sort 'Folder" objects bottom up" Activated: Engineering objects with the "Folder" property are sor‐
ted bottom up. 
The "Sort alphabetically" option is deactivated automatically.

Note
Options disabled

If both options are deactivated, the default is used.

3. Confirm your entries.

7.15.3 Filtering object trees in the Navigator

Introduction
You can filter which objects you see in the structure area and on the "Details" tab in the 
Navigator or whether you see any at all.

Filter criteria:

● The class of engineering objects 

● The system type of the following objects:

– Connectors

– Attributes and tabs

– Documents

– DocObj objects

Basic operation of the user interface
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Requirements
See also chapter Requirements for COMOS operation (Page 127).

Procedure
1. Select the "Navigator settings" command in the context menu of the Navigator.

The "Navigator settings" window opens. You are working in the "General" control group.

2. Activate one of the following options for the desired system types and classes of 
engineering objects:

– "Top"
The objects are displayed in the structure area of the Navigator. 

– "Bottom"
The objects are displayed in the "Details" tab. If the tab is deactivated, its contents are 
automatically displayed in the structure area.

– "Off"
The objects are not displayed.

3. Confirm your entries.

7.15.4 Showing and hiding structure area tabs and the "Details" tab

Requirements
See also chapter Requirements for COMOS operation (Page 127).

Procedure
1. Select the "Navigator settings" command in the context menu of the Navigator.

The "Navigator settings" window opens.

2. Activate or deactivate the options for the desired tabs in the "Tabs" control group.

Result
The tabs are shown or hidden. 

If you hide the "Details" tab, its contents are automatically displayed in the structure area.

See also
Sorting object trees in the Navigator (Page 159)

Filtering object trees in the Navigator (Page 160)

Basic operation of the user interface
7.15 Setting up the Navigator

Operation
Operating Manual, 03/2017 V10.2.1, A5E37082875-AB 161



7.15.5 Activating "Directly edit new objects"

Requirements
See also chapter Requirements for COMOS operation (Page 127).

Procedure
1. Select the "Navigator settings" command in the context menu of the Navigator. The 

"Navigator settings" window opens.

2. Activate or deactivate the "Directly edit new objects" option in the "General" control group.

3. Confirm your entries.

Result
● Option activated: If you create a new object in the Navigator by drag&dropping a base object 

or via the context menu, its properties are opened directly in the working area for further 
editing.

● Option deactivated: You must open the properties manually.

See also
Calling context menus (Page 169)

7.15.6 Showing placing information

Principle
Objects which are placed on interactive reports can be labeled in the Navigator.

Requirements
See also chapter Requirements for COMOS operation (Page 127).

Procedure
Select the "View > Icon with placing information" command in the menu bar and then select a 
subcommand:

● "... > For all placed objects"

● "... > For all placed elements"
The setting only applies for elements with the "Element" class. See also chapter 
Elements (Page 75).
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Result
An additional icon is added to the object icons:

Hiding placing information
Select the "View > Icon with placing information > Hide" command in the menu bar.

7.15.7 Navigator text

Content
The Navigator text is the character string that you see in the Navigator. It consists of the 
following elements:

● Label description
● For engineering objects with unit reference, location reference, etc.: Label 

description >> reference
If the object has several references: Label description >> ...

Note
Name instead of label

If an object does not have a label, the name is used.

Alternatively, administrators can calculate the Navigator text using a script block. You can find 
additional information on this topic in the "Administration" manual, keyword "NavigatorText 
(Object)".

Display of the references
Whether the references are displayed and with which delimiters depends on the project 
properties. You can find additional information on this topic in the "Administration" manual, 
keywords "Naming convention for base objects" and "Engineering data: Administration of the 
display".

Text coloring

Status display, history display, and working layer 
display ...

Description

Activated The icon and text of the objects are colored ac‐
cording to their status.

Deactivated The text of locked objects is colored gray.

Basic operation of the user interface
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See also
Setting general references (Page 257)

7.15.8 Reference of the "Navigator settings" window

Call
Shortcut menu of the Navigator, "Navigator settings" command

"Display" control group

Option Description
"Top" Display in the structure area of the Navigator. Can be adjusted 

for each object listed.
"Bottom" Display in the "Detail" tab. Can be adjusted for each object listed.
"Off" No display. Can be adjusted for each object listed.

See also chapter Filtering object trees in the Navigator (Page 160).

"General" control group

Option Description
"Directly edit new objects" See also chapter Activating "Directly edit new objects" 

(Page 162). 
"Save automatically" ● Activated: Objects are saved automatically.

● Deactivated: The objects are created. You must save them 
manually. The "Save changes" command is shown in the 
shortcut menu of the Navigator to enable you to do this. You 
can redelete the objects via "Ignore changes". 

"Sort alphabetically" See also chapter Sorting object trees in the Navigator (Page 159).
 "Sort Folder objects to top"

"Tabs" control group

Option/list Description
"Units" For showing and hiding the corresponding tabs.

See also chapter Showing and hiding structure area tabs and the 
"Details" tab (Page 161).

"Locations"
"Documents"
"Base data"
"Detail"

Basic operation of the user interface
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See also
Context menu in the Navigator (Page 165)

7.16 Context menu in the Navigator

Principle
Which commands you can call depends on the object for which you have called the context 
menu and which rights you have.

Important commands on the objects in the Navigator

Command Description / see also chapter ...
"Working layers/history > ..."
 
 "... > Recalculate the working layer 

display"
Recalculates the working layer display. 
Enabling and disabling the working layer display mode 
(Page 196)

 "... > Release-relevant" Excluding objects from release (Page 224)
 "... > Check in to current working 

layer"
Checks the object into the working layer.
Requirements: You have the "Write" object right for the 
selected object.

 "... > Accept collision" Identifying and resolving collisions (Page 223)
 "... > Undo deletion" Undoing the deletion of objects with the "soft delete" 

marker (Page 226)
 "... > Compare object" Comparing an object with the superordinate layer 

(Page 201)
 

 "... > Object history" Checking the object history (Page 208)
 "... > Object status" Displaying the working layer status and history status 

of an object (Page 201)
 "... > Remove soft-deleted objects 

in the released area"
Only in the released area
Objects with the "Soft delete" marking get the "Hard 
delete" marking.

 "... > Restore" Identifying and resolving collisions (Page 223)
Restoring data from superordinate layers (Page 225)
 

"Cut" Cut and move (Page 175) 
"Print" Only on documents

Printing documents (Page 312)
"Properties" Opening properties (Page 171)
"Paste" See "Copy" and "Cut".
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Command Description / see also chapter ...
"Copy" Simple copying in the Navigator without switching 

projects (Page 247)
Simple copying in the Navigator and switching 
projects (Page 248)
 

"Delete" Deleting (Page 180)
Deletion in working layers and in the released area 
(Page 38)

"Navigate" Navigating (Page 170) 
"New" Creating engineering objects via the context menu 

(Page 235)
"Rights"
 

Displaying user rights in a project (Page 190)

"Copy structure"
 

Basic knowledge on the "Copy structure" function 
(Page 123)

"Find"
 

Using Navigator search (Page 519)

"Paste link"
 

Creating links (Page 174)

"Move"
 

Cut and move (Page 175)

Important commands for the Navigator

Command Description / see also chapter ...
"Unload all dynamic icons" You can release GDI resources via this command. You can find ad‐

ditional information on this topic in the "Installation" manual, keyword 
"GDI resources".

"Working layer display" Enabling and disabling the working layer display mode (Page 196)
"Navigator settings" Reference of the "Navigator settings" window (Page 164) 
"History display" Activating and deactivating the history display (Page 205)
"Legend" Displaying legend of color settings (Page 197)
"Status display" Activating and deactivating the status display (Page 299) 

Managing object status (Page 292)

See also
Structure of the Navigator (Page 157)

Configuring the working layer display mode and the history display (Page 198)
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7.17 Saving settings of query-based result tables

Principle
User interfaces with result tables are often based on queries. In some user interfaces, you can 
permanently save the filter setting and sorting of the table; for example, in the "Open project" 
tab.

Requirements
● See also chapter Requirements for COMOS operation (Page 127).

● The result table is based on a query. 

● The user interface allows you to save the user settings.

Procedure
1. Select the "Settings > Save..." command in the context menu of a column header.

The "Save settings" window opens. See also chapter "Save settings" window (Page 591).

2. Confirm your entries.

Result
Your settings can be saved as user-specific settings or as group-specific settings. They are 
saved in the base data.

You can find additional information on this topic in the "Administration" manual, keyword 
"Administration of personal user settings (profile)".
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Basic operations for objects 8
8.1 Selecting objects

Requirements
See also chapter Requirements for COMOS operation (Page 127).

Selecting an individual object
1. Hover the mouse pointer over an object.

2. Then left-click.

Multiple selection (objects not located consecutively)
1. Select the first object.

2. Press and hold down the <Ctrl> key.

3. Select the remaining objects.

Multiple selection (objects located consecutively)
1. Select the first object in the series of consecutive objects.

2. Press and hold down the <Shift> key.

3. Select the last object in the series of consecutive objects.

Multiple selection is not available in all interfaces.

Result
The object or objects is/are highlighted. Highlighting varies according to user interface.

You can edit the object; for example, you can open its properties or call context menu 
commands.

8.2 Calling context menus

Requirements
See also chapter Requirements for COMOS operation (Page 127).
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Calling the context menu for an object
1. Select the object.

2. Then right-click.

Example: Engineering object

Calling the context menu for a user interface
1. Make sure that nothing is selected in the user interface.

2. Hover the mouse pointer over an empty space in the user interface.

3. Then right-click.

Example: Navigator

Calling the context menu for a user interface element
1. Hover the mouse pointer over the user interface element.

2. Then right-click.

Example: Header of a tab, column header in a query

Context menu commands
The menu commands you see depend on the following factors:

● The context object: Is the context object an object, a user interface, or a user interface 
element?

● For objects: For which user interface have you called the context menu?

8.3 Navigating

Principle
When you navigate to an object, it is selected in the structure area of the Navigator. 

Application 1
You are working in a user interface that provides you with access to objects (in a query or a 
report, for example). You want to navigate to an object that is displayed in the user interface.

Application 2
You want to navigate from one object to a connected object. 

Basic operations for objects
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Examples:

Object Connected objects
Engineering object ● Assigned base object

● Interactive report on which the engineering object is placed
● Counterpart connectors of its connectors
● Object which is referenced in the general data of the properties of the 

engineering object
Examples: Location reference or implementation reference

Attribute ● Inheritance source of the attribute in the base data
● An attribute linked to the attribute, from the engineering data
● For reference attributes: The referenced object

Connector Counterpart connector

Requirements
See also chapter Structure of the Navigator (Page 157).

Via the context menu
1. Select the object.

2. Application 1: Select the "Navigate > Object" command from the context menu.
Application 2: Select another of the commands listed under "Navigate" in the context menu. 
The commands you see depend on which object is selected.

Via the "Navigate" button
The "Navigate" button appears in the toolbar for the properties of objects:

Many reference fields also have this button.

Clicking on the button opens the Navigate context menu. Select a command as described 
above.

Result
Dependent upon which command you have selected, the corresponding object is selected in 
the Navigator.

8.4 Opening properties

Requirements
See also chapter Requirements for COMOS operation (Page 127).
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Procedure
1. Select the object.

2. Select the "Properties" command in the context menu.

Alternative procedure
● Double-click the object. 

● Use drag&drop to move the object from the Navigator into the working area, next to the 
header of the "COMOS" tab, or next to the headers of tabs which are already open: 

This process does not work for the following objects:

● Documents

● Queries, bulk processing, and other objects with the "Class" property of "Action"

Result
The properties of the object are opened:

● In the working area on a tab (for engineering objects, base objects, documents, and queries, 
for example)

● In a separate window (for connectors and attributes, for example)
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8.5 Opening documents

Requirements
See also chapter Requirements for COMOS operation (Page 127).

Alternative 1: Context menu
1. Select the document.

2. Select the "Open" command in the context menu.

Alternative 2: Double-click
● Double-click the document.

● Use drag&drop to move the document from the Navigator into the working area, next to the 
header of the "COMOS" tab, or next to the headers of tabs which are already open:

Alternative 3: Open read only
1. Select the document.

2. Select the "Open read only" command in the context menu.

Note
Advantage when working with working layers 

The document is not checked into the working layer.

Alternative 4: Document preview
You can display a preview of an interactive report rather than opening the report. See also 
chapter Displaying a preview of symbols and working areas (Page 141).

Result 
● COMOS-specific documents

– Reports are opened in the working area on a tab.

– If redlining comments exist for a revision, they are automatically displayed.
The redlining comments can be hidden. See chapter Viewing revision files and Redlining 
files (Page 333).

● For external documents, the relevant application is started in a separate window. 

See also
Automatic referencing of documents (Page 84)
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8.6 Creating links

Aim
You want to access an object (engineering object, document etc.) in a different node of the 
structure tree to the one under which the object is located.

Requirements
See also chapter Requirements for COMOS operation (Page 127).

Procedure
1. Select an object in the Navigator.

2. Select the "Copy" command in the context menu. 

3. Select a different object in the Navigator.

4. From the context menu select the "Paste link" command.

Result
The link is pasted in. An additional icon is added to the link - a blue rectangle at the left under 
the icon:

Special case documents: A document cannot be created directly as a link in some cases. The 
following message is displayed:

"General functions" window, "Location link is already accepted from owner" or "Unit link is 
already accepted from owner" message.

This is the case when the document originals are located in the "Unit" tab or the "Locations" 
tab, and reference documents were automatically created in the "Locations" tab. In this case, 
proceed as follows:

● Select the document to which you want to create a link.

● Select the "Navigate > Reference documents > Plant documentation" command in the 
context menu.
The "Documents" tab opens and the reference document is selected.

● Select the "Copy" command in the context menu of the reference document.

● Select the object under which the link is to be inserted.

● Select the "Paste" command in the context menu.
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Automatically generated reference documents
If the project works with a document group system, a reference document is automatically 
created when a document is created in the "Documents" tab. See also chapter Automatic 
referencing of documents (Page 84).

These reference documents are not the same as the links described above.

Delete
When you delete the link, the object is retained. When you delete the object, all links are deleted 
along with it.

8.7 Cut and move

Aim
You want to move an object (engineering object, document etc.) under a new owner in the 
structure tree.

Requirements
See also chapter Requirements for COMOS operation (Page 127).

Procedure
1. Select an object in the Navigator.

2. Select the "Copy" command in the context menu.
Alternatively: Select the "Cut" command.

– If you end COMOS without pasting, the cut object is deleted.

– When you use the "Cut" function twice in a row without the intermediate step "Paste", 
the object that was cut first will be deleted.

3. Select the new owner in the Navigator.

4. In the context menu, select the "Move" command or the "Paste" command.

Result
If the project structure allows the object to be pasted under the new owner, the object and its 
subobjects are moved.

8.8 Setting references
For setting general references of engineering objects, see chapter Setting general 
references (Page 257).

Basic operations for objects
8.8 Setting references

Operation
Operating Manual, 03/2017 V10.2.1, A5E37082875-AB 175



Possible methods 
● Drag&drop of an object from the Navigator to a reference field

● Via the "..." button that appears next to many reference fields

Requirements
● See also chapter Requirements for COMOS operation (Page 127).

● A user interface with a reference field is open. 
Example: Properties of an engineering object > "General" tab > "Base object" reference 
field

Via drag&drop from within the Navigator
1. Select the desired object in the Navigator.

2. Drag&drop the object to the reference field.
Many fields that support drag&drop are marked with the following symbol: 

Basic operations for objects
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Via the "..." button
1. Click the "..." button next to the reference field.

A window in which you select the object to be referenced opens. The layout and content 
of the window vary:

– Optional: Options you set to define whether the object tree displayed comes from the 
current engineering object, the base project or the system project.

– Tree with the objects that are available for selection
You usually see the nodes of all Navigator tabs. Sometimes, the tree is filtered. In these 
cases you only see the nodes of a specific tab or just one specific start node. 

– Optional: Field that reads out the data of the object selected in the object tree
To check your selection

– Standard buttons for confirming and canceling

Example: 

2. Select the required project if applicable.

3. Select the required object in the object tree.

4. Confirm your entries.

Result
The reference is saved. You can navigate between the two objects via the context menu. See 
also chapter Navigating (Page 170). 

Basic operations for objects
8.8 Setting references

Operation
Operating Manual, 03/2017 V10.2.1, A5E37082875-AB 177



Deleting references
Click on the "Remove reference" button next to the reference field.

Note

There are certain references which you can replace with other references but cannot delete. 
Example: The base object reference of engineering objects

Buttons next to reference fields
Reference fields can feature the following buttons:

Icon Tooltip Description
"Set pointer" Opens a window in which you select the object to be refer‐

enced.
"Remove pointer" Deletes the reference.

"Navigate, Properties" Opens a context menu via which you can navigate to the 
referenced object or its properties.

8.9 Accepting or rejecting entries with standard buttons

Frequently used buttons
Many interfaces have the following standard buttons: 

Button Description
"OK" Saves your entries and closes the interface.
"Cancel" Closes the interface without saving your entries.
"Apply" Saves your entries. The interface remains open.

Some interfaces use the following button for saving:  

8.10 Copying, cutting, and pasting texts
You usually copy texts between lists or edit fields. You can also paste character strings saved 
in "Reference" or "Data" type attributes into edit fields.

Basic operations for objects
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Requirements
See also chapter Requirements for COMOS operation (Page 127).

Procedure
1. Open a user interface (the properties of an object, for example). See also chapter Opening 

properties (Page 171).

2. Press and hold down the left mouse button to select the value of a control element.

3. To copy or cut values, select the corresponding command from the context menu.

Note
Availability

The commands for cutting are not available in all user interfaces or for all control elements. 

4. Open the user interface where you wish to paste the value.

5. Right-click in the control element where you wish to paste the value. You can usually paste 
the values to the following control elements:

– Edit fields

– Editable lists

6. Select a Paste command from the context menu.

Result
The text is pasted from the clipboard.

8.11 Checking objects

Requirements
● See also chapter Requirements for COMOS operation (Page 127).

● There are objects in the database which do not conform to COMOS basic principles. 
Example: The link from a document to an external file has been lost.

Basic operations for objects
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Procedure
1. Opening the "object test"

– A number greater than zero is entered in the "Check" field: 
Open the context menu for the "Check" field in the status bar. Select the "Object test" 
command.

– Alternative: Select the "Extra > Check > Object test" command from the menu bar.

2. The "Object test" tab opens. You see an information list with objects which do not conform 
to COMOS rules. 
If objects from other working layers are referenced, these objects are represented with a 
black cross.

3. Select an entry.

4. The context menu offers you the following options:

– Open the properties of the object to correct the error

– Navigate to the object

– Delete the entry from the error list

You can find additional information on this topic in the "Administration" manual, keyword "Using 
an object test".

8.12 Saving objects that have not been saved

Principle
Some user actions require all objects to be saved. You can see how many objects have been 
changed and not yet saved under "Save: <number>" in the COMOS status bar. 

Requirements
● See also chapter Requirements for COMOS operation (Page 127).

● There are unsaved objects.

Procedure
1. Move the mouse to "Save: <number>" in the status bar.

2. Select "Save" from the context menu.

8.13 Deleting

Aim
You want to delete an object (engineering object, document etc.).

Basic operations for objects
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General rules for deleting
● When you delete an object, the objects located underneath it are deleted recursively along 

with it. 

● Whether objects are hard deleted or soft deleted depends on the following factors:

– Are you working in a working layer or in the released area?

– Are history management and history monitoring activated?

See also chapter Deletion in working layers and in the released area (Page 38).

● If you delete a link to an object or document, the original remains. If you delete the original, 
all links are also deleted - regardless of where they are located. 
See also chapter Creating links (Page 174).

● If the database is configured accordingly, deleting a document also deletes its reference 
document. See also chapter Automatic referencing of documents (Page 84).

● If the deleted document was a report, the engineering objects placed on the report or 
evaluated by the report are retained. Graphical objects placed in the report will be deleted 
along with the report. 

Requirements
● See also chapter Requirements for COMOS operation (Page 127).

● You have the "Delete" object right for the objects being deleted.

● The object is not locked.

Note
Deleting by administrators

Administrators can delete locked objects.

Deleting in the Navigator
1. Select the required object. 

2. Select "Delete" from the context menu. Alternatively, press the <Del> key.
COMOS detects recursively which objects are deleted.

Basic operations for objects
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3. Confirm the security prompt.
COMOS analyzes the objects. If there are reasons to prevent the deletion, or if the data is 
made inconsistent by deleting, the "Delete check list" window opens. 

There is an entry for every object which has a cancel message or a warning message. You 
can navigate to the object using the context menu.
If there are cancel messages, the entire deletion process is canceled.

4. If there are only warning messages, you can delete despite the warnings. Click the "Yes" 
button in the window to do this.

Note
No single selection of objects

If you have selected single entries in the "Delete check list" window, all objects will still be 
deleted.

5. To cancel the entire deletion process, click the "No" button.

You can find additional information on the checklist when deleting in the "Administration" 
manual, keyword "Checklist when deleting".

Deleting in interactive reports
See also chapter Deleting in interactive reports (Page 436).

Deleting in queries 
See also chapter Deleting in queries (Page 483).

Delete via script
You can find additional information on this topic in the "COMOS Platform Administration" 
manual, keyword "Deleting without the COMOS interface".

Basic operations for objects
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Restoring COMOS objects
● Objects were transparent

If objects have been soft deleted, you can undo the deletion. See also chapter Undoing the 
deletion of objects with the "soft delete" marker (Page 226). 

● Objects were recreated in the working layer
Newly created and then deleted objects do not appear in the working layer display.
You can find additional information on this topic in the "Administration" manual, keyword 
"Using the "Restore COMOS objects" query".

See also
Locking engineering objects (Page 256)

Locking documents (Page 353)

Basic operations for objects
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Using projects 9
9.1 Options when working with projects

Aside from editing the project data, you also have the following options:

● Opening a project or the released area of a project (Page 185)

● Switching between open projects (Page 188)

● Displaying user rights in a project (Page 190)

● Switching the project language (Page 139)

● Closing projects (Page 190)

● Opening the working layers of a project (Page 193)

See also
Managing projects (Page 191)

Using working layers (Page 193)

Basic knowledge on projects (Page 29)

9.2 Opening a project or the released area of a project

Requirements
● A database is open. See also chapter Opening or switching between databases 

(Page 129).

● See also chapter Requirements for COMOS operation (Page 127).
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Procedure
1. Select the "File > Open project" command in the menu bar.

The "Open project" tab opens. See also chapter "Open project" tab (Page 186).
The table is based on a query. The query functions are available in the context menu of 
the column headers; for example, filtering and sorting functions. You can save these 
settings in your user settings. See also chapter Saving settings of query-based result 
tables (Page 167).

2. At the top of the tab, select a project type from the following options:

Option Project type
"Engineering" Engineering projects
"Base objects" Base projects
"Templates" Template projects
"System" System projects

You will see all projects of the selected project type for which you have read rights.

3. Select a project.
If the project has working layers, you will see them toward the bottom of the tab. See also 
chapter Opening the working layers of a project (Page 193).

4. Click "Open".

Result
The project is loaded. If you are working with working layers, the released area of the project 
will be loaded. The project's objects and documents are displayed in the Navigator.

See also
Options when working with projects (Page 185)

Switching between open projects (Page 188)

Basic knowledge on projects (Page 29)

9.3 "Open project" tab

Call
"File > Open project" menu

Using projects
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Structure

1 Options for selecting a project type
2 Project table

For project selection and project management
3 Area for working layers

For working layer selection and working layer management
4 Default buttons

Project table
You will see the projects of the project type selected above for which you have read rights.

The table is based on a query. The query functions are available in the shortcut menu of the 
column headers

Area for selecting working layers
The area has the following tabs:

● "Total overview" tab

● "List" tab

Using projects
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Working layers are displayed on the tabs in the following cases: 

● A working layer has already been created for the selected project.

● The system node for managing the working layers exists in the base project.
You can find additional information on this topic in the "Administration" manual, keyword 
"Administration of working layers".

"Total overview" tab
You see a tree with the working layers of the project selected in the project table. 

"List" tab
Only the working layers of a specific level are displayed. Your administrator can configure the 
database so that only specific levels or even only specific working layers of a level are available 
for selection in this view. You can find additional information on this topic in the "Administration" 
manual, keyword "The levels concept of base objects of working layers".

Structure: 

● "Select layer" list:
Filter. Only the working layers of this level are displayed.

● Table with all working layers of the layer selected in the "Select layer" list
The table is based on a query. The query functions are available in the shortcut menu of 
the column headers.

See also
Opening the working layers of a project (Page 193)

Opening a project or the released area of a project (Page 185)

Context menu of the "Open project" tab (Page 191)

Overview of the working layer management (Page 214)

Saving settings of query-based result tables (Page 167)

Adjusting the Object Browser in simple run mode (Page 462)

9.4 Switching between open projects

Requirements
At least two projects are open in the current COMOS session. See also chapter Opening a 
project or the released area of a project (Page 185).

Using projects
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Procedure
1. In the Navigator, click on the arrow button in the area for switching projects.

You will see a list of all projects currently open.

2. Select a project.

Result
You get information about the currently edited but still unsaved objects of the previously opened 
project. You can choose to save or discard the information.

Finally, all other unsaved information still in the background is saved.

The data from the new project is shown in the Navigator:

● If only the released area is open, the data for the released area is shown.

● If a working layer of the project is open, the working layer data is shown.

● If multiple working layers of the project are open, the data for the working layer last used 
is shown.

Note
Clipboard content when switching projects

The content of the clipboard is retained when you switch projects. See also chapter Simple 
copying in the Navigator and switching projects (Page 248).

See also
Options when working with projects (Page 185)

Switching between open working layers (Page 194)

Requirements for COMOS operation (Page 127)

Basic knowledge on projects (Page 29)

Using projects
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9.5 Displaying user rights in a project

Requirements
See also chapter Requirements for COMOS operation (Page 127).

Procedure
The following ways of displaying your user rights are available:

● Per project:
To check which global rights you have in the project, select the project root in the Navigator 
and select the "Rights" command from the context menu.

● Per object:
To check which rights you have for a particular object, select the object in the Navigator 
and press <Ctrl+A>.

Result
Your rights are displayed in a window. See also chapter Window for the project user rights 
(Page 592).

You can find additional information on this topic in the "Administration" manual, keyword 
"Administration of users and rights".

See also
Options when working with projects (Page 185)

Basic knowledge on projects (Page 29)

9.6 Closing projects

Requirements
At least two projects are open. See also chapter Opening a project or the released area of a 
project (Page 185).

Procedure
Select the "File > Close project" command in the menu bar.

Result
Unsaved objects are saved and the project is closed. The project you were previously logged 
into is now shown. If you were working in a working layer in the project, the working layer is 
shown.

Using projects
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See also
Options when working with projects (Page 185)

Requirements for COMOS operation (Page 127)

Basic knowledge on projects (Page 29)

9.7 Managing projects

Responsibility
Administrators manage projects.

Options
Project management comprises the following tasks:

● Creating projects

● Importing projects

● Exporting projects

● Copying projects

● Deleting projects

● Configuring project properties

You can find additional information on this topic in the "Administration" manual, keyword 
"Administration of projects and working layers".

See also
Options when working with projects (Page 185)

9.8 Context menu of the "Open project" tab

Principle
Which commands you can call depends on your rights.

Using projects
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Important commands 

Command
 

Description

"Recalculate the working layer display 
mode"

See also chapter Enabling and disabling the working layer display mode 
(Page 196).

"Properties" See also chapter Properties of a working layer (Page 230).
"Properties > ..."  
 "... > View" You can find additional information on this topic in the "Administration" manual, 

keyword "Checking or editing project properties". "... > Edit"
"Paste" See "Copy".
"Remove working layer write protection (af‐
ter release)"

See also chapter Releasing a working layer (Page 228).

"Export" You can find additional information on this topic in the "Administration" manual, 
keyword "Administration of projects and working layers".

"Release to the released area" See also chapter Releasing a working layer (Page 228).
"Release to the superordinate layer"
"Import"
 

You can find additional information on this topic in the "Administration" manual, 
keyword "Administration of projects and working layers".

"Copy" ● Working layers: Copying working layers (Page 216)
● Projects: You can find additional information on this topic in the 

"Administration" manual, keyword "Copying a project".
"Delete" ● Working layers: Deleting working layers (Page 217)

● Projects: You can find additional information on this topic in the 
"Administration" manual, keyword "Delete project".

"New > ..."  
 "... > Project" Projects: You can find additional information on this topic in the "Administra‐

tion" manual, keyword "Creating a new project".
 

 "... > Default <Name of the project 
structure>"

 "... > Working layer" See also chapter Creating working layers (Page 215).
"Open" Opens the selected working layer. See also chapter Opening the working lay‐

ers of a project (Page 193).
"Rights" See also chapter Displaying user rights in a project (Page 190).
"Copy text To copy texts via the clipboard

 "Paste text

See also
"Open project" tab (Page 186)
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Using working layers 10
10.1 Information about basic knowledge

The knowledge from chapter Basic knowledge on working layers (Page 32) is presumed.

10.2 Opening the working layers of a project

Requirements
● A project from the open database has working layers.

● You have experience of working with the relevant user interface. See also chapter "Open 
project" tab (Page 186).

● See also chapter Requirements for COMOS operation (Page 127).

Procedure
1. Open the "Open project" tab as described in chapter Opening a project or the released area 

of a project (Page 185). Select a project which has working layers. 
In the lower half of the "Open project" tab, you will see the "Total overview" tab. This contains 
a tree showing the working layers of the project.

2. Select the desired working layer.

3. Click "Open".

Note
"Total overview" tab: Color code of the working layers 

Black node: Double-click the desired working layer. If you have read rights, the working layer 
opens. If you do not have read rights, a message window opens. The database must be opened 
again. See also Opening or switching between databases (Page 129).

Gray node: You have read rights for the subordinate node.

Result
The working layer is opened. The following objects and documents are displayed in the 
Navigator:

● All those checked into the working layer or those created there

● All those which shine through from the superordinate layers
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See also
Creating working layers (Page 215)

Working in working layers (Page 195)

Switching between open working layers (Page 194)

10.3 Switching between open working layers

Requirements
● At least two working layers from the same project are open in the current COMOS session. 

See also chapter Opening the working layers of a project (Page 193).

● See also chapter Requirements for COMOS operation (Page 127).

Procedure
1. In the Navigator, click on the arrow button in the area for switching working layers.

You will see a list of all the working layers open in the current session for the currently 
loaded project.

2. Select a working layer.

Result
Unsaved objects are saved.

The objects and documents from the new working layer are displayed in the Navigator:

● All those checked into the working layer or those created there

● All those which shine through from superordinate layers

Using working layers
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See also
Working in working layers (Page 195)

Switching between open projects (Page 188)

10.4 Closing working layers

Requirements
At least two working layers are open. See also chapter Opening the working layers of a 
project (Page 193).

Procedure
Select the "File > Close working layer" command in the menu bar.

Result
Unsaved objects are saved and the working layer is closed. The working layer you were 
previously logged into is now shown. If you were working in the released area in the project, 
the released area is shown.

10.5 Working in working layers

Editing project data in the working layer
The same tools and options are available as when you are working without working layers or 
directly in the released area. The working layer technique only becomes relevant when working 
layers are released.

Before release, the working version of the working layer is checked. Depending on how roles 
are distributed in your project, either you or an administrator will check the working version.

● Opening the working layers of a project (Page 193)

● Switching between open working layers (Page 194)

● Basic knowledge on working layers (Page 32)

Using working layers
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Checking the working version
● Display of the object status relevant to the working layers:

– Via the working layer display mode
See chapter Enabling and disabling the working layer display mode (Page 196).

– Via the detailed object status
See chapter Displaying the working layer status and history status of an object 
(Page 201).

● Comparison of objects with those from the superordinate layer
See chapter Comparing an object with the superordinate layer (Page 201).

● Checking work progress within the working layer via the project history
See chapter Checking the object history (Page 208).

● Optional: Checking history
See chapter Working with the project history and the object history (Page 203).

Adapting the working version for the release
Preparing release of working layers (Page 217)

See also
Overview of the working layer management (Page 214)

10.6 Check by means of working layer display mode and history display

10.6.1 Enabling and disabling the working layer display mode

Requirements
● A working layer is open.

See chapter Opening the working layers of a project (Page 193).

● You are familiar with the fundamentals of working layer display mode.
See chapter Working layer display mode (Page 34).

Enabling the working layer display mode
Select the "Working layer display mode" command from the shortcut menu of the Navigator.
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Result
The working layer display mode is enabled:

● Write actions are locked.

● The objects are marked in color according to their working layer status in the following user 
interfaces:

– Navigator

– Queries

– Interactive reports

See also chapter Displaying legend of color settings (Page 197).
For the representation of standard tables on the "Base objects" tab, also see chapter 
Working layer display mode (Page 34).

● Deleted objects ("Soft deleted") are displayed in the working layer or in superordinate 
working layers.

– In the Navigator

– On the reports

See chapter Deletion in working layers and in the released area (Page 38).

● Attributes marked "Soft deleted" are visible in the properties of base objects.

Disabling the working layer display mode
Select the "Working layer display mode" command again from the shortcut menu of the 
Navigator.

See also
Working in working layers (Page 195)

Displaying the working layer status and history status of an object (Page 201)

Configuring the working layer display mode and the history display (Page 198)

10.6.2 Displaying legend of color settings

Requirements
● A working layer is open. See also chapter Opening the working layers of a project 

(Page 193).

● The status display of the engineering objects is deactivated. If the status display is activated, 
you see the legend of the active status type in the "Legend" window.

● See also chapter Requirements for COMOS operation (Page 127).
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Procedure
Select the "Legend" command from the context menu of the Navigator.

Result
The "Legend" window opens. It contains the legend for the working layer display mode and 
the history display. See also chapter "Legend" window (Page 590).

Here you can change the color settings. See also chapter Configuring the working layer display 
mode and the history display (Page 198).

See also
Working layer display mode (Page 34)

Fundamentals of history display (Page 44)

Enabling and disabling the working layer display mode (Page 196)

10.6.3 Configuring the working layer display mode and the history display

10.6.3.1 Setting colors for the object status of the working layer display mode and the history 
display

Requirements
● A working layer is open. See also chapter Opening the working layers of a project 

(Page 193).

● You have experience of working with the relevant user interface. See also chapter "Legend" 
window (Page 590).

Procedure
1. Select the "Legend" command from the context menu of the Navigator.

The "Legend" window opens.

2. Click on the "..." button next to the corresponding status value in the "Color settings" tab.

3. Select the desired color.
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4. Click the "OK" button.
The configured color is displayed in the "Color" column in the "Legend" window.

5. Select one of the following options:

– To save the color setting only for the current session, click on the "Close" button.

– To save the color setting as a personal setting, click on the following button:

See also chapter "Save settings" window (Page 591).

See also
Working layer display mode (Page 34)

Enabling and disabling the working layer display mode (Page 196)

10.6.3.2 Setting the colors for working layer levels

Requirements
● A working layer is open. See also chapter Opening the working layers of a project 

(Page 193).

● You have experience of working with the relevant user interface. See also chapter "Legend" 
window (Page 590).

Procedure
1. Select the "Legend" command from the context menu of the Navigator.

The "Legend" window opens.

2. Select the "Working layer color settings" tab.

3. Click the "..." button of the desired level.

4. Select the desired color.

5. Click the "OK" button.
The configured color is displayed in the "Color" column in the "Legend" window.

6. Select one of the following options:

– To save the color setting only for the current session, click on the "Close" button.

– To save the color setting as a personal setting, click on the following button:

See also "Save settings" window (Page 591).
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Result
When you open a working layer of this level, the background of the Navigator will be marked 
in color accordingly. This means you can tell immediately which working layer level you are 
working in.

See also
Working layer display mode (Page 34)

Enabling and disabling the working layer display mode (Page 196)

Overview of the working layer management (Page 214)

10.6.3.3 Resetting the working layer display mode and the history display to the default colors

Requirements
● A working layer is open. See also chapter Opening the working layers of a project 

(Page 193).

● You have experience of working with the relevant user interface. See also chapter "Legend" 
window (Page 590).

Procedure
1. Select the "Legend" command from the context menu of the Navigator.

The "Legend" window opens.

2. Select one of the following options:

– If you want to reset the colors of the status values, click on the "Color settings" tab.

– If you want to reset the colors of the working layers, click on the "Working layer color 
settings" tab.

3. Click the following button: 

See also
Working layer display mode (Page 34)

Enabling and disabling the working layer display mode (Page 196)

Overview of the working layer management (Page 214)
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10.6.4 Displaying the working layer status and history status of an object

Aim
It is possible to obtain a more detailed view of the working layer status of an object than the 
working layer display mode provides.

Requirements
A working layer is open.

Procedure
1. In the Navigator, select the object for which you want to view the working layer status.

2. Click the "Extra > Working layers/history > Object status" command in the menu bar.
The "Object status (Working layers/history)" tab opens. See also chapter "Object status 
(Working layers/history)" tab (Page 211).

3. To change the evaluated object, drag another object from the Navigator onto the name of 
the object currently being evaluated on the tab.

Result
The working layer status and the history status of the object are displayed in detail.

See also
Status in the working layer display mode and history display (Page 37)

Working in working layers (Page 195)

Opening the working layers of a project (Page 193)

10.6.5 Comparing an object with the superordinate layer

Requirements
● A working layer is open.

● You have experience of working with the relevant user interface. See also chapter "Object 
comparison" window for working layers (Page 202).
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Procedure
1. In the Navigator, select an object which is available in the superordinate layer.

2. Select the "Working layers/history > Compare object" command from the context menu.
The "Object comparison" window opens.
In the window, the selected object is compared with the object in the next superordinate 
working layer. The differences are displayed.

3. To change the evaluated object, drag another object from the Navigator onto the name of 
the object currently being evaluated on the tab.

See also
Working in working layers (Page 195)

Opening the working layers of a project (Page 193)

10.6.6 "Object comparison" window for working layers

Call
See also chapter Comparing an object with the superordinate layer (Page 201).
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Structure

① The name or label of the object 
Name and ID of the current working layer

② Path name of the object and name of the comparison working layer
③ Table of the differences
④ Standard button

The table is based on a query. The query functions are available in the context menu of the 
column headers.

10.6.7 Working with the project history and the object history

10.6.7.1 Setting the comparison time for the history display

Requirements
● A project, working layer, or the released area is open. See also chapter Opening a project 

or the released area of a project (Page 185) and chapter Opening the working layers of a 
project (Page 193).

● You have experience of working with the relevant user interface. See also chapter "Working 
layer/History management" tab (Page 212).
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Procedure
1. Click the "Extra > Working layers/history > Management" command in the menu bar.

The "Working layer/History management" tab opens. 

2. Select the "History" tab.

3. Choose one of the following comparison times:

– Time of release into the released area
Select the row of a release in the table. Then enable the "Changes since index" option.
The time of this release serves as the comparison time. The index number of the entry 
selected in the table is displayed in the field alongside.

– The time at which an object was changed
Drag&drop an object from the Navigator into the field next to the "Changes since" option.
The option is activated. The time the object was last changed is used as the comparison 
time.

– None
Select the "None" option.

Changes to these control elements are applied automatically for the current session and 
remain valid until the next change of working layer.

Result
The status is calculated for history display. When the history display is activated, the objects 
are marked in color according to their status.

● Comparison time set:

Color Description
Black No history entries
Blue Object has history entries and was created before the comparison time.
Green Object has history entries and was created after the comparison time.
Red Object has history entries and is soft deleted

● No comparison time set:

Color Description
Black No history entries 
Light blue History entries in the substructure
Blue History entries available
Red Object has history entries and is soft deleted

See also
Working in working layers (Page 195)

Fundamentals of history display (Page 44)

Activating and deactivating the history display (Page 205)
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10.6.7.2 Activating and deactivating the history display

Requirements
● A project, working layer, or the released area is open. 

See chapter Opening a project or the released area of a project (Page 185) and chapter 
Opening the working layers of a project (Page 193).

● You are familiar with the fundamentals of history display.
Fundamentals of history display (Page 44)

● The comparison time for the history display is set.
See chapter Setting the comparison time for the history display (Page 203).

Activating the history display
Select the "History display" command from the shortcut menu of the Navigator.

Result
The history display is activated:

● Write actions are locked.

● The objects are marked in color according to their history status in the following user 
interfaces:

– "Object history" window

– Navigator

– Queries

– Interactive reports

Note
Calculation time

The time required to calculate the history display is determined by the number of entries in 
the object histories.

● Attributes marked "Soft deleted" are visible in the properties of base objects.

See also chapter Displaying legend of color settings (Page 197).

Deactivating the history display
Select the "History display" command from the shortcut menu of the Navigator again.
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10.6.7.3 Open the "Object history" window

Requirement
● You are familiar with the fundamentals of project history and object history.

– The history management is activated.

– The object history is or was activated. 

See chapter Fundamentals of project history and object history (Page 42).

● A project, working layer, or the released area is open.
See chapter Opening a project or the released area of a project (Page 185) and chapter 
Opening the working layers of a project (Page 193).

Procedure
The "Object history" window logs entries of the project history (history management at the 
project) and entries of the object history in the narrow sense (history monitoring at the object). 
A new history entry is created for each change saved.

1. Select the desired object in the Navigator.

Note
Attributes and connectors are separate objects

According to the COMOS object model, attributes and connectors are independent objects. 
To check the history of attribute values or connection information, select the corresponding 
attribute object or connector object.

2. Select the "Working layers/history > Object history" command from the shortcut menu.
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Structure

① Toolbar for filtering the table
② History management and history monitoring status
③ Table of the history entries

The table is based on a query. The query functions are available in the shortcut menu of the 
column headers.

Buttons on the toolbar

Icon Tooltip Description
Containment of the working layer

"All underlying layers" You can see the history entries for changes in the 
current layer and in all superordinate layers.

"Current shift" History entries relating to changes are displayed in 
the current layer only.

Containment of the properties
"Only different values" You can also see history entries with changed val‐

ues.
"All values" You can also see history entries with identical val‐

ues.

Evaluation of the object history
See chapter Checking the object history (Page 208).
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10.6.7.4 Checking the object history

Requirements
● You are familiar with the fundamentals of project history and object history.

See chapter Fundamentals of project history and object history (Page 42).

● The "Object history" window is open. 
See chapter Open the "Object history" window (Page 206).

Common scope of project history and object history
● System types

The object history is available for the following system types:

– Device

– CDevice

If you have activated the object history for a device, the history entries are created for the 
lower-level attribute objects and connector objects.

Note
Attributes and connectors are separate objects

According to the COMOS object model, attributes and connectors are independent objects. 
To check the history of attribute values or connection information, select the corresponding 
attribute object or connector object and open the "Object history" window.

● The activation and deactivation of the object history is logged.

● The activation and deactivation of the "History management" option remains unlogged.

● This does not include inherited data
Example 1:
An engineering object subject to history monitoring inherits its description from the base 
object. The description is changed at the base object and the change is applied to the 
engineering object and its history entries. Because the engineering object still inherits the 
description, no new history entry is created for the engineering object.
Example 2:
Change of the Navigator text (the calculated text displayed in the Navigator) does not cause 
a history entry at the engineering object, unless the cause of the change itself causes a 
history entry.

Using working layers
10.6 Check by means of working layer display mode and history display

Operation
208 Operating Manual, 03/2017 V10.2.1, A5E37082875-AB



Scope of history monitoring at the object
History monitoring at an object monitors nodes instead of single objects. If you activate the 
function at a node, it is automatically recursively activated for all subnodes owned by that node. 
Whether or not an object is the owner of another object is controlled by the COMOS object 
model, and not by the display in the Navigator. As a consequence, links and references are 
not included.

● Example: 

Object B is placed under history monitoring. There is a link to object C under object B. 
Object C is not monitored, as object B is not the owner of object C. 

Interaction of the object history with the release of working layers
The following applies in conjunction with the release of working layers:

● Working layer is deleted with release: The entries in the object history are deleted as well

● Working layer is retained with release:

– Objects are retained: The entries in the object history are retained.
If you check an object in again, the interruption is displayed and the object history is 
continued from the time of the check-in.

– Objects are deleted when released (working layer is retained as an empty container): 
The entries in the object history are retained and frozen. The working layer must be 
opened in this case to check the history entries. The objects shine through from the 
owner layer, and you can open the object history at these objects that shine through.
In the "Object history" window, you can choose if you only want to see the frozen history 
entries of the current working layer or the transparent history entries of the owner 
working layer as well.

● The following applies to all the cases above: New history entries are only created in the 
target working layer by the release if the object history is also activated there.
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Structure of a history entry

Display Column Description
Always "Working layer" Working layer in which the object has been changed.

The object history contains both the history entries from the current layer as well as 
the history entries of this object from the superordinate working layers. You can change 
this behavior using the "All subordinate layers" / "Current layer" button.
The entries in the object history are initially sorted according to the "Working layer" 
column, then the column "At/From".

"History monitor‐
ing"

This records if the history monitoring was activated or deactivated at the object.

"On/From" Period in which a value was valid. The time stamp displayed depends on the setting 
in the "History behavior of the inherited objects" list.  You can find additional information 
on this topic in the "Administration" manual, keyword "Managing project history (history 
management)".
There are the following special features:
● First line for a newly created object

The "On/From" column remains empty. The "To" column contains the date on which 
the object was created. The working layer in which the object was created is 
specified in the "Miscellaneous" column.

● Last row
The last row is not filled in:
– The "To" column is empty. 
– A provisional text appears in the "Miscellaneous" column.
– If an additional history entry is added, the "To" and "Miscellaneous" columns 

for the last row are updated. A new last row is then created. 

"To"

"User" User who changed the object
[Additional col‐
umns as re‐
quired]

[Additional col‐
umns]

More columns are displayed, depending on the property that has changed. The new 
value (OwnValue) of this property is visible in an additionally displayed column. 
You can identify the columns that are additionally available as follows:
● "Object history" window, menu bar: "All values" button
Other columns are also available depending on the system type for which you open 
the "Object history" window.  

Always "Miscellaneous" If a property for which no additional column is available was changed, the entry "Internal 
data was changed" appears in this column.

"Remark" The "Remark" column contains two items of information:
● When a working layer is released to the released area: "History entry" window, 

"Description" field.
You can find additional information on this topic in the "Administration" manual, 
keyword "Administration of object history (history management)".

● If the "Remark" option has been set in the project. In this case, the "Remark" column 
always has the same text.

The "Description" field for the release into the released area overwrites any existing 
text from the "Remark" option.
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10.6.8 "Object status (Working layers/history)" tab

Call
"Extra > Working layers/history > Object status" menu, "Object status" tab

Structure

① Button with navigation commands to the evaluated object
② Name of the evaluated object and the working layer
③ Drag&drop area for changing the evaluated object
④ Area containing status information

Status information
The area for the status information is structured as follows:

● Description of status information

● Color code

● Value (read)

Status information about assigned objects
The following objects count as assigned objects:

● Connectors

● Attributes
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● Symbols

● Extension objects
Extension objects contain settings of the interfaces and internal COMOS information. The 
various object types have extension objects with different contents. Example: The extension 
object of queries is described in the "Administration" manual, keyword "Creating queries: 
Inheritance of the archive (XObj)".

"Layer relevance" status information
An object is layer-relevant if it can be checked into a working layer. If an object is not layer-
relevant, it is not included when a working layer is released and no history entry is created.

See also
Displaying the working layer status and history status of an object (Page 201)

"Extras > Working layers/history" menu (Page 572)

10.6.9 "Working layer/History management" tab

Call
"Extra > Working layers/history > Management" menu

Structure
The tab has two sub-tabs:

● "History"

● "Working layers"
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"History" tab
This is where you manage the project history. The tab has the following structure: 

① Table
Each row in the table represents a release in the released area.

② "Set comparison time for history display" control group
For setting the comparison time for the history display. See also chapter Setting the comparison 
time for the history display (Page 203).

"Working layers" tab
Content and function as in the "Open project > Total overview" tab. See also chapter "Open 
project" tab (Page 186).

See also
"Extras > Working layers/history" menu (Page 572)
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10.7 Overview of the working layer management

Requirements
● An engineering project exists in the database.

See chapter Managing projects (Page 191).

● You have a good knowledge of the associated user interface.
See chapter "Open project" tab (Page 186).

● You are familiar with the interaction between released area and working layers.
See chapter Interaction between released area and working layers (Page 33).

Responsibility
Depending on how roles are distributed in your project, either you or an administrator will 
manage the working layers. 

Working layer management can be restricted: Via rights administration and the configuration 
of the base objects of the working layer levels

You can find additional information on this topic in the "Administration" manual, keyword 
"Rights administration for working layers".

Tasks relating to working layer management
Working layer management comprises the following tasks:

Task See also chapter ...
Creating working layers Creating working layers (Page 215) 
Copying working layers Copying working layers (Page 216) 
Deleting working layers Deleting working layers (Page 217) 
Releasing working layers Preparing release of working layers (Page 217)

New release technology for MS SQL servers 
(Page 227)
Releasing a working layer (Page 228) 

Exporting and importing working layers You can find additional information on this topic in 
the "Administration" manual, keywords "Importing 
a working layer" and "Exporting a working layer".

See also
Working in working layers (Page 195)

Basic knowledge on working layers (Page 32)
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10.8 Creating working layers

Requirements
● You are familiar with the overview of the working layer management.

See chapter Overview of the working layer management (Page 214).

Procedure
1. Select the "File > Open project" command in the menu bar.

2. Select the desired engineering project in the "Open project" tab.
You are working on the "Total overview" tab. 

3. You have the following options:

– To create a working layer directly underneath the released area of the project, select 
the project root.

– To create a subordinate working layer under an existing working layer, select the working 
layer.

4. Select the "New > Working layer" command in the context menu.
The properties of the new working layer open.
See chapter Properties of a working layer (Page 230).

5. Enter values in the "Name" and "Description" fields.

6. Determine the base working layer. Proceed as follows:

– Click the "..." button next to the "Base working layer" field.
The "Select base working layer" window opens. You will see the working layers of the 
base project which is linked to the engineering project. 

– Select a working layer.
If the released area of the engineering project has a link to a base working layer, you 
can only select the base working layers which are located under it.

Note
No base working layer set

If you do not set a base working layer, the working layer is linked to the released area of 
the base project.

7. Confirm your entries.

Result
The working layer is created. When you open it, you see all objects from the superordinate 
layers. The objects are not checked in, they shine through.

Depending on whether you have set a base working layer, the "Navigate > Base object in base 
project" command either navigates to the released area of the project or to the linked base 
working layer.
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See also
Opening the working layers of a project (Page 193)

10.9 Copying working layers

Requirements
● You are familiar with the overview of the working layer management.

See chapter Overview of the working layer management (Page 214).

● A project from the open database has a working layer.
See chapter Creating working layers (Page 215).

Procedure
1. Select the "File > Open project" command in the menu bar.

2. Select the desired project in the "Open project" tab.
The working layers are listed in the "Total overview" tab.

3. Select a working layer (source working layer). 

4. Select the "Copy" command in the context menu.

5. Select a working layer which is parallel to the source working layer.

6. Select the "Paste" command from the context menu.

Result
● A copy of the source working layer is pasted. It contains the objects checked into and newly 

created in the source working layer. The data from the superordinate layers shines through. 

● External documents which are saved externally in the file system are not copied. They exist 
independently of working layers.

See also
"Open project" tab (Page 186)
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10.10 Deleting working layers

Note
Possible data loss

In the following cases, data is lost due to a working layer being deleted:
● The working layer has not yet been released.
● The working layer has subordinate layers which have not yet been released.

Requirements
● You are familiar with the overview of the working layer management.

See chapter Overview of the working layer management (Page 214).

● A project from the open database has working layers.
See chapter Creating working layers (Page 215).

Procedure
1. Select the "File > Open project" command in the menu bar.

2. Select the desired project in the "Open project" tab.
The working layers are listed in the "Total overview" tab.

3. Select one or more working layers. 

4. Select "Delete" from the context menu.

Result
The working layer and its subordinate layers are deleted. If there are still users working in the 
working layers, they are not deleted. A warning message with a list of active users opens.

See also
"Open project" tab (Page 186)

10.11 Preparing release of working layers

10.11.1 Overview for preparation of release

Requirements
● You are familiar with the fundamentals of working layers.

See chapter Basic knowledge on working layers (Page 32).
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Release preparation 
Before release, the working version of the working layer is checked. Depending on how roles 
are distributed in your project, either you or an administrator will check the working version.

The following functions enable you to check the working version:

● The working layer has been checked.
See chapter Check by means of working layer display mode and history display 
(Page 196).

● Performing release checks
See chapter Performing release check by means of Release manager (Page 218).

● Resolving collisions
See chapter Identifying and resolving collisions (Page 223).

● Excluding objects for release
See chapter Excluding objects from release (Page 224).

● Restoring data from superordinate layers
See chapter Restoring data from superordinate layers (Page 225).

● Restoring objects marked "Soft deleted"
See chapter Undoing the deletion of objects with the "soft delete" marker (Page 226).

10.11.2 Performing release check by means of Release manager

Requirements
● You are familiar with the overview of the working layer management.

See chapter Overview of the working layer management (Page 214).

Aim
In the Release manager, you can check and correct the state of a working layer prior to release. 
When a working layer is released, COMOS checks whether the data in the working layer 
violates the release rules. A working layer cannot be released if this is the case. 

You can also search for collisions in the Release manager. A check for collisions is not carried 
out when a working layer is released. Collisions do not prevent a working layer from being 
released.

Requirements
● A working layer is open. See also chapter Opening the working layers of a project 

(Page 193).

● You are familiar with the administration.
The Release manager uses the check settings that were defined in the base data for the 
release of a working layer of this level. You can find additional information on this topic in 
the "Administration" manual, keyword "Using the base object to control rights".
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Procedure
1. Click the "Working layers/history > Release manager" command in the menu bar.

The "Release manager" tab opens.

2. Make the settings for the check.
For a definition of when a document is considered locked, see chapter "Release manager" 
tab (Page 220).

3. Click the "Start" button.
The release check is carried out. Violations of the check settings are displayed in the events 
tables of the areas for documents and objects.
Types of violation:

– Locked documents
See also chapter "Release manager" tab (Page 220).

– Open revisions

– Incorrect names or labels

– Multiple placed objects
Finds objects that are not permitted to be placed more than once but have been placed 
once each in working layers from parallel branches.

– Collisions

The release can go ahead if there are no violations. See also chapter Releasing a working 
layer (Page 228).

Removing violations
1. Select a violation from the table.

2. Locked documents
To release documents, they must be closed by the user beforehand in the working layer 
that is the target of the release.

3. Open revision:

– To close an open revision: Select the "Revision > Created by", "... > Checked by", and 
"... > Released by" commands from the context menu.

Note
Forcing revision

One reason for an open revision is that the document has already been revisioned in 
parallel or superordinate working layers. It has a revision lock. See also chapter Unit 
revisions and project revisions (Page 110).

You can force the revisioning of the open revision via the context commands. The 
revision with the same index number from the other layer is reset to a * revision. The 
other layer cannot be released as long as this * revision exists.

– To delete an open revision: Select the "Delete 'open' revisions" command from the 
context menu.
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4. Incorrect names or labels: 
Select the "Correct name/label" command from the context menu.

5. Collision: 
Select the "Working layers/history > Restore" or "... > Accept collisions" command from the 
context menu. See also chapter Identifying and resolving collisions (Page 223).

See also
Working in working layers (Page 195)

10.11.3 "Release manager" tab

Call
"Extra > Working layers/history > Release manager" menu
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Structure

① Button to start the release check
② Settings for the release check of documents 
③ Result list with faulty documents
④ Settings for the release check of objects
⑤ Result list with faulty objects

Settings for the release check of documents
The default setting is taken from the CDevice of the working layer under "@99 > A70".

cDB: "@System > @D > WOLevels"
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"Check documents" control group:

Option Description
"For missing unit revisions" Can only be activated if the project is configured so that project 

revisions and unit revisions are possible. See also chapter Unit 
revisions and project revisions (Page 110). You can find additional 
information on this topic in the "Administration" manual, keyword 
"Automatic referencing of documents".
Activated: The release manager lists the documents which con‐
tain project revisions but no unit revisions, or * unit revisions only.
Deactivated: The release manager does not list the documents. 
Check for unit revisions manually. 

"For document version collisions" Only for DVM documents
Activated: Checks whether there are collisions between DVM 
document versions.

"For 'open' revisions" Activated: The release manager lists all documents with open re‐
visions. It does not check whether a * revision would be produced 
the next time the documents are evaluated.

"To 'locked' documents" Default: Activated
Displays locked documents. Documents are considered locked 
in the following case:
● The document exists in the working layer that is the target of 

the release (owner of the working layer to be released)
● The document was edited in the working layer to be released.
● The document is open in the working layer that is the target 

of the release.
Locked documents prevent the release. To release documents, 
they must be closed by the user beforehand in the working layer 
that is the target of the release.

"Revisions are 'open', if" control group:

Option Description
"They are not yet released" Use these options to determine when revisions count as being 

open.
 

"They are not created ('PDF file at 
first step')"
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Settings for the release check of objects
"Check objects" control group:

Option Description
"Duplicated names/labels" Activated: The Release manager lists objects with duplicated 

names or labels. With the context menu of the listed objects you 
can change the names and labels so that the names of the objects 
are unique. Duplicated names or labels of attributes and connec‐
tors are also taken into consideration.

"Collisions" Activated: The Release manager lists objects affected by colli‐
sions.

"Multiple placed objects" Activated: The Release manager lists objects that have been 
placed more than once.

See also
Performing release check by means of Release manager (Page 218)

"Extras > Working layers/history" menu (Page 572)

10.11.4 Identifying and resolving collisions

Identifying collisions
You have the following options: 

● Via the Release manager. See also chapter Performing release check by means of Release 
manager (Page 218).

● Via the working layer display mode. 

The following section describes the method using the working layer display mode. 

Requirements
● An object from a superordinate working layer has been checked in and changed in a 

subordinate layer. The object has then been changed in the superordinate layer. See also 
chapter Collisions (Page 36).

● The subordinate layer is opened.

● The working layer display mode is activated. See also chapter Enabling and disabling the 
working layer display mode (Page 196).
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Procedure
1. In the Navigator, select the object at which the collision occurred.

2. You have the following options:

– Keep information from subordinate layer:
Select the "Working layers/history > Accept collisions" command from the context menu.
The command is only available if there are no collisions in the secondary nodes of the 
object.

Note
Release overwrites data of the superordinate layer

If you call this command and then release the working layer, the data on the 
superordinate layer is overwritten. 

If you call the command in working layers on the first working layer level and release 
the working layer, the data of the released area is overwritten on release.

– Restore information from superordinate layer:
Select the "Working layers/history > Restore > Single" command from the context menu.

Result
● Keep information from subordinate layer: The data of the subordinate layer is retained on 

release.

● Restore information from superordinate layer: The object is deleted in the subordinate layer 
(hard delete). The object from the superordinate layer shines through again.

See also
Working in working layers (Page 195)

Restoring data from superordinate layers (Page 225)

Opening the working layers of a project (Page 193)

10.11.5 Excluding objects from release

Requirements
A working layer is open.

Procedure
1. Select an object in the Navigator.

2. Select the "Working layers/history > Release-relevant" command from the context menu.
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Result
● The object and all subordinate objects are not released when the working layer is released. 

The icon receives an additional symbol: 

● If the working layer is deleted after the release, these objects are lost.

● You can reactivate release relevance at any time.

Restore release relevance
Select the "Working layers/history > Release-relevant" command in the object's context menu 
again.

See also
Working in working layers (Page 195)

Context-dependent additional icons (Page 588)

Opening the working layers of a project (Page 193)

10.11.6 Restoring data from superordinate layers

Aim
If you have edited an object from a superordinate layer in a subordinate layer, you can undo 
these changes.

Requirements
● A working layer is open. See also chapter Opening the working layers of a project 

(Page 193).

● An object from the superordinate layer has been edited in the working layer.

● The working layer display mode is activated. See also chapter Enabling and disabling the 
working layer display mode (Page 196).
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Procedure
1. Select the object in the Navigator.

2. You have the following options:

– Select the "Working layers/history > Restore > Single" command from the context menu.
The object is deleted from the working layer (hard delete). The object from the 
superordinate layer shines through again.

– Select the "Working layers/history > Restore > Recursive" command from the context 
menu.
The object and all subordinate objects are deleted from the working layer. The objects 
from the superordinate layer shine through again.

Resolving collisions
You can also resolve collisions using the "Working layers/history > Restore" command. See 
also chapter Identifying and resolving collisions (Page 223).

See also
Undoing the deletion of objects with the "soft delete" marker (Page 226)

10.11.7 Undoing the deletion of objects with the "soft delete" marker

Requirements
● If you are working with working layers:

– A working layer is open. See also chapter Opening the working layers of a project 
(Page 193).

– An object from the superordinate layer has been deleted in the working layer.

● If history monitoring is active:

– A working layer, the released area, or the project is open. See also chapters Opening 
the working layers of a project (Page 193) and Opening a project or the released area 
of a project (Page 185).

– An object has been deleted.

Procedure
1. Activate the working layer display mode or the history display. See also chapters Enabling 

and disabling the working layer display mode (Page 196) and Activating and deactivating 
the history display (Page 205).

2. Select the object in the Navigator.

3. Select the "Working layers/history > Undo deletion" command in the context menu.

4. Deactivate the working layer display mode or the history display.
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See also
Deletion in working layers and in the released area (Page 38)

Restoring data from superordinate layers (Page 225)

10.12 New release technology for MS SQL servers

Requirements
● You are familiar with the overview of the working layer management.

See chapter Overview of the working layer management (Page 214).

Release technology depending on server type
As of COMOS 10.2.1, two different release technologies are used:

● Use of MS SQL server
New release technology:

– Faster release

– Shifting the workload to the server

– More flexibility for the object history

● Use of Oracle or MS Access
The old release technology of COMOS 10.2 is still used without changes.

Note
Server-based release locks the COMOS access

SQL Servers have an own performance management. Each SQL Server will switch over to a 
different state in which the tables are blocked completely when data are saved at a different 
moment.

The release of a very small working layer is processed during operation of the SQL Server. 
The release of a larger working layer results in blocked tables at the SQL Server. Blocked 
tables mean that no COMOS Client can generate write accesses during this period. Each 
storing on a COMOS Client is deferred until the release of the working layer is completed and 
the SQL tables are released again. 

Reading accesses also become somewhat slower through the busy Server.
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Object history depending on the release technology
For information on the technical background of the object history, see the "Administration" 
manual, keyword "Administration of object history (history monitoring)".

● Old release technology

– Object history active at the object:
The object history remains active and the history entries are released.

– Object history inherited:
The prerequisite is that the object history is active consistently for the object and the 
owner of the object in the source working layer and the target working layer.
This also applies to an owner change: In this case, the object history must be active in 
the old and in the new owner.

● New release technology

– Object history active at the object:
The object history remains active and the history entries are released.

– Object history inherited:
During the release, the setting for the object history at the new owner is evaluated in 
the target working layer. If the new owner has an active object history (regardless of 
whether the object history is active at the target object itself or if it was inherited), the 
history entries are released.

Releasing a working layer
See chapter Releasing a working layer (Page 228).

10.13 Releasing a working layer

Note
Possible data loss

In the following cases, data is lost or overwritten when a subordinate working layer is released:
● Objects which originate from a superordinate layer or from the released area have been 

deleted in the working layer.
As a result of the release, the data is also deleted in the layer to which the data is released. 
See also chapter Deletion in working layers and in the released area (Page 38).

● Objects which originate from a superordinate layer or from the released area have been 
edited in the working layer.
The release overwrites the editing status of the layer receiving the released layer. 

Note
Note the time required for the release of a working layer

The larger a working area is, the more time it takes to release it.
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Requirements
● You have a basic knowledge of the release of working layers.

See section Release of working layers (Page 41).

● You are familiar with the overview of the working layer management. 
See chapter Overview of the working layer management (Page 214).

● A project from the open database has a working layer.
See chapter Creating working layers (Page 215).

● The working layer has been prepared for release.
See chapter Preparing release of working layers (Page 217).

● You are familiar with the new release technology for MS SQL servers.
See chapter New release technology for MS SQL servers (Page 227).

 Procedure
1. Select the "File > Open project" command in the menu bar.

2. Select the desired project in the "Open project" tab.
The working layers are listed in the "Total overview" tab.

3. Select a working layer.

4. Select the following command from the context menu:

– If you have selected a subordinate layer: "Release to the superior working layer"

– If you have selected a working layer directly under the released area: "Release to the 
released area"

5. To confirm the release, click on the "OK" button in the "Release working layer" window.

6. COMOS automatically saves all objects that are not saved yet without a confirmation 
prompt. The working layer is released.

7. The target working layer is opened.

Automatic release check
COMOS checks whether the data in the working layer conforms to the release rules.

Violations present:

● The release is canceled. An error message is displayed.
Example: There are documents preventing a release.
A document prevents a release when it is opened by a user. See also chapter Performing 
release check by means of Release manager (Page 218).

● You can identify and correct violations in the Release manager. 
See chapter Performing release check by means of Release manager (Page 218).
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No violations present:

● The objects of the working layer are released to the superordinate working layer or to the 
released area. 

● If history monitoring is active for objects: If required, a notification is displayed indicating 
that history entries have been created and written to the target working layer on release. 

● Depending on how the base object of the working layer level is configured, one of the 
following actions is performed:

– The released working layer is set to read-only.

Note
Remove write protection

You can remove the write protection. Select the "Remove working layer write protection 
(after release)" command in the context menu of the working layer.

– The released working layer and its objects are deleted.

– The objects of the released working layer are deleted.

Note
Application cases that cannot be ascertained

During a working layer release, documents are checked twice at the source and target for 
access conflicts or collisions:
● In the beginning by the release manager
● At the point in time when the document itself is being released.

During the release of large working layers, it is technically possible for a user in the target 
working layer to open a document in between these two points in time, briefly edit it, save it, 
and close it again. 

In this case, the change in the target working layer is discarded again by the release.

10.14 Properties of a working layer

Usage
See chapter Creating working layers (Page 215).

Call
"Open project > Total overview" tab > "New > Working layer" context menu of the project root 
or a working layer
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Structure

The window has the following control elements:

Field Description
"Name" ● Any

●  Must be unique
"Description" Any
"Base working layer" For linking the working layer with a working layer of the base project

If no base working layer is set, the working layer is linked to the 
released area of the base project.

"ID" An automatically assigned even number for identifying the working 
layer
The odd numbers are used for system-internal purposes. The range 
of numbers goes up to 32768. After this, COMOS searches for IDs 
which have become free (for example, due to deletions), beginning 
with 2. If you try to create a working layer and every ID from 2 to 
32,768 is occupied by a live layer, an error message is issued. 

If tabs have been prepared under the base object of the corresponding working layer level, 
you also see these tabs. You can find additional information on this topic in the "Administration" 
manual, keyword "Administration of working layers".
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Creating engineering objects 11
11.1 Creating objects from a project structure

See also chapters Structure engineering using project structures and labeling systems 
(Page 46) and Fundamentals of creating objects (Page 54).

Requirements
Your project works with project structures. See also chapter Basic knowledge on project links 
(Page 30).

Methods for creating objects 
When working with project structures you can choose between the following methods for 
creating objects:

Create engineering objects ... See also chapter ...
Via the area of the context menu dedicated to 
structure engineering using project structures
Knowledge of the project structure is not necessa‐
ry.

Selecting a project structure from the context 
menu (Page 235) 
Creating objects from a project structure via the 
context menu (Page 236) 

Via the static new menu
Knowledge of the project structure is not necessa‐
ry.

Creating objects in the static New menu 
(Page 243) 

By working in interactive reports Creating engineering objects when working in in‐
teractive reports (Page 245) 

Using drag&drop with a base object Creating engineering objects using drag&drop 
with a base object (Page 239) 

Using imports Creating engineering objects using imports 
(Page 246) 

By copying Copying engineering objects (Page 246) 

The method you choose will depend on various factors. The following methods are generally 
recommended depending on which group of engineering objects the object you wish to create 
belongs to: 

Group Method
Objects which structure the project Context menu
Objects with a managing or supporting function Context menu
Physical objects necessary for engineering and 
operation

Interactive reports

Logical objects necessary for engineering and op‐
eration

Context menu or interactive reports
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Operating Manual, 03/2017 V10.2.1, A5E37082875-AB 233



See also
Placing objects by inserting a template (Page 384)

Free structure engineering (Page 47)

11.2 Free creation of objects
See also chapters Free structure engineering (Page 47) and Fundamentals of creating 
objects (Page 54).

Aim
You have the following options:

● You want to create a general engineering object directly under the project root.

● You want to create a general engineering object within the project structure.

● You are working with an object from a project structure. The project structure does not 
restrict which objects can be created under the object.

Requirements
If you want to create a general engineering object within the project structure, the following 
applies: The project structure allows you to create objects freely in the current node of the 
object tree. 

Methods for creating objects
In the context of free engineering of the project structure, you can choose between the following 
methods:

Method of creating objects See also chapter ...
Via the area of the context menu dedicated to free 
structure engineering

Free creation of objects directly under the project 
root (Page 238) 
Creating general engineering objects (Page 238) 

Using drag&drop with a base object Creating engineering objects using drag&drop 
with a base object (Page 239) 

By working in interactive reports Creating engineering objects when working in in‐
teractive reports (Page 245) 

Using imports Creating engineering objects using imports 
(Page 246) 

By copying Copying engineering objects (Page 246) 
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See also
Placing objects by inserting a template (Page 384)

Structure engineering using project structures and labeling systems (Page 46)

Basic knowledge on project links (Page 30)

11.3 Creating engineering objects via the context menu

11.3.1 Selecting a project structure from the context menu

Requirements
● A project is open. See also chapter Opening a project or the released area of a project 

(Page 185) and chapter Opening the working layers of a project (Page 193).

● The project works with project structures. See also chapter Basic knowledge on project 
links (Page 30).

Procedure
1. Select the "Units" or "Locations" Navigator tab.

2. Select the project root in the Navigator.
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3. Select the "New" command from the context menu.
The sub-menu opens. The entries for the project structures are displayed in the bottom half 
of the context menu: 

4. Select a project structure.

Result
● The first object of the project structure is created under the project root.

● Under the new object, you can only create objects defined by the project structure. See 
also chapter Creating objects from a project structure (Page 233).
You can only create objects freely at the points defined by the project structure. See also 
chapter Free creation of objects (Page 234).

See also
Creating objects from a project structure via the context menu (Page 236)

11.3.2 Creating objects from a project structure via the context menu

Requirements
● A project is open. See also chapter Opening a project or the released area of a project 

(Page 185) and section Opening the working layers of a project (Page 193).

● In the "Units" or "Locations" tab, the first object of a project structure has been created on 
the level under the project root. See also chapter Selecting a project structure from the 
context menu (Page 235).
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Procedure
1. Select the "Units" or "Locations" Navigator tab.

2. Select the object of the project structure or an object already created under it.

3. Select the "New" command from the context menu.
The sub-menu opens. All objects which are permitted under this object according to the 
project structure are displayed in the bottom half of the context menu: 

Note
Creating objects freely

If the top half of the context menu contains the "New > General > New object" command, 
you can also engineer the project structure freely. See also chapter Free creation of 
objects (Page 234).

4. Select the required object.

Result
● The new object is created.

If its base object is configured accordingly, further objects are automatically created along 
with the object. See also chapter Fundamentals of creating objects (Page 54).

● Under the new object, you can only create objects defined by the project structure. You 
can only create objects freely at the points defined by the project structure. See also chapter 
Free creation of objects (Page 234).

See also
Creating objects from a project structure (Page 233)
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11.3.3 Free creation of objects directly under the project root

Requirements
A project is open. 

Procedure
1. Select the "Units" or "Locations" Navigator tab.

2. Select the project root in the object tree.

3. Select the "New > New unit" or "New > New location" command from the context menu.

Result
A general unit or location is created under the project root. 

You can create more engineering objects freely under the general unit or location. See also 
chapter Free creation of objects (Page 234).

See also
General engineering objects (Page 80)

11.3.4 Creating general engineering objects
See also chapter General engineering objects (Page 80).

Requirements
● A project is open.

● The required owner is not the project root.

● If the future owner of the general object has been created with a project structure, the 
following applies: The project structure also permits general engineering objects under the 
owner. 
In this case, the node has the "New > General > New object" or "New > New object" context 
menu.

● You can only create a general position under a general unit.
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Procedure
1. In the Navigator, select the object under which you want to create the general object. To 

create a general position, select a general unit.

2. In the context menu of the object, select one of the following commands:

Command Result Availability
"New > General > New object" 
Or "New > New object"

A general object is created. Its 
properties are opened automat‐
ically.

On all Navigator tabs

"... > New unit" A general unit is created. "Units" tab
Not available under general po‐
sitions or general objects

"New > General > New position" A general position is created. "Units" tab
Only available under general 
units

"New > General > New location" A general location is created. "Locations" tab

3. Optional: Open the properties of the new object and edit them.

See also
Free creation of objects (Page 234)

Activating "Directly edit new objects" (Page 162)

Free creation of objects directly under the project root (Page 238)

11.4 Creating engineering objects using drag&drop with a base object

Advantage of this method of creating objects
This method allows you to create engineering objects that are not listed in the "New" context 
menu or in interactive reports, for example.

It can also be used in the following scenarios:

● You want to create engineering objects whose base objects are located under a common 
node.

● You want to create multiple engineering objects based on the same base object.

Requirements
● A project is open.

● You do not want to create the new object directly under the project root.
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● If the owner has been created via a project structure: The project structure allows you to 
create the required engineering object under the owner.
Restrictions: 

– Owners with the "New > General > New object" or "New > New object" context menu 
command: No restrictions

– Owners without the "New > General > New object" or "New > New object" context menu 
command: You can only create the engineering objects that are also available via the 
owner's "New" context menu.

● You have experience with the structure of the "Base objects" tab. If you have any questions, 
contact your administrator.

Procedure
1. Select the "Base objects" tab.

2. You have the following options:

– To create multiple engineering objects based on the same base object, select the 
required base object.

Note

Engineering objects can only be derived from base objects with red or green icons.

– To create multiple engineering objects located under a common base object node, select 
the common superordinate node.

3. Drag the selected base object to the detail area of the Navigator so that it is displayed on 
a separate tab. See also chapter Displaying nodes from the structure area of the Navigator 
in the detail area (Page 152).

4. To create engineering objects whose base objects are located under a common node, 
expand the node in the detail area so that you can see the required base objects.

5. Select the "Units" or "Locations" tab.

6. Open the object tree until you can see the required owner or owners.

7. You have the following options:

– To create multiple engineering objects based on the same base object, drag the base 
object and drop it onto the required owner (repeat this process as many times as 
necessary).

– To create multiple engineering objects whose base objects are located under a common 
node, drag the required base objects and drop them onto the required owner or owners 
one after the other.

Result
An engineering object derived from the base object is created. 

If the base object is configured accordingly, further objects are automatically created along 
with the engineering object. See also chapter Fundamentals of creating objects (Page 54).
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Alternative procedure
You can use the static new menu or the owner's "Elements" tab to simultaneously create 
multiple engineering objects which are based on the same base object. See also chapters 
Creating multiple objects via the static new menu (Page 241) and Deriving new elements from 
virtual elements (Page 274).

See also
Creating objects from a project structure (Page 233)

Free creation of objects (Page 234)

11.5 Creating multiple objects via the static new menu
You can create multiple objects simultaneously in the structure area of the Navigator, under 
one owner. The objects are based on the same base object. The objects are derived from the 
project structure.

Advantages compared with the context menu
● Faster, as multiple objects can be created simultaneously (bulk operation)

● Better overview of the alternatives via an object tree

● Edit name and description directly during creation (bulk operation)

Advantages compared with the "Elements" tab
● Edit name and description directly during creation

● Documents can be created

11.5.1 "Static new menu" tab

Call
"View > Static new menu" menu
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Structure

① Toolbar
② Area for configuring the new object

Fields:
● Quantity
● Name
● Description

③ Results list for all objects to be created
④ Execute button

Toolbar

Icon Tooltip Description
"Pin selected object" The selected object is fixed. 

See also chapter Pinning objects in the static new 
menu (Page 243).

"Navigate" Where you can navigate to depends on the object.
Navigation examples:
● "Object"
● "Base object"
● "Documents"
See also chapter Navigating from the static new menu 
to the pinned object (Page 244).
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See also
Creating multiple objects via the static new menu (Page 241)

11.5.2 Creating objects in the static New menu

Requirements
You have clicked on the "Static new menu" button on the toolbar:

The "Static new menu" tab is displayed in the detail area of the Navigator.

Procedure
1. Select one of the following options:

– To create new engineering objects, click on the "Units" tab in the Navigator.

– To create new locations, click on the "Locations" tab in the Navigator.

– To create new documents or document groups, click on the "Units" or "Locations" tab 
in the Navigator.

Note
Creating base objects

You need administrator rights to create new base objects. 

2. In the Navigator, select the object under which you want to create several identical objects.
The "Static new menu" tab displays all objects you can create under the select object.

3. Select the object you want to create in the "Static new menu" tab.

4. Enter the desired number of new objects in the "Quantity" field.

5. Click on the "Execute" button in the "Static new menu" tab.

Result
The specified number of new objects is created under the selected object in the structure area 
of the Navigator.

11.5.3 Pinning objects in the static new menu

Overview
You can pin the selected object in order to avoid inadvertently creating multiple objects with 
the wrong owner.
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Requirements
You have clicked on the "Static new menu" button on the toolbar:

The "Static new menu" tab is displayed in the detail area of the Navigator.

Procedure
1. In the structure area of the Navigator, on one of the tabs, select an object you would like 

to pin.

2. Click on the "Pin selected object" button on the "Static new menu" tab:

Result
The selected object is fixed. No other object can be selected.

Canceling pinning
To unpin an object, click on the "Pin selected object" button again:

See also
Navigating from the static new menu to the pinned object (Page 244)

11.5.4 Navigating from the static new menu to the pinned object

Requirements
An object is pinned on the "Static new menu" tab.

Procedure
Click on the "Navigate" button in the "Static new menu" tab. 

Where you can navigate to depends on the object.

Examples:

● Select the "Object" command to navigate to the object in the Navigator of the pinned object.

● Select the "Base object" command to navigate to the base object of the pinned object.
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Result
The object is selected in the Navigator.

See also
Pinning objects in the static new menu (Page 243)

Navigating (Page 170)

11.6 Creating engineering objects using the Elements tab
See chapter Managing elements (Page 271).

11.7 Creating engineering objects when working in interactive reports

Overview
If you are working in interactive reports, you can create engineering objects using one of the 
following actions:

● Placing objects via the symbol bar.
See also chapter Placing objects via the symbol bar (Page 381).

● Using drag&drop to place objects on the report from the Navigator.
See also chapter Placing base objects from the Navigator (Page 382).

● Creating a new object via the context menu of a symbol, thereby placing it.
See also chapter Placing objects via the context menu of a symbol (Page 383).

● Inserting a template onto the report.
See also chapter Placing objects by inserting a template (Page 384).

● Connecting objects via the connector tool.
See also chapter Connecting objects (Page 392).

● Copying objects.
See also chapter Copying/pasting and cutting in interactive reports (Page 433).

See also
Report template (Page 87)
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11.8 Creating engineering objects using imports

Overview
Objects can be created using imports:

● Via importing proprietary formats
E.g. Excel, Access, AutoCAD

● Via importing free formats
COMOS provides various XML interfaces for this purpose

You can find additional information on the different interfaces in the "Basic interfaces" manual.

Compliance with the project structure
When importing, COMOS checks whether the imported object is permitted under the new 
owner.

See also
Creating objects from a project structure (Page 233)

11.9 Copying engineering objects

11.9.1 Creating a copy of an engineering object from the properties

Requirements
● A project is open.

See also chapters Opening a project or the released area of a project (Page 185) and 
Opening the working layers of a project (Page 193).

● An engineering object has been created.
See also chapter Creating engineering objects (Page 233).

Procedure
1. Open the engineering object properties.

See also chapter Opening properties (Page 171).

2. Click on the "New; apply links and attributes" button on the toolbar:

Creating engineering objects
11.9 Copying engineering objects

Operation
246 Operating Manual, 03/2017 V10.2.1, A5E37082875-AB



Result
● A copy is created in the Navigator parallel to the engineering object.

● The copy uses the following references:

– Unit reference

– Location reference

– Reference attributes

● The following references are lost:

– Implementation reference

– Connected connectors

– Alias reference

● If linked attributes are available, the copy uses the link.

See also
Overview of the copy methods (Page 119)

Basic knowledge on copying objects (Page 120)

Creating objects from a project structure (Page 233)

Free creation of objects (Page 234)

11.9.2 Simple copying in the Navigator without switching projects

Requirements
● A project is open.

See also chapters Opening a project or the released area of a project (Page 185) and 
Opening the working layers of a project (Page 193).

● Objects are created.
See also chapter Creating engineering objects (Page 233). 

● The copies can be pasted below the desired target.

Procedure
1. Select the "Units" or "Locations" Navigator tab.

2. Select an object or multiple objects on the tab.

3. Select the "Copy" command in the context menu.
The objects and their subordinate objects are recursively added to the amount to be copied. 
The amount to be copied is saved in the clipboard.

4. Select the desired target in the Navigator.

5. Select the "Paste" command from the context menu.
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Result 
The copies are pasted below the target. The following object data is copied:

● All data which is not inherited

● Handling references:

Reference The referenced object is 
part of the amount to be 
copied

Result

Unit reference Yes The reference points to the copy.
No The reference points to the original.

Location reference Yes The reference points to the copy.
No The reference points to the original.

Reference attributes Yes The reference points to the copy.
No The reference points to the original.

Implementation referen‐
ces

Yes The reference points to the copy.
No The reference is lost.

Connectors Yes The reference points to the copy.
No The reference is lost.

● If a linked attribute was part of the amount to be copied, the copy uses the link.
If the link source was part of the amount to be copied, the copied linked attribute points to 
the copied link source.

● If documents are part of the amount to be copied, the guidelines from chapter Basic 
knowledge on copying documents and reports (Page 122) apply.

See also
Overview of the copy methods (Page 119)

Basic knowledge on copying objects (Page 120)

Creating objects from a project structure (Page 233)

Free creation of objects (Page 234)

11.9.3 Simple copying in the Navigator and switching projects

Usage
● This method of copying is not the same as the one which uses the "Cross-project copy" 

tool. The "Cross-project copy" tool works with traced objects and projections.
See also chapter Basic knowledge on the "Cross-project copy" function (Page 124).

● It is not possible to copy across databases.
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Requirements
● Source project and target project are open. See also chapters Opening a project or the 

released area of a project (Page 185) and Opening the working layers of a project 
(Page 193).

● Recommendation: Source project and target project have the same base project (see note).

● Objects have been created in the source project. See also chapter Creating engineering 
objects (Page 233).
Recommendation: They are not derived from local base objects (see note).

● The copies can be pasted below the desired target in the target project.

Note
Handling inherited properties

When you copy an engineering object, the inherited properties are not copied; they are 
read out from the base object at the copy. 

If you are working with local base objects, or the projects use different base projects and 
you copy across projects, there is a possibility that in the target project the base object does 
not exist, or there is one with the same name but different content. If this happens, data 
may be lost or altered when copied. 

See also chapter Fundamentals of the properties of engineering objects (Page 64).

Procedure
1. Switch to the source project.

See also chapter Switching between open projects (Page 188) 

2. Select the "Units" or "Locations" Navigator tab.

3. Select an object or multiple objects on the tab.

4. Select the "Copy" command in the context menu.
The objects and their subordinate objects are recursively added to the amount to be copied. 
The amount to be copied is saved in the clipboard.

5. Switch to the target project.
See also chapter Switching between open projects (Page 188).

6. Select the "Units" or "Locations" Navigator tab.

7. Select the desired target on the tab.

8. Select the "Paste" command from the context menu.
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Result 
● For the engineering objects, a search is performed in the target project and its linked base 

project for base objects with the same SystemUID as in the source project. If a base object 
is not found, the engineering objects derived from it are not pasted.

● The copies are pasted below the target. The following object data is copied:

– All data which is not inherited

– Handling references:

Reference The referenced object is 
part of the amount to be 
copied

Result

Unit reference Yes The reference points to the copy.
No The reference is lost.

Location reference Yes The reference points to the copy.
No The reference is lost.

Reference attributes Yes The reference points to the copy.
No The reference is lost.

Implementation referen‐
ces

Yes The reference points to the copy.
No The reference is lost.

Connectors Yes The reference points to the copy.
No The reference is lost.

If a linked attribute was part of the amount to be copied, then the copy only uses the link 
if the link source was also part of the amount to be copied. The copied linked attribute 
points to the copied link source. 

● The properties inherited from the base object are recalculated using the base object.
If documents are part of the amount to be copied, the guidelines from chapter Basic 
knowledge on copying documents and reports (Page 122) apply.

Alternative procedure
You can show the nodes with the objects you want to copy in the detail area of the Navigator. 
When you switch project, the nodes in the detail area remain open and you can copy the objects 
from there. See also chapter Displaying nodes from the structure area of the Navigator in the 
detail area (Page 152).

See also
Overview of the copy methods (Page 119)

Basic knowledge on copying objects (Page 120)

Creating objects from a project structure (Page 233)

Free creation of objects (Page 234)
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Using engineering objects 12
12.1 Overview of editing engineering objects

Introduction
The following section provides an overview of which tools are used to edit which properties of 
engineering objects. As the tools have different aims, the extent to which you can edit the 
properties will also vary:

Editing option Description
Complete All properties which can also be edited in the Prop‐

erties tab of the engineering object
Restricted A subset of the properties

The properties in the subset will depend on the 
user interface and sometimes on the object selec‐
ted in the user interface.

Configuration-dependent Which properties can be edited, if any, will depend 
on the configuration set by the administrator, on 
the user interface, and sometimes on the object 
selected in the user interface.

General data

User interface Editing option See also chapter ...
Properties tab Complete Editing general data (Page 253) 
Interactive report Configuration-dependent Editing object properties on the re‐

port bar (Page 400) 
Evaluating report Configuration-dependent Editing editable data (Page 448) 
Bulk processing Complete Editing object data via bulk process‐

ing (Page 490) 
Query Configuration-dependent Using queries and bulk processing 

(Page 455) 
Properties tree Restricted Editing object properties in the prop‐

erties tree (Page 279)
Navigator - -

General references

User interface Editing option See also chapter ...
Properties tab Complete Setting general references 

(Page 257)
Interactive report - -
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User interface Editing option See also chapter ...
Evaluating report - -
Bulk processing Configuration-dependent Editing object data via bulk process‐

ing (Page 490) 
Query Configuration-dependent Using queries and bulk processing 

(Page 455) 
Properties tree Restricted Editing object properties in the prop‐

erties tree (Page 279)
Navigator - -

Attributes

User interface Editing option See also chapter ...
Properties tab Complete Editing attributes (Page 260) 
Interactive report Configuration-dependent Editing placed attributes (Page 401) 

Editing object properties on the re‐
port bar (Page 400)

Evaluating report Configuration-dependent Editing editable data (Page 448) 
Bulk processing Configuration-dependent Editing object data via bulk process‐

ing (Page 490) 
Query Configuration-dependent Using queries and bulk processing 

(Page 455) 
Properties tree Complete Editing object properties in the prop‐

erties tree (Page 279)
Navigator - -

Connectors

User interface Editing option See also chapter ...
Properties tab Complete Purpose of the "Connectors" tab 

(Page 276) 
Interactive report Restricted Connecting objects (Page 392) 
Evaluating report - -
Bulk processing - -
Queries for connectors Restricted Connecting connectors via the query 

for connectors (Page 287) 
Properties tree - -
Navigator Restricted Connecting connectors in the Navi‐

gator (Page 286) 
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Elements

User interface Editing option See also chapter ...
Properties tab Complete Purpose of the "Elements" tab 

(Page 271) 
Interactive report Restricted Placing objects via the context menu 

of a symbol (Page 383) 
Evaluating report - -
Bulk processing - -
Query - -
Static new menu Restricted Creating multiple objects via the stat‐

ic new menu (Page 241) 
Navigator Restricted Creating engineering objects via the 

context menu (Page 235) 

Status
Query-based status: Shortcut menu of the Navigator

See also chapter Working with the query-based status (Page 293).

Object-based status: 

● Properties, "Status" tab

● Shortcut menu of the Navigator

See also chapter Working with the object-based status (Page 295).

12.2 Editing engineering objects in the properties

12.2.1 Editing general data

Introduction
The general data of an engineering object includes all properties from the general area of the 
properties or from the "General" tab. See also chapter Area for general data (Page 305).

When you create an engineering object, the general data are defined by the base object. You 
can change this data.

Requirements
● See also chapter Requirements for COMOS operation (Page 127).

● The properties of the engineering project are open. See also chapter Opening properties 
(Page 171).
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Changing name and label
See also chapter Changing name, label, and description (Page 254).

Changing a description
See also chapter Changing name, label, and description (Page 254).

Declaring objects as folders
See also chapter Declaring objects as folders (Page 255).

Setting references
See also chapters Switching the base object (Page 258) and Setting general references 
(Page 257).

12.2.2 Changing name, label, and description
Depending on the configuration of the engineering object, you will find these properties in the 
general data or on the "General" tab.

Note
No editing possible

If these properties have been locked by the administrator, their fields are colored gray. You 
cannot change them.

Meaning of name and label
The name and label are defined by the base object but are not inherited. Changing these 
values can have far-reaching consequences. See also chapters Alternative definitions for 
uniqueness of an object (Page 56) and Identification via name, label, description (Page 59).

Changing name and label
Requirements: The name and label are not locked.

Procedure:

1. You have the following options:

– Enter values in the "Name" and "Label" fields manually.

– Generate a name automatically via the following button: "Generate name/label 
automatically":

2. Confirm your entries.
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If objects can no longer be uniquely identified due to changes to their name or label, COMOS 
adjusts the values so that they are unique again. A message window informs you of this 
adjustment.

Changing a description
The description is initially inherited from the base object. The inherited description is displayed 
in italics.

Procedure:

1. Enter text in the "Description" field. This suspends the inheritance.

2. Confirm your entries.

See also
Editing general data (Page 253)

Area for general data (Page 305)

12.2.3 Declaring objects as folders

Principle behind folders
Objects with the Folder property organize the engineering data. They are not taken into 
consideration in the overall labeling of an object. You can specifically search for folders in 
queries. 

As long as the property is inherited from the base object, it is displayed in the properties in 
italics.

Requirements
● See also chapter Requirements for COMOS operation (Page 127).

● The properties of an engineering object are open. See also chapter Opening properties 
(Page 171).

Procedure
Activate the "Folder" option. Depending on the configuration of the engineering object, you will 
find the option in the general data or on the "General" tab.

Switching off the folder function
Requirements: The "Folder" function has not been activated on the base object. 

Deactivate the "Folder" option.
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See also
Editing general data (Page 253)

Area for general data (Page 305)

12.2.4 Locking engineering objects

Requirements
● See also chapter Requirements for COMOS operation (Page 127).

● You have the "Lock" function right. If you have any questions, contact your administrator.

● The properties of an engineering object are open. See also chapter Opening properties 
(Page 171).

Locking
Click on the "Locked" button in the toolbar in the properties of the engineering object:

Result
In the current working layer and all subordinate layers, the object and all objects located 
underneath it can only be changed by administrators. They are shown in gray in the Navigator. 

You can still edit attributes specially configured by the administrator. You can find additional 
information on this topic in the "Administration" manual, keyword "Attribute editable upon 
blocking of owner on engineering side". 

Releasing
Click on the "Release" button on the toolbar:

See also
Displaying user rights in a project (Page 190)
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12.2.5 Setting general references

Principle
The configuration of the engineering object determines the following:

● Whether the references are located in the area for general data or on the "General" tab.

● Which references are allowed.

If the engineering object uses the standard database configuration, the following reference 
fields are only visible once you have set a reference (dynamic references):

● "Unit", "Position", "Function", "Signal"

● "Location"

Overview of the references
Engineering objects can have the following reference fields:

Reference See also chapter ...
"Alias" or "Original" Alternative labeling system (Page 49) 
"Unit", "Position", "Function", or "Signal"  -
"Location" -
"Request"  Requests and implementations (Page 80)
"Implementation", "Target", or "Cable route" Implementation: Requests and implementations 

(Page 80)
Target and cable route: You can find additional in‐
formation on this topic in the manual "COMOS 
EI&C Operation".

"Base object" Switching the base object (Page 258)

Requirements
● See also chapter Requirements for COMOS operation (Page 127).

● The properties of an engineering object are open. See also chapter Opening properties 
(Page 171).

● For the following references: 

Reference The object you want to assign 
Unit, position, function, signal, location, target, 
or cable route

... has the correct class.

Request ... is a request.

● Implementation reference: The object whose properties are open has the "Request" 
property.

● "Alias" or "Original" references: The project is working with an alternative labeling system.
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Procedure
1. In the Navigator, select the object to which you want to set a reference.

2. Drag&drop it to the reference field.

Setting dynamic references
1. In the Navigator, select the object to which you want to set a reference.

2. Drag&drop it into the "Description" field or into the general area under the "Drop: Location, 
unit, implementation, alias, base object" field: 

Result
● The reference is set. 

● If the project is configured accordingly, the path to the reference object, including prefixes 
and delimiters, is shown in the Navigator behind the node of the engineering object. A 
reference to the engineering object is inserted under the referenced object.
You can find additional information on this topic in the "Administration" manual, keywords 
""Display of referenced objects" option" and ""Prefix and delimiter" group".

● You can navigate between the two objects via the context menu.

Delete reference
Click on the "Remove reference" button next to the reference field:

Setting a base object reference
See also chapter Switching the base object (Page 258).

12.2.6 Switching the base object

Requirements
● See also chapter Requirements for COMOS operation (Page 127).

● The properties of an engineering object are open. See also chapter Opening properties 
(Page 171).
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Procedure
1. Select a base object on the "Base objects" tab in the Navigator which has the same class 

as the old base object.

Note
Class 

You can check the class here: Base object properties > "System" tab > "Class" field

2. Drag&drop the base object to the "Base object" field. The field is located in the general area 
of the properties or on the "General" tab.
If inconsistencies arise due to the change of base object, they are automatically logged in 
the object test. The number entered after "Check:" in the COMOS status bar is increased.

3. If necessary, check the entries created in the object test when the base object was changed. 
You can find additional information on this topic in the "Administration" manual, keyword 
"Using an object test".

4. Confirm your entries.

Result
The base object is changed. Properties inherited from the old base object are replaced with 
those of the new base object. Checked-in properties are adopted as far as possible. 

Example:

Table 12-1 Before change of base object

Attribute (NestedName) Value at old base object Value at engineering object 
SYS.Number "100" Inherited -> "100"
SYS.Region "1" Checked in: "3"
SYS.Subregion Blank Checked in: "1"

Table 12-2 After change of base object

Attribute (NestedName) Value at new base object Value at engineering object 
SYS.Number "200" Inherited -> "200"
SYS.Region "2" Checked-in value is retained -> "3"
SYS.Subregion Attribute not available The attribute is visible in the Naviga‐

tor but no longer in the properties.
An entry is added to the object test.

See also
Fundamentals of the properties of engineering objects (Page 64)
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12.2.7 Editing attributes

12.2.7.1 Prerequisites for working with attributes
● An engineering project is open.

● An engineering object and its properties are open.

● The secondary tab of the "Attributes" tab has editable fields.
You can find additional information on this topic in the "Administration" manual, keyword 
"Creating tabs and attributes".

● For linked attributes: The secondary tab of the "Attributes" tab has statically linked attributes.
You can find additional information on this topic in the "Administration" manual, keyword 
""Link" tab".

See also
Relationship between base and engineering objects (Page 63)

Fundamentals of the properties of engineering objects (Page 64)

Attributes (Page 68)

12.2.7.2 Entering attribute values

Requirements
See chapter Prerequisites for working with attributes (Page 260).
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Procedure
1. Select a tab.

2. Enter the required values in the boxes.
How you proceed depends on the type of display of the attribute. You can find additional 
information on this topic in the "Administration" manual, keyword "Attribute: "Type of 
display" field".

3. Confirm your entries.

Result
● If you have set a unit, the values are converted automatically.

● If several users change a value of the same attribute at the same time, a message window 
opens. See also chapter Attributes for joint access (Page 72).

● If inconsistencies between linked attributes arise due to your input, or the min/max range 
is contravened, you will see the following:

– The attribute field turns orange.

– A tooltip is displayed.

–  The text color of the value changes.
See also chapters "Define attribute color" window (Page 268) and Defining the 
background color and text color of attribute values (Page 267).

Translating attributes
You can find additional information on this topic in the "Administration" manual, keyword 
"Translating attributes".
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See also
Entering values for linked attributes (Page 262)

Working in list attributes (Page 267)

12.2.7.3 Entering values for linked attributes

Principle
If an attribute (source attribute) is linked to another attribute (target attribute), the value of the 
source attribute is applied to the target attribute. Whether or not the value is adopted 
automatically and whether the link is bidirectional depends on the link type.

Requirements
See chapter Prerequisites for working with attributes (Page 260).

Procedure
1. Enter a value in the source attribute or target attribute field.

2. Confirm your input.

Result
● The value is saved to the source attribute/target attribute.

● The text color of the source attribute/target attribute changes. See also chapter Defining 
the background color and text color of attribute values (Page 267).
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● If you have entered a value in the source attribute field, the following happens to the target 
attribute:

Link Result See also chapter ...
"Static" If no value has previously been 

entered in the target attribute, 
there are no changes.
If the value of the attribute dif‐
fers from the value of the linked 
attribute, the target attribute 
field turns orange. A tooltip is 
displayed.

See also chapters Refreshing 
static links (Page 264) and Ac‐
cepting differences between 
static links (Page 264).

"Dynamic" The value is accepted automat‐
ically.

See below.
"Full dynamic"

● If you have entered a value in the target attribute field, the following happens to the source 
attribute:

Link type Result See also chapter ...
"Static" No change to the source attrib‐

ute.
If the value of the attribute dif‐
fers from the value of the linked 
attribute, the target attribute 
field turns orange. A tooltip is 
displayed.

See also chapters Refreshing 
static links (Page 264) and Ac‐
cepting differences between 
static links (Page 264).

"Dynamic" No changes to the source attrib‐
ute.
If the "Always get linked value" 
option is activated, you cannot 
edit the target attribute value.

 

"Full dynamic" The value is accepted automat‐
ically.

See above.

12.2.7.4 Refreshing attribute values

Requirements
See chapter Prerequisites for working with attributes (Page 260).

Procedure
1. You have the following options:

– To refresh the values for all attributes on the tab, right-click in the white area of the tab.

– To refresh the value of one attribute, click in its field.

2. Select the "Refresh values" command in the context menu.
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12.2.7.5 Refreshing static links

Requirements
See chapter Prerequisites for working with attributes (Page 260).

Refreshing a tab
1. Right-click in the white area of the tab.

2. Select the "Refresh static links on tab" command in the shortcut menu.

Refreshing all tabs
1. Right-click in the white area of the tab.

2. Select the "Refresh static links for all tabs" command in the shortcut menu.

Refreshing a selected attribute
1. Right-click in the white area of the tab.

2. Select the "Refresh static links for object ... " command in the shortcut menu.

3. Select a linked attribute.

Note
Refreshing static links for one attribute

When you select an attribute, the "Refresh static links" command is displayed in the shortcut 
menu. It refreshes this attribute only.

12.2.7.6 Accepting differences between static links

Requirements
See chapter Prerequisites for working with attributes (Page 260).

Accepting for an object 
1. Right-click in the white area of the tab.

2. From the shortcut menu, select the "Static links: Accept differences for object ..." command.

3. Select a linked attribute.

The differences are marked as valid as long as the default does not change.
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Always accept for an object 
1. Right-click in the white area of the tab.

2. From the shortcut menu, select the "Static links: Always accept differences for object ..." 
command.

3. Select a linked attribute.

The differences are always marked as valid, even if the value of the source changes.

Accepting/always accepting a result for an object
● The orange-colored filling between the local value and the value of the linked attributes is 

removed.

● The difference to the linked value is displayed in the tooltip.

● The value is no longer marked as invalid in the status management.

● The linked value is no longer applied in the event of a match. The local value is retained.

No longer accepting for an object
Requirements: You have already accepted a difference.

1. Right-click in the white area of the tab.

2. From the shortcut menu, select the "Static links: No longer accept differences for object ..." 
command.

3. Select a linked attribute.

Result: The following commands are available for the selected object again:

● "Refresh static links for object..."

● "Static links: Accept differences for object ..."

● "Static links: Always accept differences for object ..."

12.2.7.7 Navigating to the source attribute

Requirements
See chapter Prerequisites for working with attributes (Page 260).

Procedure
1. Move the mouse cursor over the linked attribute on the tab.

2. Select the "Navigate > Link sources > <Name of the attribute>" command in the context 
menu.
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Note
Link source is not displayed

If no source attribute is displayed under this command, this attribute is the source attribute. 
See also chapter Navigating (Page 170).

Result
The source attribute is selected in the Navigator.

12.2.7.8 Copying the attribute values of a tab

Requirements
● See chapter Prerequisites for working with attributes (Page 260).

● The source tab and target tab have the same name.

● The source attributes and target attributes have the same name.

Copying all values of a tab
1. Right-click in the white area of the tab.

2. Select the "Copy tab data" command in the context menu of the source tab.

3. Select the "Paste tab data" command in the context menu of the target tab.

Result
All attribute values are copied.

Note
Target attribute does not exist

If a target attribute does not exist, the value is not applied.

See also
Deleting all data from the tab (Page 266)

12.2.7.9 Deleting all data from the tab

Requirements
See chapter Prerequisites for working with attributes (Page 260).
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Procedure
1. Right-click in the white area of the tab.

2. Select the "Delete all data" command from the context menu.

Result
● All values which have been entered on the tab are deleted. The values inherited from the 

base object are displayed.

● Changed units are reset to their defaults.

See also
Copying the attribute values of a tab (Page 266)

Editing attributes (Page 70)

12.2.7.10 Working in list attributes

Select several cells
1. Press and hold down <Ctrl>.

2. Drag out a frame with the left mouse button held down.

Copy and paste options
● Copy and paste from Excel to the list attribute, and vice versa

● Copy and paste within a list attribute and from one list attribute to another

You are informed if the copy area and paste area are not the same size. The data is pasted 
starting from the top left.

See also
Entering attribute values (Page 260)

12.2.7.11 Defining the background color and text color of attribute values

Overview
If you or other users edit attributes, the background color and the text color of the value are 
shown in color. You can define the attribute colors yourself. 

You can find additional information on this topic in the "Administration" manual, keyword 
"Personal user settings".
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Procedure
1. Select the "Plugins > Basic > Define attribute color" command in the menu bar. See also 

chapter "Define attribute color" window (Page 268).

2. You can change attribute colors in the following ways:

– Background color of the value: Select the desired edit mode. 

– Text color of the value: Select the desired modification stamp.

3. Click the "..." button in the "Color" column.

4. Select the required color in the "Color" window.

5. Confirm your entries.

6. To save your settings, click on the following button: 

The "Save settings" window opens. See also chapter "Save settings" window (Page 591).

7. Select the required settings.

8. Confirm your entries.

Result
Your settings can be saved as user-specific settings or as group-specific settings. They are 
saved in the base data.

12.2.7.12 "Define attribute color" window

Call
See chapter Defining the background color and text color of attribute values (Page 267).
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Overview

Toolbar
Button for permanently saving the color settings:  

See also chapter "Save settings" window (Page 591).
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"Background color of the value" control group
You use the buttons of the "Color" column to specify the background color which attributes 
have in the following cases:

Scenario Default
Edit mode: "Instantiating"
You can find additional information on this topic in the 
"Administration" manual, keyword "Attribute: "Edit 
mode" field" and "Configuring an instantiation".

Yellow

Value violates a value range or does not agree with the 
link source. Correct the value. The orange filling is re‐
moved after the correction.

Orange

Edit mode: "Editable - high priority"
You can find additional information on this topic in the 
"Administration" manual, keyword "Attribute: "Editing 
mode" and "Mandatory attributes and redlining" fields.

Red

 button: Reset to standard background colors

"Text color of the value" control group
You use the buttons of the "Color" column to specify the color which the attribute values have 
in the following cases:

Scenario Default
No change in the last 48 hours. Black
Some changes in the last 48 hours. Blue
Changes by a different user in the last 48 hours. Red

 button: Reset to standard text colors
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12.2.8 Managing elements

12.2.8.1 Purpose of the "Elements" tab

Overview
● You get an overview of the elements of the engineering object:

– Of the virtual elements
Virtual elements are elements which have been prepared at the base object and can 
be created under the engineering object.

– Of the engineering data elements 
Engineering data elements (henceforth referred to as elements) are elements which 
have already been created under the engineering object.
The connector names of the elements are also displayed. Example:

See also chapter Elements (Page 75).

● You can derive new elements from the virtual elements. See also chapter Deriving new 
elements from virtual elements (Page 274).

● You can create entirely new elements. See also chapter Creating new elements 
(Page 272).

● You can delete elements. See also chapter Deleting elements in the engineering view 
(Page 275).

● You can change the base object of elements. See also chapter Changing the base object 
of elements (Page 275).

● You can open and edit the properties of the elements. See also chapter Opening 
properties (Page 171).

Note
Filtering the display

The toolbar contains buttons which allow you to filter which elements are displayed. 
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See also
Context menu of the "Elements" tab (Page 273)

12.2.8.2 Creating new elements

Requirements
See chapter Requirements for COMOS operation (Page 127).

Procedure
1. Select an engineering object in the Navigator.

2. Open the engineering object properties.

3. Select the "Elements" tab.

4. Right-click in the white area of the tab.

5. Select the "New object (below master)" command from the context menu.

6. Edit the new element. See also chapter Fundamentals of creating objects (Page 54).

Alternative
See also chapter Creating objects from a project structure via the context menu (Page 236).

Result
● The new element is created in the Navigator under the selected engineering object.

● The new element is now displayed on the "Elements" tab.

See also
Context menu of the "Elements" tab (Page 273)

Deriving new elements from virtual elements (Page 274)
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12.2.8.3 Context menu of the "Elements" tab

Context menu without selection of an element
If you click in the white area of the "Elements" tab in the context menu, the following commands 
are displayed:

Icon Command Description
"New object (below master)"
 

Opens the properties of a new engineering object. The new 
element is created below the engineering object (master).
See also chapter Creating new elements (Page 272).

"Paste" Creates a new element under the master based on the clip‐
board. You must first copy an engineering object.

"Refresh" Refreshes the tab.

"Navigate" See also chapter Navigating (Page 170).

"Sort by name" Sorts the contents of the tab by name.

"Sort by label" Sorts the contents of the tab, including the virtual ele‐
ments, by label.

"Sort by description" Sorts the contents of the tab, including the virtual ele‐
ments, by description.

Context menu with selection of an element
If you select an element on the "Elements" tab, the following commands are displayed in the 
context menu:

Icon Command Description
 "Create" Requirements: There are virtual elements available. See al‐

so chapter Elements (Page 75).
Creates a new element based on the selected element.
See also chapter Deriving new elements from virtual ele‐
ments (Page 274).

 "Create N ..." Requirements: There are virtual elements available. See al‐
so chapter Elements (Page 75).
Creates any number of new elements based on the selected 
element.
See also chapter Deriving new elements from virtual ele‐
ments (Page 274).

 "Change base object"... You can assign a new base object
to the selected element. See also chapter Changing the base 
object of elements (Page 275).

 

"Navigate" See also chapter Navigating (Page 170).

"New" See also chapter Creating engineering objects via the con‐
text menu (Page 235).

"Delete" See also chapter Deleting (Page 180).
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Icon Command Description
"Cut" Cuts the selected element.

"Copy" Copies the selected element.

 

"Paste" Pastes a cut or copied element.

"Properties" See also chapter Opening properties (Page 171).

See also
Managing elements (Page 271)

12.2.8.4 Deriving new elements from virtual elements

Requirements
● See chapter Requirements for COMOS operation (Page 127).

● The project contains an engineering object which has virtual elements and/or elements.

Procedure
1. Select an engineering object in the Navigator.

2. Open the engineering object properties.

3. Select the "Elements" tab.

4. Select a virtual element. 
The icons of virtual elements are light green. See also chapter Icon coloring (Page 586).

5. You have the following options:

– To create an element, select the "Create" command in the context menu.

– To create several elements, select the "Create N ..." command in the context menu.

Elements can be prepared in such a way that only a certain number of these elements can 
be created under the engineering object. When the defined limit is reached, the command 
is locked in the context menu.

Alternative
See also chapter Creating objects from a project structure via the context menu (Page 236) 
and chapter Creating objects in the static New menu (Page 243).
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Result
● The new element is created in the Navigator under the engineering object on the basis of 

the selected element.

● The new element is now displayed on the "Elements" tab on the basis of the selected 
element.

See also
Context menu of the "Elements" tab (Page 273)

Creating new elements (Page 272)

Elements (Page 75)

12.2.8.5 Deleting elements in the engineering view
See also chapter Deleting (Page 180) and chapter Context menu of the "Elements" tab 
(Page 273).

You cannot delete the following elements:

● Virtual elements

● Specially configured elements

See also chapter Elements (Page 75).

You can also find additional information on this topic in the "Administration" manual, keyword 
"Deleting elements in the base object".

12.2.8.6 Changing the base object of elements

Requirements
An element has been created under the engineering object. See chapter Creating new 
elements (Page 272) and chapter Deriving new elements from virtual elements (Page 274).

Procedure
1. Select an engineering object in the Navigator.

2. Open the engineering object properties.

3. Select the "Elements" tab.

4. Select an element.

5. Select the "Change base object ..." command in the context menu.
The "Select base object" window opens.

6. Choose a base object.

7. Confirm your entries.
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Result
The base object is changed. See also chapter Switching the base object (Page 258).

See also
Context menu of the "Elements" tab (Page 273)

12.2.9 Managing connectors

12.2.9.1 Purpose of the "Connectors" tab

Overview
The "Connectors" tab supplies the following information:

● What connectors the engineering object and its elements have.
Example: 

● What properties the connectors have.

● What connections the connectors have.

● You can connect and disconnect connectors. See also chapter Connecting connectors via 
the "Connectors" tab (Page 285) and chapter Disconnecting connectors via the 
"Connectors" tab (Page 288).

● You can work with auxiliary connectors. See also chapter Working with auxiliary 
connectors (Page 277).

Note
Filtering the display

The toolbar contains buttons which allow you to filter which connectors are displayed. 
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See also
Connectors (Page 73)

Connecting and disconnecting connectors (Page 284)

Properties of engineering objects (Page 302)

12.2.9.2 Working with auxiliary connectors

Overview
Each connector can only have one counterpart connector. In practice, it may occur that multiple 
connections are made to a terminal, for example. Auxiliary connectors are created in order to 
map this on a report, for example:

● Auxiliary connectors always relate to an existing connector.

● Auxiliary connectors get the name of the existing connector plus a counter, e.g. [1], in the 
"Name" field. 

If the connections are deleted, the gap is filled with new connections whenever possible. A 
gap remains, if there is a half-open connection for the index on the report.

You can find more information on this topic in the "EI&C Operation" manual, keyword "Editing 
connectors and auxiliary connectors on the tab".

12.2.10 Creating numbering ranges
You can create numbering ranges for the following objects:

● Project

● Engineering objects

● Documents

Requirements
The "Numbering ranges" tab is available in the properties of the object. You can find additional 
information on this topic in the "COMOS Platform Administration" manual, keyword "Making 
the "Numbering ranges" tab available".

Procedure
1. Open the properties of the object.

2. Go to the "Numbering ranges" tab.

3. Right-click in the free area.
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4. Select the "New" command from the context menu.
The "New numbering range" window opens.

5. Make the required entries.
See also chapter "New numbering range" window (Page 278).

You can find additional information on this topic in the "Administration" manual, keyword 
"Administration of numbering ranges".

12.2.11 "New numbering range" window

Call
See also chapter Creating numbering ranges (Page 277).

"New numbering range" window

Field name Description
"Name" Mandatory field. Name can be freely assigned.
"Description" Optional field. The description can be freely assigned.
"Base object" Mandatory field. Using drag&drop
"Prefix" Optional field. To always start the numbering range [<Prefix>] <Inter‐

val> [<Postfix>] with a specific character or a specific string.
"Suffix" Optional field. To always end the numbering range with a specific 

character or a specific string.
"Alphabet" Mandatory field. Defines the characters that make up the numberings.

You select predefined values from a list or, alternatively, enter all pro‐
vided values.
Example: "ABYZ". When listing these letters, you can use all combi‐
nations of these four entered letters. You can only use letters that were 
entered here for numbering.

"Increment" The value "1" is selected by default. 
"Start value" Mandatory field. Example "A"
"End value" Optional field. Example "ZZZ"
"Property" The property "Name" is selected by default.
"Last value used" The field is not editable. The value is assigned by the system.
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12.3 Editing engineering objects in the properties tree

12.3.1 Editing object properties in the properties tree

Purpose
The "Properties tree" tab offers you an overview of general properties of the objects selected 
in the Navigator, in queries, or in documents (engineering objects, base objects, connectors, 
etc.).

For engineering objects, documents, and base objects, you can also edit the attributes.

Requirements
See also chapter Requirements for COMOS operation (Page 127).
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Opening the properties tree
1. In the menu bar, select "View > Properties tree".

The "Properties tree" tab opens in the detail area of the Navigator.

2. Select one or more objects in the Navigator or in a query or document.

Note

Select objects of the same system type.

The "Properties tree" tab is filled: 

– The topmost bar offers access to the general properties.
Single selection: The bar shows the name of the selected object.
Multiple selection: The bar shows the number of selected objects.

– The bars below that offer access to the attributes of the attribute tab.

3. Click on a bar.
You see the general properties or the attributes of the selected objects.
Example:

If the objects have different values for a field, the value "<...>" is displayed in the field; 
otherwise, the shared value is displayed. Reference fields with different values are marked 
in yellow.
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Sorting the properties tree
Click the "COMOS sorting" button with the arrow in the toolbar of the tab: 

Sorting distinguishes between the following items:

● Tabs

● Attributes of the "frame" type

● Attributes without assignment to a frame

● Attributes with assignment to a frame

● VSUI attributes

Choose one of the following entries:

● "COMOS sorting"

– Tabs
Tabs are sorted according to the NestedName of the object

– Attributes of the "frame" type
Frame attributes are first listed and sorted according to the "TabIndex"

– Attributes without assignment to a frame
These attributes are sorted according to the "TabIndex"

– Attribute with assignment to a frame
These attributes are sorted according to the "TabIndex"

● "Alphabetical"

– Tabs
Tabs are sorted according to the NestedName of the object

– Attributes without assignment to a frame; Attributes of "frame" type are treated as such
These attributes are sorted according to Description + NestedName

– Attributes with assignment to a frame
These attributes are sorted according to the NestedName

● "Attribute filter"
Only the attributes that were determined with the VSUI function are listed. 
You can find additional information on this topic in the "Administration" manual, keyword 
"Preparing attribute filters".
If the container object for the VSUI objects is empty, only the title bar of the tab is visible 
and no attributes are listed.
If the container object of VSUI objects is missing, the properties tree is empty. In older 
versions of COMOS, the general attributes of the objects are listed in this case. 
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Editing properties in the properties tree
● Enter the required values.

As soon as you leave the edited field, the values are written to the objects. The objects are 
not automatically saved.

● Click the "Undo" button to undo your previous entries. 

All changes since the last save are undone.

● Click "Apply" to save your input.

Pinning or updating a tab
You can prevent the content of the tab from being updated as soon as you select other objects. 
This makes it possible, for example, to switch to another object in the Navigator and to 
drag&drop this object onto the "Properties tree" tab in order to set a reference there.  

● Pinning a tab
Procedure: Click the "Pin selected object" button in the toolbar of the tab: 

Result: The contents of the tab are pinned. The objects currently selected are listed in the 
toolbar of the tab. You can navigate to the objects via the adjacent button.

● Updating a tab
Click the "Pin selected object" button again: 

See also
"Properties tree" tab (Page 282)

12.3.2 "Properties tree" tab

Call
● "View > Properties tree" menu

● When a report is opened and its option script contains the "EnableVSUI2 = TRUE" variable: 
Automatically
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Structure

① Toolbar
② Area for editing the general properties and attributes
③ "Undo" and "Apply" standard buttons

Toolbar

Icon Tooltip Description
"Pin selected object" The selected object is fixed. 

See also chapter Editing object properties in the prop‐
erties tree (Page 279).

"Navigate" Where you can navigate to depends on the object.
Navigation examples:
● "Object"
● "Base object"
● "Documents"

 List for sorting attributes:
● COMOS sorting
● Alphabetic sorting
● Attribute filter
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Displayed fields
If you only select one object, you see all fields which can, in principle, be edited for this object 
in the properties tree. If you select several objects, you only see the fields available for all 
objects.

The general properties you see depend on the system type of the objects:

System type Name, label, description Full label (FullLabel) References
Engineering ob‐
ject

✓ ✓ ● Base object reference
● Unit reference
● Location reference
● Implementation 

reference
Document ✓

 
✓ ● Unit reference

● Location reference
Connector Name, description - -

Users with the relevant rights can select the following objects in the "Base objects" tab and 
edit their name and description:

● Base objects

● Tabs

● Attributes

● Standard tables

12.4 Connecting and disconnecting connectors

12.4.1 Connection options for connectors

Possible ways of connecting engineering objects using connectors
Engineering objects are connected by connectors. You can connect engineering objects in the 
following ways:

● On an interactive report.
See also chapter Connecting connectors on interactive reports (Page 285) and chapter 
Disconnecting connectors on interactive reports (Page 288).

● Via the properties of an engineering object
See also chapter Connecting connectors via the "Connectors" tab (Page 285) and chapter 
Disconnecting connectors via the "Connectors" tab (Page 288).
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● Via the navigator
See also chapter Connecting connectors in the Navigator (Page 286) and chapter 
Disconnecting connectors in the Navigator (Page 289).

● Via the query for connectors
See also chapter Connecting connectors via the query for connectors (Page 287) and 
chapter Disconnecting connectors via the query for connectors (Page 290).

See also
Connectors (Page 73)

Context menu of the "Connectors" tab (Page 291)

Connections (Page 74)

Managing connectors (Page 276)

12.4.2 Connecting connectors

12.4.2.1 Connecting connectors on interactive reports
You connect the connectors of engineering objects on an interactive report using their symbols.

See also
Fundamentals of connections on interactive reports (Page 90)

Connecting objects (Page 392)

12.4.2.2 Connecting connectors via the "Connectors" tab

Requirements
● See chapter Requirements for COMOS operation (Page 127).

● The engineering project has engineering objects with free connectors.

Procedure
1. Select the first engineering object in the Navigator. 

2. Select the "Properties" command in the context menu.

3. Select the "Connectors" tab.

4. Select the second engineering object in the Navigator.

5. Open the object structure of the second engineering object.
You see the connectors in the Navigator underneath the engineering object. See also 
chapter Setting up the Navigator (Page 157).
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6. Drag&drop a connector of the second engineering object from the Navigator to the 
corresponding connector of the "Connectors" tab.

7. Confirm your entries.

Result
● The connectors of the engineering objects are connected.

● The connection information is assigned to the connector and is visible:

– In the "Connected to" column on the "Connectors" tab

– In the Navigator

12.4.2.3 Connecting connectors in the Navigator

Requirements
● See chapter Requirements for COMOS operation (Page 127).

● The engineering project has engineering objects with free connectors.

Procedure
1. Select the first engineering object in the Navigator. 

Note
Single selections

The procedure can only be used to select items individually.

2. Open the object structure of the engineering object.
You see the connectors in the Navigator underneath the engineering object. See also 
chapter Setting up the Navigator (Page 157).

3. Select the second engineering object in the Navigator.

4. Open the object structure of the second engineering object.
You see the connectors in the Navigator underneath the engineering object. See also 
chapter Setting up the Navigator (Page 157).

5. Drag&drop the connector of the first engineering object to the desired connector of the 
second engineering object.

Result
● The connectors of the engineering objects are connected.

● The connection information is assigned to the connector and is visible:

– In the Navigator

– In the "Connected to" column on the "Connectors" tab
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12.4.2.4 Connecting connectors via the query for connectors

Requirements
● See chapter Requirements for COMOS operation (Page 127).

● The engineering project has engineering objects with free connectors.

● A query for connectors is open. See chapter Creating and opening a query (Page 458).

● The start object of the query is set. The Object Browser displays a search result. See also 
chapter Configuring queries in simple run mode (Page 462).

Connecting connectors via the Navigator using drag&drop with the Object Browser
1. Select an engineering object in the Navigator.

2. Open the object structure of the engineering object.
You see its connectors in the Navigator underneath the engineering object. See also 
chapter Setting up the Navigator (Page 157).

3. Drag&drop a connector from the Navigator to the desired connector in the Object Browser.

Connecting connectors in the Object Browser
1. Select a connector in the Object Browser.

2. Drag&drop the connector to the desired connector.

Result
● The connectors of the engineering objects are connected.

● The connection information is assigned to the connector.

● The connection information is visible in the Navigator.

● The connection information is visible in the counterpart connector columns in the Object 
Browser.
Example:

Column Description
"Name" (underlined) Name of the connected connector.
"Label" Label of the connected connector.
"Owner" Owner of the connected connector.

See also
Using queries and bulk processing (Page 455)
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12.4.3 Disconnecting connectors

12.4.3.1 Disconnecting connectors on interactive reports
If two objects are connected on an interactive report, proceed as follows:

● Directly connected objects: Move the symbol of one of the objects. See also chapter Moving 
symbols (Page 417).

● Objects connected via connections: Activate the grab points of the connection. Disconnect 
the connection from the connection point of the symbol. See also chapter Changing a 
connection run (Page 398).

The connectors are disconnected.

See also
Deleting in interactive reports (Page 436)

12.4.3.2 Disconnecting connectors via the "Connectors" tab

Requirements
● The engineering object has connectors which are connected. See chapter Connecting 

connectors via the "Connectors" tab (Page 285).

● The connectors were linked via the Navigator or in the properties of the objects.

Note
Connectors on an interactive report

If you set connectors via an interactive report, you must disconnect them on the report. 

Procedure
1. Select an engineering object in the Navigator. 

2. Select the "Properties" command in the context menu.

3. Select the "Connectors" tab.

4. Select the desired connector in the "Connected to" column.

5. Select the "Connection" command from the context menu.
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6. Select one of the following options:

– "Disconnect"

– "Disconnect (retain wires)"

– "Disconnect (keep wires at target)"

See also chapter Context menu of the "Connectors" tab (Page 291).

7. Confirm your entries.

Result
● The connectors are disconnected.

● If you select the "Connection > Disconnect" command, the wire information in the "via" field 
is also deleted.

● If you select the "Connection > Disconnect (keep wires at target)" command, the wire 
information in the "via" field is retained.

● If you select the "Connection > Disconnect (keep wires at target)" command, the wire 
information at the target object in the "via" field is retained.

● The connection information is deleted:

– In the "Connected to" column on the "Connectors" tab

– In the Navigator

12.4.3.3 Disconnecting connectors in the Navigator

Requirements
● The engineering object contains connectors which are connected. See chapter Connecting 

connectors in the Navigator (Page 286).

● The connectors were linked via the Navigator or in the properties of the objects.

Note
Connectors on an interactive report

If you set connectors via an interactive report, you must disconnect them on the report. 

Procedure
1. Select an engineering object in the Navigator.

2. Open the object structure of the engineering object.
You see the connectors in the Navigator underneath the engineering object. See also 
chapter Setting up the Navigator (Page 157).

3. Right-click on a connected connector.

4. Select "Disconnect connection" from the context menu.
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Result
● The connectors are disconnected.

● The connection information is deleted:

– In the Navigator

– In the "Connected to" column on the "Connectors" tab

12.4.3.4 Disconnecting connectors via the query for connectors

Requirements
● See chapter Requirements for COMOS operation (Page 127).

● A query has been created and opened. See chapter Creating and opening a query 
(Page 458).

● The query shows connected connectors.

Procedure
1. Select the desired connector in the "Name" column (underlined).

2. Select the "Connection" command from the context menu.

3. Select one of the following options:

– "Disconnect"

– "Disconnect (retain wires)"

– "Disconnect (keep wires at target)"

See also chapter Context menu of the "Connectors" tab (Page 291).

4. Confirm your entries.

Result
● The connectors are disconnected.

● If you select the "Connection > Disconnect" command, the wire information is also deleted.

● If you select the "Connection > Disconnect (keep wires at target)" command, the wire 
information is retained.

● If you select the "Connection > Disconnect (keep wires at target)" command, the wire 
information is retained at the target object.

● The connection information is deleted in the Navigator.

● The connection information is deleted in the counterpart connector column in the Object 
Browser.
Example:
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Column Description
"Name" (underlined) Name of the connected connector
"Label" Label of the connected connector
"Owner" Owner of the connected connector

See also
Using queries and bulk processing (Page 455)

12.4.4 Context menu of the "Connectors" tab

Note

The context menu can contain different commands, depending on the column.

List of the menu commands

Command Description
"Connect with" Displays the connectors of the object from the clipboard.
"Connection" Available only in the "Connected with" column:

● "Disconnect"
Cuts the connection between two connectors. The wire information in the 
"via" field is also deleted.

● "Disconnect (retain wires)"
Cuts the connection between two connectors. The wire information in the 
"via" field is retained.
See also under the "Wire" command.

● "Disconnect (keep wires at target)"
Cuts the connection between two connectors. The wire information in the 
"via" field at the target object is retained.

● "Cut"
Cuts the counterpart connector, including the wire information. The counter 
connector can now be linked to another connector via the "Paste" menu 
command.

● "Paste"
The connector is connected to the connector from the clipboard.

See also chapter Disconnecting connectors via the "Connectors" tab 
(Page 288).
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Command Description
"Wire" Available only in the "via" column.

● "Disconnect"
Deletes the information on the wire at the connector.

● "Cut"
Cuts the wire. The wire can be assigned to another connector via the 
"Paste" menu command.

● "Paste"
Pastes the wire from the clipboard.

"Create auxiliary con‐
nectors"

Creates auxiliary connectors for a connector. This allows users to attach mul‐
tiple wires to a terminal.
You can find more information on this topic in the "EI&C Administration" man‐
ual, keyword "Auxiliary connectors/Array connectors".

"Cross section"
"Color"
"Type info"

The corresponding details are allocated to a connection. To view the informa‐
tion in the table, the user must display the corresponding column.

"Columns" ● "Reset"
Removes all filters and other modifications from the table.

● "<Column name>"
Displays the selected column. A check appears alongside the displayed 
columns. Selecting it again hides the column again.

"Navigate" Selects the column object in the Navigator.
"Refresh" Refreshes the tab.
"Delete (connectors)" The command is only available for an auxiliary connector. The auxiliary con‐

nector is deleted.
"Properties" Opens the properties of the cell object.

See also
Connection options for connectors (Page 284)

12.5 Managing object status

12.5.1 Requirements for status management

General
See also chapter Requirements for COMOS operation (Page 127). 
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Object-based status management
● The desired status types and status values are prepared in the base data. You can find 

additional information on this topic in the "Administration" manual, keyword "Object-based 
status management".

● You have write rights for the objects whose status you are setting.

● To set the status via the properties: The engineering object has a "Status" tab. You can 
find additional information on this topic in the "Administration" manual, keyword "Reference 
of the "Configuration" tab".

Query-based status management
● Queries for status management are prepared in the base data for the desired status types. 

You can find additional information on this topic in the "Administration" manual, keyword 
"Query-based status management".

● You have read and write rights in the document directory. 

● For configuring the status query: The query can be configured.

● To save a modified query configuration: 

– The query can be saved. 

– You have write rights for the query.

12.5.2 Working with the query-based status

12.5.2.1 Displaying status information in the status query

Aim
You want to see the status of the engineering objects and details of the status values.

Requirements
See also chapter Requirements for status management (Page 292).

Procedure
1. Select the "Status display" command from the context menu of the Navigator.

2. In the context menu, select a status type which works with query-based status management 
and then select the following subcommand: "<Status type> > Status per XML file"
The status query opens in reading mode.
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3. Set a start object. See also chapter Configuring queries in simple run mode (Page 462).

4. Click the "Search" button in the toolbar of the query:

 Alternatively, click on the "Search at once" button:

Result
The result of the last status calculation is loaded in the result table. Depending on the command 
you selected when you activated the status display before the status calculation, you will see 
the status values of the following objects:

● "Complete": For all engineering objects under the start object

● "For current user": Only for engineering objects that you have edited

● "...": Only the objects which correspond to the selected filter

The following status information is displayed:

● Status value

● Status timestamp

● Status description

● Other information depending on the configuration of the status query

Displaying current status information
1. Proceed as described above.

2. Activate the status display. See also chapter Activating and deactivating the status 
display (Page 299).

3. Calculate the status. See also chapter Calculating the status (Page 294).

4. Click the "Search" button in the status query:

See also
Fundamentals of status management (Page 77)

12.5.2.2 Calculating the status

Requirements
See chapter Requirements for status management (Page 292).
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Procedure
1. Activate the status display of a query-based status type. See also chapter Activating and 

deactivating the status display (Page 299).

2. Select one or more engineering objects in the Navigator, in a query, or on a report.

3. Select the "Calculate status" command in the context menu.

Result
The status is calculated recursively for the selected nodes. The status display is refreshed in 
the user interfaces.

If the query supports hierarchical query-based status management, the status values of the 
owners are checked recursively and adapted if necessary. Objects whose status cannot be 
calculated take on the lowest status from their subobjects. 

See also
Fundamentals of status management (Page 77)

12.5.3 Working with the object-based status

12.5.3.1 Setting the object-based status

Requirements
See also chapter Requirements for status management (Page 292).

Via the navigator
Requirements: The status display is activated for the desired status type. See also chapter 
Activating and deactivating the status display (Page 299)

Procedure:

1. Select one or more engineering objects in the Navigator, in a query, or on a report.

2. Select the "Set status value" command in the context menu.

3. Select a status value.

Via the properties
1. Open the engineering object properties.

2. Select the "Status" tab.
You can see all status types.
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3. Select a status value for the desired status type.

4. Click on the adjacent "Set" button.

 Result
COMOS checks the status value:

Status is valid Consequence
Yes The status is set. See also chapter Object-based status management (Page 78). 
No ● The corrected status value is set. See also chapter Object-based status 

management (Page 78).
● The status calculation protocol opens. 

You can correct the causes of the invalid status values. See also chapter 
Correcting invalid status values (Page 297).

See also
Fundamentals of status management (Page 77)

"Status calculation protocol" window (Page 298)

12.5.3.2 Checking the object-based status

Aim
You want to check whether the status values saved at the objects still correspond to the current 
state.

Requirements
See also chapter Requirements for status management (Page 292).

Via the navigator
Requirements: The status display is activated for an object-based status type. See also chapter 
Activating and deactivating the status display (Page 299).

Procedure:

1. Select one or more engineering objects in the Navigator, in a query, or on a report.

2. Select the "Check status" command in the context menu. 
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Via the properties
1. Open the engineering object properties.

2. Select the "Status" tab.
You can see all status types.

3. Click the "Check" button next to the desired status type.

Result
COMOS checks the status values of the object and its subobjects. If there are invalid status 
values, the "Status calculation protocol" window opens. You have the following options in this 
window. Do not combine them:

● Correct the inconsistent status-related attributes. 

● Apply the correct status values calculated by the check.

See also chapter Correcting invalid status values (Page 297).

See also
"Status calculation protocol" window (Page 298)

Setting the object-based status (Page 295)

Fundamentals of status management (Page 77)

12.5.3.3 Correcting invalid status values

Introduction
If COMOS detects that you want to set an invalid status value or if you check the status values 
and the check finds invalid values, the "Status calculation protocol" window opens.

In this window you can apply the correct status values or eliminate the causes of the invalid 
status values. 

Requirements
You have set an invalid status value. See also chapter Setting the object-based status 
(Page 295). 

Or you checked the status and the check found invalid status values. See also chapter 
Checking the object-based status (Page 296).
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Applying values calculated by a check

Note
Do not use after correcting the inconsistencies

Do not apply the status values calculated by the check if you have already corrected the 
inconsistencies. Otherwise, invalid status values will be saved at the objects.

1. Activate the "Apply status values on saving" option.

2. Confirm your entries.

The internally calculated, correct status values are applied. If you check the status again or 
set a status value, the internal check will not find any invalid status values.

Correcting causes of invalid values
If the "Type" table column has the "Attribute" value, the object the row applies to has an 
inconsistent status-related attribute. If you cannot see the column, increase the frame of the 
window.

Proceed as follows:

● If a statically linked attribute differs from the source attribute, select the "Update static links 
(selected ones)" command in the context menu of the "Value" column.

● If an attribute value does not conform with a value range or a product data-related attribute 
does not conform with the default in the manufacturer device, enter a valid value in the 
"Value" column.

If you check the status again or set a status value, the internal check will not find any invalid 
status values.

See also
Object-based status management (Page 78)

"Status calculation protocol" window (Page 298)

12.5.3.4 "Status calculation protocol" window

Call
You have tried to set an invalid status value. See also chapter Setting the object-based 
status (Page 295). Or you checked the status and the check found invalid status values. See 
also chapter Checking the object-based status (Page 296).

Structure
The status protocol contains more precise information on objects with an invalid object status. 
It shows why the status values are invalid. You can correct the invalid status values. See also 
chapter Correcting invalid status values (Page 297).
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Important table columns:

Column Description
"Object" The engineering object which has an inconsistent attribute
"Status value" The object status valid for the current status type 
"Inconsisten‐
cy" and "Type"

After "Set status": The reason why the status value you selected is invalid
After "Check status": The reason why the status displayed under "Status value" 
comes into effect

The table is based on a query. The query functions are available in the context menu of the 
column headers; for example, filtering and sorting functions. You can save these settings in 
your user settings. See also chapter Saving settings of query-based result tables (Page 167).

12.5.4 Using the status display

12.5.4.1 Activating and deactivating the status display

Requirements
See also chapter Requirements for COMOS operation (Page 127).
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Procedure
1. Select the "Status display" command from the context menu of the Navigator.

2. Select a status type.
If the status type works on the basis of objects, the status display is activated. 

3. If the status type works on the basis of queries, a submenu opens. Select which objects 
the status display and status management apply to:

Command Result
"Complete" The status display and status calculation cover all objects. 

The object status is loaded from the XML status file. The objects are 
colored according to their status. 
Objects still to be calculated are black.

"For current user" As above, but status display and status calculation only cover objects 
that you have changed.
Objects that you have not edited are counted as not calculated.   

"..." Opens the filter selection. If you select one of the filters prepared in 
the status query, the status display and status calculation only cover 
objects which correspond to the filter, e.g. only the incorrect objects. 
The rest of the objects are counted as uncalculated.

Note
"Status per XML file"

See also chapter Displaying status information in the status query (Page 293).

Result
The objects are colored according to their status in the following user interfaces:

● Navigator

● Queries

● Interactive reports

See also chapter Opening the legend for status display (Page 301).

If the engineering objects have been changed since the status was last set or calculated, the 
status values may no longer be current. Calculate the status of query-based status types again 
or check the status of object-based status types. See also chapters Calculating the status 
(Page 294) and Checking the object-based status (Page 296).

Deactivating status display
Select the "Status display > Switch off" command from the context menu of the Navigator.
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12.5.4.2 Opening the legend for status display

Requirements
● Status display is activated. See also chapter Activating and deactivating the status 

display (Page 299).
When status display is deactivated, you see the legend for working layer display and history 
display in the "Legend" window.

● See also chapter Requirements for COMOS operation (Page 127).

Procedure
Select the "Legend" command from the context menu of the Navigator.

Result
The "Legend" window opens. You see the color legend of the active status type. Here you can 
change the color settings. See also chapter Changing or resetting colors for the status 
values (Page 301).

See also
"Legend" window (Page 590)

12.5.4.3 Changing or resetting colors for the status values

Requirements
● Status display is activated. See also chapter Activating and deactivating the status 

display (Page 299).

● See also chapter Requirements for COMOS operation (Page 127).

Procedure
1. Select the "Legend" command from the context menu of the Navigator.

The "Legend" window opens.

2. Proceed as described for customizing the color of the working layer display mode. You can 
save your changes permanently in your user profile.
See also chapter Setting colors for the object status of the working layer display mode and 
the history display (Page 198).

Resetting values
Proceed as described for customizing the color of the working layer display mode. See also 
chapter Resetting the working layer display mode and the history display to the default colors 
(Page 200).
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See also
"Legend" window (Page 590)

12.6 Importing and exporting engineering objects
You can import and export engineering objects.

You can find additional information on this topic in the "Basic interfaces" manual, keyword 
"Engineering projects".

12.7 Properties of engineering objects

12.7.1 Structure of the properties of engineering objects

Call
Open the properties of an engineering object. See also chapter Opening properties 
(Page 171).
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Structure
Structure and content of the properties of an engineering object depend on the configuration 
of the base object. 
In principle, the properties have the following elements:

① Toolbar
See also chapter Toolbar for engineering objects (Page 304).

② General area
The content of the general area can also be integrated in the "General" tab.
See also chapter Area for general data (Page 305).

③ Subtabs
④ Standard buttons for saving and closing the properties

Subtabs
Which tabs you see depends on the configuration of the base object. There are usually the 
following tabs:

Tab Comment See also chapter ...
"General" The content of the tab can also be integrated into 

the general area.
Area for general data (Page 305)

"Attributes" Instead of being subtabs of the "Attributes" tab, 
the attributes can also be located on tabs on the 
first level.

 Editing attributes (Page 260)

"Elements" - Purpose of the "Elements" tab 
(Page 271) 
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Tab Comment See also chapter ...
"Connectors" - Purpose of the "Connectors" tab 

(Page 276)
"Status" Only relevant to object-based status types.  "Status" tab (Page 306)

Depending on the COMOS product, there may be further tabs.

12.7.2 Toolbar for engineering objects

Buttons on the toolbar

Icon Tooltip Description
 Opens a submenu with the same navigation commands as are available for 

the object in the Navigator. See also chapter Context menu in the Navigator 
(Page 165).

"Owner" Opens the properties of the owner. For engineering objects, this is deactivated 
directly under the project root.

"New; accept links and attrib‐
utes"

Creates a copy of the engineering object in parallel with the engineering object. 
See also chapter Creating a copy of an engineering object from the proper‐
ties (Page 246).

"Create base object 'Equipment 
Data'"
"Back to device request"

For working with product data and device requests when special or unique 
production is required
You can find additional information in the "EI&C Operation" manual, keyword 
"Creating a manufacturer device for a request".
Not available for all engineering objects.

"Released" and "Locked" Locks the object so that it cannot be changed any more, or releases it again. 
See also chapter Locking engineering objects (Page 256).

"Object locking" Only relevant for your system administrators.
You can find additional information on this topic in the "Administration" manual, 
keyword ""Object locking" and "System object" state".

"System object" Only relevant for your system administrator.
You can find additional information on this topic in the "Administration" manual, 
keyword ""Object locking" and "System object" state".
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Icon Tooltip Description
"Load/save scheme" Only for the "Connectors", "Menu", and "Wires" tabs 

Opens a menu which governs the scheme used for sorting and filtering the 
table:
● "Screen scheme"

– "Load"
Loads the saved scheme.

– "Save"
Saves the current scheme for the object so that it can be reused at the 
object.

– "Delete"
Deletes the scheme and uses the default scheme.

● "Scheme per object"
– Activated

The scheme saved for the object is loaded automatically.
– Deactivated

The default scheme is used. 
-  Buttons for filtering and sorting in the "Elements" and "Connectors" tabs. 

See also
Structure of the properties of engineering objects (Page 302)

12.7.3 Area for general data
See also chapter Structure of the properties of engineering objects (Page 302).

Requirements
The base object of the engineering object allows for a general area. You can find additional 
information on this topic in the "Administration" manual, keyword ""General (up) component"".

The content of the general area can also be integrated in the "General" tab.

Control elements
The content of this area depends on the configuration of the base object. Possible control 
elements:

Control element Description
"Name" field See also chapter Editing general data (Page 253).

 "Generate name/label automatically" 
button
"Label" field
"Description" field
"Folder" option See also chapter Declaring objects as folders (Page 255).
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Control element Description
"Alias" or "Original" fields See also chapter Setting general references (Page 257).
"Unit", "Position", "Function" or "Sig‐
nal" fields
"Location" field
"Request" field 
"Implementation", "Target" or "Cable 
route" fields
"Base object" field
"Set reference ..." button Next to "Base object" field

Opens the "Look up manufacturer device for" window.
You can find additional information on this topic in the "EI&C 
Operation" manual, keyword "Allocating a single device request 
to a manufacturer device".

<Object icon> Allows you to use drag&drop to move the engineering object to 
another area, for example into the start field of a query.
If you use drag&drop to move an object under this field, a link 
field with a corresponding link is displayed. 
Requirements: The engineering object uses the standard con‐
figuration of the database.

12.7.4 "Status" tab

Purpose
Users can manage the status of the engineering object by opening the "Status" tab.

User interface
Each status type has the following control elements:

Control element Description
<Name of the status> The description of the status base object under "@99 > A40 > Y10 Active 

status".
"Status value" field List of possible status values configured at the status base object.
"Set" button Checks the status value and sets a status value. See also chapter Setting the 

object-based status (Page 295).
"Check" button Checks the status value. See also chapter Checking the object-based status 

(Page 296).
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Creating and using documents 13
13.1 Creating Documents

13.1.1 Creating documents from a project structure

Requirements
Your project works with project structures. See also chapter Basic knowledge on project links 
(Page 30).

Methods for creating objects

Creating documents ... See also chapter ...
Via the area of the context menu dedicated to 
structure engineering using project structures
Knowledge of the project structure is not necessa‐
ry.

Creating documents from a project structure via 
the context menu (Page 308)  

Via the static new menu
Knowledge of the project structure is not necessa‐
ry.

Creating multiple objects via the static new menu 
(Page 241) 

External documents only: By dragging an existing 
file from the File Explorer

Creating external documents from a File Explorer 
using drag&drop (Page 310) 

Using imports Importing and exporting documents (Page 355) 
By copying Overview of the copy methods (Page 119) 

13.1.2 Free creation of documents

Requirements
If you want to create a document freely within the project structure, the following applies: The 
project structure allows you to create documents freely in the current node of the object tree. 
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Methods for creating objects

Creating a document ... See also chapter ...
Via the area of the context menu dedicated to free 
structure engineering

Creating documents freely via the context menu 
(Page 309) 

External documents only: By dragging an existing 
file from the File Explorer

Creating external documents from a File Explorer 
using drag&drop (Page 310) 

Using imports Importing and exporting documents (Page 355) 
By copying Overview of the copy methods (Page 119) 

13.1.3 Creating documents from a project structure via the context menu

Requirements
● A project is open. See also chapter Opening a project or the released area of a project 

(Page 185) and section Opening the working layers of a project (Page 193).

● An object is located on the "Units" or "Locations" tab in the Navigator which was created 
using a project structure. See also chapter Creating objects from a project structure 
(Page 233).

● There is a document prepared for the object in the project structure.

Procedure
1. Select the object.

2. Click on "New" in the context menu.
The submenu opens. All objects which are permitted under this object according to the 
project structure are displayed in the bottom half of the context menu.

3. Select a document.

Result
● The document is created. No further settings are normally required. For an overview of all 

configuration options, see also chapter Properties of document objects (Page 357).

● If the project works with a document group system, a reference document is automatically 
created on the "Documents" tab. See also chapter Automatic referencing of documents 
(Page 84).

See also
Basic knowledge on project links (Page 30)

Opening documents (Page 173)

Opening properties (Page 171)
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13.1.4 Creating documents freely via the context menu

Requirements
● A project is open. See also chapter Opening a project or the released area of a project 

(Page 185) and section Opening the working layers of a project (Page 193).

● An object has been created in the Navigator.

● If the object was created using a project structure, the following applies: The project 
structure allows documents to be created freely under the object. 
In this case, the node has the "New > General > New document" or "New > New document" 
context menu. 

Procedure
1. Select the object.

2. From the context menu, select the "New > General > New document" or "New > New 
document" command.
The tab with the document properties opens in the working area. 

3. Enter values in the "Name, "Label", and "Description" fields in the general area.

4. Select the desired document type from the "Type" list in the "General" tab. The document 
types are sorted by document type group. See also chapter Document types (Page 82).

Note
External documents

If you select an external document, you can only open the document if the corresponding 
program is installed. Example: Microsoft Word

5. To create an interactive or evaluating report, proceed as described below. For other 
document types, proceed as follows:

– Select the change tab. It has the same name as the document type.

– Activate one of the following options in the "Document" control group:

Activated option Description
"Normal" The document is created in COMOS.
"File link" The document is a link to a file from the file sys‐

tem. 
"Reference" The document is a link to a COMOS document.

– If you have activated the "File link" option, select the "..." button next to the "File name" 
field. Select a file with the appropriate file type from the file system.
If you have activated the "Reference" option, select the "..." button next to the "Template" 
field. Select a COMOS document with the appropriate document type.

6. Confirm your entries.
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Settings for interactive and evaluating reports
1. Select the "Report" tab.

2. Click the "..." button next to the "Report template" field.
The "Select report template" window opens.

3. Select a report template and confirm your entries.
Report templates for interactive reports have the following icon:

Report templates for evaluating reports have the following icon:

Result
● The document is created.

● You can no longer change the document type.

● No further settings are normally required. For an overview of all configuration options, see 
also chapter Properties of document objects (Page 357).

● If the document has the "Template" setting, you cannot save changes to the content.

● If the project works with a document group system, a reference document is automatically 
created on the "Documents" tab. See also chapter Automatic referencing of documents 
(Page 84).

See also
Change tab for evaluating reports (Page 361)

Opening properties (Page 171)

Opening documents (Page 173)

Change tab (Page 360)

13.1.5 Creating external documents from a File Explorer using drag&drop

Principle
You can import external documents from a File Explorer into COMOS using drag&drop. You 
create a copy or a link to the file. 

Which document type and which base object the resulting document has in COMOS depends 
on the database. You can find additional information on this topic in the "Administration" 
manual, keywords "Overview of document types in COMOS" and "DocumentTypeMapping".

Creating and using documents
13.1 Creating Documents

Operation
310 Operating Manual, 03/2017 V10.2.1, A5E37082875-AB



Requirements
● A project is open. See also chapter Opening a project or the released area of a project 

(Page 185) and chapter Opening the working layers of a project (Page 193).

● You have to have the same permissions for operations between different applications in 
either case.

● The following applies when importing a PDF file: If you want to make revisions to the file 
later in COMOS, the PDF file must not have been created with the Microsoft Office PDF 
printer.

Procedure
1. Open a File Explorer.

2. Drag&drop a file under the desired owner in the Navigator.
The "Navigator" window opens.

3. Select an import mode for the document:

– "Create copy"

– "Create link"

– "Create document with version management"
If you select this option, the "Create package" option is activated.

You can find additional information on this topic in the "Project Quality Management" 
manual, keywords "Importing documents using drag&drop", "Creating a DVM document 
package", and ""Navigator" window".

Result
● A document is created in COMOS. Depending on your entries, the document is either a 

copy of the file from the file system or a link to the file.

● If COMOS recognizes the file format, the new document has the corresponding document 
type; otherwise, it has the "General document" document type.

● If the project works with a document group system, a reference document is automatically 
created on the "Documents" tab. See also chapter Automatic referencing of documents 
(Page 84).

See also
Opening documents (Page 173)

Opening properties (Page 171)

Change tab (Page 360)
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13.2 Printing documents

Requirements
One or more documents have been created. See also Creating Documents (Page 307).

Overview
You have the following print options:

● Via the navigator: All documents selected there

● Using the "Print" tool: All or selected documents under a start object

● Via the document group: All documents in the document group

● From the open document
For reports: See also chapter Printing reports (Page 451).

You can print to a paper printer or to a file. If you print to a file, you export the document.

Via the navigator
1. Select the document(s) in the Navigator.

2. Select the following command from the context menu:

– To print the report with the default printer and print configuration: "Print"

– To select the printer and print configuration yourself: "Print ..."

3. If you have selected several documents, you must specify the sequence in which the 
documents are to be printed. See below.

Using the "Print" tool
1. In the menu bar, select the following command: "Documents > Print"

The "Print" tab opens. 

Note

The tab is based on a query. You can filter, sort, and export it. See also chapter Using 
"Simple" run mode (Page 460).

2. Set a start object using drag&drop.
You see all the documents below the start object.

3. Select the desired documents.

4. Click the "Execute" button.

5. If you have selected several documents, you must specify the sequence in which the 
documents are to be printed. See below.

6. Select a printer and the print configuration in the "Print" window.

7. Confirm your entries.
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Alternatively: Use the tool "All document tools". See also chapter Working with the tool "All 
document tools" (Page 316).

Printing all documents in a document group
1. Select the document group.

2. Select the following command from the context menu:

– To print the documents with the default printer and print configuration: "Print"

– To select the printer and print configuration yourself: "Print ..."

3. Specify the sequence in which the documents are to be printed. See below.

Specifying the print sequence
When you print multiple documents at once, you need to set the print sequence of documents:

Option Print sequence
"COMOS sequence (recommended)" By COMOS internal sorting
"Selection" The sequence in which the documents were se‐

lected

Result
The documents are printed as you have specified. Reports with the same print options which 
are sent as consecutive print jobs are merged into one job. See also chapter Print jobs 
(Page 102).

The format in which reports are printed depends on the configuration of the database. You can 
find additional information on this topic in the "Administration" manual, keywords "PaperSize" 
and "Printing.config".

The following options are available:

● If the configuration of the report defines a specific output format, this format is used. If this 
format is not available, the closest suitable format is selected.

● The closest suitable format is selected.

● The standard printing behavior is executed. The standard behavior corresponds to the 
behavior for printing open reports. See also chapter Printing reports (Page 451).

Other print options
● Printing document revision files

See also chapter Overview of printing and exporting revision files (Page 337).

● Printing documents with the current revision printer
See also chapter Printing documents with revision printer (Page 315).
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Administering printing
You can find additional information on this topic in the "Administration" manual, keyword 
"Preparing printing"

See also
Document groups (Page 85)

Reference of the "Print" tab (Page 314)

13.3 Reference of the "Print" tab

Requirements
● The tab has been opened:

COMOS menu: "Documents > Print"
See also chapter Printing documents (Page 312).

● Alternatives in the COMOS menu "Documents":
The functions described here are also used at the following tabs:
"Evaluate"
"Revision"
"DWG/DXF export"
"Word export"
"Excel export"
"PDF export"
"Copy TIFF/PD file of the released revision"
"Print current revision file"
"Print with revision printer"
"All document tools"

User interface
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Meaning of the user interface elements
● Start object(s)

A COMOS object from the object tree in the Navigator

Column in the query Meaning
Owner The owner of the object from the "Document" column.

This is specified as SystemFullName with delimiter.
Document The listed document object.
Description Description of the object from the "Document" column
Revision The current revision status of the document.
Documents status Status of the respective interactive report.

● "0 - Consistent" (corresponds to error code DocError_NoError)
● "1 - Inconsistent" (corresponds to error code 

DocError_ContainsInconsistentObjects)
● "2 - No evaluation" (corresponds to error code DocError_NotEvaluated)
● "3 - Copied" (corresponds to error code DocError_Copied)

The report has been copied, but not yet opened. When you open the 
report, there is a prompt asking you where the objects generated by the 
report are to be stored.

● "Not a ComosIReport"
No document status available because the document is not an interactive 
report.

Document type You can find additional information on this topic in the "COMOS Administra‐
tion" manual, keyword "Overview of the document types in COMOS".

13.4 Printing documents with revision printer

Procedure
1. Select the "Documents > Print with revision printer" command in the menu bar.

The "Print with revision printer" tab opens.

Note

The tab is based on a query. You can filter, sort, and export it. See also chapter Using 
"Simple" run mode (Page 460).

2. Set a start object using drag&drop.
You see all the documents below the start object.

3. Select one or more documents.

4. Click the "Execute" button.
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5. If you have selected several documents, you must specify the sequence in which the 
documents are to be printed:

– "COMOS sequence (recommended)" option: By COMOS internal sorting

– "Selection" option: The sequence in which the documents were selected

The "Export of revision" window opens.

6. Activate one of the following options:

– "Without subdirectories"

– "With subdirectories"

– "In a file"

– "With file name for the revision export of the document (SYS.ExportRevFileName)"

See also chapter "Print with revision printer" and "Export of revision" windows (Page 588).

7. Optional: To change the default directory to which the documents are printed, click on the 
"..." button. If the "In a file" option is activated, you can redefine the default name of the file.

8. Confirm your entries.

Result
The documents are printed with the revision printer. You receive a file based on the current 
working state of the document. The file is not a revision file or a copy of a revision file.

See also
Overview of printing and exporting revision files (Page 337)

Printing documents (Page 312)

Working with the tool "All document tools" (Page 316)

13.5 Working with the tool "All document tools"

Introduction
With the tool "All the document tools" you can edit one or more documents below the same 
start object.

Requirements
There are objects and documents created in the Navigator. See also chapter Creating 
engineering objects (Page 233) and chapter Creating Documents (Page 307).
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Procedure
1. In the menu bar, select the following command: "Documents > All document tools"

The "All document tools" tab opens.

Note

The tab is based on a query. It uses extended run mode. You can change the search 
settings and filter and sort the results list as is usual in this run mode. You can find additional 
information on this topic in the "Administration" manual, keyword "Customizing the Object 
Browser in advanced run mode".

2. Set a start object using drag&drop.
You see all the documents below the start object.
You can configure the search settings. See also chapter Setting the search options for the 
tool "All document tools". (Page 319).

3. Select the desired documents.
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4. Click on a tool in the toolbar.
The tool is started and applied to the selected documents.
The following document tools are available:

Icon Button/Tool Alternative methods/See also chap‐
ter ...

"Print selected documents ..."1 Printing documents (Page 312) 
Printing reports (Page 451)

"Evaluate documents ..."2 Updating reports (Page 450) 
"Revision ..."1 Carrying out single revisions in bulk 

(Page 324) 
"DWG/DXF export ..."2 You can find additional information on 

this topic in the "Basic interfaces" man‐
ual, keyword "Exporting and importing 
DWG/DXF files".

"Copy TIFF/PDF file of the released revision ..."1 Printing or exporting current revision 
files (Page 338)

"Word export ..."2 You can find more information on this 
topic in the "Basic interfaces" manual, 
keyword "Exporting reports to Word".

"Excel export ..."2 You can find more information on this 
topic in the "Basic interfaces" manual, 
keyword "Exporting reports to Excel".

"PDF export ..."2 You can find more information on this 
topic in the "Basic interfaces" manual, 
keyword "Exporting a report as a 
PDF".

"Print current revision file ..."1 Printing or exporting current revision 
files (Page 338)

"Print with revision printer"1 Printing documents with revision print‐
er (Page 315) 

"Checking interactive reports for inconsistent 
DocObjects"3

The tool offers two functions:
● "Show documents with inconsistent DocObj 

in error list"
● "Delete all inconsistent DocObjs"

Checking contents and correcting in‐
consistencies (Page 443) 

1 : For all printable documents
2 : Only for reports
3 : Only for interactive reports 

5. To cancel the action, click the "Stop" button in the toolbar:
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Hiding/showing extended tools
You can show or hide the tools in the toolbar, except for the "Print selected documents ..." tool. 
Proceed as follows:

1. Click the "Options" button on the toolbar:

2. Activate or deactivate the "Activate extended functions" option.

3. Confirm your entries.

13.6 Setting the search options for the tool "All document tools".

Requirements
The tool "All the document tools" is open. See also chapter Working with the tool "All document 
tools" (Page 316).

Procedure
1. Click the "Options" button on the toolbar:

2. Activate the required options in the "Options" window:

Option Description
"Search documents below documents" Activated: Documents that are located below the 

other documents are also displayed. 
Deactivated: When a document has been found, 
there is no further searching below the docu‐
ment.

"Search documents below revisions (TIFF docu‐
ments)"

If the administrator has made the corresponding 
setting in the project properties, TIFF documents 
are printed and found.

"Autom. links to 'Document with location and unit 
pointer'"

Documents can have a pointer to a unit and/or a 
location. This also produces a return reference. 
Activated: The return references are evaluated. 

"Autom. links to 'Engineering object with location 
and unit pointer'"

Activated: Links to engineering objects are 
traced and the search for documents is contin‐
ued there. 

3. Confirm your entries.
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13.7 Revising and signing

13.7.1 Revision process

Requirement
● Familiar with fundamentals of document revisions.

See chapter Fundamentals of document revisions (Page 104).

General sequence
1. You complete a document, e.g. a circuit diagram.

2. You create a revision and execute the first revision step.
See also the following chapters: 

– Carrying out single revisions (Page 322)

– Carrying out single revisions in bulk (Page 324)

– Performing group revisions (Page 325)

If the "Create PDF file at first step" setting is activated in the project properties, a PDF 
revision file is created.

3. You inform the colleague responsible for checking.

4. The colleague checks the working state of the document. 
See also chapter Checking the working state of documents (Page 328).

5. When Redlining is used: The checker enters their corrections in the Redlining file.
See also chapter Working in Redlining files (Page 335).
Without Redlining: The checker sends you their corrections in another way.

6. The checker carries out the "Checked by" revision step.
See also chapter Carrying out revision steps (Page 327).

7. You correct the document.
If revision monitoring is switched on, the revision is created automatically.

8. If revision monitoring is switched off, you create a new revision.  

9. You carry out the first revision step.

10.You inform the colleague responsible for checking.

11.If the colleague does not find any more errors, they release the revision. 
If the "Create PDF file at first step" setting is deactivated in the project properties or the 
TIFF printer is selected, the revision file is only created at this point.
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Sequence when using working layers
If revisions are made to a document in several layers, inconsistencies can occur when the 
working layer is released. For this reason, COMOS prevents the creation or continuation of 
unit revisions in certain cases. See also chapter Unit revisions and project revisions 
(Page 110).

When working layers are used, the following, therefore, applies: 

Working layer "A" has ... Rule
Subordinate working layers As soon as you make revisions in a subordinate 

layer, revisioning for working layer "A" is locked.
Parallel working layers As soon as you make revisions in working layer 

"A", revisioning in the other parallel layers is locked 
until working layer "A" is released.

See also
Requirements for revisioning (Page 321)

General information about revisioning (Page 104)

Technical information about the revision process (Page 106)

13.7.2 Requirements for revisioning

General requirements
● A project is open. See also chapters Opening a project or the released area of a project 

(Page 185) and Opening the working layers of a project (Page 193).

● There are printable documents in the project. See also chapter Creating Documents 
(Page 307).

● You have write rights for the documents.

● You have the object rights for revisioning.

● The printer set in the project properties in the revision archive is installed on your computer.

Requirements for unit revisions
● The project configuration supports unit revisions.

● For carrying out unit revisions manually: You are not working with project revisions.

● If the project works with unit revisions and project revisions: The documents are referenced 
in the "@NameSystem" document group on the "Documents" tab.
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Requirements for project revisions
● The project configuration supports project revisions and unit revisions

● The documents are referenced in a document group from the "@Project" branch on the 
"Documents" tab. 

Requirements for group revisions
● The document group is located in the Navigator on the "Documents" tab in one of the 

following branches:

– For unit revisions: "@NameSystem" 
If there is only one document group on the "Document group" tab on the first level below 
the project root, it can have any name.

– For project revisions: "@Project"

● The document group contains references to original documents from the unit view or 
location view. 

Administration of revisions
You can find additional information on this topic in the "Administration" manual, keyword 
"Configuring revisions".

See also
Referencing documents in document groups (Page 340)

13.7.3 Carrying out single revisions
The complete revision sequence is described below. To continue an open revision, leave out 
step 4.

Requirements
See also chapter Requirements for revisioning (Page 321). The following also applies:

● Revisioning the document is not locked by a revision from a subordinate or parallel working 
layer. See also chapter Unit revisions and project revisions (Page 110).

● To create a new revision or continue an open revision or revision file: The document is not 
part of a group revision which is still a * revision.

● You have a good knowledge of the associated user interface. See chapter 
AUTOHOTSPOT.
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Procedure
1. Open the properties of the document.

2. Select the "Revisions" tab.

3. Depending on the project configuration, the following applies: 

– If the project supports project revisions, activate the "Project revision" option.
The revision table shows the project revisions of the document. 

Note
No manual unit revisions

Unit revisions are created automatically and not by you. See also chapter Unit revisions 
and project revisions (Page 110).

 If you activate the "Unit revision" option, you see in the revision table whether the 
document already has a unit revision.

– If the project is working without project revisions, you always see the unit revisions of 
the document. 

4. Click the "Creates a new revision" button in the toolbar:

A * revision is created. 

5. Optional: Edit the label and description of the revision or of the next revision step. 
See also chapter Editing revision properties (Page 329).

6. Carry out the revision steps. 
See also chapter Carrying out revision steps (Page 327).

Result
Depending on the project configuration, the revision file is created at the first or last revision 
step. If you have carried out a project revision, the unit revision is automatically created at the 
last step.

You have the following options:

● Display revision file
See also chapter Viewing revision files and Redlining files (Page 333).

● Print out or export revision file
See also chapter Overview of printing and exporting revision files (Page 337).

● If the revision file is a PDF: Insert Redlining markings
See also chapter Working in Redlining files (Page 335).

See also
Single revisions and group revisions (Page 109)
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13.7.4 Carrying out single revisions in bulk

Requirements
See also chapter Requirements for revisioning (Page 321).

Procedure
1. Select the "Documents > Revision" command in the menu.

The "Revision" tab opens.

Note

The tab is based on a query. You can filter, sort, and export it. See also chapter Using 
"Simple" run mode (Page 460).

2. Set a start object using drag&drop.
You see all the documents below the start object.
The "Revision" column contains the following information separated by ";":

– Index, label, and description of the current revision

– Name, label, and description of the most recently performed revision step in the following 
notation:
<Name>:<Label>/<Description>

3. Select the desired documents.

4. Click the "Execute" button.

5. If you have selected several documents, you are prompted to specify the sequence in which 
the documents are to be revisioned:

Option Sequence.
"COMOS sequence (recommended)" By COMOS internal sorting
"Selection" The sequence in which the documents were se‐

lected

6. Confirm your entries.
The "Revision" window opens.

7. Select a revision step.

Note
Carrying out several steps at once

You can select one of the later steps instead of the next revision step. The steps are then 
carried out one after another.
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8. Optional: Click the ">>" button. You can make the following settings:

– "Sign revisions as a batch" option 
Activated: You sign for all revisions and revision steps at once.
Deactivated: If a revision file already exists, it is displayed for review for each revision 
before the step is carried out. You sign each revision step for each revision individually.

– "Revision label" and "Revision description" fields: You can overwrite the automatically 
generated values in the first revision step.

– "Revision step label" and "Revision step description" fields: You can overwrite the 
automatically generated values.

Note

If you execute several revision steps at once, you can only enter the revision step label 
and the revision step description for the next step. They are generated automatically for 
the subsequent steps.

9. Confirm your entries.

Result
● The revision step(s) are carried out for the selected documents. If a document already has 

an open revision, this is continued. If the open revision already has the selected revision 
steps, they are skipped. If a document does not have an open revision, one is created.

● The following documents are not revisioned:

– Documents whose open revision is part of a group revision

– Documents which are locked for revisioning due to a revision from a subordinate or 
parallel working layer
See also chapter Unit revisions and project revisions (Page 110).

● If the revisioning is linked to a security certificate, you are prompted to sign the revision 
steps. See also chapter Signing revisions electronically (Page 330).

● The result of the execution is summarized in a message.

Alternative
Use the tool "All document tools". See also chapter Working with the tool "All document 
tools" (Page 316).

See also
Viewing revision files and Redlining files (Page 333)

13.7.5 Performing group revisions
The complete revision sequence is described below. To continue an open group revision, leave 
out step 4. 
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Requirements
● See also chapter Requirements for revisioning (Page 321). 

● The documents in the document group are not locked for revisioning due to a revision from 
a subordinate or parallel working layer. See also chapter Unit revisions and project 
revisions (Page 110).

Procedure
1. Open the properties of the document group.

2. Select the "Revisions" tab.

3. Depending on the project configuration, the following applies: 

– If the project supports project revisions, activate the "Project revision" option.
The revision table shows the project revisions of the document group. 

Note
No manual execution of unit revision

Unit revisions are created automatically and not by you. See also chapter Unit revisions 
and project revisions (Page 110).

 If you activate the "Unit revision" option, you see in the revision table whether the 
document already has a unit revision.

– If the project only works with unit revisions, you always see the unit revisions of the 
document group.

4. Click the "Creates a new revision" button:

Result:

– The group revision is created and the first revision step is carried out.

– After which step the index and revision files are created depends on the project 
configuration. See also chapter Technical information about the revision process 
(Page 106).

5. Optional: Edit the label and description of the revision or of the next revision step. 
See also chapter Editing revision properties (Page 329).

6. Carry out the rest of the revision steps. See also chapter Carrying out revision steps 
(Page 327).

Result
A revision is created and executed for each participant in the group revision in the same way 
as for single revisions. See also chapter Carrying out single revisions (Page 322).

To see a revision file, select the reference below the document group and select the "Properties 
of the original document" command in the context menu.
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Revisioning a document group for the first time
When a document group is revisioned for the first time, all documents participate in the revision, 
even if the "Revision all documents" option is deactivated in the document group and the 
documents have not been changed.

See also
Single revisions and group revisions (Page 109)

Viewing revision files and Redlining files (Page 333)

13.7.6 Carrying out revision steps
The following chapter applies for single revisions and group revisions. For information on bulk 
single revisions, see chapter Carrying out single revisions in bulk (Page 324).

Requirements
● Properties of a document or a document group: "Revisions" tab is visible.

● The document or documents in the document group have an open revision. See also the 
following chapters:

– Definition: Completed, open, and * revisions (Page 108)

– Carrying out single revisions (Page 322)

– Performing group revisions (Page 325)

● You have checked the working state of the document or documents. See also chapter 
Checking the working state of documents (Page 328).

Procedure
For each revision step, proceed as follows:

1. Optional: Edit the label and description of the revision step. 
See also chapter Editing revision properties (Page 329).

2. Click on the arrow next to the following button: 

You see a menu with the revision steps:

Steps which have already been executed are locked. The next step in the revision process 
is marked with a dot.
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3. Select a revision step.

Note
Carrying out several steps at once

If you select one of the subsequent steps instead of the step marked with a dot, the steps 
are carried out one after the other.

4. If the revisioning is linked to a security certificate, you set your electronic signature. 
See also chapter Signing revisions electronically (Page 330).

Result
The step is carried out. After which step the revision file is created depends on the project 
configuration. See also chapter Technical information about the revision process (Page 106).

See also
Checking the signature (Page 332)

13.7.7 Checking the working state of documents
Before you carry out a revision step, check the working state of the document. The procedure 
depends on whether a revision file already exists.

Procedure with revision file
1. Open the properties of the document.

2. Select the "Revisions" tab.

3. Open the revision file. For PDF revision files, you can also open the Redlining file. See also 
chapter Viewing revision files and Redlining files (Page 333).

The revision file is opened. You can print it or export it to a file via printing. See also chapter 
Overview of printing and exporting revision files (Page 337).

You can insert comments and mark errors in the Redlining PDF. See also chapter Working in 
Redlining files (Page 335).

Procedure without revision file
Select "Open read only" in the context menu of the document. Check the working state of the 
document.
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13.7.8 Editing revision properties

Introduction
When making revisions via the properties of a document or a document group, you have the 
following options:

● In all open revisions: Overwrite the automatically generated revision description.

● In * revisions: Overwrite the automatically generated revision label.

● For all revision steps: Overwrite the automatically generated revision step label and the 
revision step description.

Note
Special features
● If a document is part of a group revision, you can only change this information via the 

document group. The change applies to all revisions in the group revision.
● If you execute several revision steps at once, you can only enter the revision step label and 

the revision step description for the next step. They are generated automatically for the 
subsequent steps.

Requirements 
● For changing the revision label: The project properties are configured accordingly. You can 

find additional information on this topic in the "Administration" manual, keyword ""Revision 
label editable during the complete revision operation" option".

● Properties of a document or a document group: The "Revisions" tab is available.

● There is an open revision. See also the following chapters:

– Definition: Completed, open, and * revisions (Page 108)

– Carrying out single revisions (Page 322)

– Performing group revisions (Page 325)
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Procedure
1. Select a revision in the revision table.

2. If the revision properties are not displayed, click on the "Show/hide revision properties" 
button in the toolbar:

Your entries are automatically adopted by the revision table. 

3. Enter the required values in the following fields:

– "Label"

– "Revision description" 

– "Revision step label" 

– "Revision step description" 

If you carry out the next revision step immediately afterward, it adopts your entries.

13.7.9 Signing revisions electronically
See also chapter Security certificate (eSign) (Page 113).

Requirements
● The project configuration couples the revisioning to an electronic signature, which is linked 

to a security certificate. You can find additional information on this topic in the 
"Administration" manual, keyword "Managing eSign".

● You have a valid security certificate (PFX file).

● You have pressed the button to execute a revision step. See also chapter Carrying out 
revision steps (Page 327) and chapter Carrying out single revisions in bulk (Page 324). 

Procedure
The "Signature" window opens. Proceed as follows:

1. When you use an electronic signature for the first time, you select a security certificate as 
follows:

– Click the ">>" button.

– Click the "..." button next to the "Certificate" field.

– Select the certificate from your file system and confirm your entry.

2. Optional: Click on the ">>" button and enter a location.

3. Enter the password.

4. Click the "Sign" button.
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Result
The following applies to electronically signed steps: 

● If you open the revision file at a time when displaying the signature on the revision file is 
supported by the project properties, the step is visualized on the revision file. By default, it 
is stamped diagonally at the top left of the document.

● You can check at any time whether the revision file has been changed since the signature 
was set. See also chapter Checking the signature (Page 332).

See also
"Signature" window (Page 331)

13.7.10 "Signature" window

Call
See also chapter Signing revisions electronically (Page 330).

Structure
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The window has the following control elements:

Control element Description
"Password" field Field for entering the password of the PXF security 

key.
If the field is empty or contains an incorrect pass‐
word, it is red.

Button ">>" or "<<" Shows or hides the control elements marked with 
*.

Button "Reject" Cancels the signature.
Button "Sign" Signs the revision step.
"Name" field* Name of the signer

Is read out automatically from the certificate after 
the password has been entered.

"Date" field* Set automatically.
Current date and time

"Location" field* Enter a location.
"Certificate"* The certificate

If the field is empty, select your PXF file by using 
the button "...".

"Show certificate" button* Shows details of the certificate.
Only available if the password was entered.

"Cancel" button* Standard button

13.7.11 Checking the signature

Principle
The eSign signature stores security information. You can use this information to check in the 
properties of a document whether the revision file has been changed since the signature was 
set.

Check the signature if revision monitoring is switched off.

Requirements
● The properties of a document are open.

● The document has been revisioned. See also the following chapters:

– Carrying out single revisions (Page 322)

– Carrying out single revisions in bulk (Page 324)

– Performing group revisions (Page 325)

● The revision steps have been signed. See also chapter Signing revisions electronically 
(Page 330).
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Procedure
1. Select the "Revisions" tab.

2. Select a revision step in the revision table.

3. Select the "Signature > Verify signature ..." command in the context menu.
The file hash of the revision file is compared to the file hash saved in the signature attribute 
and the security certificate is checked. You can see the result in the "Check signature" 
window: 

4. Optional:

– Click the "Show certificate" button to view the details of the certificate. 

– To view the details of the file hash, activate the "Data" option. 
Invalid values are displayed in red.

See also
Carrying out revision steps (Page 327)

13.7.12 Viewing revision files and Redlining files

Requirements
● Properties of a document > "Revisions" tab is visible.

● The document has a revision with a revision file.
See also chapters Carrying out single revisions (Page 322), Carrying out single revisions 
in bulk (Page 324), and Performing group revisions (Page 325).

● For displaying redlining files: The project settings support redlining.
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Alternative 1: "Revision" tab of the document
You have the following options:

● Double-click on the revision file of the revision in the "Revision archive" column in the 
revision table.
If redlining is set as the start mode in the project settings, the redlining file opens in a new 
header; otherwise, the revision file opens.

● If redlining is not set as the start mode in the project settings, select a revision and click on 
the arrow next to the "Displays the selected revision" button in the toolbar of the revision 
table:

– To open the redlining PDF, select the "Display revision document with redlining" 
command.

– To open the revision PDF, select the "Display revision document without redlining" 
command.

You can insert comments and mark errors in the redlining PDF. See also chapter Working in 
Redlining files (Page 335).

Alternative 2: "Revision" tab of the document group
1. Open the properties of the document group.

2. Select the "Revisions" tab.

3. Note the index number of the group revision.

4. Open the properties of the individual documents. 

5. Select the "Revisions" tab.

6. Search for the revision in the revision table with the index number of the group revision.

7. Proceed as described for alternative 1.

Alternative 3: Display redlining comments in the report
1. Open the report.

If redlining comments exist for a revision, the latest redlining comments are automatically 
displayed.

2. Optional: Display older version of the redlining comments

– Click in the white area of the open report.

– Select the "Show redlining > " command in the context menu.
All versions of the redlining comments are shown in the context menu.

– To hide the redlining comments, select "Show redlining > None" in the context menu. 
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Note
Redlining comments moved in the report

The position of the redlining comments in the report deviates from the position of the redlining 
comments in the open revision file. Reason:

When the revision is printed, depending on the setting, the revision printer generates an 
additional margin. The margin is always generated when the print area is set smaller than the 
page format or the paper format. If you now place redlining comments, the position of the 
redlining comments is calculated relative to the print area. When the report is opened, the 
original position of the redlining comments is used and the redlining comments are shown at 
a different location due to the missing margin.

See also
Redlining (Page 112)

13.7.13 Working in Redlining files

Requirements
● Properties of a document > "Revisions" tab is visible.

● The document has a completed revision with a PDF revision file. 
See also chapters Carrying out single revisions (Page 322), Carrying out single revisions 
in bulk (Page 324), and Performing group revisions (Page 325)

● The project settings support redlining. You can find additional information on this topic in 
the "Administration" manual, keyword "Administration of redlining".

Procedure
1. Open the redlining file. See also chapter Viewing revision files and Redlining files 

(Page 333).
An interactive report with restricted functionality opens. Its background image shows the 
content of the revision file. 

2. To place an error, proceed as follows:

– Click the following button in the toolbar: 

– Place the error by left-clicking on the working area.
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3. To place a note, proceed as follows:

– Click the following button in the toolbar: 

– Place the note by left-clicking on the working area.

– Right-click on an empty space in the working area.

– Left-click twice on the note.
An edit field opens.

– Enter the note.

4. Confirm your entries.

Result
You can print the open redlining file or display it again later. 

If the revision is completed and users open the report, they see the contents of the redlining 
file in the working area.

See also
Redlining (Page 112)

13.7.14 Add documents to revision

Requirement
● Familiar with the "Revisions" tab.

See chapter User interface of the "Revisions" tab (Page 363).

Objective
You can add documents to a revision without changing the revision file. The added documents 
are sorted into two lists. There are no technical limitations regarding the file types that can be 
added to each list. The following distribution of documents is recommended with regard to 
content:

● "Additional documents"
Documents that describe the purpose and conditions of the revision, for example, as XML 
files or .xls files.

● "Redlining documents"
Documents that describe the quality of the revision, for example, as PDF documents with 
redlining comments.

The added documents are read-only in COMOS.

You can find additional information on this topic in the "COMOS Administration" manual, 
keyword "Controlling additional documents of revisions through base objects".
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Procedure
1. Click on one of the two buttons:

– "Additional documents"
The "Add additional document" window opens. You can see the documents that have 
already been added to this list.

– "Redlining documents"
The "Add redlining documents" window opens. You can see the documents that have 
already been added to this list.

2. Optional: Check or edit the properties of the documents already added

– Select an entry in the list

– Select the "Properties" command in the shortcut menu.
You can find additional information on this topic in the "COMOS Administration" manual, 
keyword "Controlling additional documents of revisions through base objects".

– Editing the properties

3. Select one of the following options:

– "Import"
Adds a file to the revision in COMOS.

– "Export"
Exports the selected document.

– "Delete"
Deletes the selected document. The document is not physically deleted immediately, 
but it is initially only assigned the "Deleted" status.

– "Show deleted files"
This button displays the documents that have the "Deleted" status.

4. Confirm your entries.
An icon appears in the "Additional documents" or "Redlining documents" column in the 
"Revisions" tab, if there is at least one document in the respective list. This may also be a 
document with the "Deleted" status.

13.7.15 Overview of printing and exporting revision files

Requirements
● A project is open. See also chapters Opening a project or the released area of a project 

(Page 185) and Opening the working layers of a project (Page 193).

● There are revisioned documents in the project. See also the following chapters:

– Carrying out single revisions (Page 322)

– Carrying out single revisions in bulk (Page 324)

– Performing group revisions (Page 325)
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Principle
You have the following options:

● Print revision files on paper or print to a file (export)

● Print the current revision files or any other revision file

See also chapters Printing or exporting current revision files (Page 338) and Printing any 
revision files (Page 340).

You can also print documents with the active revision printer. See also chapter Printing 
documents with revision printer (Page 315).

See also
Working with the tool "All document tools" (Page 316)

13.7.16 Printing or exporting current revision files

Requirements
See also chapter Overview of printing and exporting revision files (Page 337).

Printing or exporting current revision files
1. Select the "Documents > Print current revision file" command in the menu bar.

The "Print current revision file" tab opens.

Note

The tab is based on a query. You can filter, sort, and export it. See also chapter Using 
"Simple" run mode (Page 460).

2. Set a start object using drag&drop.
You see all the documents below the start object.

3. Select one or more documents.

4. Click the "Execute" button.

5. If you have selected several documents, you must specify the sequence in which the 
documents are to be printed:

– "COMOS sequence (recommended)" option: By COMOS internal sorting

– "Selection" option: The sequence in which the documents were selected

The "Print" window opens.

6. Select the print settings:

– To export the revision files to a file, select a PDF printer. 
The file is saved in the document directory of your Windows user profile.

– To print out the revision files, select a paper printer.
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The revision files are printed on paper or to separate files.  

Exporting with extended settings
1. Select the "Documents > Copy TIFF/PDF file of the released revision" command in the 

menu bar.
The "Copy TIFF/PDF file of the released revision" tab opens.

Note

The tab is based on a query. You can filter, sort, and export it. See also chapter Using 
"Simple" run mode (Page 460).

2. Set a start object using drag&drop.
You see all the documents below the start object.

3. Select one or more documents.

4. Click the "Execute" button.

5. If you have selected several documents, you must specify the sequence in which the 
documents are to be printed:

– "COMOS sequence (recommended)" option: By COMOS internal sorting

– "Selection" option: The sequence in which the documents were selected

The "Export of revision" window opens.

6. Activate one of the following options:

– "Without subdirectories"

– "With subdirectories"

– "In a file"

– "With file name for the revision export of the document (SYS.ExportRevFileName)"

See also chapter "Print with revision printer" and "Export of revision" windows (Page 588). 
Confirm your entries.

7. Optional: To change the default directory, click on the "..." button. If the "In a file" option is 
activated, you can redefine the default name of the file.

The revision files are printed to files according to your settings.

Alternative
Use the tool "All document tools" and the tool it contains, the "Print current revision file" tool, 
and "Copy TIFF/PDF file of the released revision". See also chapter Working with the tool "All 
document tools" (Page 316).
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13.7.17 Printing any revision files

Requirements
See also chapter Overview of printing and exporting revision files (Page 337).

Procedure
1. Open the properties of a document with revisions.

2. Select the "Revisions" tab.

3. To print a unit revision, activate the "Unit revision" option; for a project revision, activate the 
"Project revision" option.

Note
Project revision not configured

If the project configuration does not allow for project revisions, you will not see these 
options. There are only unit revisions.

4. Select a revision in the revision table.

5. Click the "Prints the selected revision" button in the toolbar of the tab:

The "Print" window opens.

6. Select the print settings: 

– To export the revision files to a file, select a PDF printer. 
The file is saved in the document directory of your Windows user profile.

– To print out the revision files, select a paper printer.

The revision files are printed on paper or to separate files.  

Alternatively: print from an open revision file or Redlining file.

13.7.18 Referencing documents in document groups

Initial situation
For revisioning to work, the documents must be referenced on the "Documents" tab in the 
document groups in the "@NameSystem" or "@Project" branch. As a general rule, the 
document groups already exist when you begin your project work. In this case, the documents 
are automatically referenced in the document groups when they are created or edited. 

If the document groups were created after the documents were created and edited, they are 
empty to begin with. You create the references manually.
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Procedure
1. Select a document group. 

2. Select the "Create references" command from the context menu. 

The documents checked into the working layer from the unit view and location view are 
automatically referenced in the document group.

13.8 Change display for revised reports
See chapter Change display for revised reports (Page 116).

13.9 Using the full-text search

13.9.1 Requirements for using the full-text search

Requirements
The working layer you are searching in has a full-text index. If you are searching across layers, 
the following layers must have an index to produce a complete search result:

● The current layer

● All superordinate layers

● The released area

Note
Updating the index

The full-text index is updated automatically. However, it may be expedient to update the index 
manually once in a while.

You can find additional information on this topic in the "Administration" manual, keyword 
"Preparing a full-text search for document contents".

See also
Using a content-based search (Page 344)

Using revision search (Page 345)

Fundamentals of full-text search for documents (Page 99)
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13.9.2 "Options" tab of the full-text search

Call
"Plugins > Basic > Full-text search" menu

Buttons on the toolbar

Icon Tooltip Description
 "Save settings" To save the selected options.

"Restore default" To restore the default settings.

"Help" Opens a help with information about the search 
options.

Control elements of the tab
"Search range" control group:

Option Description 
"Documents and Revisions" Activated: 

● Acquired results with content-based search:
– Documents
– Revisions of documents 

● Acquired results with revision search:
– Revisions of documents

"Revisions" Activated: Only the revisions of documents are listed as hits. 
"Only current revisions" Requirements: "Revisions" option is activated.

Activated: 
● Only the last project revision and the last unit revision are listed 

as hits. 
● The search rate decreases.  

"Documents" Activated: 
● Content based search: Only documents are listed as hits. 
● Revision search: Only revisions are found

"Search logic" control group:

Option Description 
"At least one of the strings" Activated: The search keys are linked with "OR". This means that 

documents or revisions are found if they contain at least one 
search key.

"All strings" Activated: The search keys are linked with "AND". This means that 
documents or revisions are found if they contain the specified 
words exactly.

"Boolean search" Activated: You can use Boolean operators during the search. 
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"Search precision" control group:

Option Description 
"Normal" Activated: The search key must be at the beginning of the word 

that is found.
Example: If you enter the word "fuse", "fuse-switch" is also found.

"Exact search" Requirements: The following options from the "Search logic" con‐
trol group are activated:
● "At least one of the strings"
● "All strings"
Activated: The search key must be found as a whole word.
Example: If you enter the word "fuse", "fuse-switch" is not found. 

"Substring search *" Requirements: The following options from the "Search logic" con‐
trol group are activated:
● "At least one of the strings"
● "All strings"
Activated: 
● A placeholder is added before and after the search key so that, 

for example, the word "test" is also found in the string "123test-
term".

● The search rate decreases.  
"Fuzzy search *" Activated: The search key is found even if it is misspelled.

You can define the degree of permissible deviation in the "Fuzzi‐
ness level (1-10)" field. The search rate decreases.  
The underlying search algorithm delivers the best results for Eng‐
lish texts.
Example: "center" and "centre"

"Research results" control group:

Option Description 
"Max. number of returned hits *" ● Defines how many rows of hits appear on one page. 

● Empty or "0": The number of hits is unlimited. 
● If you limit the number of hits, the time taken for the first page 

to be displayed will be shorter. Hits for one document may be 
split over several pages.

"Show message if more hits are 
available than displayed" 

Activated:  If the number of results found for the search key ex‐
ceeds those displayed on the first page, a message is displayed.

"Parameter of the used index" control group:

Option Description 
"Inclusion filter" You can find additional information on this topic in the "Adminis‐

tration" manual, keyword "Creating the full-text search index"."Exclusion filter"

"Index info" field: You can find additional information on this topic in the "Administration" 
manual, keyword "Creating the full-text search index".
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See also
Using a content-based search (Page 344)

Using revision search (Page 345)

Fundamentals of full-text search for documents (Page 99)

13.9.3 Using a content-based search

Requirements
See also chapter Requirements for using the full-text search (Page 341).

Excluded from the search
● Unrevisioned reports

● TIFF revisions

● External documents which have a link or a reference to a document from the file system.

Procedure
1. Select the "Plugins > Basic > Full-text search" command in the menu bar.

2. From the "Active search dialog window" list select "Content based search".
You will see the following tabs:

– "Content-based search"

– "Options"

Note
Search rate

Using the project root as the start object (default) gives the fastest search result; objects 
from lower tree levels will slow down the search.

Note
Changing the start object

You can change the start object using drag&drop from the Navigator.

3. Enter the character string you are searching for in the "Search key(s)" field. 
You can use placeholders and regular expressions. In a Boolean search, you can use 
Boolean operators. See also chapter Operators, placeholders, and regular expressions in 
the full-text search (Page 348).
As you type, an entry assistant opens and suggests words in the index of the open working 
layer which match the letters typed so far.
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4. Optional: Set search options on the "Options" tab. See also chapter "Options" tab of the 
full-text search (Page 342).

Note
Search settings

If you are only interested in the final state of documents, use the "Revisions" search options.

5. Click on the "Start" button on the "Content based search" tab.
Click the "Stop" button to stop the search.

Result
See also chapter Result of the full-text search (Page 346).

See also
Frequent errors when searching (Page 352)

Fundamentals of full-text search for documents (Page 99)

13.9.4 Using revision search

Requirements
● See also chapter Requirements for using the full-text search (Page 341).

● There are documents with revisions in the open project.

● If you are using TIFF revisions: An NTFS file system is used.

Excluded from the search
● External documents which are saved outside of COMOS

● Contents of TIFF revisions

Procedure
1. Select the "Plugins > Basic > Full-text search" command in the menu bar.

The "Full-text search" tab opens.

2. From the "Active search dialog window" list, select the "Revision search" search mode.
You see the "Attributed search" and "Options" tabs. You work in the "Attributed search" tab.

3. Determine the unit or location under which you are searching in the "Unit-/location label" 
field in the "Document data" control group.
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4. Determine which metadata you are searching for in the "Revision data" and "Element data" 
control groups.
You can work with placeholders and operators. See also chapter Operators, placeholders, 
and regular expressions in the full-text search (Page 348).

5. Optional: To search the content of PDF revisions too, proceed as follows:

– Activate the "In addition, offer the general search" option on the "Options" tab.
The "Boolean search" option is activated immediately in the "Search logic" control group.
The "Additional key word(s)" field is displayed on the "Attributed search" tab.

– Enter the character string you are searching for in the "Additional key word(s)" field on 
the "Attributed search" tab. 
You can use placeholders, regular expressions, and Boolean operators. See also 
chapter Operators, placeholders, and regular expressions in the full-text search 
(Page 348).

Note
Not for TIFF revisions

The content based search does not work for TIFF revisions.

6. Optional: Set search options on the "Options" tab. See also "Options" tab of the full-text 
search (Page 342).

7. Click on the "Search" button on the "Attributed search" tab.
Click the "Stop" button to stop the search.

Result
See also chapter Result of the full-text search (Page 346).

See also
Frequent errors when searching (Page 352)

Fundamentals of full-text search for documents (Page 99)

13.9.5 Result of the full-text search

Hit list display
The database is searched according to your settings. The search result is displayed in a hit 
list as follows:

● Revision search: In a separate window of its own

● Content based search: On the "Content based search" tab in the "Document details" control 
group
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The following applies to the hit list:

● Hits for documents which belong to a document package are grouped.

● If the hit list consists of one page, all hits for a document and its revisions are combined 
into one row.

● In order to display the search results more quickly, the file analysis is interrupted as soon 
as the maximum number of rows per page of hits specified in the options is reached. When 
you scroll to the next page, the analysis is started again. 
It is, therefore, possible that hits for one document may be distributed over several pages 
in hit lists which comprise several pages.

Searching in working layers
See also chapter Basic principle of the full-text search (Page 100).

Actions in the hit list
You have the following options in the hit list:

● Scrolling
In hit lists comprising several pages, you can scroll between pages using the following 
button: "Next subset"/"Previous subset"

● Opening a document or revision
Double-click on the cell of the document or the revision. If there are several revisions, the 
one with the highest index is opened.

● Filtering, sorting, and exporting the hit list
You can find additional information on this topic in the "Administration" manual, keywords 
"Sorting and filtering the Object Browser" and "Export data".

● Showing details of hits
Activate one of the following options above the hit list:

Option Description
"None" Activated: You only see the hit list.
"Document preview" Activated: To the right of the hit list, you see a 

document preview of the selected document or 
revision.
Requirements: The document preview is activa‐
ted in the project. You can find additional infor‐
mation on this topic in the "Administration" man‐
ual, keyword ""AutoVue - to be used to view 
documents" option".

"Document properties" Activated: To the right of the hit list, you see the 
properties of the selected hit. If needed, you can 
directly change the properties via the window.
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Columns of the hit list

Column Only for content 
based search

Note

"Document" - Name of document
"File name" ✓ The path of the file directory in which the docu‐

ment is located
"Description" ✓ Description of document
"Unit revision" - Indices of the revisions found, separated by 

commas"Project revision" -
"Unit version" - Name of the checked-in DVM version of the 

document
 

"Project version" -

See also
Using a content-based search (Page 344)

Using revision search (Page 345)

Frequent errors when searching (Page 352)

Fundamentals of full-text search for documents (Page 99)

13.9.6 Operators, placeholders, and regular expressions in the full-text search

Jokers ("Placeholder", "Wildcards")
Wildcards "*" and "?"

● "?": Finds any one character

● "*": Finds any number of characters

These placeholders can be located anywhere. Using them increases the time required for 
searching. The search is slower when the placeholder is set at the front part of the word. 

Examples:

● "app*" finds apple, appendix, etc.

● "*ge*" finds urgent, arrangement, etc.

● "?ills" finds fills and pills but not spills.

● "*ills" finds fills, pills, and spills.

% fuzzy search
Syntax: The amount of entered percentage characters defines the amount of allowed 
variations. The position defines which letters, starting from the beginning of the word, have to 
be exact hits. 
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The search rate decreases.

Examples:

● "Ba%nana"
The word has to start with Ba and can only have a single deviation to banana. 

● "B%%anana"
The word has to start with B and can have a maximum of two different characters. 

Result: The fuzzy search finds misspelled words. For example, a fuzzy search for "B%anana" 
would also find "Bannana" or "Banan". 

"~~" Numeric range
Syntax: To search in a numerical range, specify the upper and lower limits, separated by a 
double tilde symbol.

Example:

"Apple w/5 12~~17"

Result: This query finds documents in which the word apple is not placed more than five words 
away from a number between 12 and 17.

This numerical range search includes the upper and lower range. In the example 12 and 17 
are also listed as hits.

Only positive integers are allowed.

In the numeric range search commas and decimal points are interpreted as blanks. Minus 
characters are ignored. Example: -123,456.78 is interpreted as: 123 456 78 (three numbers). 

"## Regular expressions"
Regular expressions offer the possibility to search for complex character combinations. Always 
prefix a regular expression with two hash symbols, enclosing quote marks are unnecessary.

Examples:

● "Apple and ##199[0-9]"

● "Apple and ##19[0-9]+"

A regular expression always refers to a single word. For example, the query "apple pear" 
cannot be found with the regular expression "##app.*ar". 
A regular expression behaves like the asterisk placeholder (*) in terms of performance: The 
earlier the placeholder occurs in the character string, the slower the search will be. 

List of regular expressions:

● "." point or decimal delimiter
The point finds a single character. "Blan." finds "blank" and "bland". So there must be exactly 
one character at this position. 

● ".*" (point times)
The point with the multiplication sign (star, asterisk) stands for "0 or more" characters. If 
the combination ".*" is indicated at one position, anything can be entered there, but does 
not have to be. 
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● ".+" (point plus)
The point with the plus sign stands for "1 or more" characters. If the combination ".+" is 
indicated at one position, anything can be entered there, and there has to be at least one 
character. 

● "^" (caret)
Stands for the beginning of a section. 

● "$" (dollar)
Stands for the end of a section. 

● "\" (backslash)
Escape sequence: the next character is not counted as a control character. 
Example: "\$100" means that "$100" is searched for, instead of counting "$" as a control 
character. 

● "[abc]" square brackets with character string
Square brackets define a series of characters of which at least one has to appear. Example: 
"app[le]" finds "apples" and "applaus" but not "apology". 

● "[a-t]" square brackets with character range
You can also enter a character range in the square brackets by using a hyphen. In the 
above example every lower-case letter from a to t would be found. 

● "[^a-p]" square brackets with character exclusions
Finds all characters except the indicated characters. In the above example all characters 
except for the small letters from a to p would be found. 

● "[a-z]+"
With this combination the search is not for precisely one character, but for one or more.

Boolean search
A Boolean search consists of a group of words, that are put into relation by using copulas. 
Case-sensitivity of copulas is ignored. "AND" thus functions just like "and" or "anD". 

● "and"
Apple and pear: Both words need to be available. 

● "or"
Apple or pear: one of the two words has to be available.

● "w/<number>"
Apple w/5 pear: Apple has to be found within a range of five words around the word pear. 

● "pre/<number>"
Apple pre/5 pear: Apple has to be in a range of five words before the word pear is found. 

● "not w/<number>"
Apple not w/5 pear: In a range of five words before and after the word pear the word apple 
is not allowed. 

● "and not"
Apple and not pear: The word apple has to appear but the word pear is not allowed to 
appear. 

● "name contains" (<character string>)
name contains (Smith): the "Name" field has to have the entry Smith.
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● "w/<number> xfirstword"
Apple w/5 xfirstword: The word apple has to be among the first five words.

● "w/<number> xlastword"
Apple w/5 xlastword: The word apple has to be among the last five words.

() () Brackets and combinations
If you are searching for multiple copulas, use brackets.

● Example 1: 
Apple and pear or orange
Better: 

– (apple and pear) or orange
or 

– Apple and (pear or orange)

● Example 2: 
(Apple or banana) and (pear w/5 grapefruit) finds all documents, that

– contain the word apple or the word banana

– and at the same time contain the word pear in an area of five words around the word 
grapefruit.

"not"
The copula "not" in front of any search term inverts the meaning. Therewith all hit lists can be 
reduced, since documents with the according words can be excluded. 

● Example:
Apple or not pear 
Apple and not pear 
not (apple w/5 pear)

"not" can also also be used as a single copula at the beginning of a search term: 
"not pear" finds all documents in which the word pear does not appear. If "not" is not the first 
copula of the search term, "not" must be related to "and" or "or".

See also
Fundamentals of full-text search for documents (Page 99)
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13.9.7 Frequent errors when searching
If your search query does not find a document, check the following:

● Is a required folder or file extension excluded in the full-text search settings in the project 
properties?

● Is the index up-to-date?
In certain cases, users can forego the automatic update of COMOS. In such a case the 
index has to be updated manually.

● Is the document located in a subordinate or parallel working layer?

● Is the revision file already created?
Only with the "Create PDF file in first step" option the revision file is available right away. 
For all other modes the revision has to be released first in order for the revision file to be 
existent.

● Are you working in the right search mode of the full-text search?
The attributed search with default settings does not find any content in the documents.

● Are you searching for a property of the COMOS object, such as its name or label?
The full-text search is not a Navigator search and does not find COMOS properties.

● Were any spelling errors made in the document?
Maybe your search query is correct, but the editor of the document mistyped something. 
In this case you can use the fuzzy search or use jokers ("placeholders") to find the 
document. These options increase the time required for searching.

See also
Using a content-based search (Page 344)

Using revision search (Page 345)

Fundamentals of full-text search for documents (Page 99)

13.9.8 Creating document metadata outside COMOS

Principle
As a rule you create the metadata with the version management. You can create metadata 
outside COMOS in the document.

Procedure
To create the metadata of a Word document, for example, follow these steps:

1. Open a Word document.

2. Click the "File > Properties" menu.
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3. Select the "Summary" tab.

4. Enter the desired information in the field for the file properties.
Further information regarding file properties can be found in the Word Help.

Result
The metadata is applied when the document is imported into COMOS. You can also search 
for this information.

See also
Search modes for the full-text search (Page 101)

13.10 Locking documents

Requirements
● See also chapter Requirements for COMOS operation (Page 127).

● You have the "Lock" function right. If you have any questions, contact your administrator.

● The properties of the document are open. See also chapter Opening properties 
(Page 171).

Procedure
Same procedure as for engineering objects. 

Result
● Only administrators can change the properties and content of the document in the current 

working layer and all subordinate layers. The document is displayed in gray in the Navigator. 

● In interactive reports, all objects which are placed on the report are locked recursively.

● Only administrators can delete the document.

Releasing
Same procedure as for engineering objects.

See also
Locking engineering objects (Page 256)
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13.11 Using CDI documents

Requirements
● You are familiar with the overview of CDI documents.

See also chapter Overview of the CDI documents (Page 97).

● You can find additional information on this topic in the "Basic interfaces" manual, chapter 
"COMOS document interface", keyword "Requirements".

Working with CDI documents in COMOS
1. Open the project which contains the CDI documents. 

2. Open the CDI document.
Excel or Word opens. The COMOS data is automatically exported to the document. It 
corresponds to the current state of the database.

3. You have the following options:

– Excel document: Edit the data. If COMOS is running when the document is closed, the 
changes are automatically reimported to COMOS.

– Save the document in the file system. You can then work with the document outside of 
COMOS.

You cannot reimport changes to Word documents.

Working with CDI documents outside of COMOS
Requirements: The CDI document has a link to a file which is saved in the file system outside 
of COMOS. Alternatively, a copy of the CDI document has been saved in the file system.

The following applies:

● The state of the CDI document data was the current state when the document was last 
opened from COMOS.

● You can edit or archive the document, or forward it to a third party.

● Excel document: You can reimport changes to the data via the standard import. 
You can find additional information on this topic in the "Basic interfaces" manual, keywords 
"Using standard import for Access/Excel/XML files" "Using reimport for Access/Excel files 
or directories".

● You cannot reimport changes to Word data.
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13.12 Editing document properties

Procedure
● Editing general properties and attributes: The procedure is the same as for engineering 

objects.
See also chapters Editing general data (Page 253) and Editing attributes (Page 260).

● Editing the "General" tab: See also chapter "General" tab for documents (Page 358).

● "Revisions" tab: See also chapter Revising and signing (Page 320).

● Change tab of the corresponding document type: You usually only edit this tab when 
creating a document freely.
See also chapters Creating documents freely via the context menu (Page 309) and Change 
tab (Page 360).

● When numbering ranges are used: See also chapter Creating numbering ranges 
(Page 277).

See also
Properties and content of documents (Page 83)

Properties of document objects (Page 357)

13.13 Importing and exporting documents
You can find additional information on the different interfaces in the "Basic interfaces" manual 
and in the interface manuals of the modules.

13.14 PDF document view with "Multiple document preview"

Requirements
● See also chapter Requirements for COMOS operation (Page 127).

● See also chapter Overview of the PDF document view (Page 98).

● External PDF documents are located in a file directory.

Placing the PDF documents
1. In the menu bar, select the "Extra > Multiple document preview" command.

2. Open the file directory which contains the external PDF documents.

3. Drag&drop one or more PDF documents from the file directory onto the working area of 
the report.
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4. Select a placed PDF document and move it on the report.

5. Select a placed PDF document and edit the parameters as described in the following 
section. 

Editing the parameters of the PDF document
1. Select a PDF document on the working area of the report.

2. Select the "Properties" command in the context menu.

Control element Description
"P1" and "P2" fields The X and Y coordinates of the top left and bottom right point. If a 

coordinate is changed, the object is stretched or compressed ac‐
cordingly.

"Scaling" field Specifies the scale of the object.
"Edit in COMOS" option If this option is deactivated, the object cannot be opened and post-

edited in COMOS.
"Fixed content" option Pins the object.
"Show always in original size, ig‐
nore frame" option

The object protrudes over the edge of the frame if necessary. With 
this option the frame cannot be changed in size, since the frame is 
simply ignored.

"Reduce, if document does not 
fit in frame" option

The frame determines the maximum size and the object is reduced 
to fit as required.

"Enlarge or reduce" option The frame determines the size and the size of the object is always 
optimized to fit within the frame when the frame is changed.

If you have edited the inserted object, the changes may not be visible immediately. If you move 
the object slightly on the working area, the display will be recalculated.

Setting the display of the PDF document
See also chapter Setting the content and display of interactive reports (Page 373).

Deleting the PDF document on the working area
1. Select a PDF document on the working area of the report.

2. Select "Delete" from the context menu.

Printing the complete working area of the report
Click the "Print" button on the toolbar.

See also
Standard toolbar in interactive reports (Page 371)

Menu "Extra > ..." (Page 573)
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13.15 Properties of document objects

13.15.1 Structure of the properties of documents

Structure
● Toolbar

● General area

● "General" tab
See also chapter "General" tab for documents (Page 358).

● "Attributes" tab
See also chapter "Attributes" tab for documents (Page 359).

● Change tab
See also chapter Change tab (Page 360).

● "Revisions" tab
See also chapter User interface of the "Revisions" tab (Page 363).

Toolbar

Icon Tooltip Description
"Navigate" Selects the document in the Navigator.

"Released" and "Locked" Locks/unlocks the document properties. You cannot 
edit the content or delete the document. Administrators 
can still make changes and delete.

"Show base object" Displays or hides the "Base object" field in the general 
area.

"Object locking" Only relevant for your system administrators.
You can find additional information on this topic in the 
"Administration" manual, keyword ""Object locking" and 
"System object" state".

"System object" Only relevant for your system administrators.
You can find additional information on this topic in the 
"Administration" manual, keyword ""Object locking" and 
"System object" state".

General area

Control element Description
"Name" field Automatically generated

The field length is 256 characters. This allows you to address external 
files in deeply nested folders using the document object.

"Label" field The label 
"Description" field The description
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Control element Description
"Folder" option As with system type "Device".
"Base object" field The base object on which the document is based
Icon of the document As with system type "Device".
Drag&drop field

See also
Area for general data (Page 305)

13.15.2 "General" tab for documents

Control elements

Field Description
"Type" ● Determines the document type (COMOS report, Word file, etc.)

● The list includes all document types that are managed in COMOS using the 
"Administrator > Base data > Document types" menu.

● Depending on the type, the user can work with the document immediately 
after the type has been set, or must first make further entries on the change 
tab.

● The icon of the document object depends on the type.
● For external documents, the corresponding program must be installed. 

Example: Microsoft Word
"Description 2"
"Description 3"

For describing the document

"First page" The page number of the first page
The pages of the documents are numbered consecutively in document pack‐
ages and document groups. Only the first page of the first document has the 
page number "1".

"Number of pages" The number of pages the document contains
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Field Description
"Mode" Only for documents that are located under a base object or a document package. 

The mode controls what happens to the document if the owner of the document 
‑ i.e. the base object or the document package ‑ is created in the engineering 
data.
● "Virtual"

The document is not created immediately, but is available in the context 
menu. The "Virtual" mode is available in two versions:
– If the document name ends in "?" or "*", it can be created as often as 

required. The names are generated using "Nextname".
– Otherwise the document is available only once in the context menu, but 

it can still be created using script or copied manually. The names then 
have an underscore and a consecutive number.

● "Copy"
The document is created automatically in addition. It cannot be created again.

● "Base object only"
The document is not created. It is available only at the base object. 

● "Structure"
The document cannot be created in the engineering data. If the document 
is selected in the context menu, a submenu opens. If further documents are 
located under the document, they are offered in the submenu.

● "Reference"
The mode cannot be set for reports.
The mode creates a document under the engineering object. The document 
under the engineering object has a reference (a CDocument reference) to 
the document object under the base object. 
This mode is suitable for placing documents and PDFs under manufacturer 
devices. Highly specialized base objects exist for manufacturer devices. A 
document valid only for this manufacturer device belongs these specialized 
base objects. Using a referenced document from the document tree would 
therefore be too complicated; instead, a document under the base object is 
referenced.

"Inheritance mode" ● Only for documents located under a base object
● "Active"

The document is inherited to the engineering object and to subobjects in the 
base data. 

● "Inactive"
Inheritance is switched off completely. 

13.15.3 "Attributes" tab for documents
The base object of the document determines which attribute tabs and attributes you see.

Editing the attributes functions in the same way as for engineering objects. See also chapter 
Editing attributes (Page 260).
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13.15.4 Change tab

Principle
The name and content of the change tab depend on the document type. As a rule, its name 
is the same as that of the document type.

Overview
The following document types have the control elements described in this section on their 
change tab:

Group Document types
"Office" All
"Conval" All
"Others" ● Adobe PDF

● AutoCad
● Image document
● TIFF
● Text
● Unknown document

"COMOS" ● Smartsketch

The change tabs of the following document types have different control elements:

Document type More information
Evaluating report Change tab for evaluating reports (Page 361) 
Interactive report Change tab for interactive reports (Page 362) 
Report template  You can find additional information on this topic in the "Administration" man‐

ual, keyword "Change tab".
XML connector docu‐
ment

 You can find additional information on this topic in the "Basic interfaces" 
manual, keyword "XML connector".

XML connector template
PROII  Change tab for the "General" and "PROII" document types (Page 363)
General document

The "Document package" and "Reference document" document types do not have a change 
tab.
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"Document" control group
● "Normal" option

Activated: COMOS creates a new external document in the COMOS document directory. 
There is no template. If you switch to one of the other two options, the external document 
is deleted from the document directory.

● "File link" option
Activated: You see the "File name" field. Use the " ... " button to select a file from the file 
system. COMOS links the COMOS document to the file. The document is an external 
document. It has no template. The document is independent of working layers.
If you switch to the "Normal" option, the linked file is retained.

● "Reference" option
Activated: You see the "Template" field. Use the " ... " button to select a COMOS document. 
COMOS sets a link to the document. The referenced document can be opened but not 
saved. If the user edits the document, the changes are not saved. The document is 
independent of working layers.

"Object = Owner" field
Like the "Report object = Owner" field for evaluation reports.

Not available for the following document types: 

● "Others" group:

– Image document

– TIFF

– Text

● "COMOS" group: Smartsketch

13.15.5 Change tab for evaluating reports
Evaluation reports are the basis for data sheets and lists. They have the "Report" change tab. 
It has the following control elements:

"Report template" field
Link to the report template 
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The adjacent "..." button opens the "Select report template" window:

● "Base" option activated (default)
You can see the "CRp report templates" document group in the object tree of the window. 
It must be located in the base project in the Navigator in the "Documents" tab, directly under 
the project root; it collects the report templates. If it does not exist, the project root is 
displayed.

● "Current" option activated
You can view the objects that are located directly under the project root on the tabs of the 
Navigator in the current project.

Note

The "Select report template" window contains evaluation and interactive report templates. 
Users must take care to select a report template suitable for the report type.

"Report object = Owner" field
● Link to the report object

The report object is the basis from which all active and automatic functions of a report are 
executed. No document can exist without a report object. 

● Default: The object under which the report is located
Can be overwritten if the functions of the report are to be executed by an object other than 
its owner. If the default has been overwritten, it can be restored by pressing the "Delete" 
button. 

13.15.6 Change tab for interactive reports
Interactive reports are the basis of diagrams and drawings. They have the "Report" change 
tab. It has the following control elements:

"Report template" and "Report object = Owner" fields
See also chapter Change tab for evaluating reports (Page 361).

Area for display of the assigned physical files
Three instances of the document are saved for interactive reports:

● crp file
The working file

● bak file
The last saved version in each case before the current change 

● tmp file
Carried along during the working session. If the document is closed correctly, it is deleted.

If the crp file is defective, the tmp file and the bak file will still be available. They can be opened 
using the button "Open" alongside each one.

Creating and using documents
13.15 Properties of document objects

Operation
362 Operating Manual, 03/2017 V10.2.1, A5E37082875-AB



13.15.7 Change tab for the "General" and "PROII" document types

Structure

Control elements Description
"File name" The document accesses a local file.
"HTTP" The document accesses a HTTP URL.

The target of the URL must be a document file. It is not possible to 
open a general website.
If the target of the URL is a document, the document can be revisioned 
as usual.

Edit field Path and name of the file or HTTP URL
"..." Only visible when the "File name" option is activated

Button for selecting the document file

You can find more information on the topic of PROII in the "FEED Administration" manual, 
keyword "PRO/II simulation import process" and in the "FEED Operation" manual, keyword 
"Creating an import document".

13.15.8 User interface of the "Revisions" tab

User interface
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(1) Buttons

Icon Tooltip Description
"Creates a new revision" Creates a * revision.

The next revision step is displayed as the 
tooltip.

-

"Deletes '*' revision" or 
"Delete the selected revision"

Only active at * revisions and the last open revi‐
sion with revision file.

"Displays the selected revision" Only active for revisions that have a revision file.

"Prints the selected revision" -

"Show/Hide revision properties" -

or

"Revision printer Info"
 

The icon of the button depends on the set revision 
printer.
If no revision printer is set, or a freely configurable 
revision printer is set, the following icon is dis‐
played:

(2) Revision properties (displayed)
The fields for entering the revision properties are initially hidden. Click the "Show/hide revision 
properties" button.

Field Description
"Label" ● The revision label 

● Optional: For overwriting the value 
automatically generated for a * revision.
Requirement: The "Revision label editable 
during the complete revision operation" option 
is activated in the project properties

● Not editable for group revisions.
"Revision description" ● The revision description

● Optional: For overwriting the automatically 
generated value.

● Not editable for group revisions.
"Revision step label" If the field is empty, the date is used. 
"Revision step description" If the field is empty, the user who created the revi‐

sion is used. 

See also chapter Editing revision properties (Page 329).

Creating and using documents
13.15 Properties of document objects

Operation
364 Operating Manual, 03/2017 V10.2.1, A5E37082875-AB



(3) Columns

Column Description
"Index" The index of the respective revision 
"Label" Label and description of the respective revision

See also chapter Editing revision properties 
(Page 329).
 

"Description"

"Created by" The user who created the respective revision and 
the date on which the revision was created

"Checked by" The user who inspected the respective revision 
and the date on which the revision was inspected

"Released by" The user who released the respective revision and 
the date on which the revision was released

"Revision archive" The revision archive is a print file in TIFF or PDF 
format. In a document group, the "Revision ar‐
chive" column is always blank, as the archived files 
are only saved at the individual documents. 

"AddDocs" Adding documents to the selected revision. See 
chapter Add documents to revision (Page 336).

"Redlinings" Adding documents to the selected revision. See 
chapter Add documents to revision (Page 336).
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Using reports 14
14.1 Open report

A report is opened like a document. See chapter Opening documents (Page 173).

If redlining comments exist for a revision, they are automatically displayed. The redlining 
comments can be hidden. See chapter Viewing revision files and Redlining files (Page 333).

14.2 Keyboard commands in reports

Requirements
A report is open.

Keyboard commands
● Ctrl+Z Undo

The last action is undone.

● Ctrl+Y Restore
The last undone action is restored.

● Ctrl+<Arrow left> Predecessor
Navigation predecessor report. Usually, this is the report that has the preceding number in 
the document group.

– Special case: When a half-open connection is selected, the system navigates to the 
counterpart of the half-open connection.

● Ctrl+<Arrow right> Successor
Navigation successor report. Usually, this is the report that has the successor number in 
the document group.

– Special case: When a half-open connection is selected, the system navigates to the 
counterpart of the half-open connection.

● <Space> Symbol rotation
Changes the angle of the icon prior to placing. See chapter Rotating symbols when placing 
them (Page 388).
Changes the angle of the selected icon. See chapter Rotating symbols (Page 419).

Operation
Operating Manual, 03/2017 V10.2.1, A5E37082875-AB 367



14.3 Working with interactive reports

14.3.1 User interface of interactive reports

14.3.1.1 Structure of interactive reports

Overview
The graphic below illustrates the structure of interactive reports:

① Toolbar
The toolbar contains general commands which are available in all interactive and evaluating 
reports. Examples: Save, print
The toolbar in interactive reports also contains buttons for setting the grid size. 
See also chapter Toolbar in interactive reports (Page 369).

② Standard toolbar
The standard toolbar contains commands that are available in all interactive reports. You can 
use the tools on the standard toolbar to draw connections or purely graphical objects and edit 
objects placed on the report.
See also chapter Standard toolbar in interactive reports (Page 371).

Using reports
14.3 Working with interactive reports

Operation
368 Operating Manual, 03/2017 V10.2.1, A5E37082875-AB



③ Report-specific toolbar
The drawing type of the interactive report determines whether you see a report-specific toolbar 
and, if so, which tools it contains.
You can find more information on this topic in the COMOS product manuals.

④ Optional: Evaluating elements, for example parts lists, material data, etc.
⑤ Symbol bar

The symbol bar is used to place engineering objects in the working area. See also chapter 
Placing objects via the symbol bar (Page 381).
The engineering objects available on the symbol bar are determined by the drawing type of the 
interactive report. You can find more information on this topic in the COMOS product manuals.

⑥ Working area
⑦ Drawing header

The drawing header displays important management data including general project data and 
information about the design engineer and the revision status, for example.
The data is exported from the properties of the report. Exactly which data is displayed depends 
on the configuration of the report template.

⑧ Extended status bar
The status bar shows the coordinates of the mouse pointer

See also
Context menu for interactive reports (Page 444)

Working with interactive reports (Page 368)

14.3.1.2 Toolbar in interactive reports
See also chapter Structure of interactive reports (Page 368).

Buttons

Icon Tooltip Description
"Reevaluate document" See also chapter Updating reports (Page 450).

"Refresh screen" Reassembles the graphical content of the report 
and removes artifacts.

"Print" See also chapter Printing reports (Page 451).

"Save" Saves the report.
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Icon Tooltip Description
● "Cut"
● "Copy"
● "Paste"

● "Cut": Cuts the objects selected in the 
working area.

● "Copy": Copies the objects selected in the 
working area.

● "Paste": Pastes the objects that have been 
cut or copied via the toolbar.

For "Cut"/"Paste", see also the explanations in 
chapter Copying/pasting and cutting in interac‐
tive reports (Page 433).

● "Undo"
● "Restore"

Undoes the last action in the report or redoes the 
last undone action. 
Keyboard commands:
● Undo: Ctrl+z
● Redo: Ctrl+y 

Zoom and move:
● "Zoom"
● "Move sheet"
● "ZoomInOut"
● "Complete view"

See also chapters Zoom (Page 373) and Moving 
a sheet section (Page 375).

"Layers" See also chapter Showing/hiding or freezing the 
content of a layer (Page 377).

"Construction mode" Activates construction mode. 
Construction mode extends the standard toolbar 
by adding the following tools:
● "Dimension"
● "Hatching"
● When the "Line" tool is activated: The 

"Extended Construction" secondary tool
In construction mode, lines and dimensions lock 
into place not only at the grid points, but also at 
the capture points of the objects. This function 
makes it easier to construct solid bodies and 
draw purely graphical sketches. 

"Bird view" See also chapter Working in bird view 
(Page 376).

"Changes in working layers" See also chapter Showing changes in working 
layers (Page 437).
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Icon Tooltip Description
● "Navigate to predecessor"
● "Navigate to successor"

Navigates to previous or next report.
Requirements: The report is located in a docu‐
ment package, there are predecessors and suc‐
cessors, and the report template supports this 
function. You can find additional information on 
this topic in the "Administration" manual, keyword 
"EnablePaging".
Keyboard commands:
● Predecessor: Ctrl+<Arrow left>
● Successor: Ctrl+<arrow right>
The keyboard commands work even without En‐
ablePaging. In this case, the sequence of the 
documents in a document group is used.

"Page" Browse to previous or next page.
Requirements: The report template supports mul‐
tipage reports. You can find additional informa‐
tion on this topic in the "Administration" manual, 
keyword "MultiPaging".

"Grid" See also chapter Grid (Page 92) and chapter 
Switching off the grid (Page 380).

"Zoom" See also chapter Zoom (Page 373).

14.3.1.3 Standard toolbar in interactive reports
See also chapter Structure of interactive reports (Page 368).

Buttons

Icon Tooltip Description See also chapter ...
"Select" For selecting the symbols and graphical 

elements placed on the report
Selecting symbols and graphical el‐
ements (Page 391)

"Line" For drawing a line. Drawing a line (Page 406) 

"Arc" For drawing a circle or an arc. Drawing circles and arcs 
(Page 408) 

"Rectangle" For drawing a rectangle. Drawing rectangles (Page 410)

"Text" For placing a text. Placing texts (Page 411)

"Connection" For connecting placed objects. Activating and deactivating the 
"Connection" tool (Page 392)
Drawing the start point and end 
point of the connection (Page 392)
Drawing intermediate points on the 
connection (Page 394)
Connecting several objects with 
one line (Page 395)
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Icon Tooltip Description See also chapter ...
"Assign ob‐
ject"

For editing engineering objects placed on 
the report. Available assignment modes:
● "Define owner" mode

Moves engineering objects in the 
Navigator under a different owner.

● "Change object" mode:
– Replaces an engineering object 

placed on the report with a different 
engineering object which has not 
yet been placed.

– Assigns a new base object to an 
engineering object.

● Modes for inserting links which are 
specific to the drawing type
Example: When you use the "Assign 
location" mode links to the engineering 
objects selected in the report are 
inserted under a location.
You can find more information on this 
topic in the COMOS product manuals.

● "Automatic" mode
One of the above assignment modes 
is executed. Which assignment mode 
is executed depends on which object 
you drag from the Navigator onto the 
symbols selected in the report.

In some reports, you set an assignment 
mode via the "Mode" list in the toolbar. If 
you do not see the list, "Automatic" mode 
is set by default.

Changing owners (Page 402)
Switching base objects (Page 402)
Switching engineering objects 
(Page 403)

"Transform" For transforming symbols and graphical 
elements
The procedure is identical for symbols and 
graphical elements.

Moving symbols (Page 417)
Rotating symbols (Page 419)
Mirroring symbols (Page 421)
Scaling symbols (Page 423)
Aligning symbols (Page 425)
 

14.3.2 Reference of the "Report" user settings

Requirements
● You are familiar with changing the user settings.

See chapter Changing user settings (Page 140).
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Reference

"Paging behavior" Default setting: "Use same report viewer"
● "Use same report viewer"

When another report is opened, the current report is closed. When changes exist that 
have not been saved, the user is prompted to save the changes.

● "Use new report viewer (if changed)"
When another report is opened, the following applies:
– When there are no changes in the current report, the current report is closed.
– When there are changes in the current report, the additional report is shown in another 

tab. The current report remains open.
● "Use new report viewer (always)"

The additional report is shown in another tab. The current report remains open.
"Default rotation angle" Default setting: 90°

Specifies the rotation angle when the space key is used. See chapter Change rotation an‐
gle (Page 430).

"Reverse mouse wheel zoom 
direction"

Default setting: Deactivated
Reverses the direction in which the mouse wheel must be rotated for zooming. See chapter 
Zoom (Page 373).

14.3.3 Setting the content and display of interactive reports

14.3.3.1 Zoom

Requirements
● An interactive report is open. 

See chapter Opening documents (Page 173).

● You are familiar with reference of the user settings.
See chapter Reference of the "Report" user settings (Page 372).

Maximum zoom factor
Maximum zoom factor: 800%
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Continuous zoom (mouse wheel)
1. Click the working area of the report to select it.

2. Turn the mouse wheel

– Turn mouse wheel to the front
You zoom out of the report, the percentage decreases during zooming. 

– Turn mouse wheel to the back
You zoom in to the report, the percentage increases during zooming. 

Zooming with the mouse wheel can be reversed with 
InvertMouseWheelZoomforReport. You can find additional information on this topic 
in the "Administration" manual, keyword "Adapting the construction mode and zooming of 
the working area".

Continuous zoom (ZoomInOut)
1. Click the "Zoom In/Out" tool on the standard toolbar: 

2. Move the mouse to the working area.

3. Press and hold down the left mouse button.

4. You have the following options:

– To zoom in, move the mouse downward or to the right.

– To zoom out, move the mouse upward or to the left.

Zooming in on a specific section (zoom)
1. Click the "Zoom" tool on the standard toolbar: 

2. With the left mouse button held down, drag out a frame on the working area.
The tool will zoom in on the frame.

3. Single-click the working area. 
The entire area is displayed once again.

Zooming out from the complete view
1. Click the "Complete view" tool on the standard toolbar: 

2. You have the following options:

– To zoom all placed elements, left click once on the working area.

– To zoom the document sheet, left click again.
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Changing the zoom factor in defined steps
You have the following options:

● Use the following buttons on the standard tool bar: 

● Use the <Page down> button to zoom in and the <Page up> button to zoom out.

● Enter the desired factor in the "Zoom" field and press the <Return> key.

Adapting zoom with mouse and keyboard
1. To zoom a section of the working area, press and hold down the <Alt Gr> button and drag 

open the desired section with the left mouse button.

2. To adapt the working area to the window size, press and hold down the <Alt Gr> button 
and click the working area.

Moving the zoomed-in section
You have the following options for moving the zoomed-in section:

● Work in bird view. See also chapter Working in bird view (Page 376).

● Use the "Move sheet" function. See also chapter Moving a sheet section (Page 375).

14.3.3.2 Moving a sheet section

Requirements
An interactive report is open. See also chapter Opening documents (Page 173).

Procedure
1. Select the "Move sheet" button on the standard toolbar: 

2. Move the mouse to the working area.

3. Keep the left mouse button held down and move the mouse.

Result
The working area is moved.

Using reports
14.3 Working with interactive reports

Operation
Operating Manual, 03/2017 V10.2.1, A5E37082875-AB 375



Alternative
1. Move the mouse pointer to the working area.

2. Hold down the <Alt> key and the left mouse button.

3. Move the mouse.

The tool previously activated on the toolbar remains active. 

See also
Working in bird view (Page 376)

14.3.3.3 Working in bird view

Principle
When bird view is activated, a small window in which you can see the whole report opens 
above the report. The section currently displayed in the working area is highlighted:

Bird view allows you to maintain an overview of where the section currently shown in the 
working area is located within the report as a whole. You can also use bird view to move the 
section. 

Requirements
An interactive report is open. See also chapter Opening documents (Page 173).
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Opening bird view
Click the "Bird view" button on the standard toolbar: 

The "Bird view" window opens. The section currently shown in the working area is highlighted 
in white; the rest is colored gray.

Moving a section
1. Move the mouse pointer to the white area in the "Bird view" window.

2. Keep the left mouse button held down and move the mouse until the white area covers the 
desired section.

The section is moved to the working area of the report.

14.3.3.4 Showing/hiding or freezing the content of a layer

Requirements
● An interactive report is open. See also chapter Opening documents (Page 173).

● The interactive report uses layers.
You can find additional information on this topic in the "Administration" manual, keyword 
"Setting up layers for reports".

● Layers are assigned to the objects and graphical elements placed on the report.
See also chapter Assigning layers (Page 404).
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Procedure
1. Click the "Layers" button on the toolbar: 

The "Layers" window opens. 

2. Edit the following settings:

Visible Hides or shows the layer in the report.
Frozen Locks or unlocks the layer for editing. Objects in locked layers cannot be se‐

lected and edited in the report. 
Visible (printout) Activated: The layer is printed.
Visible (export) Activated: The layer is exported.

The effect of this option depends on the extent to which the target format sup‐
ports layers:
● Excel, Word, EMF

The layers are not exported despite activate option
● PDF, AutoCad

The layers are exported but switched to invisible in the target.
See also chapter Exporting and importing reports (Page 452).

3. To apply your settings immediately, activate the "Apply immediately" option.
The selected settings only apply to the current session.

4. To save your settings, click on the following button: 

The "Save settings" window opens. See also chapter "Save settings" window (Page 591).

5. Select the required settings.

6. Confirm your entries.
Your settings can be saved as user-specific settings or as group-specific settings. They are 
saved in the base data.
You can find additional information on this topic in the "Administration" manual, keyword 
"Administration of personal user settings (profile)".

7. Confirm your entries in the "Layers" window.

See also
Layers in interactive reports (Page 93)

14.3.3.5 Setting the scale

Requirements
An interactive report is open. See also chapter Opening documents (Page 173).
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Procedure
1. Select the "Options > Scale factor" command in the context menu of the working area.

The "Scale factor" window opens.

2. Select the scale.

3. Confirm your entries.

Result
The scale and the symbol display are adjusted.

Whether the symbol texts are made bigger or smaller depends on the report template 
configuration. You can find additional information on this topic in the "Administration" manual, 
keyword "DrawText".

14.3.3.6 Using working layer display mode

Requirements
An interactive report is open. See also chapter Opening documents (Page 173).

The working layer display mode is activated. See also chapter Enabling and disabling the 
working layer display mode (Page 196).

Two processing states for placed objects
COMOS objects can be colored according to their processing status. This coloring takes place 
on the report. Graphical objects (circles, lines, text) are not colored, because these objects 
exist only on the report. 

If COMOS objects are placed on a report, there are two processing states: 

● Processing state of the object in the Navigator

● Processing state of the object on the report

Example 1: If a COMOS object is placed on a report, then: 

● All other circumstances remaining equal, the COMOS object is unchanged in the Navigator 
(status color: black)

● All other circumstances remaining equal, the COMOS object is new on the report (status 
color: green) 

Example 2: If an element is added to a COMOS object, then:

● All other circumstances remaining equal, the COMOS object is unchanged in the 
subordinate objects in the Navigator (status color: light blue)

● All other circumstances remaining equal, the COMOS object is unchanged on the report 
(status color: black)
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Selecting the displayed status color
The following instruction describes which of the two processing states is displayed on the 
report.

● From the context menu of the report, select the command "Working layer display mode".

● Select one of the following options:

– "All changes (in document)"
(Default setting when COMOS restarts)
The changes to the object itself and the changes to child objects below are taken into 
account. 
Both the changes in the Navigator and the changes on the report are taken into account.
If the processing state in the Navigator and the processing state on the report conflict, 
the status color of the processing state on the report is displayed.

– All changes (in Navigator)
The changes to the object itself and the changes to child objects below are taken into 
account. 
The status color of the objects placed on the report are based on the processing state 
of the object in the Navigator.

– Own changes only (in Navigator)
The changes to the object itself and the changes to child objects below are ignored.
The status color of the objects placed on the report are based on the processing state 
of the object in the Navigator.

– Own changes only (in document)
The changes to the object itself and the changes to child objects below are ignored.
The status color of the objects placed on the report are based on the processing state 
of the object on the report.

The selected mode is valid for the entire COMOS session and for all documents (of the 
engineering modes that support status colors). If you change mode, the current document is 
automatically re-evaluated. All documents open in the background must be manually updated 
using "Reevaluate document".

14.3.4 Switching off the grid

Application examples
You switch off the grid in the following cases:

● To connect objects via dynamic connectors.

● If the grid size has been altered after objects have been placed and connections or graphical 
elements have been drawn in.
In this case, the connectors of the objects and the lines of the graphical elements are not 
usually located on the grid points any longer.

Requirements
An interactive report is open. See also chapter Opening documents (Page 173).
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Procedure
Press and hold down the <Shift> key.

Result
As long as the key is held down, you are not committed to the grid.

See also
Grid (Page 92)

14.3.5 Placing objects

14.3.5.1 Placing objects via the symbol bar
See also chapters Fundamentals of placing on interactive reports (Page 88) and Structure of 
interactive reports (Page 368).

Advantage of this method
● The symbol bar offers quick access to important objects you are working with in the report. 

● The objects on the symbol bar are defined explicitly for use in the current report. 

Requirements
● An interactive report is open. See also chapter Opening documents (Page 173).

● The report has a symbol bar.

Procedure
1. Left-click the button of the object in the toolbar.

Insert mode is activated. 

2. Move the mouse pointer to the working area.
A coordinates cross is displayed instead of the mouse pointer. The object symbol is 
attached to the coordinates cross.

3. Optional: You can rotate the symbol before you place it. See also chapter Rotating symbols 
when placing them (Page 388).

4. Left-click on the position where you want to place the symbol.
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Result
The symbol is inserted into the report. The corresponding engineering object is created in the 
Navigator. Where the object is created depends on the COMOS product and the report 
template. You can navigate from the working area to the object. See also chapter Navigating 
(Page 170).

Insert mode remains active. You can place further instances on the working area without 
reselecting the button on the symbol bar.

See also
Switching off the grid (Page 380)

Inserting objects on a connection (Page 396)

14.3.5.2 Placing base objects from the Navigator

Advantage
You have more objects to choose from than on the symbol bar.

Requirements
● An interactive report is open. See also chapter Opening documents (Page 173).

● You have experience with the structure of the "Base objects" tab. If you have any questions, 
contact your administrator.

● The base object has a symbol for the drawing type of the report.

Procedure
1. Select the required base object on the "Base objects" tab in the Navigator.

2. Move the object into the working area of the report using drag&drop.

3. Optional: You can rotate the symbol before you place it. See also chapter Rotating symbols 
when placing them (Page 388).

Result
An engineering object based on the base object is created in the Navigator. The symbol of the 
engineering object is placed on the report.

It depends on the COMOS product and the report template where the object is created. You 
can navigate from the working area to the object. See also chapter Navigating (Page 170).

See also
Switching off the grid (Page 380)

Inserting objects on a connection (Page 396)

Using reports
14.3 Working with interactive reports

Operation
382 Operating Manual, 03/2017 V10.2.1, A5E37082875-AB



14.3.5.3 Placing engineering objects from the Navigator

Advantage
You have more objects to choose from than on the symbol bar.

Requirements
● An interactive report is open. See also chapter Opening documents (Page 173).

● Engineering objects have been created on the "Units" or "Locations" tabs in the Navigator. 
See also chapter Creating engineering objects (Page 233).

● The objects have a symbol for the drawing type of the report.

Procedure
1. Select the desired engineering object on the "Units" or "Locations" Navigator tab.

2. Move the object into the working area of the report using drag&drop.

3. Optional: You can rotate the symbol before you place it. See also chapter Rotating symbols 
when placing them (Page 388).

Result
The symbol of the engineering object is placed on the report.

See also
Switching off the grid (Page 380)

Inserting objects on a connection (Page 396)

14.3.5.4 Placing objects via the context menu of a symbol

Requirements
● An interactive report is open. See also chapter Opening documents (Page 173).

● A symbol is placed. See also chapter Fundamentals of placing on interactive reports 
(Page 88).

● In the context menu of the symbol, objects from the project structure are offered for the 
"New" command. 

Note

The "New" command is not available in all drawing types.
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Procedure
1. Select the symbol (symbol A).

2. Select the "New" command from the context menu.
The submenus open. All objects which are permitted under this object according to the 
project structure are displayed in the bottom half.

3. Select an object.
The symbol of the object (symbol B) is attached to the mouse pointer.

4. Optional: You can rotate the symbol before you place it. See also chapter Rotating symbols 
when placing them (Page 388).

5. Click the left mouse button.

Result
● Symbol B is inserted into the report and is created in the Navigator below the engineering 

object for symbol A.

● If there is already a corresponding object located below the engineering object, and this 
object has not yet been placed, no new object is created. Instead, symbol B is assigned to 
the existing object.

● If the command makes several objects available, their symbols are placed below one 
another. 

You can find more information on this topic in the COMOS product manuals.

See also
Creating objects from a project structure via the context menu (Page 236)

Switching off the grid (Page 380)

14.3.5.5 Placing objects by inserting a template
See also chapter Fundamentals of templates and usages (Page 50).

Requirements
● An interactive report is open. See also chapter Opening documents (Page 173).

● There is a template available to insert into the interactive report. The open interactive report 
has the same drawing type as the interactive report that belongs to the template.

● There is nothing selected in the working area of the report.
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Procedure
1. Select the "Place template" command from the shortcut menu in the working area.

The "Select document as template" window opens. The window contains two lists and an 
object tree.

2. In the lists, specify the project in which and the tab on which the template you wish to insert 
is located. 
You will usually use the templates of the base project.
The contents of the selected tab from the selected project are shown in the object tree. 

3. Select the template object in the object tree.
A preview of the template is displayed below the object tree. 

4. Confirm your entries.
The "Select document as template" window closes. The template is attached to the mouse 
pointer. 

5. Optional: You can rotate the template before you place it. See also chapter Rotating 
symbols when placing them (Page 388).

6. To place the template, left-click on the desired position in the working area.

Note
Limited placement of the template

The placement of the template in the report depends on how you configure the template. 
You can find additional information on this topic in the "Administration" manual, keyword 
"Creating a template".

Result
The objects are placed on the interactive report and are connected. The corresponding objects 
are created in the Navigator. Where the objects are created depends on the COMOS product 
and the report template. You can navigate from the working area to the objects. See also 
chapter Navigating (Page 170).

Placing a base object with a reference to a template object
If a base object has a reference to a template object, you can place the template directly on 
the report. To do this, move the base object into the working area using drag&drop.

See also
Creating templates from placed objects (Page 441)

Switching off the grid (Page 380)
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14.3.5.6 Placing or deleting attributes

Requirements
● An interactive report is open. See also chapter Opening documents (Page 173).

● The owner of the attribute is placed on the report. See also the following chapters:

– Placing objects via the symbol bar (Page 381)

– Placing base objects from the Navigator (Page 382)

– Placing engineering objects from the Navigator (Page 383)

– Placing objects by inserting a template (Page 384)

Procedure
1. Select the desired attribute in the Navigator.

2. Drag&drop the attribute into the working area. 

Result
● The attribute value is displayed on the report. If the value is empty, only the anchor of the 

attribute is displayed: 

● If the attribute changes, the value on the report is automatically updated.

● If you select or move the owner's symbol, the attribute value is also selected or moved. 

You can edit the attribute value in the report. See also chapter Editing placed attributes 
(Page 401).

Note
No orange circuitry of attributes on the report

The orange circuitry with inconsistent entries is not available on the report.

For orange circuitry, see chapter Entering attribute values (Page 260). 
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Moving a placement
1. Select the attribute in the working area.

2. Move the attribute to the desired position.

Deleting a placement
1. Select the attribute in the working area.

2. Select "Delete" from the context menu.

See also
Switching off the grid (Page 380)

14.3.5.7 Placing a report on a report

Requirements
● Two interactive reports have been created. See also chapter Creating Documents 

(Page 307).
In the information that follows, the reports are referred to as reports A and B.

● The reports have the same drawing type. 

Procedure
1. Open the interactive report (report A) on which you want to place the other report (report 

B). See also chapter Opening documents (Page 173).

2. Move report B from the Navigator onto the working area of report A using drag&drop.

Result
The graphical content of report B is displayed on the working area of report A, as is a control 
triangle:

The objects behind the symbols are still only placed on report B. The graphical content you 
see on report A is connected to report B. It is read-only. Changes to graphical content in report 
B are also visible on report A when the next update takes place.  

You can break apart report B and transfer its contents to report A. See also chapter Breaking 
apart a placed report (Page 439).
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If you retain the connection, you have the following options:

● Replace report B with a different report or change the coordinates. 
See also chapter Replacing a placed report and changing coordinates (Page 438).

● Open report B. See also chapter Opening a placed report (Page 438).

14.3.5.8 Rotating symbols when placing them

Principle
If you place an object on an interactive report, its symbol initially has an orientation specified 
by the symbol definition.

For the following placement methods, you can rotate the symbol before you place it:

● Via the symbol bar

● By moving a base object or an engineering object from the Navigator using drag&drop

● Via the context menu of a symbol

● By inserting a template

Requirements
● An interactive report is open. 

See chapter Opening documents (Page 173).

Procedure
1. Change the rotation angle if necessary.

See chapter Change rotation angle (Page 430).

2. Then proceed as described for the individual placement methods.
See also:

– Chapter Placing objects via the symbol bar (Page 381).

– Chapter Placing base objects from the Navigator (Page 382).

– Chapter Placing engineering objects from the Navigator (Page 383).

– Chapter Placing objects via the context menu of a symbol (Page 383).

– Chapter Placing objects by inserting a template (Page 384).

3. Move the mouse pointer to the working area.

4. Press the <Space> bar once for each rotation.

Result
The symbol is rotated counter-clockwise. By default, it is rotated in 90° increments. When 
placing from the Navigator, the symbol will not be refreshed until you move the mouse pointer 
again.
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See also
Rotating symbols (Page 419)

14.3.5.9 Placing external files (OLE objects)

Aim
File types that do not come from COMOS can be placed in the report. If the third-party software 
linked with the data type supports OLE, an OLE object is created on the report. Depending on 
the scope of the OLE support, the following functions may be available:

● Displaying the content of the third-party file in the report

● Opening, editing and saving the third-party file

● Resolving the OLE object

General conditions for OLE objects
The display and editing of OLE objects is controlled by the operating system and the installed 
third-party software and therefore varies depending on the client. When a report with OLE 
object is opened on a COMOS client without third-party software, the content of the OLE object 
cannot be displayed and the OLE object cannot be opened.

A change in the operating system can also result in a change regarding the support of OLE 
objects.

Creating OLE objects with drag&drop
1. Open the Windows Explorer.

2. Use drag&drop to move the file to the report.

– Alternative 1: A preview of the content appears on the report
Special case bmp and jpg: When bmp and jpg are dragged to the report, the content is 
also displayed. However, an OLE object was not created in this case, and the placed 
files cannot be opened even with a double-click in a third-party software. Instead, these 
file types are converted into the COMOS format ReportPicture during the import.

– Alternative 2: An empty, dashed frame is created in the report with an icon in the center.
The icon has a size of 16*16 pixels and, depending on the zoom, can therefore hardly 
be recognized. See the information on "Make frame visible" below.

3. Alternative: Create OLE object in the Navigator first

– Drag the external file to the Navigator.

– Use the import mode "Create copy" or "Create link".
A document of the type "General document" is created with the import mode "Create 
copy".
The list of document types is applied with the import mode "Create reference".
Note: The import mode "Create document with version management" (DVM) does not 
support OLE objects.

– Drag the object from the Navigator to the report.
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Editing an OLE object
1. Open the properties of the OLE object in the report

– Select the placed object.

– Select the "Properties" command in the context menu.

– Edit the properties
You can find additional information on this topic in the "Administration" manual, keyword 
"Paste object (OLE object).

2. Make invisible frame visible
If the linked OLE third-party software does not offer a preview of the file content, an empty, 
dashed frame is created in the report with an icon in the center. To make the placed frame 
visible, follow these steps:

– Drag a large selection frame on the report with the mouse
The placed object is also selected and displayed

– Click the placed object.
The object is selected.

– Select the "Properties" command in the context menu.

– Disable the "Fixed content" option
The frame gets a green background.

3. Confirm your entries.
The window closes.

4. Optional: Select the "Dissolve OLE object" command in the context menu.
The content of the OLE object is traced with report functions. Lines are created as report 
lines, texts as report texts. The original OLE object still exists.
Examples: OLE object for an Excel file, OLE object for a Word document.

5. Double-click the OLE container in the report.
The external file opens in the assigned program.

Interaction with other COMOS functions
● Revisioning

If an OLE object is edited outside of COMOS, this does not result in a *-Revision being 
created in the report.

● When an OLE object is used and edited in different working layers, changes to the OLE 
object are transferred to the other working layers with a delay.

● When OLE objects are created in the Navigator first, the following applies:

– OLE objects in the Navigator cannot be transferred to DVM documents (no checkout/
checkin possible).

– OLE objects in the Navigator do not support CDI.
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Similar functions
OLE objects can be created on report templates with the context menu. You can find additional 
information on this topic in the "Platform Administration" manual, keyword "Paste object (OLE 
object).

14.3.6 Selecting symbols and graphical elements

Requirements
● An interactive report is open. See also chapter Opening documents (Page 173).

● There are symbols or graphical elements placed on the report. See also chapter Placing 
objects (Page 381) and chapter Working with graphical elements (Page 406).

Procedure
1. Click the "Identify" button in the standard toolbar: 

Note

Alternatively, you can deactivate the tool that is currently active using the <Esc> keyboard 
command. The "Identify" tool is activated automatically.

2. Select the desired symbols and graphical elements as described below.

Single selection
Left-click on a symbol or graphical element.

Multiple selection
1. Press and hold down the <Ctrl> key.  

2. Left-click on several symbols or graphical elements.

Selecting the contents of an area
1. Press and hold down the left mouse button.

2. Use the mouse to drag out a frame which surrounds the desired symbols and graphical 
elements.

Deselecting
To deselect a selected symbol or graphical element, left-click the working area of the report.
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See also
Customizing the arrangement of frames and tabs (Page 146)

14.3.7 Connecting objects

14.3.7.1 Activating and deactivating the "Connection" tool
See also chapter Fundamentals of connections on interactive reports (Page 90).

Requirements
An interactive report is open. See also chapter Opening documents (Page 173).

Procedure
Click the "Connection" button in the report-specific toolbar: 

Result
The "Connection" tool is activated. A coordinate cross is displayed instead of the mouse 
pointer: 

When drawing the connection run, the coordinate cross helps you to align it with the objects 
and connections that have already been placed.

You can now set the start point of the connection. See also chapter Drawing the start point 
and end point of the connection (Page 392).

14.3.7.2 Drawing the start point and end point of the connection
See also chapter Fundamentals of connections on interactive reports (Page 90). 
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Introduction
The following table offers you an overview of when to select which start points and end points: 

Start point/end point Usage
Static connector of a placed object The connection should start or end at an object which has 

static connectors.
See also chapter Connectors (Page 73).

Any position on the symbol line of a 
placed object

The connection should start or end at an object which does 
not have static connectors, e.g. a vessel. 

Any position on a connecting line You want to extend an open connecting line. In this case, 
select the open end as the start or end point.
Or you want a connection that you have already drawn to 
branch off. In this case, select a point in the middle as the 
start or end point.

Any free position on the working area You want to draw a connection with a start point or end point 
which is - at least initially - unconnected.

Note
Selecting a symbol line or connecting line as a start point or end point

If you select a symbol line or connecting line as the start or end point, the connection is realized 
using dynamic connectors. 

See also chapter Connectors (Page 73).

Requirements
● An interactive report is open. See also chapter Opening documents (Page 173).

● The "Connection" tool is activated. See also chapter Activating and deactivating the 
"Connection" tool (Page 392).

● Depending on the start point and end point: The relevant objects have been placed on the 
report or a connection has been drawn. See also chapter Placing objects (Page 381).

Procedure
1. Move the mouse to the desired start point. If necessary, switch off the grid. See also chapter 

Switching off the grid (Page 380).

2. Click the left mouse button.
The start point of the connection is drawn in. The "Connection" tool remains activated. 

3. Optional: Determine the exact connection run by drawing intermediate points. See also 
chapter Drawing intermediate points on the connection (Page 394). 

4. Optional: Connect several objects with one line. See also chapter Connecting several 
objects with one line (Page 395).

5. Move the mouse to the desired end point. If necessary, switch off the grid. See also chapter 
Switching off the grid (Page 380).
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6. Click the left mouse button.

7. End the connection by right-clicking.

Note
Meeting lines for dynamic connectors

If you want to create a dynamic connector, the mouse must be exactly on the symbol line or 
the connecting line. Otherwise, a connection will be created with an unconnected start or end 
point.

Result
The connection is created:

● If you have drawn an object-based connection, the corresponding objects are created.

● Dynamic connectors are inserted on the report and at the objects if applicable.

● The objects are connected in the report and in the Navigator via their connectors.

You then have the following options: 

● You can change the connection run.
See also chapter Changing a connection run (Page 398).

● You can extend open connections. In this case, select the open end as the start or end 
point.

● You can place more objects on the connection.
See also chapter Inserting objects on a connection (Page 396).

14.3.7.3 Drawing intermediate points on the connection
See also chapter Fundamentals of connections on interactive reports (Page 90).

Requirements
● An interactive report is open. See also chapter Opening documents (Page 173).

● You have just drawn the start point of the connection as described in chapter Drawing the 
start point and end point of the connection (Page 392). The "Connection" tool is still 
activated.

Procedure
1. Move the mouse to the position on the working area where the connecting line is to change 

direction.

2. Click the left mouse button.
An intermediate point is inserted. 

3. Repeat steps 1 and 2 until you have plotted the desired run.
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Result
The connecting line now consists of several connected lines which are treated as one line.

Example:

You can adjust the connection run later using the grab points of the connection. See also 
chapter Changing a connection run (Page 398).

Next, set the end point of the connection as described in chapter Drawing the start point and 
end point of the connection (Page 392).

See also
Switching off the grid (Page 380)

14.3.7.4 Connecting several objects with one line

Requirements
● An interactive report is open. See also chapter Opening documents (Page 173).

● Several objects have been placed on the report. See also chapter Placing objects 
(Page 381).

● The object symbols have static connectors.

Procedure
1. Arrange the object symbols so that their connectors are all in a line. See also chapter Moving 

symbols (Page 417). Rotate a symbol if necessary. See also chapter Rotating symbols 
(Page 419).

2. Activate the "Connection" tool. See also chapter Activating and deactivating the 
"Connection" tool (Page 392).

3. Draw the start point of the connection as described in chapter Drawing the start point and 
end point of the connection (Page 392). 

4. Draw a connecting line which runs across the symbol connectors.
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5. Example from the COMOS P&ID product: 

6. Draw the end point of the connection as described in chapter Drawing the start point and 
end point of the connection (Page 392).

Result
All objects whose connectors are joined by the line you have drawn are connected on the 
report and in the Navigator.

See also
Fundamentals of connections on interactive reports (Page 90)

Switching off the grid (Page 380)

Changing a connection run (Page 398)

14.3.7.5 Inserting objects on a connection
See also chapter Fundamentals of connections on interactive reports (Page 90) and section 
Fundamentals of placing on interactive reports (Page 88).

Introduction
When you place an object using the symbol bar or from the Navigator, you can insert the object 
on a connection. This connects it automatically.

You can also place the object first and then move it to a connection.

Requirements
● An interactive report is open. See also chapter Opening documents (Page 173).

● A connection has been drawn on the report. See also chapter Drawing the start point and 
end point of the connection (Page 392).

● To move an object to a connection later: The object is not connected. It has static 
connectors.
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Inserting an object by placing it on a connection
1. Proceed at first as you would to place an object freely. See also the following chapters:

– Placing objects via the symbol bar (Page 381)

– Placing base objects from the Navigator (Page 382)

– Placing engineering objects from the Navigator (Page 383)

2. Move the mouse to the connecting line when placing.
When the connectors of the symbol touch the connecting line, the connecting line turns 
yellow.
Example from the COMOS P&ID product:

3. Place the object onto the connecting line.

Inserting an already placed object onto a connection
Drag&drop the object onto the connecting line. When the connectors of the symbol touch the 
connecting line, the connecting line turns yellow.

Result
If you have placed the object from the symbol bar or the base data, a new object is created in 
the Navigator.

The object is inserted onto the connection on the report and is linked via its connectors:

● Object-based connection: To the respective connection object 

● Connection without objects: To the objects at which the connection without objects starts 
or ends

See also chapter Drawing the start point and end point of the connection (Page 392).

See also
Switching off the grid (Page 380)

Changing a connection run (Page 398)
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14.3.7.6 Connecting objects directly

Requirements
● An interactive report is open. See also chapter Opening documents (Page 173).

● There are objects placed on the report which have symbols with connectors. See also 
chapter Placing objects (Page 381).

Procedure
Drag&drop a symbol so that its connector is on the connector of another symbol.

Result
The objects are connected in the report and in the Navigator via their connectors.

See also
Switching off the grid (Page 380)

Fundamentals of connections on interactive reports (Page 90)

14.3.7.7 Changing a connection run

Requirements
● An interactive report is open. See also chapter Opening documents (Page 173).

● A connection has been drawn. See also chapter Drawing the start point and end point of 
the connection (Page 392).

Using reports
14.3 Working with interactive reports

Operation
398 Operating Manual, 03/2017 V10.2.1, A5E37082875-AB



Shortening or extending connecting lines or inserting intermediate points
1. Left-click on the connecting line twice. Do not double-click.

You will see the grab points. Each line that forms part of the polyline has the following grab 
points: 

① Start point or end point for shortening and extending
② Center for inserting a kink

2. To change the run of the line, drag&drop the grab points.

Changing connections
You can connect placed symbols, disconnect connections, and merge connecting lines at a 
later time.

To do this, drag&drop the start point or end point of a line to a connector or another line. 
Alternatively, disconnect the start point or end point from the connected connector or line. 

Examples:

The connection information is adjusted accordingly. 
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14.3.8 Editing the properties of placed objects in the interactive report

14.3.8.1 Editing object properties on the report bar

Requirements
● At least one object is selected on the report. 

See chapter Selecting symbols and graphical elements (Page 391).

Procedure
The report bar only offers access to certain properties. 

1. Control elements for the selected object are shown in the toolbar. Which control elements 
you see depends on the report and the selected object. The following control elements are 
possible:

– Object icon

– Fields for editing the name, label, and description

– Fields for editing selected attributes

– Button for applying the entries

Example:

2. Enter the required values in the boxes.

3. Click the "Apply" button: 

Note

You can switch from one field to the next using the <Tab> key. Complete your entry with 
the <Return> key.

You can find additional information on administration in the "Administration" manual, keyword 
"Preparing attribute filters".

Result
Your entries are saved to the object. The symbol is updated if necessary.

Alternative methods of editing the object properties
For an overview of all editing methods, see also chapter Overview of editing engineering 
objects (Page 251).
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See also
Opening documents (Page 173)

14.3.8.2 Editing placed attributes

Requirements
● An attribute is placed on the report.

See chapter Placing or deleting attributes (Page 386).

● The attribute is selected on the report.
See chapter Selecting symbols and graphical elements (Page 391).

Procedure
1. Left-click on the selected attribute value.

An editable field or drop-down list is shown on the working area.

2. Enter a value.

3. Note for text fields with page break (including RTF texts): When text fields with overflowing 
text are moved to the next page with a page break, the text field can only be edited on the 
first page.

Editing RTF texts
Note for attributes of the type of display "Memo field (RTF)": Unlike other attributes, 
DisplayValue for RTF text fields is neither used nor displayed on the interactive report. 
Instead, an XML string is created and saved in DisplayXValue(0). That is why an RTF text 
field should be prepared beforehand in the report template.

When the RTF text field is properly prepared:

1. A green field appears on the report. This field symbolizes the text frame, in other words, 
the maximum usable area for the RTF text on this page.

2. Left-click on the green field.
After a short evaluation phase, the RTF editor is displayed.

3. If the RTF text frame is too small, the menu of the RTF editor cannot be fully displayed. In 
this case, click on the arrow on the right side of the menu of the RTF editor.

4. After the adjustment, click on the white area of interactive report.

Result
The value is saved to the object temporarily. If you close the report without saving, the existing 
value is restored.
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14.3.8.3 Changing owners

Requirements
● At least one object is selected on the report. 

See chapter Selecting symbols and graphical elements (Page 391).

Procedure
1. Click the "Assign object" button in the standard toolbar: 

– In some reports, you will see the "Mode" list in the toolbar. Select the "Automatic" or 
"Define owner" assignment mode. 

– If you do not see the list, the "Automatic" mode is set by default.

2. Drag&drop the new owner from the Navigator onto one of the selected symbols.

3. Exit the "Assign object" function with a right-click.

Result
● The objects are moved below the new owner in the Navigator. Objects which are not allowed 

there are not moved.

● If necessary, a copy of the owner structure is created when the objects are moved.

● If all objects located underneath a unit are moved, the unit is deleted.

● If there are categories below the new owner, the objects are sorted into the categories.

● Properties calculated via the owner are updated. 

14.3.8.4 Switching base objects

Requirements
● There is an object placed on the report. 

See chapter Placing objects (Page 381).

● The new base object has a symbol for the report. 
See chapter Symbols and symbol components (Page 93).
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Procedure
1. Click the "Assign object" button in the standard toolbar:

– In some reports, you will see the "Mode" list in the toolbar. Select the "Automatic" or 
"Change object" assignment mode. 

– If you do not see the list, "Automatic" mode is set by default.

2. Select the new base object on the "Base objects" tab in the Navigator.

3. Drag&drop the selected base object to a placed object.
Multiple assignment is not possible. With the procedure described above, exactly one object 
is automatically selected on the report.

Result
● The base object is changed.

● The engineering object applies the properties and attributes of the new base object. 

● The checked-in values are retained:

– For properties and attributes which were checked into the engineering object before the 
base object was changed

– For properties and attributes that are available at the new base object

● The symbol of the new base object is displayed on the working area.

14.3.8.5 Switching engineering objects

Requirements
● There is an object placed on the report. See also chapter Placing objects (Page 381).

● An engineering object is created in the Navigator. The following applies to the object:

– It has the same class as the placed object. 

– It has a symbol for the drawing type of the report. 

– Recommendation: Their connectors are not linked.

Note
Differing connection information

If an object connector is connected and the corresponding connector of the object 
originally placed on the report is also connected, the connection information in the 
Navigator differs from that on the report. See also chapter Checking contents and 
correcting inconsistencies (Page 443).
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Procedure
1. Click the "Assign object" button in the standard toolbar: 

– In some reports, you will see the "Mode" list in the toolbar. Select the "Automatic" or 
"Change object" assignment mode. 

– If you do not see the list, "Automatic" mode is set by default.

2. Drag&drop the selected engineering object to a placed object.
Multiple selection is not possible. With the procedure described above, exactly one object 
is automatically selected on the report.

Result
● The original engineering object is no longer placed. 

If the originally placed engineering object is located below the report in the Navigator, it is 
deleted.

● The engineering object from the Navigator is placed on the report.

● If possible, the connection information which is already set is applied. 

14.3.8.6 Assigning layers

Aim
You have the following options:

● You want to assign an engineering object a different layer than the one defined by its base 
object.

● You want to assign a layer to a graphical element.

Requirements
● At least one object is selected on the report. 

See chapter Selecting symbols and graphical elements (Page 391).
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Procedure
1. Select one of the following alternatives:

– To assign a layer to an engineering object, select the "Options > Graphical properties" 
command in the context menu. 
Requirements for this step: The drawing type supports layers for placed objects. 
Example: Drawing types in the P&ID module support layers for placed objects.
The "Graphical properties" window opens.

– To assign a layer to a connection, select the "Options > Graphical properties" command 
in the context menu. 

– To assign a layer to a graphical element, select the "Properties" command in the context 
menu.

2. Select the desired layer from the "Layer" list.
In the "Layers" tool you specify how the layers react in terms of printing and exporting. See 
chapter Showing/hiding or freezing the content of a layer (Page 377).

3. Confirm your entries. 

See also
Layers in interactive reports (Page 93)

14.3.8.7 Editing properties of a multiple selection

Requirements
● Several objects have been selected on the report. 

See chapter Selecting symbols and graphical elements (Page 391).
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Procedure
1. Select the "Properties" command in the context menu of the selection.

The "Edit properties" window opens.
The object whose attribute tabs are used as template for editing the selection is listed in 
the title bar of the window. Example: 

– Title bar "Edit properties - Template: +0.L001-E3 Lamp"
The engineering object "E3 Lamp" under location "L001" is used. This engineering object 
offers the attribute tabs for editing.

Note
Checking effect with deviating base objects 

When the selection includes engineering objects with different base objects, the attribute 
tabs may also be different. In this case, the edited attribute determines the engineering 
objects for which the input is applied. 
● If the edited attribute exists in all base objects involved, all engineering objects in the 

selection are edited as well.
In this case, it must technically be the same attribute. An accidental similarity of the 
attribute description or the attribute name is not sufficient.

● If the attribute does not exist in some base objects, the entries are not applied for 
the affected engineering objects.

2. Edit the properties.

3. Confirm your entries.

14.3.9 Working with graphical elements

14.3.9.1 Drawing a line

Principle
You can draw a single line or a polyline. A polyline consists of single lines.

Requirements
An interactive report is open. See also Opening documents (Page 173).
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Procedure
1. Click the "Line" button in the standard toolbar: 

The "Line parameter" button is shown in the toolbar.

2. Optional: To specify the line parameters in advance, proceed as follows: 

– Click on the "Line parameter" button: 

The "Line parameter" window opens.

– Set the desired parameters. See also chapter Windows for setting the parameters of 
graphical elements (Page 415).

– Confirm your entries.

Your entries are used as templates for further lines.

3. Optional: To allow the "Line" tool to lock into place at the capture points of objects and 
graphical elements, proceed as follows:

– Activate the "Construction mode" button on the toolbar:

The "Extended construction" button is shown on the standard toolbar.

– Activate the "Extended construction" button: 

4. Determine the start point with the left mouse button. 
The following fields are shown in the report bar for control purposes:

– "LX" and "LY": Location of the point in the X- and Y-direction

– "W": Absolute angle

– "L": Length of the line

5. Determine the end point with the left mouse button.
The "Switch end points" button is shown on the report bar.

6. Optional: Correct the specifications for angle and length on the report bar.

7. Optional: Add more lines to the line. You have the following options:

– To continue from the end point of the line, repeat steps 5 and 6.

– To continue from the start point of the line, click on the "Switch end points" button: 

Then repeat steps 5 and 6.

8. Right-click to complete the drawing.
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Result
One or more lines have been drawn. You can change the lines subsequently. See also chapter 
Editing graphical elements (Page 412).

You can group the lines. See also chapter Grouping (Page 430).

See also
Rounding polylines (Page 408)

Switching off the grid (Page 380)

14.3.9.2 Rounding polylines

Requirements
You have drawn a polyline with the "Line" tool. See also chapter Drawing a line (Page 406).

Procedure
1. Click the "Arc" button in the standard toolbar: 

More buttons are shown in the toolbar. 

2. Click on the "Round polyline" button: 

3. Left-click the position on the line where the rounding is to begin.
The rounding is displayed on the working area. 

4. Left-click on the point on the adjacent line where the rounding is to end. 

14.3.9.3 Drawing circles and arcs

Requirements
An interactive report is open. See also chapter Opening documents (Page 173).
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Additional control elements when the "Arc" tool is activated
When the "Arc" tool is activated, you see the following control elements in the toolbar:

● Buttons for different construction modes:  

Icon Construction mode
2-point construction (circle)

3-point construction (circle)

2-point construction (arc)

3-point construction (arc)

● A button for rounding polylines: 

See also chapter Rounding polylines (Page 408).

● "Radius" field: For specifying the radius exactly

Note

The value entered here has the unit specified by the report template. It applies for all circle 
construction modes apart from 2-point arc construction until the "Arc" tool is deactivated. 

Procedure
1. Click the "Arc" button in the standard toolbar:

2. Select the button for the desired construction mode on the toolbar.

3. To draw a circle with the 2-point construction, proceed as follows:

– Determine the center of the circle by left-clicking.

– Determine the radius by left-clicking again.

Note
Entering the exact radius

Alternatively, you can enter the exact radius in the "Radius" field on the toolbar. 
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4. To draw an arc with the 2-point construction, proceed as follows:

– Determine the center of the circle by left-clicking.

– Determine the start point and the radius of the arc by left-clicking again.

Note
Drawing direction from start point

The arc is drawn in counter-clockwise.

– Determine the end point of the arc by left-clicking a third time.

5. To draw a circle with the 3-point construction, proceed as follows:
If no value has been entered in the "Radius" field in the toolbar: 

– Determine the first two points which lie on the circumference by left-clicking.
A circle is displayed on the report. It is created from these two points and the current 
mouse position.

– Left-click a third time to determine the third point and, thus, the radius and position of 
the circle. 

If a value has been entered in the "Radius" field in the toolbar: 

– Determine the first point which will lie on the circumference by left-clicking.
A circle with the defined radius is displayed on the report.

– Determine the second point which is to lie on the circumference by left-clicking again. 
This also determines the position of the circle.

6. To draw an arc with the 3-point construction, proceed as follows:

– If a value has been entered in the "Radius" field in the toolbar, delete it. Otherwise, you 
will not be able to set the arc length freely.

– Determine the first two points which lie on the circumference by left-clicking.
A circle is displayed on the report. It is created from these two points and the current 
mouse position.

– Determine the radius, end point, and position of the arc by left-clicking a third time.

Result
A circle or arc is drawn in. It can be edited later. See also chapter Editing graphical elements 
(Page 412).

See also
Switching off the grid (Page 380)

14.3.9.4 Drawing rectangles

Principle
Rectangles consist of a single line.
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Requirements
An interactive report is open. See also Opening documents (Page 173).

Procedure
1. Click the "Rectangle" button on the standard toolbar: 

2. Drag out a rectangle with the left mouse button held down.
You can see the width and height of the rectangle in the toolbar.

3. To change the dimensions, enter the desired values in the toolbar.

4.  Press the <Return> key.

5. Left-click on any location in the report.
The rectangle is adjusted.

Result
The rectangle is inserted. You can fill the rectangle via its parameters. It can be edited later. 
See also chapter Editing graphical elements (Page 412).

See also
Switching off the grid (Page 380)

14.3.9.5 Placing texts

Requirements
An interactive report is open. See also chapter Opening documents (Page 173).
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Procedure
1. Click the "Text" button on the standard toolbar: 

The toolbar is extended: 

① "Default values for text parameters" button
For defining the exact text parameters

② Field for inputting text directly

2. Depending on whether you only want to determine the text or also the text parameters, 
proceed as follows:

– Only determining text:
Enter the text in the toolbar.

– Determining text parameters:
Open the "Text parameters" window via the "Default values for text parameters" button. 
Enter the desired text. Determine its parameters and confirm your entries.
See also chapter Windows for setting the parameters of graphical elements (Page 415).

Your entries are used as templates for placing further texts.
The text is attached to the mouse pointer.

3. Set the insertion point with the left mouse button.

Result
The text is inserted. You can change the text and its parameters at any time. See also chapter 
Editing graphical elements (Page 412).

See also
Fundamentals of graphical elements (Page 92)

Switching off the grid (Page 380)

14.3.9.6 Editing graphical elements

Overview
You can edit graphical elements in the following ways:

● Directly on the working area using the grab points

● In the "Properties" window
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● Using the "Transform" tool
The procedure is like the procedure for symbols. See also the following chapters:

– Mirroring symbols (Page 421)

– Rotating symbols (Page 419)

– Scaling symbols (Page 423)

– Aligning symbols (Page 425)

– Distorting symbols (Page 426)

● You can move them.
The procedure is like the procedure for symbols. See also chapter Moving symbols 
(Page 417).

● You can assign a level. See also chapter Assigning layers (Page 404).

Requirements
● An interactive report is open. See also chapter Opening documents (Page 173).

● There is a graphical element placed on the report. See also the following chapters:

– Drawing a line (Page 406)

– Drawing circles and arcs (Page 408)

– Drawing rectangles (Page 410)

– Placing texts (Page 411)

Using grab points
1. Left-click twice on the graphical element. 

2. Move the grab points using drag&drop.

The following figures show the editing options for the various graphical elements:

● Text:

① Move
② Change alignment

● Lines: 

① Change the length
② Change angle and length

Using reports
14.3 Working with interactive reports

Operation
Operating Manual, 03/2017 V10.2.1, A5E37082875-AB 413



● Circles/Arcs:

① Move
② Change radius and alignment
③ Change angle
④ Change the radius

● Rectangles: 

① Change length and width
② Move

Using the "Properties" window
1. Select the graphical element.

2. Select the "Properties" command in the context menu.

3. The properties of the graphical element open.

4. Change the properties if necessary. 
See also chapter Windows for setting the parameters of graphical elements (Page 415).

5. Confirm your entries.
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14.3.9.7 Windows for setting the parameters of graphical elements

Windows
You define the parameters of the graphical elements placed on reports in the following 
windows:

Graphical element Window
Line "Line parameter"

See also chapter Drawing a line (Page 406) and chapter Rounding 
polylines (Page 408).

Circle/Arc "Circle (arc) parameter"
See also chapter Drawing circles and arcs (Page 408).

Rectangle "Rectangle parameter"
See also chapter Drawing rectangles (Page 410).

Text "Text parameter"
See also chapter Placing texts (Page 411).

Calling the windows
For graphical elements already placed on a report: Context menu of the graphical element, 
"Properties" command

To define templates for placing texts and lines in advance: See chapter Placing texts 
(Page 411) and chapter Drawing a line (Page 406).

Control elements
The following table gives you an overview of all control elements used to configure the 
parameters of the graphical elements. The table is sorted alphabetically: 

Control element Parameter is used 
for ...

Description

"Filling in" Circle/Arc
Rectangle

Option activated:  Shows a color field. The rectangle or the circle is filled 
with the color shown here.
Left-click in the field to select a different color.

"Alignment" Text The options determine the position of the text in relation to the mouse 
pointer.  

"Width" Line
Circle/Arc
Rectangle

Line width
If you change the measurement unit, the width is converted automatically.

"Level" Line
Circle/Arc
Rectangle
Text

The level assigned to the graphical element
Requirements: The report works with levels. 
See also chapter Showing/hiding or freezing the content of a layer 
(Page 377) and chapter Assigning layers (Page 404).
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Control element Parameter is used 
for ...

Description

"Color" Line
Circle/Arc
Rectangle
Text

The line color
Left-click in the field to select a different color.

"Function group plan" Rectangle Reference field for displaying or printing a report section in a different report
See also chapter Integrating a report section into a different report 
(Page 440) and chapter Removing connections to other reports 
(Page 441).

"Label" Line
Circle/Arc
Rectangle

Field for entering a label
The label can be evaluated in scripts. 
Lines and rectangles with the identification "GR" are interpreted as graphics 
during an Excel export, not as cell delimiters.

"No cell delimiter" Line Only in report templates
Relevant for Excel exports
Option activated: The value "GR" is input in the "Label" field.

"Line type" Line
Circle/Arc
Rectangle

The standard lines have round ends.

"Center" Circle/Arc -
"Name" Rectangle -
"P1" Line The X-coordinate and Y-coordinate of the starting point

Rectangle The X-coordinate and Y-coordinate of the top left-hand point of the rectangle
"P2" Line The X-coordinate and Y-coordinate of the end point

Rectangle The X-coordinate and Y-coordinate of the bottom right-hand point of the 
rectangle

"Radius" Circle/Arc -
"Font" Text The "..." button opens a window for determining the font, size, display, etc.
"Apply immediately" Line

Circle/Arc
Rectangle
Text

Option activated: All changes to the parameters are immediately applied 
to the report.

"Start angle" Circle/Arc -
"Soft" Text Only for configuring report templates.
"Angle" Text See also chapter Rotating symbols (Page 419).

Rotates the text around its placing position in 90° increments. 
If the text is rotated with the mouse, the current angle is also entered here.

Circle/Arc Angle which gives the length of the arc.
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14.3.10 Information on editing text
There are two types of texts on an interactive report:

● Text based on an attribute
This text is automatically updated when necessary and exists as a separate object in the 
object model.
See chapter Editing placed attributes (Page 401) for more.

● Text as a graphical element
This text can be edited manually and only exists on the report.
See chapter Placing texts (Page 411) for more.

Texts can be edited on evaluating reports when prepared correctly. See chapter Editing 
editable data (Page 448) for more.

14.3.11 Editing symbols of placed objects

14.3.11.1 Moving symbols

Overview
You can choose between the following tools when moving symbols:

● Drag&drop

● "Transform" tool, "Move" mode

● Grab points

Requirements
● An interactive report is open. See also chapter Opening documents (Page 173).

● Objects have been placed on the report. See also chapter Placing objects (Page 381).

Moving using drag&drop
1. Select the symbols of the desired objects.

2. Move the symbols with the mouse via drag&drop.

Moving with the "Transform" tool
Advantage of this method:

● You can specify the direction and length of the moving vector exactly. 

● You can create copies and move them.
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Procedure:

1. Click the "Transform" button on the standard toolbar:

Buttons for transforming are shown on the toolbar.

2. Click on the "Move" button: 

More control elements are shown in the toolbar.

3. Define the movement vector: Choose one of the following methods:

– Determine the start point and end point of the vector with the left mouse button.
The vector is shown as a blue arrow.

– Determine how far the symbols are moved in the "X" and "Y" fields on the toolbar. 
Unit: Default unit of the report

4. Select the symbol which you want to move or copy. To select several symbols, hold down 
the <Ctrl> key.

5. If you only want to copy the symbol and move the copies, proceed as follows:

– Enter the number of copies in the "Copies" field.

– Select the insert mode in the "Mode" field. The insert modes available are the same as 
when you copy and paste via the context menu. See also chapter Copying/pasting and 
cutting in interactive reports (Page 433).

6. Click the "Execute" button on the toolbar: 

The symbol is moved from its original position relative to the moving vector to the target 
position. 

If you create copies, they are each displaced according to the moving vector when inserted.

Moving with grab points
1. Left-click twice on a symbol. Do not double-click.

You will see the grab points.

2. Move the gray square using drag&drop.

Note
Moving subsymbols and texts or the whole symbol

You can often only move the subsymbols and texts of a symbol, not the whole symbol.

See also
Selecting symbols and graphical elements (Page 391)

Distorting symbols (Page 426)
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14.3.11.2 Rotating symbols

Overview
You can choose between the following tools when rotating symbols:

● <Space key> 

● Grab points

● "Transform" tool, "Rotate" mode

Requirements
● An interactive report is open. See chapter Opening documents (Page 173).

● Objects have been placed on the report. See chapter Placing objects (Page 381).

Rotating using the <space key>
1. Select the symbols of the desired objects.

2. Press the <space key>.

The symbols are rotated counter-clockwise. This is performed in 90° increments by default. 
See chapter Change rotation angle (Page 430).
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Rotating with the grab points
1. Left-click twice on a symbol. Do not double-click. 

You will see the grab points.

2. Move the green circle clockwise using drag&drop: 

Note
Rotating subsymbols or texts

If the symbol has subsymbols or texts, you can rotate these individually, or rotate the entire 
symbol including all subsymbols and texts. 

Example: Surface heat exchanger in P&ID

① Rotate whole symbol
② Rotate subsymbol

The symbol is rotated in 90° increments. 

Rotating with the "Transform" tool
Advantage of this method:

● You can choose the point of rotation freely. 

● You can create copies and rotate them.

● You can rotate several symbols at once.

Procedure:

1. Click the "Transform" button on the standard toolbar:

Buttons for transforming are shown on the toolbar.

2. Click the "Rotate" button: 

More control elements are shown in the toolbar.

Using reports
14.3 Working with interactive reports

Operation
420 Operating Manual, 03/2017 V10.2.1, A5E37082875-AB



3. Enter an angle in the "Rotation angle" field:

– No sign: Rotation to the right

– Negative sign: Rotation to the left

Example: "-45"

4. To define the point of rotation, click on the working area.

5. Select the symbol which you want to rotate or copy. To select several symbols, hold down 
the <Ctrl> key.

6. If you only want to copy the symbol and rotate the copies, proceed as follows:

– Enter the number of copies in the "Copies" field.

– Select the insert mode in the "Mode" field. The insert modes available are the same as 
when you copy and paste via the context menu. See also chapter Copying/pasting and 
cutting in interactive reports (Page 433).

7. Click the "Execute" button on the toolbar: 

The symbol is rotated around the defined point of rotation by the specified angle. 

If you create copies, one copy is inserted per rotation. 

See also
Symbols and symbol components (Page 93)

14.3.11.3 Mirroring symbols

Introduction
You can choose between the following tools when mirroring symbols:

● "Transform" tool, "Rotate" mode

● Context menu of a symbol

Requirements
● An interactive report is open. See also chapter Opening documents (Page 173).

● Objects have been placed on the report. See also chapter Placing objects (Page 381).

Mirroring with the "Transform" tool
Advantage of this method:

● You can mirror several symbols at once. 

● You can determine the mirror axis freely.

● You can create copies when mirroring.
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Procedure:

1. Click the "Transform" button in the standard toolbar:

Buttons for transforming are shown on the toolbar.

2. Click on the "Mirror" button: 

More control elements are shown in the toolbar.

3. Draw the mirror axis by left-clicking.
The mirror axis is represented by a blue line. 

4. Select the symbol you want to mirror. To select several symbols, hold down the <Ctrl> key.

5. If you only want to copy the symbol and mirror the copies, proceed as follows:

– Enter the number of copies in the "Copies" field.

– Select the insert mode in the "Mode" field. The insert modes available are the same as 
when you copy and paste via the context menu. See also chapter Copying/pasting and 
cutting in interactive reports (Page 433).

6. Click the "Execute" button on the toolbar: 

Mirroring an individual symbol on X-axis or Y-axis of the report with the context menu
The context menu for mirroring symbols is available in two versions:

● Context menu with ET-specific reports

– Mirror symbol horizontally

– Mirror symbol vertically

● Context menu with P&ID-specific reports

– Mirror symbol on own X-axis

– Mirror symbol on own Y-axis

The content of these functions is the same in the ET-specific reports and in the P&ID- specific 
reports.

1. Select the symbol in the working area.

2. In the context menu, select the command "Options > Mirror symbol on..." or "Mirror symbol 
horizontally"/"Mirror symbol vertically".
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14.3.11.4 Scaling symbols

Overview
You can choose between the following tools when scaling symbols:

● "Transform" tool, "Scale" mode

● Grab points

Requirements
● An interactive report is open. See also chapter Opening documents (Page 173).

● Objects have been placed on the report. See also chapter Placing objects (Page 381).

Scaling with the "Transform" tool

Note
Principle

The symbol is moved and enlarged along an imagined line between the symbol center and a 
reference point determined by you.

1. Click the "Transform" button in the standard toolbar: 

The report-specific toolbar for transforming is displayed.

2. Click the "Scale" button in the report-specific toolbar: 

More control elements are shown in the toolbar.

3. Define the reference point by left-clicking.

Note
Scaling without moving

If you only want to scale a symbol, select the symbol center as the reference point. 

The reference point is shown as a blue double circle. 

4. Select the object you want to move. To select several objects, hold down the <Ctrl> key.

5. Enter the scaling factors separately for the X-axis and Y-axis under "Factor X" and "Factor 
Y".

– Factor > 1: Moving by the factor away from the reference point and magnification by this 
factor.

– Factor < 1: Moving by the factor toward the reference point and reduction by this factor.
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6. If you only want to copy the symbol and scale the copies, proceed as follows:

– Enter the number of copies in the "Copies" field.

– Select the insert mode in the "Mode" field. The insert modes available are the same as 
when you copy and paste via the context menu. See also chapter Deleting in interactive 
reports (Page 436).

7. Click the "Execute" button on the toolbar: 

Scaling with grab points
Scaling using the grab points is not available for all symbols. Proceed as follows:

1. Left-click twice on a symbol. Do not double-click. 
You will see the grab points.

2. Move one of the turquoise squares using drag&drop. 

Result
● The symbol is moved and scaled. 

● Whether or not symbol texts are scaled depends on the symbol definition. You can find 
additional information on this topic in the "Administration" manual, keyword "DrawText".

Example of scaling with the "Transform" tool
The following illustration shows how a symbol was scaled along a horizontal axis with the 
"Transform" tool: 

1

2

345

① Reference point
② Imagined scaling axis between Object ④ and Reference point ①. 

Note: The scaling axis is not visible in the interactive report. 
③ Result of the scaling with the factors x = 0.5 and y = 0.5
④ Starting position
⑤ Result of the scaling with the factors x = 2 and y = 2
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14.3.11.5 Aligning symbols

Aim
You want to align symbols with a different symbol (reference symbol) or adjust them according 
to the reference symbol.

Requirements
● An interactive report is open. See also chapter Opening documents (Page 173).

● Objects have been placed on the report. See also chapter Placing objects (Page 381).

Procedure
1. Click the "Transform" button in the standard toolbar:

Buttons for transforming are shown on the toolbar.

2. Click on the "Align" button: 

More control elements are shown in the toolbar.

3. Select the reference symbol.

4. Select the symbols you want to edit.

Note
Mixed selection

You can also edit graphical objects. To do this, only select graphical elements. If a selection 
contains symbols and graphical elements, only the symbols are edited. 

5. To align the symbols, select one of the following modes in the "Align" list:

– "At point of origin horizontal"

– "At point of origin vertical"

– "Left:"

– "Right:"

– "Top:"

– "Bottom:"
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6. To adjust the symbols, select one of the following modes in the "Align" list:

– "Adjust width"

– "Adjust height"

– "Adjust size"

7. Click the "Execute" button on the toolbar: 

14.3.11.6 Distorting symbols

Requirements
● An interactive report is open. See also chapter Opening documents (Page 173).

● Objects have been placed on the report. See also chapter Placing objects (Page 381).

Procedure
1. Click the "Transform" button on the standard toolbar:

Buttons for transforming are shown on the toolbar.

2. Click on the "Distort" button: 

More control elements are shown in the toolbar.

3. Define the movement vector: Choose one of the following methods:

– Determine the start point and end point of the vector with the left mouse button.
The vector is shown as a blue arrow.

– Determine how far the symbols are moved in the "X" and "Y" fields on the toolbar. 
Unit: Default unit of the report

4. Determine a polygon which includes the symbols you want to move by left-clicking.

Result
The content of the selection polygon is moved as soon as you close the polygon. The following 
rules apply: 

● Symbols with connectors are only moved if all the connectors lie in the selection polygon.

● Symbols that have no connectors are only moved if the rectangle around them lies 
completely within the selection polygon.

● Circles are always completely moved but not distorted.

● Lines: If the start point is outside of the polygon, it is not moved. If the end point is inside 
the polygon, it is moved. Start point and end point are reconnected and, thus, distorted.

Using reports
14.3 Working with interactive reports

Operation
426 Operating Manual, 03/2017 V10.2.1, A5E37082875-AB



See also
Moving symbols (Page 417)

14.3.11.7 Overwriting inherited symbols locally

Principle
You can overwrite the symbol an engineering object has inherited from a base object for an 
individual interactive report. 

Requirements
● An interactive report is open. See also chapter Opening documents (Page 173).

● There is an object placed on the report. See also chapter Placing objects (Page 381).

● The object symbol is not locked for editing. 

Procedure
1. Select the object symbol.

2. Select the "Options > Edit symbol" command in the context menu.
The Symbol Editor opens. 

3. Make the required changes. You can find additional information on the operation of the 
Symbol Editor in the "Administration" manual, keyword "Configuring symbols".

4. Confirm your entries.

5. Close the Symbol Editor.

Result
The changes to the symbol will be saved locally for the open report. They have no effect on 
placements in other reports.

Note
Automatic updating from the base data interrupted

If the administrator changes the symbol of the base object at a later date, the symbol in the 
report will not be updated.

See also
Restoring the original symbol (Page 429)
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14.3.11.8 Editing the graphical properties of a symbol

Requirements
● An interactive report is open. See also chapter Opening documents (Page 173).

● There is an object placed on the report. See also chapter Placing objects (Page 381).

Procedure
1. Select the object symbol.

2. Select the "Options > Graphical properties" command in the context menu.
The "Graphical properties" window opens.

3. Edit the graphical properties. See also chapter "Graphical properties" window (Page 428).

4. Confirm your entries.

Result
The symbol is adjusted.

Note
Restricted effect

The configuration of the symbol in the base data can prevent your entries in the "Graphical 
properties" window from taking effect. You can find additional information on this topic in the 
"Administration" manual, keyword "Reference of the SymbolScript".

14.3.11.9 "Graphical properties" window

Call
See chapter Editing the graphical properties of a symbol (Page 428).

"Line" control group
The "Line" control group relates to all lines of the selected symbol. It has the following control 
elements:

Control element Description
"Width" If you change the measurement unit, the width is 

converted automatically.
"Line type" -
"Color" Left-click in the field to select a different color.
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Control element Description
"Filling in" Option activated: Shows a color field. The symbol 

is filled in with the color displayed in the color field. 
Left-click in the field to select a different color. 

"Level" The level assigned to the graphical element
Requirements: The report works with levels. 
See also chapter Assigning layers (Page 404) and 
chapter Showing/hiding or freezing the content of 
a layer (Page 377).

"Geometry" control group

Control element Description
"Angle" See also chapter Rotating symbols (Page 419)
"Scaling factor X" See also chapter Scaling symbols (Page 423).
"Scaling factor Y"

14.3.11.10 Restoring the original symbol

Requirements
● An interactive report is open. See also chapter Opening documents (Page 173).

● There is an object placed on the report. See also chapter Placing objects (Page 381).

● The object symbol has been redefined on the report:

– In Symbol Editor
See also chapter Overwriting inherited symbols locally (Page 427).

– Via the graphical properties
See also chapter Editing the graphical properties of a symbol (Page 428).

Procedure
1. Select the symbol.

2. Select the "Options > Restore the original symbol" command in the context menu.

Result
The symbol definition of the base object takes effect again.
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14.3.11.11 Change rotation angle

Procedure
The angle of rotation is controlled via the user settings. See chapter Reference of the "Report" 
user settings (Page 372).

14.3.11.12 Editing parameters of the symbol texts

Aim
You want to edit the font and formatting of the texts for a symbol.

Procedure
1. Select the symbol.

2. Select the "Options > Edit symbol texts" command in the context menu.
The "Symbol text parameter" window opens. 

3. To edit the display for all text symbols at once, select the "All symbol texts" entry from the 
"Symbol text label" list.

4. To edit the display of symbol texts for a specific label, proceed as follows:

– Select the desired label in the "Symbol text label" list.
The texts with this label are displayed in the "Found texts" field.

– Select the desired texts.

5. Edit the parameters.

6. Confirm your entries.

See also
Symbols and symbol components (Page 93)

14.3.12 Working with groupings

14.3.12.1 Grouping

Requirements
● An interactive report is open.

● There are symbols or graphical elements placed on the report.
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Procedure
1. In the working area, select the symbols and graphical elements you wish to group.

2. Select the "Grouping > Create" command in the context menu.

Result
The selected symbols and graphical elements are grouped. If you select an element of a group, 
the entire group is initially selected. 

Consequence:

● Actions which are applicable to several elements are applied to the whole group.
Examples: 

– Moving

– Deleting 

– Copying

– Changing the graphical properties

Note
Applying an action to the originally selected element only

To apply an action which is applicable to several elements to the originally selected element 
only, select the element again. Perform the required action.

● Actions which are only applicable to one element are applied to the element originally 
selected.
Examples: Navigating and opening the properties

See also
Removing elements from a group (Page 431)

Undoing grouping (Page 432)

14.3.12.2 Removing elements from a group

Requirements
● An interactive report is open.

● The symbols or graphical elements placed on the report have been grouped.

Procedure
1. Select the element you wish to remove from the group.

2. Select the "Grouping > Remove from group" command in the context menu.
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Result
The element is removed from the group. If the object group only has one element left after this 
process, it is ungrouped. 

See also
Grouping (Page 430)

Undoing grouping (Page 432)

14.3.12.3 Undoing grouping

Requirements
● An interactive report is open.

● The symbols or graphical elements placed on the report have been grouped.

Procedure
1. Select an element from the group.

2. Select the "Grouping > Cancel" command in the context menu.

Restoring a group
1. Select an object which was included in the group.

2. Select the "Grouping > Restore" command in the context menu of the construction area.

See also
Grouping (Page 430)

Removing elements from a group (Page 431)
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14.3.13 Copying/pasting and cutting in interactive reports

Special features for pasting
The following applies when pasting symbols which have been copied or cut:

● If you use the shortcut menu, you can select a paste mode. The paste mode determines 
whether engineering objects are created in the Navigator, and where they are created.

● If you use the standard keyboard command for pasting, the paste location is determined 
by the "Automatic" paste mode.

● Cut/Paste 
If the report is changed with this combination, both reports must stay open. If the source 
document is closed between the "Cut" and "Paste" work steps, the source document is 
automatically saved when it is closed. This means the objects will still be present in the 
source document. 
Example: Objects are cut in a report, then another report is opened with "Navigate to". The 
target document opens in the same tab as the source document so that the source 
document is automatically closed and saved. You can now insert the objects in the target 
document with "Paste", but the objects still exist in the source document.

Requirements
● An interactive report is open. See also chapter Opening documents (Page 173).

● There are engineering objects or graphical elements placed on the report. See also chapter 
Placing objects (Page 381) and chapter Working with graphical elements (Page 406).

Using the shortcut menu
1. Select the desired symbols and graphical elements.

2. In the shortcut menu, select the "Copy" or "Cut" command.

Note
Additional information required for cutting

In some cases, depending on the drawing type, you must determine what is to happen to 
other objects which are indirectly affected by cutting. Example from P&ID: A pump placed 
on a pipe is cut.

You can find additional information on this topic in the COMOS product manuals.
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3. If you wish to paste the selection onto a different interactive report, open the report.

Note
Observe the drawing type

You can only paste the objects if they have a symbol for the drawing type of the report.

4. To paste the selection, select the paste mode in the shortcut menu of the working area. It 
determines what happens to the engineering objects of the symbols when pasted:

"Paste > ..." Result in the Navigator
"Automatic" One of the other paste modes is executed, as defined by the drawing 

type.
You can find additional information on this topic in the COMOS 
product manuals.

"At same position" The engineering objects are pasted in the same position, i.e. parallel 
to the originals when copied.

"Parallel to document" The engineering objects are pasted parallel to the report.
"Below document" The engineering objects are pasted below the report.
"Keep objects" Cut: The engineering objects are located where they were before 

they were cut.
Copy: The engineering objects are placed more than once. No new 
objects are created. 

"Structure below document" For copying or cutting objects which are not located below a report.
This paste mode reproduces the structure below which the objects 
are located as far as the highest shared unit or location. After past‐
ing, you can transfer the objects more easily to a new target structure 
in a second step.
Result of the pasting: A "@CopyStruct<No>" node is created below 
the report, and the reproduced structure and the objects are created 
below that.

"No objects" No engineering objects are pasted in the Navigator.
The symbols are pasted into the report as pure graphics. 

If you paste the selection onto a different interactive report, you can also paste the symbols 
and graphical elements onto the working area in the same position as in the original. Select 
the "Paste at original position" command from the shortcut menu.
The same menu also exists for copied reports. See also chapter "Define insert mode for 
objects" window (Page 594).

Result
● The graphical elements and symbols are pasted. 

● Engineering objects are created or moved in the Navigator as determined by the paste 
mode.
The "Below document" and "Parallel to document" paste modes do not apply if there are 
category folders parallel to the report and the report template supports the use of categories. 
In this case, the objects are sorted into the categories. 
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● The following applies when copying:

– All the non-inherited data is copied.

– If a linked attribute was part of the amount to be copied, the copy uses the link.
If the link source was part of the amount to be copied, the copied linked attribute points 
to the copied link source.

– Ideally, elements are pasted below the previous owner. If no more elements can be 
inserted below the previous owner, a new owner is created. 

● Properties which depend on the owner are recalculated based on the new owner.

● The following references are retained: 

Reference Copy Cut
Unit reference ✓ ✓
Location reference ✓ ✓
Implementation reference Only if the referenced object 

has also been copied
✓

Request reference ✓
Reference attributes ✓

If the referenced object has al‐
so been copied, the reference 
attribute points to the copy.

✓

Connectors Only if the connected object 
has also been copied

Object is connected via the "Con‐
nection" tool: Depends on com‐
ponent and drawing type 
Object is connected directly to 
the other component: ✓

Controlling paste mode by means of script
You can specify in the options script for the report template that a certain paste method is used 
automatically. The shortcut menu "Define paste mode" does not appear in this case.

You can find additional information on this topic in the "Platform Administration" manual, 
keyword "Functions for the options script", option "OverrideCopyMode".

Alternative procedure for copying within a report
1. Select the desired symbols and graphical elements.

2. Press and hold down the <Ctrl> key.

3. Move the selection to the desired position in the working area using drag&drop.

See also
Basic knowledge on copying objects (Page 120)

Overview of the copy methods (Page 119)
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14.3.14 Deleting in interactive reports

Principle
You can delete the graphical elements and symbols from an interactive report. 

You have the following options when deleting a symbol:

● You delete the symbol only.

● You delete the symbol and the corresponding engineering object.

Requirements
● An interactive report is open. See also chapter Opening documents (Page 173).

● There are engineering objects or graphical elements placed on the report. See also chapter 
Placing objects (Page 381) and chapter Working with graphical elements (Page 406).

Deleting a symbol
1. Select the symbol in the working area.

2. Select "Delete" from the context menu.

Result:

● The symbol is deleted. 
If the symbol was connected on the report, the connection is disconnected. 

● If the engineering object of the symbol is located below the report in the Navigator, the 
engineering object is deleted as well. If it is not below the report, it is not deleted. However, 
it is no longer placed on the report.

Deleting a symbol and engineering object
1. Select the symbol in the working area.

2. Select "Delete > Object" from the context menu.

Result: As above, but the corresponding engineering object is always deleted. If there are 
objects located below the engineering object, they are also deleted. See also Deleting 
(Page 180).

Deleting graphical elements
1. Select a graphical element. 

2. Select "Delete" from the context menu.

Multiple selection
You can select several symbols or graphical elements and delete them simultaneously.
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Additional information
In some cases, depending on the drawing type, you must determine what is to happen to other 
objects which are indirectly affected by the deletion. Example from P&ID: A pump placed on 
a pipe is deleted.

You can find more information on this topic in the COMOS product manuals.

See also
Deletion in working layers and in the released area (Page 38)

14.3.15 Showing changes in working layers

Introduction
You can show the content from a working layer of an interactive report in a different working 
layer, and thus compare the editing statuses.

Requirements
● The engineering project uses working layers. 

● A working layer or the released area is open. See also chapter Opening the working layers 
of a project (Page 193) and chapter Opening a project or the released area of a project 
(Page 185).

● The content of the report has been altered in a working layer. The working layer is not the 
same one that the report was created in.

Procedure
1. Open the interactive report. See also chapter Opening documents (Page 173).

2. Click the "Changes in working layers" button in the toolbar.
The report is locked. The "Changes in working layers" window opens. It contains a table of 
the working layers in which the content of the report has been edited. If necessary, the 
released area is also listed. 
The table contains the following information:

– ID, name, and description of the working layer or the released area

– User and date of last change 

– Option to show/hide the content

3. To show the content of one or more other working layers, activate the options for these 
working layers in the "Visible" column.
The content of the selected working layers is shown in the working area, in addition to that 
of the current working layer. The symbols are colored according to their working layer status.

4. To hide content from another working layer again, deactivate the option you previously 
activated, or close the window.
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14.3.16 Working with placed reports

14.3.16.1 Replacing a placed report and changing coordinates

Requirements
● An interactive report is open. See also Opening documents (Page 173).

● Another interactive report is placed on the report. See also chapter Placing a report on a 
report (Page 387).

● The placed report has not yet been broken apart. 

Procedure
1. Select the control triangle of the placed report:

2. Select the "Options" command in the context menu.
The "Options" window opens.

3. To replace the placed report with a different one, use drag&drop to move a different 
interactive report with the appropriate drawing type from the Navigator to the "Document" 
field.
The graphical content of this report is displayed.

4. To specify the exact coordinates for the placement, enter the coordinates for the left upper 
corner of the control triangle in the "X" and "Y" fields.
The graphical content of the report is moved correspondingly.

5. Confirm your entries.

14.3.16.2 Opening a placed report

Requirements
● An interactive report is open. See also chapter Opening documents (Page 173).

● Another interactive report is placed on the report. See also Placing a report on a report 
(Page 387).
The placed report has not yet been broken apart.

Procedure
1. Select the control triangle of the placed report.

2. Select the "Open" command in the context menu.
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Result
The placed report is opened.

14.3.16.3 Breaking apart a placed report

Requirements
● An interactive report is open. See also chapter Opening documents (Page 173).

● Another interactive report is placed on the report. See also Placing a report on a report 
(Page 387).
The placed report has not yet been broken apart.

Procedure
1. Select the control triangle of the placed report:

2. Select the "Dissolve placed document" command in the context menu.

Result
● The objects which were below the original report in the Navigator are moved to below the 

open report. They are placed on the open report.

● The graphical contents of the original report remain placed on the open report. They are 
no longer read-only.

● The original report is deleted. 

● The control triangle disappears.

14.3.17 Printing interactive reports

Overview
You have the following options:

● Print the whole report
See also chapter Printing reports (Page 451).

● Printing a report section
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Printing a report section
1. Open the report. See also chapter Opening documents (Page 173).

2. Zoom the working area until it displays the desired section. See also chapter Zoom 
(Page 373).

3. Click the "Print" button on the toolbar: 

4. Select a printer and the print configuration in the "Print" window.

5. Activate the "Marking" option.

6. Confirm your entries.

Only the selected objects are printed in the selected zoom to the full-screen format. The 
selected objects are scaled to the format set on the printer. The scale factor is ignored. The 
page proportions are retained. 

Alternatively, you can integrate the report section into a different report and then print this 
report. See also chapter Integrating a report section into a different report (Page 440).

14.3.18 Integrating a report section into a different report

Requirements
● An interactive report is open. See also chapter Opening documents (Page 173).

● A second report of the same drawing type is created. See also chapter Creating 
Documents (Page 307).

● The document version of the reports is the same as the COMOS version.
You can find additional information on this topic in the "Administration" manual, keyword 
"Data maintenance: Match document version"

Procedure
1. Using the "Rectangle" tool, draw a rectangle around the contents which you want to 

integrate into the other report.
See also chapter Drawing rectangles (Page 410).

2. Open the properties of the rectangle.

3. Move the second report from the Navigator to the "Function group plan" field using 
drag&drop.

4. Confirm your entries.

5. Save the open interactive report.
The display of the frame line changes. It becomes a dashed gray line.
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Result
● The selected section is integrated into the second report. Changes to the original report 

are displayed in the second report automatically.

● You can print out the section without opening the original report by printing the second 
report.

● The connection between the two reports remains intact until it is canceled. See also chapter 
Removing connections to other reports (Page 441).

● The objects placed in the section are only placed on the original report.

14.3.19 Removing connections to other reports

Requirements
● An interactive report is open. See also chapter Opening documents (Page 173).

● A section of the report has been integrated into another interactive report. See also chapter 
Integrating a report section into a different report (Page 440).

Procedure
Delete the rectangle which surrounds the integrated section. See also chapter Deleting in 
interactive reports (Page 436).

14.3.20 Creating templates from placed objects
See also chapter Fundamentals of templates and usages (Page 50).

Principle
In an engineering project, you can create a template for other interactive reports from an edited 
interactive report.

Requirements
● An interactive report is open. See also chapter Opening documents (Page 173).

● Objects have been placed and connected in the working area of the interactive report. See 
also chapter Placing objects (Page 381) and chapter Connecting objects (Page 392).

● To create a global template: You have write rights in the base project.
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Procedure
1. Select the desired symbols and connections.

2. Select the "Create template" command from the context menu.
The "Create template" window opens.

In the right-hand area (④), you see the symbols which will become part of the template.

3. In the list (①), specify the tab on which the template is to be created in the Navigator.

4. Specify where the template is to be created via the options (②):

– "Project" option: As a local template in the current engineering project 

– "Base project" option: As a global template in the base project.

5. Specify the node below which the template object is to be created in the object tree (③).

6. Confirm your entries

Result
The template is created. 

See also
Placing objects by inserting a template (Page 384)
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14.3.21 Checking contents and correcting inconsistencies

Requirements
● An interactive report is open. See also chapter Opening documents (Page 173).

● Objects have been placed and connected on the report. See also chapter Placing objects 
(Page 381) and chapter Connecting objects (Page 392).

Checking
Select the "Check > Document" command in the context menu of the working area. 

The contents of the working area are checked. The checking algorithm and display of the 
results depend on the product. Following the check, you can correct the errors and warnings 
found. You can find more information on this topic in the respective COMOS product manuals.

Displaying and analyzing inconsistencies
1. Select "Inconsistency > Show previous" or "... > Show next" in the context menu. If there 

is only one error, you are offered the "... > Show inconsistency" command.
The working area is zoomed and the incorrect object selected.

2. Select the "Inconsistency > Analyze" command in the context menu.
A message opens showing a precise analysis.

Deleting all inconsistent objects
Select the "Inconsistency > Delete all inconsistent objects" command in the context menu. 

The objects are deleted in the working area and in the Navigator.

Searching for reports with inconsistent DocObj objects
You can search for reports with inconsistent DocObj objects and delete the inconsistent 
DocObj objects using the "All document tools" tool.

See also
Working with the tool "All document tools" (Page 316)
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14.3.22 Context menu for interactive reports

Principle
The commands you see depend on the following factors:

● Whether the shortcut menu was called for the working area or for one or more graphical 
elements and symbols (selection)

● Whether the report was opened as read-only

Shortcut menu of the objects: Important commands 
Sorted alphabetically:

Command
 

Description

"Refresh" Refreshes the display of the symbol.
"Cut" See also chapter Copying/pasting and cutting in interactive reports 

(Page 433).
"Properties" See also chapter Opening properties (Page 171).
"Paste" See also chapter Copying/pasting and cutting in interactive reports 

(Page 433).
"Paste at original position" See also chapter Copying/pasting and cutting in interactive reports 

(Page 433).
"Settings > ..." The subcommands you see depend on the report.

You can find additional information on this topic in the COMOS product man‐
uals.

 "... > Label visible" Shows the device label on the symbol.
You can find additional information on this topic in the "COMOS EI&C Oper‐
ation" and "COMOS EI&C Administration" manuals.

"... > Fixed" You can find additional information on this topic in the "Administration" man‐
ual, keyword "Using search text to define placeholder symbols".

"... > Background" If two symbols are overlapping, the selected symbol is moved to the back‐
ground or foreground."... > Foreground"

"... > Search text" You can find additional information on this topic in the "Administration" man‐
ual, keyword "Using search text to define placeholder symbols".

"Graphical format" The command transfer settings that have been set in the "Graphical proper‐
ties" window. You can find more information on this topic in the "P&ID Oper‐
ation" manual, keyword "Applying the graphical format".

 "... > Memorize graphical format"
"... > Apply graphical format"

"Grouping" See chapter Working with groupings (Page 430).
"Inconsistencies" See chapter Checking contents and correcting inconsistencies (Page 443).
"Copy" See chapter Copying/pasting and cutting in interactive reports (Page 433).
"Create template" See chapter Creating templates from placed objects (Page 441).
"Delete" See chapter Deleting in interactive reports (Page 436).
"Navigate" See chapter Navigating (Page 170).
"New" See chapter Placing objects via the context menu of a symbol (Page 383).
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Command
 

Description

"Options > ..." The subcommands you see depend on the report. The commands listed below 
are used in many reports. 
You can find additional information on this topic in the COMOS product man‐
uals.

 "... > Release" Releases a locked symbol for editing.
" ... > Graphical properties" See chapter Editing the graphical properties of a symbol (Page 428).
"... > Restore the original symbol" See chapter Restoring the original symbol (Page 429).
" ... > Lock" Locks the symbol for editing.
"... > Edit symbol" See chapter Overwriting inherited symbols locally (Page 427).
"... > Mirror symbol on own X-axis" See chapter Mirroring symbols (Page 421).
"... > Mirror symbol on own Y-axis"
"... > Edit symbol texts" See chapter Editing parameters of the symbol texts (Page 430).

Shortcut menu of the report: Important commands 
Sorted alphabetically:

Command
 

Description

"Properties" See chapter Opening properties (Page 171).
"Paste" See chapter Copying/pasting and cutting in interactive reports (Page 433).
"Paste at original position" See chapter Copying/pasting and cutting in interactive reports (Page 433).
"Inconsistencies" See chapter Checking contents and correcting inconsistencies (Page 443).
"Create template" See chapter Creating templates from placed objects (Page 441).
"Place template" See chapter Placing objects by inserting a template (Page 384).
"Navigate" See chapter Navigating (Page 170).
"Options > ..." The subcommands you see depend on the report. The commands listed below 

are used in many reports. 
You can find additional information on this topic in the COMOS product man‐
uals.

 "... > Export" Product-specific
"... > Import" Product-specific
" ... > Construction mode" Activates the "Construction mode" button in the toolbar of the report. See also 

chapter Toolbar in interactive reports (Page 369).
" ... > Scale" See chapter Setting the scale (Page 378).
" ... > Symbol rotation" See chapter Change rotation angle (Page 430).

"Check" See chapter Checking contents and correcting inconsistencies (Page 443).
"<Number> Delete objects outside" Deletes all objects and graphical elements which are outside the working area.
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More commands
More commands are possible, depending on the following factors:

● Report template 

● Base object of the engineering object for whose symbol the shortcut menu was called

You can find additional information on this topic in the COMOS product manuals.

See also
Structure of interactive reports (Page 368)
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14.4 Working with evaluating reports

14.4.1 Structure of evaluating reports

Structure

① Toolbar
The buttons have the same function as the corresponding buttons in interactive reports. See 
also chapter Toolbar in interactive reports (Page 369).

② Evaluated data
Fields marked in green are editable.

③ The drawing header displays important management data including general project data and 
information about the design engineer and the revision status, for example.
The data is exported from the properties of the report. Exactly which data is displayed depends 
on the configuration of the report template.

See also
Overview of evaluating reports (Page 95)
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14.4.2 Zooming and moving a page section

Requirements
An evaluating report is open. See also chapter Opening documents (Page 173).

Procedure
The procedure is the same as the procedure in interactive reports. See also chapter Zoom 
(Page 373) and chapter Moving a sheet section (Page 375).

14.4.3 Editing editable data

Requirements
● An evaluating report is open. See also chapter Opening documents (Page 173).

● It has editable data.

Procedure
1. Left-click in a field highlighted in green. Multiple selection is not possible. 

2. Enter a new value or select a value from a list.

3. RTF texts are edited like on interactive reports. See chapter Editing placed attributes 
(Page 401) for more.
Specialty: If an RTF text is longer than the text frame on an evaluating report, a new page 
is created and the text continues on the next page.

Result
The value is automatically saved at the corresponding object.

If inconsistencies occur between linked attributes due to your input, the field turns orange. 

Correcting an inconsistency or accepting a difference
1. Select the "Navigate" command in the context menu of the field.

The corresponding attribute is selected in the Navigator.

2. Select the engineering object under which the attribute is located. 

3. Select the "Properties" command in the context menu.

4. Select the tab on which the attribute is located.

5. Correct the inconsistency or accept the difference. See also chapter Refreshing static 
links (Page 264) and chapter Accepting differences between static links (Page 264).
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See also
Overview of evaluating reports (Page 95)

14.5 Working with sketch reports

14.5.1 Inserting notes

Principle behind notes
There is not normally enough space to write longer texts in a sketch. You can use the "Note" 
tool to set a reference text and place the corresponding text elsewhere (Notes are also referred 
to as footnotes).

Requirements
● A sketch report is open. 

● The sketch report supports the use of notes. You can find additional information on this 
topic in the "Administration" manual, keyword "Preparing for using notes in sketch reports".

Inserting notes
1. Select the "Note" command in the context menu of the sketch report.

A reference text, similar to a footnote character, is inserted in the sketch report. A note 
object is created underneath the report. 

2. Optional: Move the reference text to the desired position in the report.

3. Open the note object, enter the text, and confirm your entries.
The note text is written to the note list.

4. If you want to see your entries immediately, click the "Reevaluate document" command 
from the toolbar of the report.

Deleting notes
1. Select a note in the report.

2. Select the "Delete note" command from the context menu.

The note and the COMOS note object are deleted.

See also
Overview of the sketch reports (Page 97)

Opening documents (Page 173)
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14.5.2 Inserting drawings

Requirements
A sketch report is open.

Procedure
The procedure depends on the template of the sketch report: 

● The template is based on a template for evaluating reports and supports the insertion of 
drawings: 

– Click the "Sketch designer" button on the toolbar. It opens the Symbol Editor. 

– Draw a sketch in the Symbol Editor.

– Confirm your entries.

The drawing is inserted in the space reserved for the sketch via a graphical object in the 
report template. 

● The template is based on a template for interactive reports: 
Use the graphical drawing tools on the toolbar. They are used in the same way as in 
interactive reports. See also chapter Working with graphical elements (Page 406).

See also
Overview of the sketch reports (Page 97)

Opening documents (Page 173)

14.6 Updating reports

Requirements
One or more reports have been created.

Updating an open report
1. Open a report.

2. Select the "Reevaluate document" button on the toolbar: 
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Updating several closed reports
1. Select the "Documents > Evaluate " command from the menu.

The "Evaluate" tab opens.

Note

The tab is based on a query. You can filter, sort, and export it. See also chapter Using 
"Simple" run mode (Page 460).

2. Set a start object using drag&drop.
You see all the documents below the start object.

3. Select the desired reports.

4. Click the "Execute" button.

Alternatively: Use the tool "All document tools". See also chapter Working with the tool "All 
document tools" (Page 316).

Result
The objects placed on the report or objects evaluated by the report are recalculated. The report 
content is updated.

14.7 Printing reports

Overview
You have the following options:

● Printing an open report

● Printing a report without opening

You can print to a paper printer or to a file. If you print to a file, you export the report.

Printing an open report
1. Open the report. See also chapter Opening documents (Page 173).

2. Click the "Print" button on the toolbar of the report.

3. Select a printer and the print configuration in the "Print" window.

4. Confirm your entries.

You can select your own print format or use the default format for the printer. If the report format 
is bigger than the print format, the report is scaled. In the reverse case, not all of the printing 
area is used.
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Printing a report without opening
See also chapter Printing documents (Page 312).

Difference in printing when report is open or closed
● Report is open.

The report is in write access. During printing, * revisions are taken into consideration and 
appear in the printout.

● Report is closed or report was opened with write protection
The report is in write protection. There is no evaluation in write protection. Therefore, no 
new * revisions are generated, and * revisions are also not included in the printout.
This is also the case when a closed report is printed using the context menu. 

See also
Printing interactive reports (Page 439)

Overview of printing and exporting revision files (Page 337)

14.8 Exporting and importing reports

Export options
You can export the contents of reports:

Target format Report type More information ...
PDF Interactive and evaluating reports "Basic interfaces" manual, keyword "Ex‐

porting a report as a PDF"
Word Interactive and evaluating reports "Basic interfaces" manual, keyword "Ex‐

porting reports to Word"
Excel Evaluating reports "Basic interfaces" manual, keyword "Ex‐

porting reports to Excel"
DWG/DWX Interactive reports "Basic interfaces" manual, keyword "Ex‐

porting and importing DWG/DXF files"
EMF Interactive and evaluating reports "Basic interfaces" manual, keyword "Ex‐

porting reports to EMF"

When exporting as PDFs, you can also export the project structure in the form of bookmarks.

The export of interactive reports is also controlled by the layers. See also chapter Showing/
hiding or freezing the content of a layer (Page 377).

Reimporting Excel data to COMOS
You can reimport changes to the exported Excel data into COMOS. The objects evaluated by 
the evaluating report are updated accordingly. You can find additional information on this topic 
in the "Basic interfaces" manual, keywords "Reimporting content from Access/Excel/XML files" 
and "Reimporting content from Access/Excel files or directories".
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Importing and exporting DWG and DXF files
You can import the contents of DWG and DXF files to interactive reports and vice versa. You 
can find additional information on this topic in the "Basic interfaces" manual, keyword 
"Exporting and importing DWG/DXF files".
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Using queries and bulk processing 15
15.1 Purpose of queries

Queries search for objects of a specific system type. The search result is displayed in an Object 
Browser. You can edit the data directly in the Object Browser.

The configuration of the query determines:

● Which objects are being searched for

● What data is displayed in the Object Browser

● What data you can edit in the Object Browser

● The run mode in which the query is started

The database has predefined standard queries. Experienced users and administrators derive 
their own queries from standard queries, configure the queries according to the requirements, 
and save them in the Navigator. 

The standard query interface differs depending on the system type searched for.

See also
The main versions of queries (Page 455)

15.2 The main versions of queries

Requirements
● You are familiar with the purpose of the queries.

See chapter Purpose of queries (Page 455).
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Variants of queries

Variants Subvariants Aim Available in CO‐
MOS version

"Classic" display Run mode: Ad‐
vanced

Main target group: Administrators and experienced users
This run mode has a complex user interface and offers all con‐
figuration options. 
You can find additional information on this topic in the "Adminis‐
tration" manual, keyword "Customizing the Object Browser in ad‐
vanced run mode".

All COMOS ver‐
sions

Run mode: Sim‐
ple

Main target group: Users.
The configuration options are limited. The user can only change 
the start object. 
See chapter Using "Simple" run mode (Page 460).

As of COMOS 9.0

Database 
search

Main target group: Administrators and experienced users
The database search requires the "Advanced" run mode and 
classification of the objects. This subvariant is the fastest search 
among the classic variants.
You can find additional information on this topic in the "Adminis‐
tration" manual, keyword "Database search".

As of COMOS 9.0

Customized 
query

 Main target group: Specified by customer
For the most part, the administrator can influence the visual ap‐
pearance and the configuration options of queries. 
You can find additional information on this topic in the "Adminis‐
tration" manual, keyword "Administration of queries and bulk pro‐
cessing".

All COMOS ver‐
sions

"Alternative" dis‐
play

 Main target group: Users.
The alternative display has a simplified user interface with very 
limited configuration options. No longer supported as of COMOS 
10.2.1.

COMOS 9.2 to CO‐
MOS 10.2

Bulk processing  Main target group: Users.
The query user interface is combined with the object properties 
window.
See chapter Prepared bulk processing (Page 486).

All COMOS ver‐
sions

Snapshot dis‐
play

 Main target group: Users.
If a snapshot of the required query was created in "COMOS 
Snapshots", you can open the query in the Snapshot display 
mode. 
You can find additional information on this topic in the "Snap‐
shots" manual.

As of COMOS 
10.1.1

"QueryView" dis‐
play

 Main target group: Users.
The "QueryView" display replaces the Object Browser. The new 
object browser is significantly faster but has fewer configuration 
options.
The object browser is the internal part of a query in which the 
actual hit list of the objects is shown. See chapter User interface 
of the queries in "Simple" run mode (Page 460) (using the "Sim‐
ple" run mode as an example in the figure).
See chapter User interface in the "QueryView" display 
(Page 469).

As of COMOS 
10.2.1

Using queries and bulk processing
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Using queries in COMOS
● Prepared standard queries

See chapter Overview of the prepared standard queries (Page 457).

● Queries in report lists
You can find additional information on this topic in the "Administration" manual, keyword 
"Specifying a row report or a default row".

● Queries in XML connectors
You can find more information on this topic in the manual "Basic interfaces", keyword 
"Administering queries for XML connectors".

See also
Relationship between queries and bulk processing (Page 486)

15.3 Overview of the prepared standard queries

Requirements
● You are familiar with the main variants of queries.

See chapter The main versions of queries (Page 455).

Standard queries
The database contains standard queries for the following system types:

● "Query for engineering objects"

● "Queries for documents"

● "Queries for connectors"

The following standard queries are also available for the administrator:

● "Queries for base objects"

● "Queries for attributes"

● Further queries:

– "Tools"

– "DVM queries"

The prepared standard queries are available in the COMOS menu:

● "Extra > Query > ..." menu
See chapter Menu "Extra > Query" (Page 570).

See also
Creating and opening a query (Page 458)
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15.4 Creating and opening a query

Requirements
● Optional: COMOS is started with 4GB support. See chapter Overview of startup options 

(Page 128).

● An engineering project is open. See chapter Opening a project or the released area of a 
project (Page 185).

● You are familiar with the overview of the prepared standard queries.
See chapter Overview of the prepared standard queries (Page 457).

Creating queries via the menu bar
1. In the menu bar, select "Extra > Query > <System type>".

2. Select a query in the submenu.
The tab of the "<System type>" query opens. See also chapter Identification via object 
system type (Page 60).
Default in the database: The query starts in the "Advanced" run mode. See also chapter 
Activating "Simple" run mode (Page 459).

3. Click the "Save / Load ... > Save as ..." button on the toolbar.
The "Save as ..." window opens.

4. Drag&drop an object from the Navigator to the "Save as" field.

Note

The creation mode of the object must be configured in such a way that the query can be 
created.

You can find additional information on this topic in the "Administration" manual, keyword 
""Creation mode" control group".

5. Enter values in the "Name" and "Description" fields.

6. Confirm your entries.
The query is created in the Navigator underneath the selected object.

Creating a prepared query via the "New" context menu
Requirements: A query has been prepared by your administrator. You can find additional 
information on this topic in the "Administration" manual, keyword ""Elements" tab at base 
objects".

Procedure:

1. Select the engineering object.

2. Select the "New > <Name and description of the query>" command from the context menu.

The run mode depends on the configuration of the query. See also chapter Activating "Simple" 
run mode (Page 459).
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Opening a query
If the query does not open automatically when you create it, proceed as follows:

● Existing query: 
Context menu of the query object, command "Open (classic)" or "Open (QueryView)"

● Context menu of the query object, command "Open (Snapshot)".
You can find additional information on this topic in the "Snapshots" manual.

● Double-click the query object

15.5 Entering values in a query

Requirements
● A query is open.

See chapter Creating and opening a query (Page 458).

Procedure
The following procedure is permissible in "Simple" run mode and in "Advanced" run mode.

1. Select a cell with a white background.

2. Double-click or select F2.
The cell is highlighted and the text size increased.

3. Enter a text.

Special case attributes: The "Format" field in the "General" tab is not evaluated. You can enter 
values in the object query that do not match the definition in the "Format" field.

15.6 Activating "Simple" run mode

Requirements
A query has been created and opened. See chapter Creating and opening a query 
(Page 458).

Procedure
This chapter describes the use of a query in the "Simple" run mode. 

● In the context menu of a column header, select "Run mode > Simple".
See also chapter Using "Simple" run mode (Page 460).

Note on "Advanced" run mode
In the context menu of a column header, select "Run mode > Advanced".
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For the "Advanced" run mode, see the "Administration" manual, keyword "Customizing the 
Object Browser in advanced run mode".

15.7 Using "Simple" run mode

15.7.1 User interface of the queries in "Simple" run mode

Requirements
● A query is open.

See chapter Creating and opening a query (Page 458).

Structure

① Toolbar
② General data
③ Object browser with the results list
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Toolbar in simple run mode
The toolbar has the following buttons:

Icon Tooltip Description
"Refresh - F5" Recalculates the display and the values of the found objects. The search 

quantity is recalculated.
"Print list ..." Prints the results list.

"Export data ..." Exports the results list to the following formats:
● Excel
● Access
● Text
● XML

"Find" Only for cross-project queries
Starts the search.

Toolbar in extended run mode
The toolbar has the following buttons:

● The same buttons as in the simple run mode

● Additional button, depending on the system type that the query processes.
You can find additional information on this topic in the "Administration" manual, keyword 
"Reference of the buttons on the toolbar".

General data
Here you set the basic settings of the query. The fields you see depend on the following factors:

● On the system type that processes the query

● On the run mode

– Simple run mode: You see the "Start object(s)" field.

– Extended run mode: You see more fields. You can find additional information on this 
topic in the "Administration" manual, keyword "Create query".

Object Browser
Here you see and edit the objects that the query finds.

The context menu of the rows and columns provides numerous commands. See also chapter 
Context menu for queries in simple run mode (Page 467).

See also
Using queries and bulk processing (Page 455)
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15.7.2 Configuring queries in simple run mode

Requirements
● A query has been created and opened. See chapter Creating and opening a query 

(Page 458).

● The run mode is "Simple". See chapter Activating "Simple" run mode (Page 459).

Setting a start object and adjusting the Object Browser
● Drag&drop a start object from the Navigator into the "Start object(s)" field:

● Configure the Object Browser. See also chapter Adjusting the Object Browser in simple 
run mode (Page 462).

Saving the query
1. Click the column header.

2. Select "Save" from the context menu.

15.7.3 Adjusting the Object Browser in simple run mode

15.7.3.1 Configuring columns

Requirements
A query has been created and opened. See chapter Creating and opening a query 
(Page 458).

Changing the column width
1. Move the move between two column headers.

The mouse pointer will change to a slider arrow. 

2. Keep the mouse button pressed and move the mouse to the right or left.

Changing the column order
1. Select a column.

2. Keep the left mouse button pressed and move a column header to the right or left.
A blue bar indicates where the column is to be positioned.
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Showing and hiding columns
1. Select the "Columns ..." command in the context menu of the column header.

2. You have the following options:

– To show a column, activate the option in the "Visible" column.

– To hide a column, clear the option in the "Visible" column.

15.7.3.2 Sorting the Object Browser

Display in the user interface
● Unsorted Object Browser: When you move the mouse pointer to a column header, you see 

the following button:

● Sorted Object Browser: You see one of the following buttons in the column header:

Requirements
● A query has been created and opened. See chapter Creating and opening a query 

(Page 458).

● The Object Browser displays a search result.

Procedure
1. Left-click on the button on the column header to sort.

The window with the sorting options opens.

2. Select one of the following options:

– To sort the table in ascending order, select the "Ascending" command.

– To sort the table in descending order, select the "Descending" command.

– To remove the sorting, select the "None" command.

15.7.3.3 Filtering the Object Browser

Display in the user interface
● Filtered Object Browser: You see the following button in the column header:

● Unfiltered Object Browser: You only see the button after you move the mouse pointer onto 
a column header.
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Requirements
● A query has been created and opened. See chapter Creating and opening a query 

(Page 458).

● The Object Browser displays a search result.

Procedure
1. Left-click on the button on the column header to filter.

The window with the filter options opens. You see a user interface with all the values from 
the column and a field for entering a filter value freely. 

2. You have the following options:

– To filter one or more values, activate the options next to the corresponding values.

– To remove the filtering by values, deactivate the corresponding options.

– To filter by a substring, enter the desired string in the field. Click the following button to 
execute filtering: 

– Click the following button to remove filtering by substring: 

15.7.4 Editing texts with "Search&Replace"

Requirements
● The query is configured.

See chapter Configuring queries in simple run mode (Page 462).

Searching
A search is performed in the visible list. If rows have been hidden by the "Filter" option, they 
are no longer included in the search.

1. Optional: Select a closed area of cells in the list.
The cells determine the range when the option "Marked area" is selected.

2. Select the "Search/Replace" command in the context menu of the header line.

3. Enter text or select a text in the "Search for" field. 
The entries since the "Search and Replace" dialog was opened are available in the drop-
down list.
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4. Select an option in the "Search in" group

– "Current column"
Searches in the column 

– "Current query"
Searches all columns in the query

– "Marked area"
Searches the selected area.
This option requires a closed area of cells to be selected. When multiple scattered cells 
have been selected using <Ctrl>+click, the first cell and the last cell are used and the 
search covers the entire range in between.

5. Click "Find next".

Replace
1. Select the "Search/Replace" command in the context menu of the header line.

2. Switch to the "Replace" tab.

3. Configure the search as described in the preceding section. 

4. Click "Find next"
If a match is found, it is selected in the list.

5. Click "Replace". 
The selected match is replaced.

6. Optional: Click "All".
All matches are replaced.

15.7.5 Exporting queries

Requirements
● A query has been created and opened. See chapter Creating and opening a query 

(Page 458).

● The Object Browser displays a search result.
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Procedure
1. Click the "Export data ..." button on the toolbar:  

2. Select one of the following commands:

– "Microsoft Excel"
Output in an Excel file

– "Microsoft Access"
Output in an Access file

– "Text file"
Output in a TXT file

– "XML file"
Output in an XML file.

3. Select a directory and enter a file name.

4. Click on the "Save" button.

Rules for editing exported data
To reimport the data, observe the following points:

● The exported data may not be sorted or filtered.

● The first row of an exported table contains important information. You cannot edit it.

● The last column of a table exported to Access contains important information. You cannot 
edit it.

● The exported data may only be edited at those points that were released for editing within 
COMOS. These are the cells in Excel marked in white. Do not remove the spreadsheet 
protection in Excel, since this only concerns cells that cannot be edited anyway.

● You can only reimport the following file types with the standard tool:

– Excel file
During export the file type "xlsx" is also offered. However, only "xls" is available for 
importing.

– Access file

– XML file

● Grouped objects cannot always be reimported correctly. Editable columns should only 
appear on the last level of each grouping.
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15.7.6 Context menu for queries in simple run mode

Shortcut menu of the column header
The following commands are displayed in the shortcut menu of the column header in simple 
run mode.

Icon Command Description
"Search/Replace" Finds and replaces the desired term in the query.

- "Run mode > ..." See also chapter Activating "Simple" run mode (Page 459).
  "... > Simple"
  "... > Extended"

"Print > ..." Prints your query.

 "... > Print"

"Export > ..." See also chapter Exporting queries (Page 465).

 "... > Microsoft Excel"

"Columns ..." See also chapter Configuring columns (Page 462).

- "Reset" Restores the preconfigured settings.
"Save" See also chapter Configuring queries in simple run mode (Page 462).

Shortcut menu in the object browser
The following commands are displayed in the shortcut menu of the object browser in simple 
run mode.

Note

The shortcut menu can contain different commands, depending on the column.

Icon Command Description
"Remove pointer" Deletes the reference. See also chapter Setting references (Page 175).

"Edit (F2)" Edits the desired field.

"Copy text" To copy texts via the clipboard.
See also chapter Copying, cutting, and pasting texts (Page 178).
 

"Paste text"

"Refresh (selected)" Refreshes the selected field.

"Navigate > ..." See also chapter Navigating (Page 170).

"Delete" See also chapter Deleting in queries (Page 483).
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Icon Command Description
"Copy" See also chapter Copy fundamentals (Page 119).

"Properties" See also chapter General properties of engineering objects (Page 67).

See also
The main versions of queries (Page 455)

15.8 Using the "QueryView" display

15.8.1 Aim of the "QueryView" display

Objective from user view
From the software point of view queries consist of different components, the so-called classes. 
The classes are divided into two groups:

● Classes for calculating the search results

● Classes for representing the search results 
This group also includes the so-called object browser.

The "QueryView" representation is a variant of the object browser.

● Query in the "Classic" mode: Old object browser

● Query in the "QueryView" mode: New object browser
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The query in the "QueryView" mode has the following framework conditions:

● The components for calculating the search results are unchanged. The calculation of the 
search results (calculation of the object collection) takes exactly as long as in the 
"Classic" mode.
This applies in particular when a query is accessed by means of a script and the 
collection is used directly in the script. In this case there is no speed advantage because 
the object browser is not used.

● In the query it is possible to scroll faster vertically.
The relative speed advantage in comparison to the two modes rises with the number of 
columns: 

– If a query has only a few columns so that all the columns are visible on the screen, a 
smaller speed advantage then exists.

– If a query has many columns so that clearly more than half the columns are not visible 
on the screen at any time, the speed advantage increases notably.

At queries with a small number of lines (a few hundred lines) the relative time difference is 
not noted so strongly by the user. The absolute time advantage increases notably at large 
queries with above a few thousand lines.

● The query has a reduced scope at the configuration options.

Further information for Administrators
● Creating or offering a query in the COMOS menu

You can find additional information on this topic in the "Administration" manual, keyword 
"Creating a query".

● Class documentation
You can find additional information on this topic in the "Class Documentation ivbQuery_dll" 
manual, keyword "Individual structure of the class hierarchy".
The "QueryView" mode is a new implementation of the "Comos.NQuery.Grid" class. The 
"Comos.NQuery.Grid" class made the "Alternative" mode available in previous COMOS 
versions. Through the new implementation the "Alternative" mode is no longer required.

See also
User interface in the "QueryView" display (Page 469)

15.8.2 User interface in the "QueryView" display

Requirements
● You are familiar with the main variants of queries.

See chapter The main versions of queries (Page 455).

● You are familiar with the purpose.
See chapter Aim of the "QueryView" display (Page 468).
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User interface

Procedure
1. Select the "Open (QueryView)" command in the Navigator in the context menu of a query.

The query opens (1). 

2. Edit the toolbar (2) and the general area of the query (3).
You can find additional information on this topic in the "Administration" manual, keyword 
"Reference of the buttons on the toolbar" and keyword "Setting general inputs for queries".

3. Edit the area of the new object browser (4).
See the section "Available functionalities in the new object browser" below.

See also
Reference of functionalities (Page 470)

15.8.3 Reference of functionalities

15.8.3.1 Support for all settings of the "Classic" representation
There are a number of settings which are evaluated in the QueryView, but cannot be edited.

In these cases, you edit the query in the "Classic" representation and save the query.

The settings then take effect in the "QueryView" representation. 
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15.8.3.2 Function group "Display (Read only)"

Requirements
● You are familiar with the user interface of the "QueryView" display.

See chapter User interface in the "QueryView" display (Page 469).

"Display" function group

Main function Subfunction Availability in 
COMOS 10.2.1

Display of the table content according to the 
standard display in the "Classic" display mode

  

 Text Yes
 Text alignment Yes
 Background color (red, orange) Yes
 Font color Yes
 Italics for inheritance Yes
 Underlining of the cells when references can be set No
 Underlining of the column header when references can 

be set
Yes

 Icon/symbol Yes
 Display of a check box Yes
 Display of an option button No
 Column width Yes
 Row height Yes
 Display of difference between write protection and write 

permission
Yes

 Check of write permission also depending on the CO‐
MOS kernel (rights, ValueBlocked)

Yes

 Display of a field that can be set with "drag&drop" Yes
Table headers   
 Show description of the column Yes
 Display unit

(Properties of the column, "Extras" tab: Unit)
Yes

 Display of activated column sorting Yes
 Display of activated column filtering Yes
 Consider manual header height No
 Underlining of the column header when the cells of the 

column have a reference
Yes

Display of hierarchical queries (grouped queries)   
 Expand/collapse individual nodes Yes
 Display of the hierarchy column by means of grouping 

numbers in the column header
Yes

 Expand / collapse all the nodes by means of context 
menu at the grouping number in the column header

Yes
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Main function Subfunction Availability in 
COMOS 10.2.1

 Display hierarchy within a cell by means of triangular 
arrow

Yes

 Grouped cells ("expandable" cells) with gray back‐
ground

Yes

 Multiple grouping with same grouping level: The se‐
quence of the ungrouped columns defines the se‐
quence of the grouped columns

Yes

 MouseOver for the hierarchy arrow (also not available 
in the "classic" display mode)

No

Display of a selection   
 Switching between row selection and cell selection No
 Switching between multiselection and individual selec‐

tion
Yes

 Selection of a column-spanning area Yes
Display column sums   
 Display sums for tables in list form No
 Display sums for tables in hierarchy display No
Fix columns in visible area  No
Dataset selector Display of the dataset selector Yes
 Switch display of the dataset selector No
Status bar   
 Display number of rows Yes
 Display the number of visible cells at filtered or grouped 

displays
Yes

 Display number of selected rows No
Drag selection in the query to another COMOS 
area with "drag&drop"

  

 Drag individual objects from the query with "drag&drop" No
 Drag multiple objects from the query with "drag&drop" No

15.8.3.3 Function group "Edit contents"

Requirements
● You are familiar with the user interface of the "QueryView" display.

See chapter User interface in the "QueryView" display (Page 469).

Edit contents

Main function Subfunction Availability in 
COMOS 10.2.1

Edit cells   
 Cell with text input Yes
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Main function Subfunction Availability in 
COMOS 10.2.1

 Cell with drop-down list Yes
 Cell with text input and drop-down list Yes
 Cell with check box or option Yes
 Cell with COMOS selection button ("…" button for date 

or signature)
No
Only at date: F2 
opens a window 
for selecting the 
date. Text entry 
of a date not 
available.

 Cell with display type "Memo" No
 Drag&drop of an object at cells with objects  Yes
 Display of an impossible drag&drop ("prohibited sign") Yes
 Support of shortcuts Yes
 Cell with file selection button ("…" button for file selec‐

tion)
No

 Selection button for reference attributes Yes
Editing a multiple selection   
 Under consideration of the framework conditions in ac‐

cordance with the main function "Edit cells":
Set the same value in the same column for all selected 
rows

Yes

 Ignore incorrect entries Yes
Drag&drop   
 Set individual reference with drag&drop Yes
 Set the same reference for multiple selected rows (1:N) Yes
 Set multiple selection of references to a multiple selec‐

tion of rows
Yes

 Display incorrect drag&drop entries Yes
Edit cells in a hierarchy column  No
Update sum display during table editing  No
Selection area   
 Copy values to clipboard No
 Apply values from clipboard to selection area No
Support new row   
 Save values of a new row when exiting row No
 Save values of a new row with "OK"/"Apply" No
Delete row and update object browser  No
Move row  No
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15.8.3.4 Function group "Edit configuration"

Requirements
● You are familiar with the user interface of the "QueryView" display.

See chapter User interface in the "QueryView" display (Page 469).

Edit configuration

Main function Subfunction Availability in 
COMOS 10.2.1

Sorting   
 Create/read/update/delete sorting criteria Yes
 Properties of a sorting criterion Yes
Filter   
 Create/read/update/delete filter criteria Yes
 Properties of a filter criterion Yes
Combined sorting and filter criteria   
 Area for editing the sorting/grouping Yes
 Area for editing the filter Yes
 Context menu for editing a row in the sorting or filtering No

Context menu 
deleting: Yes

Automatic filter  No
Automatic sorting  No
Adjust row height by means of dataset selector  No
Edit the table by means of the dialog of the col‐
umn properties

 No

Adjust the header height  No
Column   
 Select single column No
 Move single column Yes
 Delete single column No
 Select multiple columns No
 Move multiple columns No
 Delete multiple columns No
 Change column width with mouse Yes, but new col‐

umn width is not 
stored

 Automatic column width by double-clicking the column 
border

Yes

Create column in object browser with drag&drop   
 Drag&drop of an attribute No
 Drag&drop of multiple attributes No
 Drag&drop of a unit No
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Main function Subfunction Availability in 
COMOS 10.2.1

 Drag&drop of a location No
 Drag&drop of a position No
 Drag&drop of a function No
 Drag&drop of a CDevice No
 Drag&drop of a project node No
Generate column in object browser by means of 
"New >" context menu

  

 Create column for object properties (project, time 
stamp, etc.)

No

 Create column for object status No
 Create column for system status No
 Create column for row statistics No
Delete column with context menu  No
Run mode: Switching between "Simple" and "Ad‐
vanced"

 No

15.8.3.5 Function group "COMOS Integration"

Requirements
● You are familiar with the user interface of the "QueryView" display.

See chapter User interface in the "QueryView" display (Page 469).

Integration of QueryView into additional COMOS user interfaces

Main function Subfunction Availability in 
COMOS 10.2.1

Open standard queries either in "Classic" or 
"QueryView" display mode

  

 By means of context menu in the Navigator Yes
 By means of COMOS menu Yes
 By means of double-click and therefore depending on 

a default 
Yes

 Cross-project queries Yes
Support of the functions and settings in "Top‐
QueryBrowser" 

  

 "Navigate" menu Yes
 Update query Yes
 Save and read the settings Yes
 Save settings in the profile No
 Print list No
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Main function Subfunction Availability in 
COMOS 10.2.1

 Export to an Excel file Yes
Only in the com‐
mand bar

 Export to an Access file No
 Export to a text file No
 Export to an XML file No
 Display "General properties" option group of the query No
 Execute "Search at once" and "Search" Yes
 Extended command bar No
Support of all variants of "TopQueryBrowser" Execution of specialized queries in the "QueryView" 

display mode
Yes

Display script area   No
Progress bar  Yes
Support of XML connectors  No

15.8.3.6 Function group "Integration functions in shortcut menu column header"

Requirements
● You are familiar with the user interface of the "QueryView" display.

See chapter User interface in the "QueryView" display (Page 469).

Integration of QueryView into additional COMOS user interfaces Functions at column header

Main function Subfunction Availability in 
COMOS 10.2.1

Context menu column header: Search / Replace   
 Search No
 Replace No
Context menu column header: Print  No
Context menu column header: Export   
 Export to an Excel file No
 Export to an Access file No
 Export to a text file No
 Export to an XML file No
Context menu column header: Options   
 Menu item No
 Support existing settings Yes
Context menu column header: Divisions: Value 
| Unit

 No
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15.8.3.7 Function group "Support of object editing"

Requirements
● You are familiar with the user interface of the "QueryView" display.

See chapter User interface in the "QueryView" display (Page 469).

Integration of QueryView into additional COMOS user interfaces

Main function Subfunction Availability in 
COMOS 10.2.1

Context menu: Navigating  Yes
Context menu: New Mode of operation: Cell-oriented (ByCell) Yes
 Mode of operation: Row-oriented (ByRow) No
Context menu: Delete  No
Context menu: Cut  No
Context menu: Copy  No
Context menu: Paste  No
Context menu: Properties  Yes
Context menu: Working layers/History  No
Context menu: Script functions for COMOS ob‐
jects

 No

Hide and cancel commands executed in the con‐
text menu by QueryBrowser EventHandler

 Yes

Update of objects ("UpdateWatcher")
(Deleted objects are displayed with <<Delete>>)

 Yes

Mutual automatic selection between queries and 
report

 No

Integration with "DevEdit"  No
Support of attributes of the "Query" display type  No

15.8.4 Deviating behavior for "Classic" display

15.8.4.1 Deviating behavior for keyboard commands

Requirements
● You are familiar with the user interface of the "QueryView" display.

See chapter User interface in the "QueryView" display (Page 469).
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Keyboard commands
● Tabulator in "Classic" display mode

At the end of a row, the tabulator jumps to the general input fields of the query.

● Tabulator in "QueryView" display mode
At the end of a row, the tabulator jumps to the next row.

15.8.4.2 Deviating behavior during cell editing

Requirements
● You are familiar with the user interface of the "QueryView" display.

See chapter User interface in the "QueryView" display (Page 469).
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Display of the cell in edit mode
● Display of edit mode in "Classic" display mode

– The input field of the cell is displayed as box with a black frame and white area above 
the list:

– The content of the cell is selected. 

– When you scroll through the list, the input field remains stationary.

● Display of edit mode in "QueryView" display mode

– The cell itself is switched to edit mode:

– The cursor is at the end of the cell text, the content of the cell is not selected.

– When you scroll through the list, the edited cell scrolls along.

Editing date fields
The "..." button for opening the special date dialog is not available.

F2 opens a window for selecting the date. Text entry of a date not available.
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No error messages
Incorrect entries are prevented in the familiar way, but no error message is displayed.

Even with automatic correction, no messages are displayed. Example: automatic name 
correction by appending a suffix when new objects are assigned an existing name.

Multiple selection
● Behavior in "Classic" display mode

The multiple selection is retained after confirmation.

● Behavior in "QueryView" display mode

– When an input is confirmed with "Return", the multiple selection is canceled and the cell 
in the next row is selected.

– When an input is confirmed with <Ctrl>+"Return", the multiple selection is retained.

15.8.4.3 Deviating behavior during row editing

Requirements
● You are familiar with the user interface of the "QueryView" display.

See chapter User interface in the "QueryView" display (Page 469).

Manual row height
● Manual row height in "Classic" display mode

Requirements: The dataset selectors are activated.
When you change the row height with the mouse, the new height applies to all rows.

● Manual row height in "QueryView" display mode
Requirements: None
When you change the row height with the mouse, the new height applies only to this row.
The new cell height is not saved.

15.8.4.4 Deviating behavior during grouping

Requirements
● You are familiar with the user interface of the "QueryView" display.

See chapter User interface in the "QueryView" display (Page 469).
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Display of a single grouping
● Display of a grouping in "Classic" display mode

The grouped column is hidden.
The information of the grouped and hidden columns is converted into a new cell. The new 
row contains exactly one cell. The width of this cell cannot be changed until the grouping 
has been deleted and the column becomes visible once again.

You can find additional information on this topic in the "Administration" manual, keyword 
"Grouping queries".

● Display of a grouping in "QueryView" display mode
The grouped column is hidden.
A new column is generated in which all the groupings of a grouping level are combined. 
The width of this new column can be changed.
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Display of multiple grouping
● Display of multiple grouping in "Classic" display mode

In case of a combined grouping of two columns, the information of the two hidden columns 
is entered in a row with two cells:

You can find additional information on this topic in the "Administration" manual, keyword 
"Grouping queries".

● Display of multiple grouping in "QueryView" display mode
In case of a combined grouping of two (or more) columns, a shared column without header 
text is shown:

The width of this shared column is determined by the width of the column hidden at the 
outer left. The information of the two hidden columns is entered in a shared cell: The 
sequence of the information in the shared cell is determined by the sequence of the columns 
in the object browser before they were grouped. The separator between the information is 
the hashtag.
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15.8.4.5 Deviating behavior in the "Sorting/Filter" dialog

Requirements
● You are familiar with the user interface of the "QueryView" display.

See chapter User interface in the "QueryView" display (Page 469).

New row in the "Sorting" area
● New row in the "Classic" display mode

As soon as you edit the cell and leave it, a new row is created at the end of the list.

● New row in the "QueryView" display mode
You must confirm inputs in the current row with Return for a new row to be created.

● Input in the "Filter value" column
No selection list for the filter value is provided in the "QueryView" display mode. The filter 
value can only be entered via a text box.

"Filter" area
● The command bar is not available in the "Filter" area.

15.9 Deleting in queries

Requirements
A query has been created and opened. See chapter Creating and opening a query 
(Page 458).

The run mode is "Simple". See chapter Using "Simple" run mode (Page 460).

Procedure
1. Select the desired object in the Object Browser.

2. Select "Delete" from the context menu.
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3. Confirm the security prompt.
COMOS analyzes the objects. If there are reasons to prevent the deletion, or if the data is 
made inconsistent by deleting, the "Delete check list" window opens. 

There is an entry for every object which has a cancel message or a warning message. You 
can navigate to the object using the context menu.
If there are cancel messages, the entire deletion process is canceled.

4. If there are only warning messages, you can delete despite the warnings. Click the "Yes" 
button in the window to do this.

Note
No single selection of objects

If you have selected single entries in the "Delete check list" window, all objects will still be 
deleted.

5. To cancel the entire deletion process, click the "No" button.

You can find additional information on the checklist when deleting in the "Administration" 
manual, keyword "Checklist when deleting".

Result
Depending on the configuration of the query, either the selected object or the object to which 
the query row relates is deleted.

You can find additional information on this topic in the "Administration" manual, keyword 
"Deleting in the Object Browser" and chapter ""Options" context menu: "General" tab".

See also
Deleting (Page 180)
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15.10 Using cross-project queries

Principle
You can apply a cross-project query to all projects or to selected projects and working layers.

Requirements
A cross-project query has been created and opened. You can find additional information on 
this topic in the "Administration" manual, keyword "Creating queries: Cross-project queries".

Applying cross-project queries to all projects
1. Select the "*** In all projects" entry from the "Start object(s)" list.

2. Configure the query as required. You can find additional information on this topic in the 
"Administration" manual, keyword "Customizing the Object Browser in advanced run mode".

3. To update the query, click the "Search" button:  

Result
● The result of the query will be listed.

● COMOS scans the project currently logged on to the current working layer and all other 
projects in the released area.

● By default, the cells in the search result cannot be edited. To edit the properties of an object, 
navigate to the object. The query remains visible in this case.

Applying cross-project queries to single projects or working layers
1. Select the "File > Open project" command in the menu bar.

2. Move the "Open project" tab so that it is shown next to the cross-project query. See also 
chapter Customizing the arrangement of frames and tabs (Page 146).

3. Drag&drop the required work layers or projects from the "Open project" tab to the "Start 
object(s)" field of the query. Select only one working layer per project.

4. Configure the query as required. You can find additional information on this topic in the 
"Administration" manual, keyword "Customizing the Object Browser in advanced run mode".

5. To update the query, click the "Search" button: 
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Result
● The result of the query will be listed.

● By default, the cells in the search result cannot be edited. To edit the properties of an object, 
navigate to the object. The query remains visible in this case.

15.11 Using queries for bulk processing

15.11.1 Relationship between queries and bulk processing

Requirements
● You are familiar with the main variants of queries.

See chapter The main versions of queries (Page 455).

Aim
The "Bulk processing" tool can be used to process data for a large number of objects 
simultaneously. For example, "Bulk processing for engineering objects" allows you to set the 
general data and attribute values of multiple engineering objects at the same time.

Bulk processing is an extended query. With bulk processing, you always process objects with 
the same system type.

See also
Prepared bulk processing (Page 486)

15.11.2 Prepared bulk processing

Prepared bulk processing
The database contains bulk processing for the following system types:

● "Bulk processing for engineering objects"

● "Bulk processing for documents"

See also chapter Using queries and bulk processing (Page 455).

Bulk processing is also available to the administrator for the following system types:

● "Bulk processing for base objects"

● "Bulk processing for attributes"

● "Bulk processing for connectors"
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You can find additional information on this topic in the "Administration" manual, keyword "Bulk 
processing".

See also
"Extra > Bulk processing" menu (Page 569)

Bulk processing tab (Page 488)

15.11.3 Creating bulk processing

Requirements
● An engineering project is open. See chapter Opening a project or the released area of a 

project (Page 185).

● Engineering objects have been created in the project. See chapter Creating engineering 
objects (Page 233).

● See also chapter Prepared bulk processing (Page 486).

Creating bulk processing via the menu bar
1. In the menu bar, select "Extra > Bulk processing > Bulk processing for <system type> > 

Bulk processing: <system type>".
The "Bulk processing: <system type>" tab opens. See also chapter Identification via object 
system type (Page 60).

2. Click the "Save / Load ... > Save as ..." button on the toolbar.
The "Save as ..." window opens.

3. Drag&drop an object from the Navigator to the "Save as" field.

Note

The creation mode of the object must be configured in such a way that the bulk processing 
can be created.

You can find additional information on this topic in the "Administration" manual, keyword 
"Creation mode control group".

4. Enter values in the "Name" and "Description" fields.

5. Confirm your entries.

Result
Bulk processing is created in the Navigator underneath the selected object.
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Creating prepared bulk processing via the "New" shortcut menu
Requirements: Bulk processing has been prepared by your administrator. You can find 
additional information on this topic in the "Administration" manual, keyword ""Elements" tab at 
base objects".

1. Select the engineering object.

2. Select the "New > <Name and description of the bulk processing>" command from the 
shortcut menu.

15.11.4 Bulk processing tab

Call
"Extra > Bulk processing > Bulk processing for <system type>" menu

Structure

① Toolbar
② Query
③ Area for editing the selected objects
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Toolbar
The buttons of the toolbar depend on the system type that the query processes and on the 
selected objects.

Query
The structure of the query depends on the system type that the query processes.

Components:

● General data
Basic settings of the query. The fields change according to the system type.

● Object Browser
The result of the query is displayed here. Select the objects you want to edit.

Area for editing the selected objects
The structure depends on the system type that the query processes.

Components:

● Area for the general data

● Area for the attributes and attribute tabs

See also
Using queries and bulk processing (Page 455)

15.11.5 Configuring bulk processing

Requirements
● A bulk processing has been created and opened. See chapter Creating bulk processing 

(Page 487).

● Objects have the same class or subclass.

Setting a start object and adjusting the Object Browser
Drag&drop an object from the Navigator into the "Start object(s)" field":

The objects and object data found by the query are displayed in the Object Browser. You can 
find additional information on this topic in the "Administration" manual, keyword "Customizing 
the Object Browser in advanced run mode".

The data and attributes of the first object from the Object Browser are displayed in the area 
for editing the marked objects.
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Placing attributes on the "General" tab
You can find additional information on this topic in the "Administration" manual, keyword 
"Placing attributes on the "General" tab".

Saving bulk processing
1. Click the "Save/Load ..." button in the toolbar of the tab.

2. Select the "Save" command.

See also
Using queries and bulk processing (Page 455)

15.11.6 Editing object data via bulk processing

Requirements
● A bulk processing has been created and opened. See chapter Creating bulk processing 

(Page 487).

● The bulk processing is configured. See chapter Configuring bulk processing (Page 489).

● You have a good knowledge of the associated user interface. See chapter Bulk processing 
tab (Page 488).

Updating the Object Browser automatically
To update the Object Browser automatically, activate the "Search at once" button:  
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Procedure
1. Select the desired objects in the Object Browser.

Note

Note in which order you select the objects. If the first selected object in the Object Browser 
has the attribute, the attributes dragged onto the working area are displayed.

In the area for editing the marked objects, you will see the general data and attributes of 
the selected objects. The values entered at the topmost object of the selection are displayed.
If there are deviating values on the other selected objects, the corresponding value is 
marked in blue. Reference fields with different values are marked in yellow.

2. Edit the general data.

Note
"Name" and "Label" must be unique

Parallel objects in the Navigator must have unique names and labels. If they are given the 
same name, only the topmost object is changed. A counter is appended to the rest of the 
data.

3. Edit the attribute values on the "General" tab and all other added tabs. See also chapter 
Configuring bulk processing (Page 489).

4. Confirm your entries.

Result
● Your entries are saved.

● If one of the selected objects does not have a changed attribute or a changed property, the 
value is not saved.
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Using aided engineering 16
16.1 Using task management

Using the "Task management" plugin, you can: 

● Specify tasks, including across projects

● Manage individual task parameters

● Allocate tasks to users

There are two types of tasks:

● "Basic task"

● "Workflow task"

16.1.1 Opening the "Task management" plugin

Requirements
● You have logged into COMOS using your user name.

● A COMOS project is open.

● Your administrator has made the necessary default settings
You can find additional information on this topic in the "Administration" manual, keyword 
"Administration of task management".

Procedure
● Select the "Plugins > Basic > Task management" command in the menu bar.

The "Task management" tab opens. The display differs as follows:

– First opened
The interface starts with default settings. Drag&drop the bottom edge of the "Filtered 
tasks" table down to enlarge the table.
No tasks are displayed in the table. Search for the existing tasks via the filter or create 
a new task.

– Reopened
You see the same content as when the tab was last closed.

See also
Creating a new task (Page 494)

Filtering tasks (Page 495)

Editing tasks (Page 496)
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16.1.2 Using editing mode and view mode

Procedure
1. Edit some the following attributes in the "Filtered tasks" table without activating editing 

mode:

– "Planned start date"

– "Planned end date"

– "User"

– "Link to person responsible"

– "Representative"

– "Reference object"

– "Classification"

2. Select editing mode to edit a task completely. See also Chapter Editing tasks (Page 496).

3. When you edit a task, COMOS automatically changes in the background to the project that 
contains the task. Basic tasks are the project "USERS". Workflow tasks can be created in 
correspondingly prepared engineering projects. The rest of the COMOS interface is locked 
while the task is edited. This prevents you editing in two projects at the same time: in the 
currently open project and in the project which has been opened in the background by the 
task.

4. If you select the "View mode" command, task editing ends. The project open in the 
background is closed. You can access all COMOS functions once more. 

5. If you switch projects or to another working layer, the "Task management" plugin remains 
open.

16.1.3 Creating a new task

Requirements
The "Task management" plugin is open. See also Chapter Opening the "Task management" 
plugin (Page 493).

Procedure
1. In the "Filtered tasks" area click, on the "New task" button.

A new row is created in the "Filtered tasks" table. The columns of the table are defined. 
The properties of the task open below the table. Some attributes are populated 
automatically.

2. Enter a descriptive text for the task in the "Description" field.

3. Enter the required information. 

4. Save your entries.
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16.1.4 Filtering tasks

Requirements
The "Task management" plugin is open. See also chapter Opening the "Task management" 
plugin (Page 493).

Procedure
1. Open the filter with the  button.

2. Make the required filter settings.
The labels of the fields in the filter correspond to the labels of the column headers in the 
"Filtered tasks" table.

3. Click on the "Filter" button.

4. To hide the filter and see more table columns, click on the  button.

Result
● The database is browsed for existing tasks.

● The tasks are listed in the "Filtered tasks" table. The columns of the table are defined.

● When you close the"Task management" plugin your filter settings are automatically set the 
next time you open the plugin. The filter result is not displayed automatically.

16.1.5 Colors of tasks
When a task is loaded for the task table, task management reads the color status and marks 
the associated row in the task table using this color. If the task cannot be edited by the current 
user, it is displayed lightly shaded.

Using aided engineering
16.1 Using task management

Operation
Operating Manual, 03/2017 V10.2.1, A5E37082875-AB 495



16.1.6 Editing tasks

Editing individual tasks
Individual tasks can optionally be edited in the "Filtered tasks" table or in the working area 
under the table on the tabs. 

● To change properties of the task displayed in the "Filtered tasks" table, click in the desired 
cell.

● To assign persons, follow these steps:

– Open the "Units" tab. 

– Select the "USERS" object.

– Search under an object of type "Person".

– Drag&drop the person object into a cell in the "User" column.

● To edit a task, right-mouse click in the task row in the "Filtered tasks" table and select the 
"Edit" command in the context menu. 
The task management changes to edit mode. See chapter Using editing mode and view 
mode (Page 494).
The menu bar below the table turns red. The properties of the task are displayed below the 
table.

Note
Evaluating permissions

You have different permissions for editing tasks depending on your role. Depending on 
your permission, you can only edit one or both of the following tabs: "Task management" 
tab and "Data" tab.

– Make the required changes.

– Confirm your entries. 

– Click on the "Update table" button in the "Filtered tasks" area in the menu bar.

Bulk processing of tasks
To make the same changes to several tasks simultaneously, select the tasks in the table and 
press <F2>. 

16.1.7 Transferring tasks to other users

Precondition
Editing mode is activated. See also Using editing mode and view mode (Page 494).

Using aided engineering
16.1 Using task management

Operation
496 Operating Manual, 03/2017 V10.2.1, A5E37082875-AB



Procedure
1. Open the task properties.

See also Editing tasks (Page 496).

– First option: Drag&drop the user into the task's "User" cell in the "Filtered tasks" table.

– Second option: Select the "Attributes > Task management" tab.
Set a reference to a user in the "User" field

2. Click on the "Send" button.

Result
The task is transferred to the selected user. The new user is now able to edit the task. A new 
entry is created on the "Attributes > History" tab.

16.1.8 Copying tasks

Procedure
1. Open the properties of the task which you wish to copy.

See also Editing tasks (Page 496).

2. In the "Number of copies" field, state how many copies of this task you wish to create.

3. Click on the "Copy task" button.

Result
The required number of tasks is created in the table. All newly created tasks have the same 
properties as the opened task.

16.1.9 Status of tasks

Definition of status
There are two main statuses for a task: "active" and "archived". All the tasks are set to either 
one of these two statuses. The status changes automatically when you click on the "Send" or 
"Cancel" buttons on the "Edit" tab in the task properties.

Possible status:

● "In definition" (active)

● "Waiting" (active)

● "In progress" (active)

● "Done" (active) 
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● "Cancelled" (archived)

● "Archived/checked" (archived)

When it is being produced, the task status is "In definition". When it is forwarded to the first 
editor the task status is set to "In progress". While you are carrying out the initial editing steps 
the task status remains "In progress". When you assign the task to the person in charge, that 
person can either pass on the task for further editing or change the status to "Done". You are 
also able to change the task status from "Done" back to "In progress".  If the task status has 
been set to "Done" and you select the "Checked" status, the task is archived. The "Cancelled" 
and "Checked" statuses are final statuses and cannot be changed again.

"Waiting" option
If the "Waiting" option is active in the "Attributes > Edit" tab in the task properties, you cannot 
change the task status. If you deactivate the option, the task is restored to the same status as 
before the option was activated.

16.1.10 Exporting the task list to MS Excel
You can export the tasks displayed in the task table to an equivalent MS Excel table. This 
applies to MS Excel 2003 and later. Only the columns which are actually displayed are 
exported. In the exported table, the tasks are marked according to their color status.

Requirements
● A task list has been created.

Procedure
● Click on the "Export task list to Microsoft Excel" button in the top toolbar in the "Task 

management" tab.

Result
Task management opens an instance of Excel. In the first table table sheet, a corresponding 
column is transferred to the Excel table for each column displayed in the task list.

Note
No automatic saving

The exported table is not saved. You can specify the file path and format directly in Excel when 
you save the table. No specific Excel format is predefined.
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16.1.11 Changing the column order permanently

Requirements
The "Task management" plugin is open.

Procedure
To change the column order in the task list, move the header fields to the desired position 
using drag&drop.

Result
● The most recently used order is saved automatically in the user settings.

● The most recently used order is displayed again when task management is opened or the 
task list is filtered.

16.1.12 Showing or hiding columns permanently

Requirements
The "Task management" plugin is open. See also Chapter Opening the "Task management" 
plugin (Page 493).

Procedure
1. Click on the column header of one individual column.

2. You have the following options in the context menu of the column header:

– To hide a displayed column, select the "Hide column" command in the context menu.

– To display a hidden column again, select the "Show column" command in the context 
menu.

Result
● Information on which columns are shown and hidden is automatically saved in the user 

settings.

● These settings are reused when task management is opened or the tasks are refiltered.
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16.1.13 Editing workflow activities
If you are working with workflows in COMOS and create activities, these are also analyzed 
and displayed in the "Task Management" plugin. You cannot change the properties of the 
activities in the "Filtered tasks" table. 

Requirements
Your administrator has prepared the workflow activities for editing with task management.

You can find additional information on this topic in the "Administration" manual, keyword 
"Configuring workflow activities".

Procedure
You edit these workflow activities in the project in which you created them.

Open the properties of the activity. COMOS automatically changes in the background to the 
project in which you created the activity.

16.2 Using engineering tasks

16.2.1 Objective of engineering tasks

Objective
Engineering tasks automate work steps. Examples of automated works steps are: 

● Creating objects based on templates

● Linking objects (setting signal, reference, pointer or implementation)

● Moving objects

● Evaluating documents

As user, you cannot decide yourself which type of work step you want to automate with the 
help of an engineering task. Instead, the engineering task is prepared by the COMOS 
administrator. 

The following actions are available:

● Configuring tasks (setting the conditions of a work step)

● Executing tasks

● Undoing tasks

● Checking the task status

In practice, tasks are used to configure engineering projects according to the modular design 
principle. To do this, all required hardware objects and all software blocks needed to fulfill the 
function as well as the channel allocations or implementations have to be prepared in the task. 
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Existing engineering objects are detected during execution of the task and assigned or 
connected if they can be clearly identified. The plant documentation (circuit diagrams, etc.) is 
automatically generated. The execution of the tasks is logged. This facilitates redesign at any 
time by undoing a decision that has been made and executing the task again with new 
parameters.

Terminology
Outdated synonyms for the term "engineering" task are:

● eBlock

● E-Block

See also
Opening the task user interface (Page 501)

16.2.2 Opening the task user interface

Requirements
See chapter Objective of engineering tasks (Page 500).

User interface
Initial display of the "Tasks" tab:

"Tasks" tab with engineering tasks:
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Procedure
To open the "Tasks" tab, follow these steps:

1. Create an engineering object with prepared tasks.
Example 1:

– Open the sample project "iDB_P01".

– Select the "New > New unit" command from the context menu of the root object.

– Select the "New > New position" command in the context menu of the unit.

Example 2:

– Open the sample project "iDB_P01".

– Select the "New > A40 Plant (general)" command in the context menu of the root object.

2. Open the properties of an object.

3. Change to the "Tasks" tab

4. Initialize the "Tasks" tab.

– Select the tab of a task class.
or

– Create a task.

See chapter Initializing the task user interface (Page 503).

See also
Examples for task classes (Page 503)

Using aided engineering
16.2 Using engineering tasks

Operation
502 Operating Manual, 03/2017 V10.2.1, A5E37082875-AB



16.2.3 Using engineering tasks in the property window

16.2.3.1 Automatic saving

Requirements
● The task user interface is open.

See chapter Opening the task user interface (Page 501).

Automatic saving
All settings on the "Tasks" tab are saved automatically. This is true even if the "Tasks" tab is 
closed with "Cancel" or if not all tasks are executed. 

See also
Creating new tasks (Page 504)

16.2.3.2 Initializing the task user interface

Requirements
● The task user interface is open.

See chapter Opening the task user interface (Page 501).

● You are familiar with automatic saving.
See chapter Automatic saving (Page 503).

Procedure
1. Change to the "Tasks" tab

2. You select a task class by selecting a tab below. See chapter Examples for task classes 
(Page 503).

3. If a tab does not yet exist for a task class, first create an engineering task from this task 
class. See chapter Creating new tasks (Page 504).

16.2.3.3 Examples for task classes

Requirements
● The task user interface is open.

See chapter Opening the task user interface (Page 501).
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Task classes for assignment and implementation
In COMOS, engineering data is collected on the "Units" and "Locations" tabs.

● Objects named "Position", among others, are created on the "Units" tab. A "Position" object 
serves as a folder and collects process tags, signals and requests, among other things, 
from Basic Engineering.

● Data objects that are used to manage the IO information are created on the "Locations" 
tab. These include objects for control cabinets and PLC stations.

Positions can be assigned in bulk to objects with the IO information using an engineering task. 
This step links the information on the "Units" and "Locations" tabs.

Select one of the following tabs: 

Task class (= title of the 
tab)

Description Tasks See also chapter ...

"SW interface" Configures the copied 
in software.

● Assigned PLC
● Assigning I/O 

hardware

Bulk assignment by 
means of an engineer‐
ing task (Page 510) 

HW interface" Configures the copied 
in hardware.

● Implementing the 
control

Bulk implementation by 
means of an engineer‐
ing task (Page 511) 

16.2.3.4 Creating new tasks

Requirements
● The task user interface is initialized.

See chapter Opening the task user interface (Page 501).

User interface
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Procedure
In the initial state, you create a new task in the empty "Tasks" tab. The associated tab for the 
task class is created automatically and the engineering task is automatically sorted correctly.

If tabs already exist for the task classes, new tasks can be created in each tab. The new tasks 
are automatically sorted into the correct tab of the task class.

1. Select the "New" command from the context menu.

2. Select a task.

See also
Displaying the task status (Page 506)

Calculating or updating the task status (Page 506)

Configuring tasks: Setting target object (Page 507)

16.2.3.5 Selecting tasks in the properties window

Requirement
● The task user interface is initialized

See chapter Initializing the task user interface (Page 503).

● Tasks have been created.
See chapter Creating new tasks (Page 504).

Procedure
Select one of the following options:

● Select all tasks

– Select all tasks in the task list with <Ctrl> and mouse click.

● Select a subset of tasks

– Select a subset of tasks in the task list with <Ctrl> and mouse click.

● Selecting an individual task

– Select an individual line in the task list.

See also
Calculating or updating the task status (Page 506)
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16.2.3.6 Calculating or updating the task status

Requirements
● The tasks have been created.

See chapter Creating new tasks (Page 504).

Procedure
Calculating the status for a subset of tasks

1. Select a subset of tasks with <Ctrl> and mouse click

2. Click the "Calculate status" button in the toolbar of the task area:

 

Calculating or updating the status for all tasks

1. Open the command list with a click on the arrow to the right of the "Calculate status" button.

2. Select "Calculate status (all)"

See also
Displaying the task status (Page 506)

16.2.3.7 Displaying the task status

Requirements
● The task status has been calculated.

See chapter Calculating or updating the task status (Page 506).

Status 
The status of the tasks is displayed in the "Status" column:

Icon Status
(No icon) Undefined status. The task status has not yet been calculated.

Information is still missing for configuration of the task. The task cannot be executed.

Even though the task seems to be completely configured, the task could not be execu‐
ted successfully. 
The task was executed successfully.
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Automatic status updating
The task status is updated automatically in the following cases:

● Task executed

● Task undone

● Task target or template modified

See also
Configuring tasks: Setting target object (Page 507)

16.2.3.8 Configuring tasks: Setting target object

Requirements
● The tasks have been created.

See chapter Creating new tasks (Page 504).

Procedure
1. Keep the "Tasks" tab open.

2. Select the target object in the Navigator.

3. Drag the target object into the "Target object" field:

By setting the target object, you automatically update the task status. See chapter Displaying 
the task status (Page 506). 

See also
Using the detail area (Page 508)

Executing tasks (Page 508)
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16.2.3.9 Using the detail area

Requirements
● A task is selected in the task user interface

See chapter Selecting tasks in the properties window (Page 505).

Procedure 
You can find information on this topic in the "EI&C Operation" manual.

● Keyword "Using the Implementation manager"

● Keyword "Using the Potential manager"

You can find the administration on this topic in the "EI&C Administration" manual.

You can find information on the "Template search" and "Target search" detail area in the "EI&C 
Administration" manual.

● Keyword "Administering the template search"

● Keyword "Administering the target search"

See also
Executing tasks (Page 508)

16.2.3.10 Executing tasks

Requirements
● The tasks have been configured.

See chapter Configuring tasks: Setting target object (Page 507).

Procedure
Execute a subset of the tasks

1. Select a subset of tasks with <Ctrl> and mouse click

2. Click the "Execute (selected)" button in the toolbar of the task area:

Execute all tasks

1. Open the command list with a click on the arrow to the right of the "Execute (selected)" 
button.

2. Select "Execute (all)"
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Result
The affected tasks are executed. The task status is updated. 

See also
Undoing tasks (Page 509)

16.2.3.11 Undoing tasks

Requirements
● The tasks have been executed.

See chapter Executing tasks (Page 508).

Note
Errors caused by open reports

All reports in the working area must be closed before they are undone.

Procedure
Undo a subset of tasks

1. Select a subset of tasks with <Ctrl> and mouse click.

2. Click the "Undo (selected)" button in the toolbar of the task area:

 

Undo all tasks

1. Open the command list with a click on the arrow to the right of the "Undo (selected)" button.

2. Select "Undo (all)"

Result
The affected tasks are undone. The original status is restored. The task status is updated. 
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16.2.4 Examples for using engineering tasks

16.2.4.1 Bulk assignment by means of an engineering task

Requirements
● You are familiar with the examples for task classes.

See chapter Examples for task classes (Page 503).

Different workflows 
There are three scenarios for bulk assignment:

● Assign position and station (assign PLC)

● Assign position and I/O module (assign I/O hardware)

● Assign position and control cabinet (assign I/O hardware)

An additional engineering task is required to complete all three cases: the implementation of 
the requests from the "Units" tab to the I/O modules on the "Locations" tab.

Assigning a PLC station
Engineering task used: "@30 Structures > M41 > A50 > A30 > A10 > A60 > A10 Control (PLC)"

1. Open the properties of the unit.

2. Select the "Tasks" tab.

3. Select the "SW interface" tab.
You see all engineering tasks present at positions below the unit.
The "Target object" field is blank.

4. Select one or several engineering tasks called "Assign PLC" in the "Target object" column.

5. Switch to the "Locations" tab in the Navigator.

6. Find a station in a control cabinet.

7. Drag the station to the selection in the "Target object" column.

Assigning I/O hardware with the interface module
1. Open the properties of the position.

2. Select the "Tasks" tab.

3. Select the "SW interface" tab.
You see all engineering tasks present at positions below the unit.
The "Target object" field is blank.

4. Select one or several engineering tasks called "Assign I/O hardware" in the "Target object" 
column.

5. Switch to the "Locations" tab in the Navigator.
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6. Find a field location.

7. Find a corresponding interface module in the field location.

8. Drag the interface module to the selection in the "Target object" column.

Assigning I/O hardware by means of the control cabinet
1. Open the properties of the position.

2. Select the "Tasks" tab.

3. Select the "SW interface" tab.
You see all engineering tasks present at positions below the unit.
The "Target object" field is blank.

4. Select one or several engineering tasks called "Assign I/O hardware" in the "Target object" 
column.

5. Switch to the "Locations" tab in the Navigator.

6. Find a control cabinet.

7. Drag the control cabinet to the selection in the "Target object" column.

See also
Bulk implementation by means of an engineering task (Page 511)

16.2.4.2 Bulk implementation by means of an engineering task

Requirements
● You are familiar with the examples for task classes.

See chapter Examples for task classes (Page 503).

● Bulk assignment by means of an engineering task has taken place.
See chapter Bulk assignment by means of an engineering task (Page 510).

Implementing the control
1. Open the properties of the object that was assigned in the previous engineering task:

– PLC station

– Interface module

– Control cabinet
Alternatively, you can also use the field location instead.

2. Select the "Tasks" tab.

3. Select the "HW interface" tab.
You can see all engineering tasks.
The "Target object" field is blank.
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4. Select one or several engineering tasks called "Implement PLC" in the "Target object" 
column.

5. Find a PLC.

6. Drag the PLC to the selection in the "Target object" column.

You can find additional information on this topic in the "EI&C Operation" manual:

● Keyword "Using the Implementation manager"

● Keyword "Using the Potential manager"

16.2.5 Additional information
You can find additional information on this topic in the "Administration" manual, keyword 
"Preparing engineering tasks".

16.3 Intelligent management of templates
COMOS offers you the possibility to manage templates and to transfer changes to the 
templates into the existing planning structures. This means that you have the possibility to use 
new template versions or also corrections for already modified applications without having to 
delete instance-specific adaptations, such as attribute values or subsequently configured 
supplements, in the application.

"Assembly Updater" plugin
The "Assembly Updater" plugin offers you an overview of the utilization of the templates 
including the original template version. You can visualize deviations from the original template. 
You can reject deviations or apply them in the updated versions. Any contradictory changes 
are displayed as collisions and you have the possibility to work through the collisions in detail. 

Use a preconfiguration for the matching of specific object classes and the handling of 
differences.

In order to use the updates a version management of the templates is required. To do so, 
prepare the database accordingly. See section Updating usages / instances (Page 516). 

Preparing the templates
A corresponding preparation of the templates to be used is necessary for reliable functioning 
of the update. A dedicated release process via the independent "Template administration" 
plugin is the basic requirement for using the "Assembly Updater" plugin. You can find additional 
information on this topic in the "Administration" manual, keyword "Administering templates". 
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16.3.1 Creating new templates

Requirement
● The rights groups have been created. You can find additional information on this topic in 

the "Administration" manual, keyword "Creating a group and assigning rights".

● The template objects and the engineering task "Create assembly" have the attribute 
"Y00A05563 Template version" on the "Y00T00005 COMOS System" tab.  
The "Template version" attribute is read out and displayed in the version history of the 
plugin. 

Procedure
1. Select the command "Plugins > Automation > Templates > Template administration" in the 

menu bar. 
The "Template Administration" plugin is opened. 
If the @Template object already exists, the objects lying below the node are displayed here.

2. From the list select whether you wish to use the template on the "Units" tab or the 
"Locations" tab in the Navigator.

3. To change the base object for the template object or the template folder click the "Options" 
button in the menu bar of the plugin.
The "Options" window opens.

4. Carry out the desired changes.

5. Confirm your entries.
The "Options" window is closed.

6. Select one of the following options:

– To create a new folder for template objects click the "Create template folder" button in 
the menu bar of the plugin.

– To create a new template object click the "Create template" button in the menu bar of 
the plugin.

7. Enter a name and a description.
To edit a template object first activate the editing mode.

8. Confirm your entries.

16.3.2 Editing templates

Requirement
● You have the required rights. See chapter AUTOHOTSPOT.

● The template objects and the engineering task "Create assembly" have the attribute 
"Y00A05563 Template version" on the "Y00T00005 COMOS System" tab. 
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Note
Templates are locked

When you edit a template or do not check in changes to the template, this template is locked 
in this working layer for other users. You can only edit this template further with Administrator 
rights.

Procedure
1. Select the command "Plugins > Automation > Templates > Template administration" in the 

menu bar.
The "Template Administration" plugin is opened. 

2. From the list select whether you wish to use the @Template node on the "Units" tab or the 
"Locations" tab in the Navigator.

3. Select the template that you want to edit.

4. Click the "Edit template" button in the menu bar of the plugin.

5. Carry out the desired changes.

6. Confirm your entries.

Result
● The version history of the object shows when and by whom the template object was 

changed. 

● The symbol of the template object changes and indicates that several versions are available.

16.3.3 Saving and enabling changes

Requirement
● You have already created and edited template objects. See chapter Editing templates 

(Page 513).

● Editing mode is activated.

Procedure
1. Click the "Check in changes to the template" button in the menu bar of the plugin.

A window opens.

2. Enter a comment.
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3. Confirm your entries.

4. If there are instances that use an older version of the template, a corresponding warning 
is opened.
In order to continue working with the instances update the instances before the check-in. 

Note
"Assembly Updater" plugin

The "Assembly Updater" plugin can only process the current version of the instance and 
solve conflicts during updating.

Saving without checking in
If you have changed template objects and do not want to check in these changes yet, click the 
"Save changes of the template" button in the menu bar of the plugin. 

Note
Templates are locked

When you edit a template or do not check in changes to the template, this template is locked 
in this working layer for other users. You can only edit this template further with Administrator 
rights.

Undoing changes
If a version of the template object already exists and you want to undo the current changes, 
click the "Undo all changes" button in the menu bar of the plugin.

16.3.4 User interface reference "Template Administration" plugin

Menu bar

Icon Tooltip Description
"Create template" Creates a new template object below the se‐

lected node.
"Create template folder" Creates a new template folder below the se‐

lected node.
"Edit template" Activates the edit mode for the selected tem‐

plate.
"Check in changes to the template" Saves the changes to the template and relea‐

ses them.
"Save template changes" Saves the changes to the template.

"Undo changes" Undoes the changes since the last check-in.
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Icon Tooltip Description
"Delete" Deletes the selected object and the nodes ly‐

ing underneath it.
"Options" Opens the "Options" window.

"Templates" control group

Control element Description
"Tab" list Select the tab into navigator to which the templates are saved 

from this list.
"Current template object" field Shows the currently selected template object.
Field Shows the name of the selected template object.
"Change" button Activates the edit mode for the name.
Field Displays the description of the selected template object.
"Change" button Activates the edit mode for the description.

16.3.5 Updating usages / instances

Initial situation
A template that is used in your engineering project has been changed.

Aim
The usages derived from the template should incorporate the changes. Important data for the 
configuration from the old objects can be retained or overwritten in the engineering project. 

You can first carry out the resulting changes in a working layer to better check the effects.

Requirements
You have read rights in the "@Template" node.

Procedure
1. Select the "Plugins > Automation > Templates > Assembly Updater" command in the menu 

bar:

2. In the "@Template" node, navigate to the template object - the object under which the 
template is located.

3. Set the desired start object under which the search for the usages is to be carried out.
You may use the project node here.
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4. Drag the template object into the "Template" field.
The current version of the template is displayed in the "Template version" row.
Changes that are relevant for the updating of the instances are evaluated and displayed 
automatically. The owner of the engineering task who generated the instance is displayed 
for each instance. Information such as the working layer in which the instance was 
generated and the version of the instance are also displayed. All the differences of the 
instance to the original version (current - 1) of the template are listed below the instance.

5. Select one of the following options from the list:

– To display all the changes select the entry "Display all changes".

– To display only those changes through which conflicts were triggered select the entry 
"Display changes that require action".

6. Click the "Update" button.

7. Select one of the following options:

– Individually select the changes that you want to keep for each instance.

– To undo the selection for an instance click the "Reset instance" button.
Existing changes are evaluated again. You can correct the selection.

– To undo the selection for all the instances click the "Apply default decisions again to all 
differences" button in the menu bar of the plugin.

8. Confirm your entries.

Changing rules for the matching
You can change the rules for the matching of the templates with the instances. You can find 
additional information on this topic in the "Administration" manual, keyword "Specifying rules 
for standard actions".
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Using Navigator search 17
17.1 Using Navigator search

Navigator search modes
● "Database-based search": COMOS searches the properties of objects. 

● "Search in Navigator text": COMOS searches the object text which is visible in the 
Navigator. See also chapter Identification via name, label, description (Page 59).
For experienced users

Search rate
The search rate depends on the search settings and the search quantity. For comparable 
search settings and search quantities, the database-based search is faster.

Excluded from the search
Database-based search:

● Attribute values and descriptions inherited from the base object
See also chapter Fundamentals of the properties of engineering objects (Page 64).

● Attributes with the "Values in XML" edit mode

Both search modes:

● Links to objects
See also chapter Creating links (Page 174).

● Objects under search objects and index objects
See also chapter Fundamentals of views and working areas (Page 49).

● For activated views: Objects filtered out of the view
See also chapter Fundamentals of views and working areas (Page 49).

Requirements
See also chapter Requirements for COMOS operation (Page 127).
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Procedure
1. Select the start object of the search in the Navigator. 

2. Select the "Search" command in the context menu. 
Alternatively, press <F3> or <Ctrl+F> on the keyboard.
The "Search ..." window opens. The object selected in the Navigator is entered in the 
"Search below" field as the start object. 

Note
Changing the start object

You can change the start object using drag&drop from the Navigator. 

3. Select the "Options" tab. 

4. Select the search mode from the "Type of search" list. 

5. Define the search settings: 

– "Database-based search" mode: 

Control group Description
"Supported objects" Determine which objects you are searching for.

Available options:
● "Base objects"
● "Engineering objects"
● "Documents"
● "Attributes"

"Supported properties" Determine which object properties are searched:
● "Name" option: The name
● "Description" option: The description

– Not for attributes
– Documents: Also searches "Description 2" and "Description 

3".
● "Label" option: The label

Not for attributes
● "Value" option: Value 

Only for attributes

– "Search in Navigator text" search mode:

Option Description
"Case-sensitive" -
"With pattern matching" Recommended

If you do not know the exact spelling or you are 
searching for objects with similar Navigator 
texts, activate this option.

The following button opens a tooltip about the permitted placeholders:

6. Select the "Search" tab. 
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7. Enter the search text in the "Contained text" field. 
Case-sensitive:

– "Database-based search" mode: Not evaluated 

– "Search in Navigator text" search mode: Depends on the search settings

Note
"Search in Navigator text" search mode

The search expects the exact Navigator text including spaces. The number of spaces can 
vary. For this reason, you should work with pattern matching and placeholders. See also 
chapter Placeholders for searching for Navigator text (Page 521).

8. Click the "Start" button. 

Result
COMOS searches recursively below the start object for the search text and lists the result in 
a table. The result table is based on a query. The query functions are available in the context 
menu of the column headers.

The following information is displayed for each hit:

● "Relative name" column: For identifying the object 

● "Description" column: The description of the object

● "Text" column: The hit text. You can tell from this text why an object appears in the results 
set.

You can navigate from the table to the objects or open their properties.  

Accelerating the search for Navigator text
The search for Navigator text only considers the texts of objects visible in the Navigator. If you 
filter objects out of the Navigator using the Navigator settings, you will accelerate the search. 
See also chapter Filtering object trees in the Navigator (Page 160).

17.2 Placeholders for searching for Navigator text

Requirements
● You are familiar with using the Navigator search.

See chapter Using Navigator search (Page 519).

Any single character
Placeholder: "?"
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If you only use this placeholder, you must also specify spaces; for example, between name 
and description. There are three spaces in the basic state, but this number can vary. Therefore, 
combine the "?" placeholder with the "*" placeholder.

No or multiple characters
Placeholder: "*"  

Example:

Search text Description
"*" Finds all objects
"[A]*" Finds all objects which begin with "A". 

Any single digit
Placeholder: "#"

Including single characters in the character list
Placeholder: "[<character>]"

Set each character in its own square brackets.  Only the first character in the square brackets 
is evaluated. 

If you write several of these expressions one after another, the expressions are organized 
hierarchically.  

Example:

Search text Description
"[H1]*" Finds all objects which begin with "H". The "1", as the second character, is ignored. 
"[H][4]*" Only finds the object "H4". 

Excluding single characters from the character list
Placeholder: "[!<character>]"

A character range cannot be excluded.

If you write multiple character exclusions one after another, the expressions are organized 
hierarchically.  

Examples:

Search text Description
"[!B]*" If the "Case-sensitive "option is enabled, a search is made for all objects that do not 

start with "B". 
"[!A][!B]*" Searches for all objects that do not have "A" as the first letter and do not have "B" as 

the second letter. 
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Defining a character range
If the "Case-sensitive" option is activated, the character range applies ASCII sorting.

Example:

Search text Description
"[A-d]" Depending on whether the "Case-sensitive" option is activated, the following letters are 

searched for:
● Option deactivated: A, a, B, b, C, c, D, d
● Option activated: All upper case letters (i.e., A to Z) and the special characters [ \ ] 

^ _ ‘ and the lower case letters a, b, c, d

Delimiters
Possible delimiters:

● ","

● ";"

Delimiters can only increase the search quantity. 

Examples:

Search text Description
"[A]*;[B]*" Searches for all objects that either have an "A" or a "B" as first letter.
"[!A]*;[!B]*" The "[!A]*" expression searches for all objects except those that begin with "A". The "[!

B]*" expression adds all objects which do not begin with B to these results.
Together, the two sets of results deliver all of the objects.

Calling the quick help
Requirements: The "Search ..." window is open.

1. Click on the "Options" tab

2. Click this button:

17.3 Alternative search tools
See chapter Searching for objects in the iDB (Page 525).
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Using the database of the type "iDB" efficiently 18
18.1 Using working layers

Terminology
This document contains guidelines for editing the base data and templates in "COMOS iDB 
(industrial data base)" COMOS databases. In this chapter, the abbreviation "iDB" is used for 
"COMOS iDB (industrial Data Base)". 

Using working layers
Do not work in the released area.

Use working layers when you adapt the iDB. In a working layer, you can test the changes 
without obstructing other COMOS users.

This also applies to correction of translation errors.

Consequences of deviations

CAUTION

Data loss and loss of performance possible

Any deviation from the guidelines described in this documentation can have the following 
consequences:
● Loss of data due to inconsistencies
● Increased expenditure for using the database

18.2 Searching for objects in the iDB

18.2.1 Overview: Search techniques for the iDB

Overview: Identifying objects
You can define the uniqueness of an object in different ways. See also chapter Alternative 
definitions for uniqueness of an object (Page 56). The selected definition also determines the 
tool with which the objects are searched for and identified. Database-independent procedures 
to search for and identify an object can be found in the chapter Overview of the identification 
of objects (Page 55).
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The following supplements apply especially when using the iDB according to iDB standards:

● Name
See chapter Name masks in the iDB (Page 549).

● Classification
See chapter Classifications in the iDB (Page 557).

Alternative 1: "Attribute search" tab
In the attribute search, you can specify one or more character strings used to find attributes. 
The results list is optionally displayed in the tab or exported to an Excel list.

See chapter Using "Attribute search" tab (Page 527).

Alternative 2: Query "A10 Attribute descriptions DE/EN"
The "Attribute descriptions DE/EN" query is the fastest way to find an attribute based on 
description in the attribute catalog. The description of the attribute contains a text for the 
attribute purpose.

See chapter Using "Attribute descriptions DE/EN" query (Page 530).

Alternative 3: Creating your own query
You can find objects in the iDB using queries. Queries provide various search techniques: 

● Recursive search
The recursive search occurs starting from a start object via the collections of this object. 
This search procedure is suitable for searching in deeper structure levels with a 
manageable amount of objects. Example: Search for equipment of a pump station.
See chapter Using queries and bulk processing (Page 455).
You can find additional information on this topic in the "COMOS Administration" manual, 
keyword "Queries for engineering objects".

● Back pointer search 
The back pointer search starts searching from the base object and finds all instances of 
this base object. The search via base object pointer in the properties of the base object is 
also supported. 
Example: Search for all occurrences of an object in a project.
See chapter Using queries and bulk processing (Page 455).
You can find additional information on this topic in the "COMOS Administration" manual, 
keyword "Query for engineering objects".

● Reference attributes
The search using reference attributes (also called link specifications) is a search in which 
a reference to a "common feature" (or a common object) is set in the project. This link must 
be provided in the data model. This search is fast and targeted. However, it requires that 
the project and engineering objects be created accordingly.
Example: Process streams which are transferred from the PFD to one or more pipes or 
pipe segments. 
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● Database search (Search Manager)
The Search Manager is used for searching on the database layer directly. A query is 
converted directly into an SQL query, which is able to search even larger object amounts 
very quickly. Note: For an object to be found, the information for which the search is being 
performed must be checked in at the object.
There are two variants: 

– Direct database search
A search for any properties in the complete database. Examples:
Properties which are always checked in: name and label. 
Properties which can only be searched for if they have been checked in at the object: 
description and value.

– Specialized search for classification keys. 
Classification keys are always checked in at the object. This means that it is possible 
to search for objects across engineering projects.

You can find additional information on this topic in the "COMOS Administration" manual, 
keyword "Database search".

● Scan Manager
The Scan Manager is outdated and should no longer be used.

Alternative 4: Full-text search for documents
The full-text search allows you to search within all documents on the file level. Both internal 
COMOS documents such as reports and revisions and external COMOS documents such as 
Word, Excel, or pdf files can be searched. In addition to this, metadata of objects can be 
searched.

A requirement for full-text search is the indexing of the project. The search is very fast and can 
search 50,000 documents, for instance, in an extremely short amount time. A disadvantage is 
the large amount of data which is created through indexing.

See chapter Fundamentals of full-text search for documents (Page 99).

You can find additional information on this topic in the "COMOS Administration" manual, 
keyword "Overview of the full text search".

Alternative 5: Navigator search
See chapter Using Navigator search (Page 519).

18.2.2 Using "Attribute search" tab

Requirement
● You are familiar with the overview of the search for objects and data.

See chapter Overview: Search techniques for the iDB (Page 525).

● You are familiar with the attribute catalog "@40".
See chapter "@40 Attribute catalog" (Page 545).
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Searching for objects using the "Attribute search" tab
1. Open the base project.

2. Select the following object:
"@40 @Y > A10 Attribute catalog"

3. Open the "Attribute search" tab

4. Select the field "String 1".
Optional: Select the field "String 2".
Enter one or two strings.

5. If a search is made for two strings, the strings are linked with "OR". It is not possible to 
select another operator in the "Logical OP" field.

6. Set a start object from the base data.

7. Select the language in which the search for the string is to be performed.

8. Optional: Activate the search using upper case/lower case letters 

9. Optional: Activate the search based on the attributes' locations of use
This option takes account of the use of attributes in the node "@40 @Y > A20 Tabs catalog".

10.Optional: Activate the search based on the attributes' duplicates
Requirement: The "With usage" option is activated.
This option takes account of the use of inherited attributes.

11.Click the "Search text" button

Searching for objects using "Attribute search" and a search list
The following procedure makes it possible for you to use more than two strings, unlike the 
simple attribute search. 

1. Open the base project.

2. Select the following object:
"@40 @Y > A10 Attribute catalog"

3. Open the Excel list "A10 Template COMOS attributes" created there.

4. Enter a string either in one of the two languages or in both languages.

5. Save the Excel list.
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6. Open the "Attribute search" tab

7. In the "Template" field, select the edited Excel list.

8. In the "Log file" field, select the location where the results list is saved.

9. Optional: Activate the search based on the attributes' locations of use in the options below

10.Optional: Activate the search by upper case/lower case letters in the options below 

11.Click on the "Excel export" button.

12.Optional: Delete the "Status" field if you perform several exports. 

13.The "Link 1" and "Link 2" fields are for internal use and should not be edited. These fields 
control how the Excel list is set up for export.

14.Open the Excel list. 
The time and date are entered in the file name of the Excel file.

In the results list, the entries are black if:

● The string was found

● All other search conditions were met

In the results list, the entries are red if:

● The string was found

● At least one of the search conditions has not been met

In the results list, the entry "Not found" appears if:

● The string was not found
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18.2.3 Using "Attribute descriptions DE/EN" query

Requirements
● You are familiar with the overview of the search for objects and data.

See chapter Overview: Search techniques for the iDB (Page 525).

● You are familiar with the attribute catalog "@40".
See chapter "@40 Attribute catalog" (Page 545).

Procedure
The "Attribute descriptions DE/EN" query is the fastest way to find an attribute based on 
description in the attribute catalog. The description of the attribute contains a text for the 
attribute purpose.

1. Open the "Base data" tab in the Navigator.

2. Find the following object:
"@40 > A10 > Y00 @Y Attribute collection":

3. Open the tree structure below the object.
You will find:

– Folder "A05 @Y Semantic attribute collection"

– Query "A10 attribute descriptions DE/EN"

4. Select the "Open (classic)" command in the context menu of the "A10 Attribute descriptions 
DE/EN" query.

5. Set the following start object:
"@40 > A10 > Y00 >A05 @Y Semantic attribute collection"

6. Click the "Search" button in the command bar of the query.

7. Select the "AutoSort" command in the column header of the query.

8. Sort either the "Description DE" or "Description EN" column.

9. Scroll in the list to the desired description.

10.Alternatively: Select the "Autofilter" command in the column header of the query. 

11.Select the "Navigate > Attribute" command in the context menu.

Using the database of the type "iDB" efficiently
18.2 Searching for objects in the iDB

Operation
530 Operating Manual, 03/2017 V10.2.1, A5E37082875-AB



18.3 Structuring of the "Base data" tab in the iDB

18.3.1 Overview of the main nodes in the iDB
The COMOS iDB is subdivided into main nodes:

The main nodes start with an @.
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The main node @30 is used for engineering. The other main nodes are used to set up the 
main node @30:
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@30 Components and templates of @30 Meaning and use
See chapter 
"@30 Struc‐
tures" 
(Page 543).

① @10 Requirement objects COMOS base objects.
General base objects which are not dependent on particular stand‐
ards. Settings of base objects required for basic COMOS function‐
alities are edited here. On the lower levels of @10, the objects are 
differentiated according to physical requirements and logical re‐
quirements. The branch @10 is not used in engineering.
@10 is used as follows:
● @30

The base objects are supplemented with standard-specific and 
topic-specific information in the branch @30.

● @50
The base objects are supplemented with device-specific 
information in the branch @50.

② @20 General objects
See chapter "@20 General 
objects" (Page 539).

General base objects which are not dependent on particular stand‐
ards. That also includes base objects which are not part of a unit 
but which generally support the work in COMOS. Example: Decision 
tables, engineering tasks, workflow objects.

③ @40 @Y Attributes and tabs
See chapter "@40 Attribute 
catalog" (Page 545).

Root node for the templates of attributes and tabs. The name affix 
"@Y" must be retained for compatibility reasons.

④ @50 Manufacturer devices
See chapter "@50 Manufac‐
turer devices" (Page 546).

Manufacturer device catalog.
Components and templates of @50:
@10 Requirement objects

⑤ Additional elements  
⑥ Additional connectors Connectors do not have their own main node. Instead, the connec‐

tors are prepared in nodes @10, @20, and @30. See also chapter 
Reference: Names of the connector types (Page 550) and chapter 
Connectors on EI&C reports (Page 554).

⑦ Additional symbols  
⑧ Scripts For simplification, scripts are stored in the main node "@20":

"@20 > A80 Scripts"
⑨ Classification  
⑩ Status management "@99 > A40 Status" See chapter Reference: "@99 System" 

(Page 555).
⑪ Standard tables and unit sys‐

tems
Standard tables and unit systems are a COMOS tool for standardi‐
zation of inputs and are used everywhere in COMOS. There are five 
types of standard tables:
● "Attribute catalog"

The standard tables that are used by attributes are collected 
here. These standard tables are used by engineering. See 
chapter "Standard tables > @40 Attribute catalog table" 
(Page 547).

● "System tables"
These standard tables contain data that is used by the system.

● "Special standard tables"
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@30 Components and templates of @30 Meaning and use
These standard tables contain data that is used by external 
applications.

● "Mapping tables"
The various ways views of data or objects are mapped to each 
other in these standard tables.

● NLS tables
The data that is used for localization is collected here.

Main nodes that are not used in @30
● @99 System settings

System-related objects

– Classifications

– Database-dependent user interfaces

– Document type mapping

– Revision base objects

– Status of objects

– Profile objects

– Working layers

– Layers of documents

See chapter Reference: "@99 System" (Page 555).

● Templates
Templates are not base data, but instead are engineering objects which are prepared so 
that they are ready for use. 

Documents do not have their own main node. Instead, base objects of documents are sorted 
in node @30. The template objects of the documents are on the "Documents" tab in the base 
project. See chapter Structuring of the "Documents" tab in the iDB (Page 559).

See also
Note on subnodes with a Y prefix (Page 534)

Note on the subnodes of the COMOS modules (Page 535)

Note on subnodes with labeling systems (Page 536)

18.3.2 Note on subnodes with a Y prefix

Requirements
● You are familiar with the overview of the main nodes.

See chapter Overview of the main nodes in the iDB (Page 531).
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Overview of the Y nodes
Some areas below the main nodes are labeled with a Y prefix:

● Y00
The general objects (catalog objects) are located in this area.

● Y10
Objects with system access are located in this area.

● Y20
The core objects are located in this area.

● Y30
This area includes objects which require special attributes and tabs to support an interface 
and usually have a deviation from the standardized naming convention. The attributes and 
tabs are taken from the following nodes: 

– "@40 > A10 > Y30 @Y Attribute catalog > Y30 @Y Special attributes collection" 
and 

– "@40 > A20 @Y Tab catalog > Y30 @Y Special tab collection" 

● Y40
Objects for mapping objects to one another are located in this area.

Examples
● "@20 > A70 Queries"

● "@40 > A10 @Y Attribute catalog"

18.3.3 Note on the subnodes of the COMOS modules

Requirements
● You are familiar with the overview of the main nodes.

See chapter Overview of the main nodes in the iDB (Page 531).

Overview of the Mxx labeling
The letter "M" is reserved for COMOS modules.

The list of current modules can be found in the iDB below "@30 Structures" The following list 
shows a snapshot as an example:

Area Number range Module Module number
Platform M0x COMOS general M00
  Basic M01
  Enterprise Server M02
  SAP M03
  View/Web view M04
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  Interfaces M05
  Teamcenter Interface M06
    
Process M2x Process general M20
  FEED M21
  P&ID M22
  PipeSpec Designer M23
  PipeSpec Manager M24
  Isometrics M25
  PlantModeler M26
  PDMS Integration M27
  MTO (Material management) M28
    
Automation M4x Automation general M40
  EI&C M41
  Logical M42
  Fluidics M43
  PCS7 AdvES

 – omitted since V10.1.3.0.0
M44

  Automation Designer 
 – omitted since V10.1.3.0.0

M45

    
Operations M6x Operations general M60
  MRO M61
  Shutdown M62
  Portable & Direct M63
  Inspection M64
  PQM M65
  PQM4RI M66
    
Customer Zxx Customer Z00
  etc. Z..

18.3.4 Note on subnodes with labeling systems

Requirements
● You are familiar with the overview of the main nodes.

See chapter Overview of the main nodes in the iDB (Page 531).
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Labeling systems in @30 > M00
Because tagging systems are structural information, they are stored in node @30 Structures. 
The labeling systems are integrated into the normal subnodes in node "M00": 

There are no central root nodes below which all components of a labeling system would be 
available.

The base objects used are cross-inherited from the @10, @20 and @50 nodes.

A20 Project settings
All elements which belong to the corresponding labeling system are referenced here. These 
must all come from the corresponding labeling system base node from node @30:
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A30 Units
Unit structures for the labeling system:

● All objects from node @30 which can be created on the "Units" tab are derived from node 
@10. 
Example: "@30 > M00 > A30 > A30 > A40 > A > AA > A10"

● The unit structures are compiled into the desired structure using the base objects from node 
@20 as elements. This is achieved using cross-inheritance.
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A40 Locations
Location structures for the labeling system:

18.3.5 "@20 General objects"

Requirements
● You are familiar with the overview of the main nodes.

See chapter Overview of the main nodes in the iDB (Page 531).

Purpose of the "@20 General objects" node
This node contains base objects for logical objects such as units, functions, queries, etc. There 
are no standard-specific structures. 

Structure and order of the "@20 General objects" node

First level in @20
● Sorting according to COMOS object types with specified class/subclass

Examples: Units, categories 

or

● Sorting according to base objects related by topic with different object configuration
Examples: SAP objects, PDMS objects
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Second level in @20
Subnodes for the COMOS modules. Only the currently needed structures are created. Missing 
nodes can be added, if necessary.

Example of a COMOS-module specific subnode structure:

"@20 > A70 Queries"
A distinction is made between the following types:

● Y10 System queries
System queries are stored here, specific to the COMOS module.
(Queries used by the software).

● Y20 Core queries
The queries supplied by COMOS are stored here, specific to the COMOS module:

– A70 > Y20 > M00
Queries which are available in the COMOS menu

– A70 > Y20 > Mxx
Queries which are used by documents or objects. See chapter Object queries for 
reports (Page 563).
The content-related meanings of these queries are described in the specialist COMOS 
manuals. 
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● Y30 Customer queries for interfaces
This is the storage location of queries that have fixed names due to an interface or use tabs 
and attributes whose names are not structured according to the existing guidelines.

– A70 > Y30 > M03 SAP
Queries for SAP

● Z10 Customer queries
Customer-specific queries are stored here.

– Z99 Menu
This is where queries for customer-specific expansions to the COMOS menu should be 
stored.
The COMOS menu displays the content from both the "@99 > A20 > M00 > A40" node 
and the Z99 node. If the nodes do not exist or are empty, the COMOS menu "Extra > 
Query" at the corresponding locations is empty.
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"@20 > B20 Engineering tasks"
The engineering tasks (eBlocks) are sorted into module-specific folders:

● "B20 > Y10 > M00"
The basic types of engineering tasks are sorted in the "M00" node.

1

2

3

① Task class
② Engineering task
③ Tab for controlling the engineering task

● "B20 > Y10 > M40", "B20 > Y10 > M41" and more
By means of cross-inheritance, a basic type is inherited in the module-specific folders and 
is adapted there (e.g. renamed).
Example:
The engineering task "A10 Merge" from node M00 is inherited in node M41 at position (2) 
and is renamed there to "A20 Control loop":

1

Engineering tasks that do not rely on an object from M00 may also be created in the M40, 
M41, etc. nodes. 
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"@20 > D40 Reserved object names"
There are base objects in the database that are searched for with a predetermined name and 
a predetermined location. This means that these base objects have to be available at a 
particular location with a particular name.

Names are reserved in the iDB for this reason and stored in the following node:

● @20 > D40

– The "Y00" node stores objects with reserved names that belong to the delivery state of 
the iDB. 

– The "Z10" node stores customer-specific objects with reserved names.

● In the other main nodes, base objects are created which have a base object pointer set to 
the base object with a reserved name created in the "@20 > D40". The reserved names 
are transferred through the base object pointer.

● The name mask for reserved names is Y00R12345.

Connectors sometimes have fixed names too. See also chapter Reference: Names of the 
connector types (Page 550) and chapter Connectors on EI&C reports (Page 554).

18.3.6 "@30 Structures"

Requirements
● You are familiar with the overview of the main nodes.

See chapter Overview of the main nodes in the iDB (Page 531).

Purpose of the "@30 Structures" node
This node includes the standard-specific structures as they are used in the engineering objects. 
While the "@10" and "@20" nodes contain the definitions of the base objects themselves, the 
"@30" node defines the relations between these objects as specified in the various standards. 
This means that this node is responsible for the structures of the right mouse button, project 
presettings, labeling systems and position catalogs, for example according to EN or ANSI. 

There are no direct base object pointers to the objects in the "@10" and "@20" nodes from 
the engineering data. The objects are used as base objects in the "@30" node instead and 
the objects in the "@30" node have base object references to objects in the "@10" and "@20" 
nodes.

To create these structures, the required "subobjects" are defined as elements of the "main 
object" to enable the "subobjects" to be created below the "main object" using the right mouse 
button. Note that these relations must be defined in the "@30" node. It is therefore necessary 
to use objects from the "@10" and "@20" nodes in the "@30" node and to create the structures 
with the objects in "@30".
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Basic structure rules of the "@30" node
The "@30" node is structured according to the following rules:

● First level: Module-specific sorting

– M00 COMOS general
The structures that span all COMOS modules are saved in subnode M00. 

– M01 Basic

– M02 Enterprise Server

– M03 SAP

– M04 COMOS web

– M05 Interface

– M06 Teamcenter interface

– M20 Process technology general

– M21 FEED

– M22 P&ID

– And so on
Nodes that start with a Z should be used for creating customer-specific structures. 
Existing structures can be expanded for specific customers by adding the suffix "_Z".

● Second level: There is always the same, topic-oriented basic structure in Mxx branches:

– A10 General structures

– A20 Project settings

– A30 Units

– A40 Locations

– A50 Device structures

– A60 Functions

– A70 Signals

– A80 Documents

– A90 Document groups

– B10 Templates/macros
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● The @30 structure is constructed below the topic-oriented basic structure using cross-
inheritance. These structures are stored in corresponding nodes for the respective standard 
or topic structure.
The topic-oriented basis structure in the "@30" node is constructed of objects of the "@10", 
"@20" and "@50" nodes. All objects (except for structure objects) must have a base object 
pointer to an object in the "@10", "@20" or "@50" nodes or must be derived from them 
using hierarchical inheritance.

● Structure objects (that were not created for engineering but are only used for structuring) 
may be changed in the "@30" node. See the following block "Permitted customized settings 
in the "@30" node".

18.3.7 "@40 Attribute catalog"

Requirements
● You are familiar with the overview of the main nodes.

See chapter Overview of the main nodes in the iDB (Page 531).

Definition of an iDB attribute
Attributes in the COMOS iDB sense are value-saving objects. Attributes are managed in the 
attribute catalog.
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Principle of uniqueness
An attribute is only created once in the attribute catalog. If you require attributes with the same 
content but with different display, these attributes are derived from the same catalog attribute.

Attributes collection

Catalog attribute

Example: "Current"

Place the catalog attribute on a 
tab in the tab collection

Derived attribute
Example: "Current" attribute on the 

"Technical data" tab

Using the tab on an object

Example: "Technical data" tab 

with "Current" attribute on the "Motor" object

The derived attributes can also be placed multiple times on a tab.  

18.3.8 "@50 Manufacturer devices"

Requirements
● You are familiar with the overview of the main nodes.

Overview of the main nodes in the iDB (Page 531)

Purpose of the "@50 Manufacturer devices" node
The manufacturer catalogs are located under @50. The manufacturer catalogs are currently 
divided into two groups: 
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● A10 COMOS
Includes manufacturer catalogs for typical COMOS functions and workflows. 
Example: Manufacturer devices for the COMOS PipeSpec Designer function.

● A20 SIEMENS AG
Includes Siemens manufacturer catalogs.
Example: Manufacturer devices for Siemens automation objects.

These catalogs include the base objects for the components which can be ordered such as 
devices (manufacturer devices) and accessories. For a base object to be considered a 
manufacturer device base object, a valid article number must exist in the "Order data" tab. 

The branch @50 does not depend on a standard, which is why there are no standard-specific 
structures. Instead this branch @50 includes manufacturer-specific structures. All base objects 
from this node are derived from requirements from the @10 branch. This means that devices 
from different manufacturers can be derived from the same requirement from the @10 branch.

Creating base objects in @50
The branches in @50 are mostly empty on the layer of the manufacturer devices. You first 
have to create the manufacturer device base objects. You can find more information on this 
topic in the respective solution manuals:

18.3.9 "Standard tables > @40 Attribute catalog table"

Requirements
● You are familiar with the overview of the main nodes.

See chapter Overview of the main nodes in the iDB (Page 531).

Aim
The standard tables that are used by attributes are placed here. This node is divided into three 
areas:

● "Y00 Standard table for attributes"
Standard tables of COMOS

● "Y30 Special standard tables collection"
Selection list for specific subjects

● "Z10 Standard table for customer attributes"
Freely available to customers

Storage and assigning names

Note

All standard tables that are assigned to attributes are only copied in the tab at the derived 
attribute.
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● The name of a standard table is made up as follows: Y00N + consecutive five-digit number.
Example: Y00N00001

● Special standard tables receive the prefix "Y20"
Y30Nnnnnn (e.g. Y30N00001)

● Customer-specific standard tables receive the prefix "Z10"
Z10Nnnnnn (e.g.: Z10N00001)

When standard tables belong together thematically, the variants are assembled together below 
a grouping standard table. Meaningful descriptions are used to distinguish the variants. The 
description is also selected based on the tab in which the standard table of attributes is opened. 
The variants receive a suffix, for example A01/A02:

The higher-level object (Y00N00048 in the above example) contains no values by definition. 
The subordinate standard tables contain the values.

Note

The search for standard tables takes place by means of queries. This search is textual and 
runs through the "Description" field of the respective standard table.

The standard tables are grouped in accordance with the same rules as with the attributes:

● Grouping in packages of 500

● Below grouping in packages of 25

Note

In the delivery state, COMOS iDB does not use standard tables that are checked in or created 
in the engineering project.
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18.4 Name masks in the iDB

18.4.1 Overview of the naming convention in the iDB

Overview
The following provides an overview of how the names of the objects in the iDB are formed. 
Using these masks you can, for example, search for items specifically by name.

● Attribute:
Y00A12345

● Tab:
Y00T12345

● Standard table:
Y00MxxN12345

● Reserved name:
Y00R12345

● Border on tab:
FR001

● Label on tab:
LA001

● Script in the script library:
MxxS12345

● Customer objects
The prefix "Z" designates customer-specific nodes and objects.
The suffix "_Z" designates customer-specific nodes and objects.
Example: Z00A12345

Explanation of the wildcards used in the name masks:

● Mxx corresponds to the module key with a two-digit count index (00-99)
See chapter Note on the subnodes of the COMOS modules (Page 535).

● 12345 corresponds to a five-digit count index (00001-99999)

● 001 corresponds to a triple-digit count index (001-999)

Names of connectors
See chapters Reference: Names of the connector types (Page 550) and Connectors on EI&C 
reports (Page 554).
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Special letters
There are special letters in the COMOS iDB that are not used for counting and are skipped for 
this reason:

● "W"
The letter "W" identifies nodes and objects belonging to internal Siemens topics.

● "X" in the "Documents" topic area
The letter "X" designates object queries on report templates.
Example: AB_A10_X10

● "X" in the "Database update / Database extension" topic area
The letter "X" indicates nodes and objects that belong to the content layer.

● "Y"
The letter "Y" is reserved for designating attributes, tabs, standard tables, and scripts.

● "C"
The letter "Z" designates customer-specific nodes and objects.

18.4.2 Reference: Names of the connector types

Requirements
● You are familiar with the overview of the naming system in the iDB.

See chapter Overview of the naming convention in the iDB (Page 549).

Naming system for connectors
The name given is neutral and is assigned for each module. 

Attention must be paid to the length of the name as the name will be displayed on different 
plans.

Connectors are generally independent of the drawing type, i.e. a connector may be displayed 
on different drawing types. In some cases connectors are only displayed on one drawing type 
or on no drawing type at all.

Structure of the name: 3 or 4 characters (the first two characters are letters; the following 
characters are figures with consecutive numbering):

Note

The consecutive numbering may have one or two digits.

1st position 2nd posi‐
tion

3rd posi‐
tion

4th position Note

Letter Letter Number Number  
A    Basic
B    Basic
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1st position 2nd posi‐
tion

3rd posi‐
tion

4th position Note

Letter Letter Number Number  
C    Process
D    Process
E    Automation
F    Automation
G    Operations
H    Operations
     
Z    Often used for customer-specific connectors
     
 A   Free naming within each module
 …   Free naming within each module
 Z   Free naming within each module
     
  0 1 Consecutive numbering (one or two digits)
  0 2 Consecutive numbering (one or two digits)
   … Consecutive numbering (one or two digits)
  0 9 Consecutive numbering (one or two digits)
  1 0 Consecutive numbering (one or two digits)
   … Consecutive numbering (one or two digits)

The first digit is for the purposes of assignment to the 4 higher-level areas in COMOS. The 
letter "Z" is reserved for customer-specific connectors. The second digit is assigned within an 
area. After this the number is consecutive (with one or two digits).

Fixed names in the Automation area

ET Multiline EAxx
ET Singleline EBxx
ET Bridge internal ECxx
ET Bridge external EDxx
ET Reserve EExx – EHxx (4 Reserve)
IC Multiline EIxx
IC Singleline EKxx
IC Reserve ELxx – EOxx (4 Reserve, when J is not used)

Fluid Hydraulic FAxx
Fluid Pneumatic FBxx
Fluid Lubrication FCxx
Fluid Reserve FDxx-FHxx (5 Reserve)
Logical FUP input FIxx
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Logical FUP output FKxx
Logical Reserve FLxx

There are more exceptions in the area of automation for connector arrays and PE connectors.

Fixed names in the M20 Process area

Old name New name Note Module
CX0 CX0 for origin connectors (never used in BaseProject) VIPER
CX1 CX1 Viper ComosConnectors VIPER
CX2 CX2 Viper ComosConnectors VIPER
CX3 CX3 Viper ComosConnectors VIPER
CX4 CX4 Viper ComosConnectors VIPER
CA1 CA1 for actuator connectors VIPER
CA2 CA2 for actuator connectors VIPER
CA3 CA3 for actuator connectors VIPER
CA4 CA4 for actuator connectors VIPER
CAn CAn for actuator connectors VIPER
CY1 CY1 for dynamic connectors (never used in BaseProject) VIPER
CY2 CY2 for dynamic connectors (never used in BaseProject) VIPER
CY3 CY3 for dynamic connectors (never used in BaseProject) VIPER
CY4 CY4 for dynamic connectors (never used in BaseProject) VIPER
CYn CYn for dynamic connectors (never used in BaseProject) VIPER
CP1 CP1 for physical connectors (never used in BaseProject) VIPER
CP2 CP2 for physical connectors (never used in BaseProject) VIPER
CP3 CP3 for physical connectors (never used in BaseProject) VIPER
CP4 CP4 for physical connectors (never used in BaseProject) VIPER
CPn CPn for physical connectors (never used in BaseProject) VIPER
CM1 CM1 for attachment connectors (for mounting parts like nuts or slip on 

flanges)
VIPER

CM2 CM2 for attachment connectors (for mounting parts like nuts or slip on 
flanges)

VIPER

CM3 CM3 for attachment connectors (for mounting parts like nuts or slip on 
flanges)

VIPER

CM4 CM4 for attachment connectors (for mounting parts like nuts or slip on 
flanges)

VIPER

CMn CMn for attachment connectors (for mounting parts like nuts or slip on 
flanges)

VIPER

C#1 C#1 for CP/CX in IsoSymbols. VIPER
C#2 C#2 for CP/CX in IsoSymbols. VIPER
C#3 C#3 for CP/CX in IsoSymbols. VIPER
C#4 C#4 for CP/CX in IsoSymbols. VIPER
C#n C#n for CP/CX in IsoSymbols. VIPER
CX# CX# for connectionTypes in IsoSymbols VIPER
CP# CP# for connectionTypes in IsoSymbols VIPER
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Old name New name Note Module
I1 CI1 input connector FEED
O1 CO1 output connector FEED
O2 CO2 output connector FEED
O3 CO3 output connector FEED
O4 CO4 output connector FEED
001 CN1 dynamic and/or neutral connector FEED
002 CN2 dynamic and/or neutral connector FEED
003 CN3 dynamic and/or neutral connector FEED
004 CN4 dynamic and/or neutral connector FEED
W CS1 signal line connector FEED
W1 CS2 signal line connector FEED
W2 CS3 signal line connector FEED
W3 CS4 signal line connector FEED
W4 CS5 signal line connector FEED
Wn CSn signal line connector FEED
I1 DI1 input connector P&ID
I2 DI2 input connector P&ID
O1 DO1 output connector P&ID
O2 DO2 output connector P&ID
001 DN1 dynamic and/or neutral connector P&ID
002 DN2 dynamic and/or neutral connector P&ID
W DS1 signal line connector P&ID
W1 DS2 signal line connector P&ID
W2 DS3 signal line connector P&ID
W3 DS4 signal line connector P&ID
W4 DS5 signal line connector P&ID
Wn DSn signal line connector P&ID

Comparison of names in the old COMOS database and COMOS iDB

Old connector name in DB V10.0 and below New connector name in the COMOS iDB
SLI EB01
SLO EB02
SL1 EB01
SL EB01
SL1 EB01
SL11 EB02
CPxx EAxx
BI[1] EC[1]
BI[2] EC[2]
BE[1] ED[1]
BE[2] ED[2]
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Old connector name in DB V10.0 and below New connector name in the COMOS iDB
I I
I[3] I[3]
I1 I1
I2 I2
IN1 EA01
IN2 EA02
O O
O[1] O[1]
O1 O1
O2 O2
O3 O3
OUT1 EA02 or EA03
PE EE01

18.4.3 Connectors on EI&C reports

Requirements
● You are familiar with the overview of the naming system in the iDB.

See chapter Overview of the naming convention in the iDB (Page 549).

Dynamic connectors on EI&C reports
If you move an object which does not have a symbol onto an EI&C report via drag&drop, a 
"black box" is created as the symbol for this object.

The figure below shows the connector names of a black box:

A black box has dynamic connectors. You can use the dynamic connectors from all sides at 
the same time.

If you wire the black box, the connectors are created during runtime. To enable COMOS to 
assign the location, a distinction is made between X/Y and I/O. Because wiring of this type 
does not take place until the project planning stage, this naming does not exist in the base 
project.
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18.5 Reference: "@99 System"

Requirements
● You are familiar with the overview of the main nodes.

See chapter Overview of the main nodes in the iDB (Page 531).

"@99 > A10 Classification key"
See chapter Classifications in the iDB (Page 557).

"@99 > A20 User interface"
Objects used to sort windows, tabs and menus in COMOS are sorted here.

Generally applicable user interfaces in "@99 > A20 > M00"
● "A10 Mapping tables"

User interfaces for linking attributes to other attributes or Excel.

● "A20 Q-Signatures"
This query displays the signatures of documents.

● "A30 Search/index object"
This is where you make the settings for search and index objects.

● "A40 'Extra' menu entries"

– Node "@99 > A20 > M00 > A40 > A10 Query" creates the structure of the COMOS menu 
"Extra > Queries".
You can find additional information on this topic in the "COMOS Administration" manual, 
keyword "Creating a query".

● "A50 Data import"

● "A60 'Documents' menu entries"
The objects collected in this node control some entries in the "Documents" menu. Example: 
Print manager.

"@99 > A30 System data"
Objects for system functions are stored here. 

Generally applicable user interfaces in "@99 > A30 > M00"
● "A10 Read processors"

Various import interfaces.

● "A20 Document type mapping"
A list of objects that each represent the file extension of a document type. Depending on 
the document type, special import settings are available.

● "A30 ESign batch"
Base objects for controlling the electronic signatures of documents.
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● "A40 Link objects"
The links specify standard objects. Example: A specification concerning which wire list 
should be used.

● "A50 Revision"
Controls the base objects of the revisions. The revisions are used to identify editing states 
of an object and make them verifiable.

● "A60 XML connector data"
Objects for administration of XML connectors.

– "A10 Query pointer"
Carrier object for the "Y00T00034.Y00A00772 Query" attribute. The name of this 
attribute is hard-coded. If an XML connector detects an attribute of this name, the "Query 
pointer" functionality is activated.

● "A70 Working areas"
Base objects that represent the working areas.

"@99 > A40 Status"
See chapter Status management (Page 77).

"@99 > A50 Profiles/user settings"
For each user there is an object in which the user settings are saved.

"@99 > A70 Working layers"
Objects used to control working layers are sorted here.

The attributes of the working layer base objects are entered with the "~" working area and are 
therefore invisible for everyone except the administrators. 

You can find additional information on this topic in the "COMOS Administration" manual, 
keyword "Administering working areas".

Keywords for the StandardDB: @WOLEVELS
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"@99 > A80 Graphical layers"
Objects used to control graphical layers in interactive reports are sorted here:

See chapter Showing/hiding or freezing the content of a layer (Page 377).

Keywords for the StandardDB: @GRAPHICS, @LAYERS 

18.6 Classifications in the iDB

Objectives of classification
Classification has the following objectives:

1. Search: The objective is to find a particular object or similar objects. You are supported by 
specialized queries when doing so.

2. Control: The objective is to assign similar reactions. In this case, either the objects 
themselves can react in the same way or else the environment treats all objects in the same 
way.

3. Standardize: The objective is to create uniform names for objects across databases and 
companies. This makes it easier to compare, exchange or group objects.

Only the base data (base objects, document base object, etc.) is classified. The engineering 
objects and engineering documents apply the classifications from the base data.

Application cases
● Cross-project queries use the classification

You can find additional information on this topic in the "COMOS Administration" manual, 
keyword "Creating a query: Cross-project queries".

● Database search uses the classification
You can find additional information on this topic in the "COMOS Administration" manual, 
keyword "Overview of the database search".
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Basic variants of classifications
The classification keys are stored in "@99 > A10" system node. See chapter Reference: "@99 
System" (Page 555).

COMOS uses two types of classification keys:

● Hierarchical classification
Five hierarchically dependent fields with 1 to 4 characters each.
In hierarchical classification, the subsequent layers (2, 3, etc.) can only be set in relation 
to the layers before them.
Default in the iDB: The first layer of the hierarchical classification is a three-digit key for the 
module name (M00 for Basic, M20 for Process, M40 for Automation, and so on). 

● Functional classification
Five independent fields with 1 to 4 characters each.
You can assign any combination of functional classification keys.
Default in the iDB: The first functional classification of all objects is a key made up of two 
digits twice. The first two digits are a key for the class. The following two digits are a key 
for the subclass.

Both the hierarchical classifications and the functional classifications exist separately for 
default objects and for customer objects. For this reason, four basic variants for classifications 
appear below "@99 > A10":  

● Classification key 1: COMOS (hierarchic)
The classification key 1 is created and delivered exclusively by Siemens and is also 
constant in future iDB versions.

● Classification key 2: COMOS (functional)
The classification key 2 is created and delivered exclusively by Siemens and is also 
constant in future iDB versions. 

● Classification key 3: Customer (hierarchic)
The naming convention for classification key 3 is similar to that of classification key 1.

● Classification key 4: Customer (functional)
The naming convention for classification key 4 is similar to that of classification key 2. 

Relationship between classifications and class/subclass
For compatibility reasons, the following properties are still available: Base objects, "System" 
tab: "Class" and "Subclass" standard tables
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Class and subclass are mapped as functional classification in the iDB:

● Functional classification "@99 > A10 > A20 > N1" and all subsequent classification keys 
up to "P8D3"

– Two characters for the class

– Two characters for the subclass

When new base objects are created, the settings for classifications "Class/Subclass" and the 
properties "Class/Subclass" must match.

Classification keys for documents
Classification keys for documents are constructed in a DCC structure below the following node:

● "@99 > A10 > A10 > M00 > A140 Documents"

18.7 Structuring of the "Documents" tab in the iDB

18.7.1 Document templates in the iDB

Relationship with external files
Reports consist of a report object in COMOS and an external .CRp file.

See chapter Fundamentals of documents and reports (Page 81).

Overview of storage
The documents are made available in the "Documents" tab in the Navigator. The following 
nodes are here:

The templates for interactive reports and evaluating reports are located in the node A30 and 
are sorted according to IEC 61355.

A10 Master reports
The master reports are arranged in accordance with their format. A master report is created 
for each format. They only contain one frame and are otherwise empty:

The "A10 Master reports" node is divided into DIN and ANSI formats. Sorting in the DIN area 
takes place in accordance with the ISO-5457 standard.
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Example: The following 2 reports are below the A10 > A10 > A10 DIN A0 node:

● A10 Master report DIN A0 portrait

● A10 Master report DIN A0 landscape

The master reports are evaluating reports as standard. To use an interactive report, insert the 
base object of the corresponding evaluating report and change the type to interactive in the 
report properties.

A15 Master templates
The master templates are the templates for evaluating reports. The master template is a 
combination of master report and header and/or footer.

This node is divided into the following areas:

● Data sheets

● Lists

The master reports in the nodes "A10 Data sheets" and "A20 Lists" are distinguished by the 
standard they use. Example: "COMOS iDB Standard", "PIP Standard".

For the COMOS iDB standard:

● All data sheets: DIN A4 portrait / ANSI A portrait

● All lists: DIN A3 landscape / ANSI B landscape

A20 Header
This node contains templates for headers and footers.

The header line reports are sorted in the style of the DIN and ANSI standards and the 
respective modules. The header line reports include a predefined document header:
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A30 Template acc. IEC 61355
The document templates are sorted in the style of the standard for classification and 
designation of documents (DCC) IEC 61355. Each document template is grouped under a 
document folder which includes the main report, subreports and queries.

● The name of the document group is composed as follows: The first two letters of the DCC 
structure + "_" + COMOS iDB count.

● The main report has the same name as the document group.

● The name of the subreport and queries is composed as follows: The first two letters of the 
DCC structure + "_" + COMOS iDB count + COMOS iDB count. 
Example: AB_A10_A10 Header. See also chapter Using or editing subreports (Page 562).

Example AB_A10:

The base objects for the document templates are stored on the "Base data" tab in the "@30" 
node:

See also
Object queries for reports (Page 563)

Base objects for the document templates (Page 564)
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18.7.2 Using or editing subreports

Requirements
● You are familiar with the storage and structure of the document templates in the iDB.

See chapter Document templates in the iDB (Page 559).

Aim
Subreports make it possible to use information numerous times.

Name of the subreport
See chapter Document templates in the iDB (Page 559).

Storing the subreport
Subreports are stored in a document folder together with the calling main report. The name of 
the folder corresponds to the name of the main report. 

The description is used to indicate that it is a subreport.

Grouping of subreports
Subreports can be grouped in a separate subreport folder under a report folder.

The figure shows the grouping of subreports below the FB_B10_B10 folder:

Figure 18-1 Subreport_Folder

The structure in the file system is identical.
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Dynamically selected subreports
Various subreports are prepared for dynamic subreports and the user selects one of these in 
engineering project. The user selects an entry from a list for this. Example:

● Units tab, <Process>: "A70 Process units > FB.001 Process flow diagram"

● Open the properties of the process flow diagram, "Attributes > Material balance" tab

● "Design" list 

The structure in the file system is identical.

18.7.3 Object queries for reports

Requirements
● You are familiar with the storage and structure of the document templates in the iDB.

See chapter Document templates in the iDB (Page 559).

Aim
Lists are displayed for object queries, in which an object query is called from a list field.

Name and storage location
● Create a report template object for each created row.

● Create the report template object below the document group of the main report.

● Report templates can be stored and edited in working layers.

Object queries are created under the main report to which they belong. The name is made up 
as follows:

● Name of the main report + "X" (reserved letter for object queries) + count in increments of 
10.
Example: AB_A30_X10

Example: AB_A10_X10

The base objects of the object queries are stored in the respective module node under "@20 
> A70 > Y20 Core queries":
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See also chapter "@20 General objects" (Page 539).

Configuring object queries
You can find additional information on this topic in the "Administration" manual, keyword 
"Placing a list".

18.7.4 Base objects for the document templates

Requirements
● You are familiar with the storage and structure of the document templates in the iDB.

See chapter Document templates in the iDB (Page 559).
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Structure of the document base objects
The base objects for documents are stored in the "@20 > A60 Documents" node. This node 
is divided into the following areas:

● "A10 Base ojects"
The base objects for documents and external file types are stored in this node.
Document base objects are inherited in the respective "@30 > Mxx > A80 Documents" 
node.

● "A20 Document groups"
The base objects for document groups are stored in this node. This node is divided into the 
following areas:

– "A10 Hierarchy group"

– "A20 Document group"

● "A30 Additional objects"
The base objects for additionally required objects are stored in this node. These objects 
can be used as an elements at the document base objects, for example .
Example: Note object

● "Z10 Customers"
Customer-specific document base objects

18.8 Using case variants as design cases or editing them

Objective
A unit can have various statuses. The statuses can be defined and rated using different design 
cases. You can only access one value per design case directly in the user interface. You can 
access all values in scripts.

Procedure
There are two different views of a unit: 

● Operator view (Owner/Operator (OO)) 
The OO talks about run cases. 

● Scheduler view (Engineering, Procurement, and Construction (EPC)). 
The EPC designs a unit for different design cases.
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In each individual case, the attributes of an object can take on different values. Depending on 
the task, only individual values or the values for each design case of an attribute are to be 
displayed.

There are two approaches to design cases in COMOS:

● Managing the case variants using simulation case objects
Main application: FEED module
You can find additional information on this topic in the "FEED Operation" manual, keyword 
"Managing design cases".
Simulation case objects are created under an object with the names of the individual design 
cases. The attributes that are relevant at this object for a design case exist at all simulation 
case objects. The software creates a fully dynamic linking between the attribute at the object 
and the attribute at the active simulation case object. 
An individual tab at the FEED objects is responsible for switching between the design cases 
at the individual object or across areas. This means all values of the design cases are 
available at the same time with direct access and can be easily reached with object queries.

● Managing case variants using project properties and by switching the attributes
Obsolete. Only continues to be available for compatibility reasons.
Design cases can be defined in the project settings. You can store information on whether 
each attribute can take different design cases into consideration on the attribute itself. An 
individual value can be stored for each design case and for each attribute. If you have 
defined design cases in the table, a list is displayed in the toolbar in which you select the 
design case that is to be in effect for the entire project. The design cases are switched 
throughout the entire project for all attributes.
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User interface reference 19
19.1 Reference of the COMOS menu bar

19.1.1 "File" menu

Commands in the "File > ..." menu

Icon Call Description
 "... > Open database..." See chapter Opening or switching between databases (Page 129).

Alternatively: Create a database (Access). You can find additional in‐
formation on this topic in the "Administration" manual, keyword "Admin‐
istration of COMOS startup and the working environment".

"... > Open project" See chapter Opening a project or the released area of a project 
(Page 185).
Alternatively: Create a project. You can find additional information on 
this topic in the "Administration" manual, keyword "Creating a new 
project".

"... > Close project" See chapter Closing projects (Page 190).

"... > Close working layer" See chapter Closing working layers (Page 195).

"... > Save project" All open objects and actions are saved. 
Note: Modified properties are applied and also saved. You cannot can‐
cel after saving. Navigator operations cannot be undone.
COMOS saves as much data as possible. The "Save" button in the 
dialog fields, however, only saves if the entries are consistent.
Example: Duplicate name in the properties:
● "File > Save project":

Name is automatically corrected; object is saved.
● Save in properties:

Save is rejected; an error message is output due to duplicate names.
The cache is cleared.

"... > Languages" See chapter Switching the user interface language (Page 138).

"... > User settings" See chapter Changing user settings (Page 140).

"... > Exit" Use this command to exit COMOS. All changes since the last save 
operation are saved in the project and in the database.
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19.1.2 "View" menu

Commands in the "View > ..." menu

Icon Call Description
"... > Back" Switches to previous view in the history of viewed objects. 

"... > Forward" Switches to next view in the history of viewed objects. 

- "... > Quick launch" See also chapter Enabling and disabling quick launch 
(Page 130).

- "... > Screen 2" Opens a second working area. By default, COMOS is configured 
in such a way that documents are opened on this screen.

- "... > Icon with placing information > ..."  
  "... > Hide" See also chapter Showing placing information (Page 162).
  "... > For all placed objects"
  "... > For placed elements only"

"... > Properties tree" See also chapter Editing object properties in the properties tree 
(Page 279).

"... > Status window" You can find more information on this topic in the "P&ID Opera‐
tion" manual, keyword "Status window".

"... > Symbol and document preview" See also chapter Displaying a preview of symbols and working 
areas (Page 141).

"... > Window list" See also chapter Closing tabs or switching between tabs using 
the window list (Page 156).

"... > Favorites" See also chapter Working with favorites (Page 142).

"... > Static new menu" See also chapter Creating multiple objects via the static new 
menu (Page 241).

19.1.3 "Administration" menu
This "Administration" menu is only relevant for system administrators.

You can find additional information on this topic in the "Administration" manual, keyword 
""Administrator" menu".

19.1.4 "Documents" menu
Using the "Documents" menu, you can select all actions of "All Document tools" as individual 
actions.
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Commands in the "Documents > ..." menu
The menu commands use the same tab. The layout of this tab is described using the "Print" 
tab as an example. See also chapter Reference of the "Print" tab (Page 314).

Icon Call Description
"... > Print" See also chapter Printing documents (Page 312). 

"... > Evaluate" See also chapter Updating reports (Page 450).

"... > Revision" See also chapter Carrying out single revisions in bulk (Page 324).

"... > DWG/DXF export" You can find additional information on this topic in the "Basic in‐
terfaces" manual, keyword "Exporting and importing DWG/DXF 
files".

"... > Word export" You can find more information on this topic in the "Basic interfa‐
ces" manual, keyword "Exporting reports to Word".

"... > Excel export" You can find more information on this topic in the "Basic interfa‐
ces" manual, keyword "Exporting reports to Excel".

"... > PDF export" You can find more information on this topic in the "Basic interfa‐
ces" manual, keyword "Exporting a report as a PDF".

"... > Copy TIFF/PDF file of the released revi‐
sion"

See also chapter Printing or exporting current revision files 
(Page 338).

"... > Print current revision file"

"... > Print with revision printer" See also chapter Printing documents with revision printer 
(Page 315).

"... > All document tools" See also chapter Working with the tool "All document tools" 
(Page 316).

19.1.5 "Extra" menu

19.1.5.1 "Extra > Bulk processing" menu

Commands in the "Extra > Bulk processing > ..." menu

Icon Call Description
"... > Bulk processing for engineering objects > 
Bulk processing: Engineering objects"

See also chapter Prepared bulk processing (Page 486) and chap‐
ter Using queries and bulk processing (Page 455).
You can find additional information on this topic in the "Adminis‐
tration" manual, keyword "Bulk processing".

"... > Bulk processing for base objects > Bulk 
processing: Base objects"
"... > Bulk processing for attributes > Bulk pro‐
cessing: Attributes"
"... > Bulk processing for documents > Bulk pro‐
cessing: Documents"
"... > Bulk processing for connectors > Bulk pro‐
cessing: Connectors"
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19.1.5.2 Menu "Extra > Query"

Requirements
● You are familiar with the use of queries and bulk processing.

See chapter Using queries and bulk processing (Page 455).

Commands in the "Extra > Query > ..." menu

Icon Call Description
"... > Query for engineering objects > ..." Prepares standard queries for the system type: Engineering 

object.
  "... > Query: Engineering objects"
  "... > Query: Engineering objects (cross-

project)"
  "... > Query: Engineering objects (alter‐

native)"
"... > Query for base objects > ..." The standard queries are available for the administrator.

You can find additional information on this topic in the "Ad‐
ministration" manual, keyword "Queries". 

  "... > Query: Base objects"
  "... > Query: Base objects (alternative)"

"... > Query for attributes > ..." The standard queries are available for the administrator.
You can find additional information on this topic in the "Ad‐
ministration" manual, keyword "Queries". 

  "... > Query: Attributes"
  "... > Query: Attributes (alternative)"

"... > Query for documents > ..." Prepares standard queries for the system type: Document.
   "... > Query: Documents"

  "... > Query: Documents (cross-project)"
  "... > Query: Documents (alternative)"

"... > Query for connectors > ..." Prepares standard queries for the system type: Connector.
   "... > Query: Connectors"

  "... > Query: Connectors (alternative)"
 - "... > Tools > ..." The standard queries are available for the administrator.

You can find additional information on this topic in the "Ad‐
ministration" manual, keyword "Queries". 

  "... > Restore COMOS objects"
  "... > Changed devices in a layer"
  "... > Changed attributes in a layer"
  "... > Wire list (over connectors)"  
  "... > Implement requests" See also chapter Requests and implementations (Page 80).

Administering the menu
You can find additional information on this topic in the "Administration" manual, keyword 
"Administration of queries and bulk processing".
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19.1.5.3 Menu "Extra > Standard import"

Commands in the "Extra > Standard import > ..." menu

Icon Call Description
"... > Access/Excel/XML reimport" You can find additional information on this topic in the "Basic interfaces" man‐

ual
, keywords "Reimporting content from Access/Excel/XML files" and "Reim‐
porting content from Access/Excel files or directories".

"... > Blank table" You can find additional information on this topic in the
"Basic interfaces" manual, keyword "Standard import "Blank table"".

"... > Blank XML" You can find additional information on this topic in the "Basic interfaces" man‐
ual
, keyword "Standard import "Blank XML"".

You can find additional information on this topic in the "Administration" manual, keyword 
"Commands in the "Extra > Standard import" menu".

19.1.5.4 Menu "Extra > Translation"

Commands in the "Extra > Translation > ..." menu

Icon Call Description
"... > Single translation" You can find additional information on this topic in the "Administration" 

manual, keyword "Using single translations: Translation of the descrip‐
tion".

"... > Bulk translation" You can find additional information on this topic in the "Administration" 
manual, keyword "Using automatic translation in bulk translation".

"... > Translation database" You can find additional information on this topic in the "Administration" 
manual, keyword "Working with the translation database".

"... > Translation search" You can find additional information on this topic in the "Administration" 
manual, keyword "Using a translation search".

19.1.5.5 "Extra > Check" menu

Commands in the "Extra > Check > ..." menu

Icon Call Description
"... > Object test" You can find additional information on this topic in the "Adminis‐

tration" manual, keyword "Using an object test".
"... > Edit instances" You can find additional information on this topic in the "Adminis‐

tration" manual, keyword "Configuring an instantiation".
"... > Edit product data" You can find additional information on this topic in the "EI&C Op‐

eration" manual, keyword "Editing product data and using manu‐
facturer devices".
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19.1.5.6 "Extra > Detail" menu

Commands in the "Extra > Detail > ..." menu

Icon Call Description
"... > Modification of Name/Label" You can find additional information on this topic in the "EI&C 

Operation" manual, keyword "Modification of name/label".
"... > Device selection (product data)" You can find additional information on this topic in the "EI&C 

Operation" manual, keyword "Manufacturer device selection for 
numerous components".

"... > Characteristics for connections" You can find additional information on this topic in the "EI&C 
Operation" manual, keyword "Setting characteristics for con‐
nections on connectors".

"... > Signal cross-references" You can find additional information on this topic in the "Automa‐
tion Logical" manual, keyword "Using the signal cross-reference 
list".

19.1.5.7 "Extras > Working layers/history" menu

Commands in the "Extra > Working layers/history > ..." menu

Icon Call Description
"... > Management" See also chapter Setting the comparison time for the history display (Page 203) and 

chapter "Working layer/History management" tab (Page 212).
"... > Object status" See also chapter Displaying the working layer status and history status of an object 

(Page 201) and chapter "Object status (Working layers/history)" tab (Page 211).
"... > Release manager" See also chapter Performing release check by means of Release manager (Page 218) 

and chapter "Release manager" tab (Page 220).

19.1.5.8 Menu "Extra > 3D review"

Commands in the "Extra > 3D review > ..." menu

Icon Call Description
"... > 3D view" You open the 3D visualization tool from this menu.

You can find additional information on this topic in the "Isometrics" and "PipeSpec 
Designer" manuals.

"... > Symbol editor"
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19.1.5.9 Menu "Extra > Monitoring"

Commands in the "Extra > Monitoring > ..." menu

Icon Call Description
"... > System monitor" You can find additional information on this topic in the "Administration" manual, 

keyword "Using the System Monitor".
"... > Performance monitor" You can find additional information on this topic in the "Administration" manual, 

keyword "Using the Performance Monitor".
"... > Performance monitor for 
query analysis"

You can find additional information on this topic in the "Administration" manual, 
keyword "Performance monitor for query analysis".

"... > CVS Monitor" You can find additional information on this topic in the "Administration" manual, 
keyword "Using the CVS Monitor".

"... > Database performance" You can find additional information on this topic in the "Administration" manual, 
keyword "Monitoring the database performance".

19.1.5.10 Menu "Extra > ..."

Commands in the "Extra > ..." menu

Icon Call Description
"... > Object matcher" See also chapter Basic knowledge on copying with the object matcher 

(Page 125).
You can find additional information on this topic in the "Administration" man‐
ual, keyword "Comparing and matching objects".

"... > Cross-project copy" See also chapter Copy fundamentals (Page 119) and chapter Basic knowl‐
edge on the "Cross-project copy" function (Page 124).

"... > Report designer" You can find additional information on this topic in the "Administration" man‐
ual, keyword "Administration of report templates".

"... > Reimport" You can find additional information on this topic in the "COMOS Platform 
Interfaces" 
manual, keywords "Reimport file" and "Reimport directory".

"... > Restrict working areas" You can find additional information on this topic in the "Administration" man‐
ual, keyword "Restrict working areas".

"... > Object debugger" You can find additional information on this topic in the "Administration" man‐
ual, keyword "Object debugger".

"... > Multiple document preview" See also chapter Overview of the PDF document view (Page 98) and chapter 
PDF document view with "Multiple document preview" (Page 355).
You can find additional information on this topic in the "Administration" man‐
ual, keyword "Comparing PDF documents".
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19.1.6 Menu "Plugins"

19.1.6.1 "Plugins > Basic" menu

Commands in the "Plugins > Basic > ..." menu

Icon Call Description
"... > Define attribute color" See also chapter Defining the background color and text color of attribute val‐

ues (Page 267).
"... > Document interface" See also chapter Overview of the CDI documents (Page 97).

You can find additional information on this topic in the "Basic interfaces" man‐
ual, keyword "Using a COMOS document interface".

"... > Native object XML import 
export"

You can find additional information on this topic in the "Basic interfaces" man‐
ual, keyword "Data exchange with NOXIE".

"... > Cross-class copy" See also chapter Basic knowledge on the "Cross-class copy" function 
(Page 124).
You can find additional information on this topic in the "Administration" manual, 
keyword "Cross-class copy".

"... > Full-text search" See also chapter Using the full-text search (Page 341).
You can find additional information on this topic in the "Administration" manual, 
keyword "Preparing a full-text search for document contents".

"... > Error analysis for 3D objects" You can find additional information on this topic in the "PipeSpec Designer" 
manual, keyword "Plugin "Error analysis for 3D objects"".

"... > DWG/DXF mapping editor" You can find additional information on this topic in the "Basic interfaces" man‐
ual, keyword "Configuring mapping of DWG data".

   
"... > PDMS Engineering Inter‐
face"

You can find additional information on this topic in the "3D Integration Opera‐
tion" manual, keyword "COMOS PDMS Integration".

"... > Walkinside object assign‐
ment"

You can find additional information on this topic in the "3D Integration Admin‐
istration" manual, keyword "COMOS 3D viewing".

"... > Assign line types" You can find additional information on this topic in the "P&ID Administration" 
manual, keyword "Specifying line types".

"... > Job management" You can find additional information on this topic in the "Administration" manual, 
keyword "Configuring the Job Manager". 

"... > Task management" You can find additional information on this topic in the "Administration" manual, 
keyword "Administration of task management".

"... > Data aggregation" You can find additional information on this topic in the "Administration" manual, 
keyword "Data warehouse: Data aggregation".

"... > Snapshot" You can find additional information on this topic in the "Snapshots" manual, 
""COMOS Snapshots" at a glance".
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19.1.6.2 Menu "Plugins > Automation"

Commands in the "Plugins > Automation > ..." menu

Ico
n

Call Description

"... > Signal/device assign‐
ment manager"

You can find additional information on this topic in the “EI&C Operation" manual, key‐
word "Using the signal/device assignment manager".

"... > Update macroblocks" You can find additional information on this topic in the "Automation Logical" manual, 
keyword "Update macroblocks".

"... > Bulk editing of half-open 
connections"

You can find additional information on this topic in the "EI&C Operation" manual, key‐
word "Bulk editing of half-open connections".

"... > Generic Excel import" You can find additional information on this topic in the "Automation Interfaces" manual, 
keyword "Generic Excel import".

"... > Connection pattern defi‐
nition"

You can find additional information on this topic in the "EI&C Administration" manual 
and in the "EI&C Operation" manual, keyword "Connection pattern definition".

"... > SPI interface" You can find additional information on this topic in the "Automation Interfaces" manual, 
keyword "SPI interface".

"... > Loop Document Manag‐
er"

You can find additional information on this topic in the “EI&C Operation" manual, key‐
word "Using the Loop Document Manager".

"... > Cabinet Equipment As‐
sistant"

You can find additional information on this topic in the "EI&C Operation" manual, key‐
word "Cabinet Equipment Assistant".

19.1.6.3 "Plugins > PQM" menu

Commands in the "Plugins > PQM > ..." menu

Icon Call Description
"... > Include documents" You can find additional information on this topic in the "Project Quality 

Management" manual, keyword "Include documents".
"... > File transfer" You can find additional information on this topic in the "Project Quality 

Management" manual, keyword "Bulk import of documents".
"... > Start Excel" Starts Excel.

"... > Start Outlook" Starts Outlook.

"... > Start Powerpoint" Starts Powerpoint.

"... > Start Visio" Starts Visio.

"... > Start Word" Starts Word.

"... > Viewer settings" You can find additional information on this topic in the "Project Quality 
Management" manual, keyword "Making the viewer settings".

"... > DVM transmittal" You can find additional information on this topic in the "Project Quality 
Management" manual, keyword "Transmittals".
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Icon Call Description
"... > DVM queries > ..."  

 "... > Bulk checkin/checkout You can find additional information on this topic in the "Project Quality 
Management" manual, keywords "Checking in documents in bulk" and 
"Checking out documents in bulk".

19.1.6.4 Menu "Plugins > SAP"

Commands in the "Plugins > SAP > ..." menu

Icon Call Description
"... > SAP login" You can find additional information on this topic in the "Basic interfaces" 

manual, keyword "Logging in to the SAP target system".
"... > SAP interface configuration" You can find additional information on this topic in the "Basic interfaces" 

manual, keyword "Checking the SAP interface configuration".

19.1.6.5 "Plugins > Collaboration" menu

Commands in the "Plugins > Collaboration > ..." menu

Icon Call Description
- "... > COMOS Mobile Document Review > ..." You can find more information on this topic in the "COMOS Web" 

manual, keyword "Sending COMOS documents to "COMOS Mobile 
Document Review"".

 "... > Send"

 "... > Outbox"
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19.1.7 "Help" menu

Commands in the "Help > ..." menu

Icon Call Description
"... > COMOS help system" The COMOS help system contains the documentation for the following product 

areas in CHM format:
● COMOS Platform
● COMOS Process
● COMOS Automation
● COMOS Operations
● COMOS Lifecycle
The complete COMOS documentation is available free of charge and in mul‐
tiple languages from the My Documentation Manager (http://
www.siemens.com/comos-dokumentation) on the Internet.

"... > COMOS <version number> - 
Readme"

Opens a PDF help file with important information about the installed version.

"... > COMOS <version number> - 
What's New

Opens a PDF help file with important updates about the installed version.

- "... > Show help at start" Option activated: Next time you start COMOS, the PDF help file "COMOS 
<version number> - readme" will open automatically. 

- "... > COMOS info" Information on the installed COMOS version.
- "... > Database info ..." Information regarding the database in use.

19.2 Reference of the COMOS toolbar

Default toolbar buttons

Icon Tooltip Description
"Back", "Forward" Switches to previous/next view in the history of viewed ob‐

jects.
"Open database" See also chapter Opening or switching between databases 

(Page 129).
"Open project" See also chapter Opening a project or the released area of 

a project (Page 185) and chapter Opening the working layers 
of a project (Page 193).

"Save project" -

"Print" See also chapter Printing documents (Page 312).

"Query" - See also chapter Using queries and bulk processing 
(Page 455).
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Icon Tooltip Description
"Bulk translation" For translating the objects

You can find additional information on this topic in the "Ad‐
ministration" manual, keyword "Using automatic translation 
in bulk translation".

 "Revision" See also chapter Carrying out single revisions in bulk 
(Page 324).

"Reimport" You can find additional information on this topic in the "Basic 
interfaces" manual, "Using reimport for Access/Excel files or 
directories".

"Native object XML import ex‐
port"

You can find additional information on this topic in the "Basic 
interfaces" manual, keyword "Data exchange with NOXIE".

"Full-text search" See also chapter Using the full-text search (Page 341).

"Properties tree" See also chapter Editing object properties in the properties 
tree (Page 279).

"Status window" You can find additional information on this topic in the "P&ID 
Operation" manual, keyword "Status window display".

"Symbol and document pre‐
view"

See also chapter Displaying a preview of symbols and work‐
ing areas (Page 141).

"Window list" See also chapter Closing tabs or switching between tabs 
using the window list (Page 156).

"Favorites" See also chapter Working with favorites (Page 142).

"Static new menu" See also chapter Creating multiple objects via the static new 
menu (Page 241).

19.3 Object icons reference

19.3.1 Overview of the object icons

Icons
Objects have the following icons in the structure tree of the Navigator and in other user 
interfaces.  

Object Icon Description
Project Is displayed when a project is open. 

Working layer Displayed when a working layer of a project is open.

Engineering object - Depends on class and subclass. See also chapter Icons for base and 
engineering objects (Page 579).Base object -

Document - Depends on document type. See also chapter Icons of the document 
types (Page 587).
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Object Icon Description
Connector - In the COMOS products there are various connector types and sub‐

types.
Example:
"P&ID" subtype: 

You can find additional information on this topic in the COMOS product 
manuals.

Attribute tab Collects attributes.

Attribute See also chapter Attribute fundamentals (Page 68).

DocObj object The object saves the information on which interactive report the engi‐
neering object is placed. See also chapter DocObj objects (Page 95).

Standard table Only on the "Base objects" tab. 
You can find additional information on this topic in the "Administration" 
manual, keyword "Administration of standard tables".

The icons can have additional icons. See also chapter Context-dependent additional icons 
(Page 588).

See also
Icon coloring (Page 586)

19.3.2 Icons for base and engineering objects

Principle 
The icons depend on the class and subclass of the base object. The icons of the base objects 
and the derived engineering objects are the same, but the coloring is different. See also chapter 
Icon coloring (Page 586).

Icons

Icon Class Subclass Description
"Action"  All objects of the "Action" class are administration objects and are used to 

search for or to manipulate data. The "Action" class itself has no effect in 
COMOS. The capabilities of an action object are determined by its subclass.

"Action" "Decision table" This is used to modify or replace other objects based on predetermined 
criteria. Example: If you created a motor in an assembly group, you can 
use a decision table to replace the fuses according to the power. In electrical 
engineering, this is a parameterized macro. 
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Icon Class Subclass Description
"Action" "Import" External tables can be imported into COMOS and the data of the table can 

be stored in the form of base objects or engineering objects.
You can find additional information on this topic in the "Basic interfaces" 
manual, keywords "Standard import "Blank table"" and "Standard import 
"Blank XML"".

"Action" "Object query: <sys‐
tem type>" 

Queries are tools used to find and change objects. There are separate 
queries for each of the most important system types and predefined queries 
for specific tasks. 

"Action" "Script" This subclass is not evaluated.
"General"  An object of this class is generally visible on all tabs in the Navigator of the 

engineering project.
You can find additional information on this topic in the "Administration" 
manual, keyword "General object class".

"Unit"  A group of technical devices that belong together in functional terms, or the 
topmost logical grouping that appears meaningful to the user in the techni‐
cal area. 
Units and locations are used to organize labeling systems. You can find 
additional information on this topic in the "Administration" manual, keyword 
"Labeling systems".

"Unit" "Blackbox" This subclass is not evaluated any further in current COMOS versions.
"Unit" "Category" Devices can be sorted automatically with the help of "Categories" instead 

of only being globally assigned to a unit. 
You can find additional information on this topic in the "Administration" 
manual, keyword "Categories".

"Connectors"  A connector is a connecting point at which one technical product can be 
appropriately connected with another technical product. 
You can find additional information on this topic in the "Administration" 
manual, keyword "Configuring connectors".

"Assembly"  The "Assembly" class is not evaluated in any special way. With regard to 
content, an assembly is a collection of objects that are technically related, 
mostly pre-wired or pre-connected. In electrical engineering, this is a com‐
ponent circuit. It is not mandatory that modules in this sense also have a 
base object with the "Assembly" class. However, if modules also use a base 
object of the "Assembly" class in the technical sense, then these objects 
are easier to identify.
Note: In COMOS, the term "Assembly" is used with different meanings. In 
most cases, it does not refer to a base object of the "Assembly" class.
An example of base objects of the "Assembly" class is available as a hook-
up in the "COMOS EI&C Administration", keywords "Customization over‐
view of the mounting catalog".

"Assembly" "Segment" This subclass is used for engineering tasks.
"Data set"  COMOS P&ID product, COMOS Isometrics product: 

Objects of this class are only used as carriers of a graphic. You can define 
symbols for the base object in the usual way and then place them on an 
interactive report. However, no engineering object is created. 
Design diagrams: These objects are ignored in the collision check.
Other COMOS products: The class forms an object in the normal way. 
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Icon Class Subclass Description
"Data set" "Component" COMOS FEED product: 

This subclass is not queried in the software. The "PEClasses" attribute is 
used instead. You can find additional information on this topic in the "FEED" 
manual, keyword "Component".
COMOS Isometrics product: 
Inspection objects must have this subclass. 

"Data set" "User address" The user addresses of workstations in the network can be stored here. This 
technique is used in the PLC area. 
You can find additional information on this topic in the "EI&C Administration" 
manual, keyword "User address".

"Document"  Class for evaluating and interactive documents
You can find additional information on this topic in the "Administration" 
manual, keyword "Creating, editing, and grouping document types".

"Document 
group" 

 Logical unit within the "Document" tab of COMOS. If the unit or location 
view is linked to a document group, documents that have been created 
according to a particular naming convention are referenced automatically. 
You can find additional information on this topic in the "Administration" 
manual, keyword "Base data for the documents".

"Element"  Constituent part of a device that usually does not function autonomously. 
Elements cannot be ordered individually. Exceptions are terminals. Al‐
though terminals have the "Element" object class, they behave like an ob‐
ject of the "Device" type. 
Incorporate elements using the "Elements" tab. Device requests are the 
main application area for objects in the "Element" class and without a sub‐
class. 
Elements are treated in a special way at the following points in COMOS: 
● Base objects, "System" tab, "Unique label":
● Default for FALSE class, otherwise TRUE.
● Specialties for generating the name / label.
● Function "Device.DetailType"
● Owners with class "Element" are skipped.
● The name/label is not checked across folders
● Special feature with projections for copying structures
● Attributes, link type: "Via connector":
● If the connected object does not have the source attribute and is of class 

"Element", the attribute is also searched at the owner.
"Element" "Break" No longer used.
"Element" "Wire" Wires are elements of cables. In addition, objects of this class are used for 

screens in COMOS. 
You can find additional information on this topic in the "EI&C Administration" 
manual, keyword "Base objects for cables".

"Element" "Equipment" If you build three-level terminal strips, use this subclass. 
You can find additional information on this topic in the "EI&C Administration" 
manual, keyword "Preparing terminal strips".
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Icon Class Subclass Description
"Element" "Graphic" ● COMOS ET product:

Objects of this subclass are only used as a carrier of a graphic. No 
engineering object is created.
You can find additional information on this topic in the "EI&C 
Administration" manual, keyword "C30 symbol construction". 

● COMOS P&ID product:
Objects of this subclass are always created underneath the P&ID 
diagram.
You can find additional information on this topic in the "EI&C 
Administration" manual, keyword "Additional graphics". 

● Other COMOS products: This subclass is not evaluated.
"Element" "Terminal" Terminals are elements of terminal strips. 

You can find additional information on this topic in the "EI&C Administration" 
manual, keyword ""Terminal" subclass".

"Element" "Pipe" Part of the pipe structure in P&ID planning. Pipe segments are based on 
the subclass "Pipe".
You can find additional information on this topic in the "P&ID Administration" 
manual, keyword "Preparing a base object of the pipe segment". 

"Element" "Segment" Defines a unit and/or a location for a subarea of a diagram. Works the same 
way as class "Device", subclass "Segment". 
You can find additional information on this topic in the "EI&C Administration" 
manual, keywords "ID segment", "Polygon", and "Sheet areas EI&C".

"Element" "Plug" Plugs are elements of plug strips. 
You can find additional information on this topic in the "EI&C Administration" 
manual, keyword "Base object for plugs".

"Element" "Nozzle" Area of application: P&ID
Is used for nozzles ("NOZZLE"). 
You can find additional information on this topic in the "P&ID Administration" 
manual, keyword ""Nozzles + connections" base object".

"Function"  In other words: COMOS positioning function 
The function describes the measuring or positioning tasks and the process‐
ing functions in a position. It corresponds to a "measuring point" in the P&ID 
scheme.

"Function" "Actuator" An actuating component in P&ID planning, such as a valve. It is an add-on 
part as opposed to the actuator (insert), and the pipe remains in one piece. 
You can find additional information on this topic in the "P&ID Operation" 
manual, keyword "Overview of functions".

"Function" "Actuator (insertion)" Area of application: P&ID
An actuating component in the P&ID planning. If no attribute for the sepa‐
ration of a pipe is present at the component, the subclass also serves for 
the detection of segment-cutting components.
You can find additional information on this topic in the "P&ID Operation" 
manual, keyword "Overview of functions".

"Function" "Instrumentation" Area of application: P&ID
Devices in P&ID diagrams, for example, a measuring point.
You can find additional information on this topic in the "P&ID Operation" 
manual, keyword "Overview of functions".
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Icon Class Subclass Description
"Function block"  Functional components are used in functional diagrams. Example: Function 

logic (AND link, OR link).
You can find additional information on this topic in the "Automation Logical" 
manual, keyword "Block-specific definition".

"Function block" "Action block" Is used in functional diagrams. When you are planning step sequences, an 
action block always forms the termination. 
You can find additional information on this topic in the "Automation Logical" 
manual, keyword "Step sequence".

"Function block" "Step" Is used in functional diagrams. 
You can find additional information on this topic in the "Automation Logical" 
manual, keyword "Step sequence".

"Function block" "Transition" Is used in functional diagrams. 
You can find additional information on this topic in the "Automation Logical" 
manual, keyword "Step sequence".

"Function block" "Visualization ele‐
ment"

This object represents a graphical / visual element of the subsequent unit 
controller. 

"Function ele‐
ment" 

 No longer used.

"Function ele‐
ment"

"Instrumentation" -

"Device"  A device is the smallest separately labeled technical product that fulfills a 
task together with other products. In other words: Resource. 
Thus in COMOS, "devices" are always part of a "unit" or a "location".

"Device" "Actuator (insertion)" Area of application: P&ID
Identifies P&ID components which are inserted in pipes. Example: Valves
If no attribute for the separation of a pipe is present at the component, the 
subclass also serves for the detection of segment-cutting components.

"Device" "Equipment" - 
"Device" "Terminal strip" Terminal strips connect devices and can have bridges. A terminal strip can 

be of any desired size. 
You can find additional information on this topic in the "EI&C Administration" 
manual, keyword "Terminal/plug strips, grounding".

"Device" "Cable" A cable is a bundle of wires. 
You can find additional information on this topic in the "EI&C Administration" 
manual, keyword "Cables".

"Device" "Logical potential" A logical potential is used to pass on a potential value from one connector 
to the next. 
You can find additional information on this in the "EI&C Administration" 
manual, keyword "Potential information".

"Device" "Potential" A potential represents a physical potential, hence a potential rail. For that 
reason a potential can have any desired number of connectors.
You can find additional information on this topic in the "EI&C Administration" 
manual, keyword "Potential". 

"Device" "Pipe" Alternative for the pipe structure in the P&ID planning. Is no longer used.
"Device" "Contactor/Relays" This detail class initiates the creation of a contact mirror at an object. A 

contact surface is created for relays or contactors. 
You can find additional information on this topic in the "EI&C Administration" 
manual, keyword "Relays and contactors".
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Icon Class Subclass Description
"Device" "Segment" Similar to class "Location", subclass "Segment", but was extended to cover 

locations. Objects of this subclass are used as ID segments. An engineer‐
ing object is created and a DocObj is generated. 
Segments are used in almost all planning types.

"Device" "Plug strip" Plug strips connect devices by means of a plug and socket. Plug strips 
typically do not have bridges. 
You can find additional information on this topic in the "EI&C Administration" 
manual, keyword "Plug strips".

"Device" "Nozzle" Behaves like class "Element", subclass "Nozzles". 
"Device" "Consumer" Obsolete. Objects with other subclasses can also be consumers, for exam‐

ple, contactors (subclass Coils/Relays).
You can find additional information on this topic in the "EI&C Operation" 
manual, keyword "Consumers".

"Device re‐
quest"

- Obsolete; now solved via the "Request" property of base objects.

"Costs" - Cost objects are used for mounting planning.
You can find additional information on this in the "EI&C Administration" 
manual, keyword "Mounting catalog".

"Mounting" - Here you enter the time expenditure or a special note concerning the 
mounting of a device or a unit. 
You can find additional information on this topic in the "EI&C Administration" 
manual, keyword "Mounting catalog".

"Location" - The location or mounting position of a technical module. Often also under‐
stood as a functional allocation.

"Location" "Slot" A subarea within a rack and the smallest logical unit in a control cabinet. 
Holds I/O cards, for example.

"Location" "Rack" A subarea within a control cabinet. Is used in cabinet engineering.
"Location" "Category" Devices can be automatically sorted into objects of this class instead of 

only being globally assigned to a unit. 
You can find additional information on this topic in the "Administration" 
manual, keyword "Categories A35 below the modules".

"Location" "Room" Represents the physical room in which parts of a unit controller are instal‐
led. 

"Location" "Control cabinet" Represents a physical control cabinet. 
"Location" "Segment" Similar to class "Device", subclass "Segment", but has been extended to 

cover locations. Objects of this subclass are used as ID segments. An en‐
gineering object is created and a DocObj is generated. 

"Quality assur‐
ance" 

- A blank information block that can be used for any desired internal purpo‐
ses. 

"Revision" - In COMOS this is the means used to check the versions of documents on 
the basis of defined criteria (the elements in a revision object) and to correct 
or release them as necessary. You create the revision scheme yourself.
You can find additional information on this topic in the "Administration" 
manual, keyword "Overview of the revision base objects".
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Icon Class Subclass Description
"Signal" - Signals are processed at various places in COMOS. A COMOS position 

can have multiple signals. There is also an "Signal" item with various sub‐
types in the "Type" of a connector. 
You can find additional information on this topic in the "EI&C Administration" 
manual, keyword "Connector: Signal from owner".

"Point" - A position designates a control or a process task.
"Point" "Equipment" Equipment in the P&ID planning.

You can find additional information on this topic in the "P&ID Operation" 
manual, keyword "Positions".

"Point" "Material stream" All COMOS products: This subclass is not evaluated. The "PEClasses" 
attribute is used instead.
You can find additional information on this topic in the "FEED Administra‐
tion" manual, keyword "Material stream".

"Point" "Pipe" Area of application: P&ID
A part of the pipe structure. Pipe sections are based on the subclass "Pipe".
You can find additional information on this topic in the "P&ID Administration" 
manual, keyword "Preparing a base object of the pipe segment". 

"Cable route" - Is used to group spatial wires between two locations. When you connect 
two objects on a report, the line that is drawn is automatically converted 
into a route upon conclusion with a right-click. 
You can find additional information in the "EI&C Administration" manual, 
keyword "Base objects for trays, ducts, channel parts".

"Processing" - This object is used in connection with signal processing.
"Maintenance" - A freely available parameter that is often defined as cost per unit of time.
"Time" - A freely available parameter with which you can define time ranges or points 

in time.
"Accessory" - Is not specifically evaluated. In practice, an accessory is a device that is 

available for another particular device. As their most important property, 
therefore, accessories have an assignment to a device from the device 
catalog.

"Accessory" "Equipment" Is not specifically evaluated.

See also
Classes and subclasses (Page 66)

Icons of the document types (Page 587)
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19.3.3 Icon coloring

Coloring of base objects

Color Icon RGB value Description
Red 255,0,0 You can derive engineering objects from these base objects.
Pink 255, 200, 200 These base objects structure the base data. You cannot de‐

rive engineering objects from them.
The base object has the value "Group" or "Structure" in the 
"Creation option" field in the "System" tab.

You can find additional information on this topic in the "Administration" manual, keyword 
""Creation option" control group".

If base objects are entered for a different base object on the "Elements" tab and have the 
creation option "Normal" or "Block", their icons have the same colors as on the "Elements" tab. 
See below. 

Coloring for engineering objects
As determined by the class and subclass.

Coloring on the "Elements" tab
Engineering data elements: As determined by the class and subclass.

Other elements:

Color Icon RGB values Description
Pink 255, 200, 200 Structuring base object, see above.

There are elements located below it which you can create in 
the engineering data.

Red1) 255,0,0 For engineering objects: Only among elements of structured 
base objects.
You can create these elements in the engineering data.

Light 
green

(0,255,0) Virtual element 
You can derive one or any number of elements in the engi‐
neering data.

Dark 
green2)

(0,125,0) The element is created in the engineering data automatically. 
You can delete it there.

Tur‐
quoise2)

(31,143,159) The element is created in the engineering data automatically. 
You cannot delete it.

1) Only in the properties of engineering objects
2) Only in the properties of base objects

See also chapter Elements (Page 75).

You can find additional information on this topic in the "Administration" manual, keyword 
""Virtual" control group".
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Status display, history display, and working layer display
When status display, history display, or working layer display is activated, the object icons are 
colored according to their status.

See also
Icons for base and engineering objects (Page 579)

19.3.4 Icons of the document types

Icons

Icon Document type More information
Evaluating report template See also chapter Report template (Page 87).

You can find additional information on this
topic in the "Administration" manual, keyword 
"Administration of report templates".

Interactive report template

Evaluating report See also chapter Overview of evaluating reports 
(Page 95) and chapter Working with evaluating 
reports (Page 447).

Interactive report See also chapter Basic knowledge on interactive 
reports (Page 86) and chapter Working with in‐
teractive reports (Page 368).

Grouping of documents (Package) You can find additional information on this topic 
in the "Administration" manual, keywords "Over‐
view of document types in COMOS" and "Creat‐
ing, editing, and grouping document types".

Reference document (Reference)

Unknown document (Undefine)

General document (GeneralDocument) See also chapter Change tab for the "General" 
and "PROII" document types (Page 363).

General XML
Image document
Smartsketch
Tiff document

You can find additional information on this topic 
in the COMOS product manuals.

XML document You can find additional information on this topic 
in the "Administration" manual, keywords "Over‐
view of document types in COMOS" and in the 
"Basic interfaces" manual, keyword "XML con‐
nectors".

XML connector template

External documents have the icon defined by their application.

See also
Change tab (Page 360)
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19.3.5 Context-dependent additional icons

Overview
The following table shows the additional elements that can have object icons. The icon of a 
base object or an engineering object with the "Device" class is used as the basic icon; for 
documents, the icon of an evaluating report is used:

Icon Description See also chapter ...
Unchanged basic icon -
Not release-relevant object Excluding objects from release 

(Page 224)
Request Requests and implementations (Page 80) 

With placing information activated: An object 
placed on an interactive report

Showing placing information (Page 162) 

Link to an object Creating links (Page 174) 
Local base object1) Fundamentals of base objects (Page 62) 

Element with the "Block" property Elements (Page 75)
Inherited object1) "Administration" manual, keyword "Inheri‐

tance and forwarding of objects and infor‐
mation"

Checked-in object1)

Projected object1) Basic knowledge on the "Copy structure" 
function (Page 123) 

Reference document on the "Documents" tab Automatic referencing of documents 
(Page 84) 

1) Only used in the base data.

19.4 Window with multiple use

19.4.1 "Print with revision printer" and "Export of revision" windows

Call
● Via the "Print with revision printer" tool. See also chapter Printing documents with revision 

printer (Page 315).

● Or via the "Copy TIFF/PDF of the released revision" tool. See also chapter Printing or 
exporting current revision files (Page 338).

The windows have identical control elements.
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User interface

Control elements
The windows have the following options:

"Without subdirectories" Prints the documents/the revision files of the docu‐
ments to single files. 
Components of the file name:
● Project name
● Working layer name
● SystemFullName of the document

"With subdirectories" Prints the documents/the revision files of the docu‐
ments to subdirectories which map the object tree 
of the Navigator. Files from parallel documents in 
the Navigator end up in the same subdirectory.
Structure of the directories: Project > Working lay‐
er > One folder per component of the SystemFull‐
Name 
The file names correspond to the document 
names.

"In a file" Prints the documents/the revision files of the docu‐
ments to a common file.

"With file name for the revision export of the docu‐
ment (SYS.ExportRevFileName)"

Prints the documents/the revision files of the docu‐
ments to single files. The file names are calculated 
from the attribute. 
If the attribute is missing or empty, the file name is 
generated in the same way as with the "Without 
subdirectories" option.

The windows also have a field with a button for directory selection or file selection.
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19.4.2 "Legend" window

Call
See also chapter Displaying legend of color settings (Page 197) and chapter Opening the 
legend for status display (Page 301).

Structure of "Color settings" tab

① Button for permanently saving the color settings
See also chapter "Save settings" window (Page 591).

② Column with the status values
③ Column with the assigned colors

If the mouse focus lies on a cell of the column, a button for changing the color is displayed. See 
also chapter Setting the colors for working layer levels (Page 199).

④ Button to restore the standard colors
⑤ Standard button 

Structure "Working layer color settings" tab
The structure corresponds to that of the "Color settings" tab. The left-hand column contains 
the working layers instead of the status values. 
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19.4.3 "Save settings" window

Call
Saves user-defined settings in the profile objects.

Call from various user interfaces. See the following chapters:

● Defining the background color and text color of attribute values (Page 267)

● Saving settings of query-based result tables (Page 167)

● Setting the colors for working layer levels (Page 199)

User interface

"Save settings for" control group
The following option determines which project your settings apply to:

● "Current project"

● "Base project"

● "System project"

The following option determines which users your settings apply to:

● "Current user"

● "All users"
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If an option is locked, click on the "Extended >>" button. Under the "Rights" control group, you 
can see an overview of the rights assignment.

"Current container" field
The base object under which your user-specific settings are stored.

"Rights" control group
The overview of the rights assignment refers to the options in the "Save settings for" control 
group.

You can find additional information on this topic in the "Administration" manual, keyword 
"Administration of users and rights".

19.4.4 Window for the project user rights

Call
● For project: In the context menu of a project, select the "Rights" command

● For an object: Select the object in the Navigator and use the <Ctrl+A> keyboard command
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User interface

Structure
The window has the following tabs:

● "General":

– For displaying general information about the object or the project, such as possible 
reasons why it has write protection, information about its creation, and the most recent 
change to the object

– For displaying the object rights for this object

● "Rights": 

– "Object rights" option enabled: For controlling the object rights for this object

– "Function rights" option enabled: For controlling the function rights in the current project

– If you have the "Set user rights" right, you can change how the rights are allocated by 
activating or deactivating the appropriate option. 
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More information
You can find additional information on the topic of rights and setting user rights in the 
"Administration" manual.

See also
Displaying user rights in a project (Page 190)

19.4.5 "Define insert mode for objects" window

Call
Automatically when a copied interactive report is first opened

The same menu also exists for copied reports. See also chapter Copying/pasting and cutting 
in interactive reports (Page 433).

User interface

Structure
The window has several options. The options determine whether new engineering objects are 
created when the report is copied, and where they are created:

Option Description
"Automatic" The objects placed on the original report are cop‐

ied and pasted as determined by the report set‐
tings. 

"Keep objects" The objects placed on the original report are also 
placed on the copy. This means that they are 
placed multiple times.
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Option Description
"At same position" The objects placed on the original report are cop‐

ied and pasted in parallel to the original objects. 
"Parallel to document" The objects placed on the original report are cop‐

ied and pasted next to the document. 
If the report is configured in such a way that the 
placed objects are sorted into categories, this op‐
tion has no effect. Copies are also created in the 
categories.

"Below document" The objects placed on the original report are cop‐
ied and pasted below the document. 
If the report is configured in such a way that the 
placed objects are sorted into categories, this op‐
tion has no effect. Copies are also created in the 
categories.

"Structure below document" A structure is created below the copied report. This 
reflects the structure in which placed objects from 
the original report are located.

"Do not generate objects" The DocObj objects will be deleted. No objects are 
placed on the copy of the interactive report.

See also
Basic knowledge on copying documents and reports (Page 122)

19.5 Context menu in the Navigator
See chapter Context menu in the Navigator (Page 165).
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